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About This Manual

This section explains who should read the Cisco ONS 15454 User Documentation Release 2.2.1,
how it is organized, related documentation, and document conventions.

Audience
This guide is for Cisco ONS 15454 installation technicians and administrators who are responsible
for configuring, maintaining, and enhancing ONS 15454 networks.
Organization
Chapter Title Description
Chapter 1 Installation Provides installation procedures for all ONS 15454

hardware components

Chapter 2 Card Reference Describes all ONS 15454 cards, including their features,
protection methods, and specifications

Chapter 3 Using the Cisco Transport Controller  Explains how to set up the ONS 15454 software

Chapter 4 Configuring Networks Contains procedures for configuring ONS 15454 rings
and circuits

Chapter 5 Provisioning Cards Explains how to use the CTC to configure ONS 15454
electrical cards, optical cards, and the Alarm Interface
Controller card

Chapter 6 DWDM Provides a description of dense wavelength division
multiplexing and explains how the ONS 15454 uses
DWDM to increase bandwidth

Chapter 7 Ethernet Applications Describes how to use the Ethernet features of the ONS
15454

Chapter 8 Network Management Explains the different protocols used to manage ONS
15454 networks

Chapter 9 CTC Alarms Lists the alarms generated by the ONS 15454 that can be
viewed using the CTC

Chapter 10  Maintenance Describes miscellaneous operations that the ONS 15454

requires after installation
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Chapter Title

Description

Chapter 11 TL1 Reference

Lists TL1 alarms, commands, and autonomous messages
supported by the Cisco ONS 15454

Appendix A Regulatory and Compliance Lists customer, industry, and government requirements

Requirements

met by the Cisco ONS 15454

Appendix B Glossary

Defines commonly-used terms

Appendix C  Acronyms

Defines commonly-used acronyms

Related Documentation

Cisco ONS 15454 Release 2.2.1 Release Notes

Cisco ONS 15454 Product Overview

Cisco Warranty Services for ONG Products
Cisco ONS 15454 Quick Configuration Guide

Cisco ONS 15454 Quick Installation

Related products:

Guide

Installing the Cisco ONS 15516 DWDM Filters

Conventions

The following conventions are used throughout this publication:

Note Means reader take note. Notes contain helpful suggestions or useful background information.

equipment damage or loss of data.

harm to yourself or others.

“ B P

Convention

Telcordia

Cisco Transport Controller (CTC)
Bold

Ttalic

xxxiv Cisco ONS 15454 User Documentation

Caution Means reader be careful. In this situation, you might do something that could result in

Warning Means reader be careful. In this situation, you might do something that could result in

Tips Means the information might help you solve a problem.

Definition

Replaces all instances of Bellcore, the former name of
Telcordia Technologies, Inc.

Replaces all instances of Cerent Management System (CMS)
Denotes icons, buttons, or tabs that the user must select

Field where the user enters a value
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> Used to separate consecutive actions; for example, “click the
Maintenance>Protection>Ring tabs”

Procedure: Precedes all procedures; a horizontal line indicates the end of
each procedure

Obtaining Documentation

The following sections provide sources for obtaining documentation from Cisco Systems.

World Wide Web

You can access the most current Cisco documentation on the World Wide Web at the following sites:
® http://www.cisco.com
® http://www-china.cisco.com

® http://www-europe.cisco.com

Optical Networking Product Documentation CD-ROM

Optical networking-related documentation, including Cisco ONS 15454 User Documentation,
Release 2.2.1, is available in a CD-ROM package that ships with your product. The Optical
Networking Product Documentation CD-ROM, a member of the Cisco Connection Family, is
updated as required. Therefore, it might be more current than printed documentation. The CD-ROM
package is available as a single package or as an annual subscription. You can also access Cisco
documentation on the World Wide Web at http://www.cisco.com, http://www-china.cisco.com, or
http://www.europe.cisco.com.

Ordering Documentation

Cisco documentation is available in the following ways:

® Registered Cisco Direct Customers can order Cisco Product documentation, including the
Optical Networking Product CD-ROM, from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

® Nonregistered Cisco.com users can order documentation through a local account representative
by calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, in North America,
by calling 800 553-NETS(6387).

Documentation Feedback

If you are reading Cisco product documentation on the World Wide Web, you can submit technical
comments electronically. Click Feedback in the toolbar and select Documentation. After you
complete the form, click Submit to send it to Cisco.

You can e-mail your comments to bug-doc @cisco.com.

To submit your comments by mail, for your convenience many documents contain a response card
behind the front cover. Otherwise, you can mail your comments to the following address:
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Cisco Systems, Inc.

Document Resource Connection
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance

Cisco.com

Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners
can obtain documentation, troubleshooting tips, and sample configurations from online tools.
For Cisco.com registered users, additional troubleshooting tools are available from the TAC
website.

Cisco.com is the foundation of a suite of interactive, networked services that provides immediate,
open access to Cisco information and resources at anytime, from anywhere in the world. This highly
integrated Internet application is a powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers and partners streamline
business processes and improve productivity. Through Cisco.com, you can find information about

Cisco and our networking solutions, services, and programs. In addition, you can resolve technical
issues with online technical support, download and test software packages, and order Cisco learning
materials and merchandise. Valuable online skill assessment, training, and certification programs are
also available.

Customers and partners can self-register on Cisco.com to obtain additional personalized information
and services. Registered users can order products, check on the status of an order, access technical
support, and view benefits specific to their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center

The Cisco TAC website is available to all customers who need technical assistance with a Cisco
product or technology that is under warranty or covered by a maintenance contract.

Contacting TAC by Using the Cisco TAC Website

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC by going to the TAC
website:

http://www.cisco.com/tac
P3 and P4 level problems are defined as follows:

® P3—Your network performance is degraded. Network functionality is noticeably impaired, but
most business operations continue.

® P4—You need information or assistance on Cisco product capabilities, product installation, or
basic product configuration.

In each of the above cases, use the Cisco TAC website to quickly find answers to your questions.
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To register for Cisco.com, go to the following website:
http://www.cisco.com/register/

If you cannot resolve your technical issue by using the TAC online resources, Cisco.com registered
users can open a case online by using the TAC Case Open tool at the following website:

http://www.cisco.com/tac/caseopen

Contacting TAC by Telephone

If you have a priority level 1(P1) or priority level 2 (P2) problem, contact TAC by telephone and
immediately open a case.The toll-free Optical Networking Assistance number is 1-877-323-7368.

P1 and P2 level problems are defined as follows:

® P1—Your production network is down, causing a critical impact to business operations if service
is not restored quickly. No workaround is available.

® P2—Your production network is severely degraded, affecting significant aspects of your
business operations. No workaround is available.
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CHAPTER 1

Installation

This chapter provides procedures for installing the Cisco ONS 15454. Chapter topics include
installation equipment, rack installation, equipment access, power and ground installation,
backplane interface connections (alarms, timing, craft interface, etc.), card turn-up procedures, cable
installation, cable management, and hardware specifications.

Note The Cisco ONS 15454 assembly is intended for use with telecommunications equipment
only.

Warning The ONS 15454 is intended for installation in restricted access areas. A restricted access
area is where access can only be gained by service personnel through the use of a special tool, lock,
key, or other means of security. A restricted access area is controlled by the authority responsible for
the location.

Warning The ONS 15454 is suitable for mounting on concrete or other non-combustible surfaces
only.

Warning The ONS 15454 should be installed in the lower rack position or mounted above
another ONS 15454 unit.

Warning The ONS 15454 must have 1 inch of airspace below the installed unit to allow air flow to
the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf assembly) provides
this spacing and should not be modified in any way.

Caution Unused card slots should be filled with a blank faceplate (Cisco P/N 15454-BLANK). The
blank faceplate ensures proper airflow when operating the ONS 15454 without the front door
attached.

Note The ONS 15454 is designed to comply with GR-1089-CORE Type 2 and Type 4. Install and
operate the ONS 15454 only in environments that do not expose wiring or cabling to the outside
plant. Acceptable applications include Central Office Environments (COEs), Electronic Equipment
Enclosures (EEEs), Controlled Environment Vaults (CEVs), huts, and Customer Premise
Environments (CPEs).
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1.1

1.2

1.2.1

1-2

Installation Overview

y'\

When installed in an equipment rack, the ONS 15454 assembly is typically connected to a fuse and
alarm panel to provide centralized alarm connection points and distributed power for the ONS 15454
system. Fuse and alarm panels are third-party equipment and are not described in this
documentation. If you are unsure about the requirements or specifications for a fuse and alarm panel,
consult the documentation for the related equipment.

You can mount the ONS 15454 in a 19- or 23-inch rack. The shelf assembly weighs approximately
55 pounds with no cards installed. An ONS 15454 is installed in a rack using reversible mounting
brackets on each side of the shelf. The ONS 15454 features a front door for added security, a fan tray
module for cooling, and extensive fiber management space.

ONS 15454 optical cards have SC connectors on the card faceplate. Fiber optic cables are routed into
the front of the destination cards.

DS-1, DS-3, DS3XM-6, and EC-1 units require special Electrical Interface Assemblies (EIAs) to
provide the coaxial connection points for the shelf. In most cases, EIAs are ordered with the ONS
15454 and come pre-installed on the assembly backplane. See the “Backplane Covers” section on
page 1-18 for more information about the EIAs. DS-1 units support wire wrap twisted pair
connections or an AMP CHAMP EIA. DS-3, DS3XM-6, and EC-1 units support BNC or SMB EIAs
on the assembly backplane.

The front door of the ONS 15454 shelf allows access to the shelf assembly, fan tray, and fiber
management area. The back panel provides access to alarm contacts, external interface contacts,
power terminals, and BNC/SMB connectors.

The ONS 15454 is powered using -48V DC power. Positive, negative, and ground power terminals
are accessible on the backplane.

Warning Read the installation instructions before you connect the system to its power source.

Installation Equipment

You will need the following tools and equipment to install and test the ONS 15454.

Included Materials

These materials are recommended and are shipped with the ONS 15454. The number in parentheses
gives the quantity of the item included in the package.

® #12-24 x 3/4 pan head phillips mounting screws (8)
® #12 -24 x 3/4 socket set screws (2)

® T-handle #12-24 hex tool for set screws (1)

® ESD wrist strap with 1.8 m (6 ft) coil cable (1)

® Tie wraps (10)

® Pinned Allen key for front door (1)

Cisco ONS 15454 User Documentation
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1.2.2 User-Supplied Materials

These materials and tools are recommended but are not supplied with the ONS 15454.

Equipment rack (22 inches total width for a 19-inch rack; 26 inches total width for a 23-inch rack)
Fuse panel

Power cable (from fuse and alarm panel to assembly), #12-#14 AWG

Ground cable #14 AWG (4.0 mm) stranded

Alarm cable pairs for all alarm connections, #22 or #24 AWG, solid tinned

Building Integrated Timing Supply (BITS) clock cable pair #22 or #24, solid tinned

Single mode SC fiber jumpers with UPC polish (55 dB or better) for optical cards

Shielded coaxial cable terminated with SMB or BNC connectors for DS-3 cards

Shielded ABAM cable terminated with AMP CHAMP connectors or unterminated for DS-1
cards with #22 or #24 AWG ground wire (typically about two feet in length)

Tie wraps and/or lacing cord

Labels

1.2.2.1 Tools Needed

#2 Phillips screw driver
Medium slot head screw driver
Small slot head screw driver
Wire wrapper

Wire cutters

Wire strippers

Crimp tool

1.2.2.2 Test Equipment

1.3

Volt meter
Power meter (for use with fiber optics only)

Bit Error Rate (BER) tester, DS-1 and DS-3

Installation in a Rack

The ONS 15454 is easily mounted in a 19- or 23-inch equipment rack. The shelf assembly projects
5 inches from the front of the rack. It mounts in both EIA-standard and Telcordia-standard racks.
The shelf assembly is a total of 17 inches wide with no mounting ears attached. With the mounting
ears attached, the shelf assembly is 19 inches wide. Ring runs are not provided by Cisco and may
hinder side-by-side installation of shelves where space is limited.

The ONS 15454 measures 18.5 inches high, 19 or 23 inches wide (depending on which way the
mounting ears are attached), and 12 inches deep (40.7 by 41.8 by 26.4 cm). You can install up to four
ONS 15454 shelves in a seven-foot equipment rack. The ONS 15454 must have 1 inch of
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airspace below the installed unit to allow air flow to the fan intake. If a second ONS
15454 is installed underneath the unit, the air ramp on top of the bottom unit provides the
air spacing needed and should not be modified in any way. Figure 1-1 shows the dimensions
of the ONS 15454 shelf assembly.

Figure 1-1 Dimensions

Top View
22" total width

A
Y

12"

J B

< -
< >

19" or 23" between mounting screw holes

Side View Front View
5" . 22" total width
<« < >
I A A
18.5"
oo0 §
Y y — __1&
12 19" or 23" between mounting screw holes

1.3.1 Reversible Mounting Bracket

g Caution Use only the fastening hardware provided with the ONS 15454 to prevent loosening,
deterioration, and electromechanical corrosion of the hardware and joined material.

g Caution When mounting the ONS 15454 in a frame with a non-conductive coating (such as paint,
lacquer, or enamel) either use the thread-forming screws provided with the ONS 15454 shipping kit,
or remove the coating from the threads to ensure electrical continuity.

The shelf assembly comes preset for installation in a 23-inch rack, but you can reverse the mounting
bracket to fit the smaller, 19-inch rack. The following steps describe how to reverse the shelf
assembly mounting bracket to fit a 19- inch rack.
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Procedure: Reverse the Mounting Bracket
Step 1 Remove the screws that attach the mounting bracket to the side of the shelf assembly unit.

Step2  Flip the detached mounting bracket upside down. Text imprinted on the mounting bracket
will now also be upside down.

Step 3  Place the widest side of the mounting bracket flush against the shelf assembly.

The narrow side of the mounting bracket should be towards the front of the shelf
assembly. Text imprinted on the mounting bracket should be visible and upside down.

Step4  Align the mounting bracket screw holes against the shelf assembly screw holes.
Step5  Insert the screws that were removed in Step 1 and tighten them.

Step 6  Repeat the procedure for the mounting bracket on the opposite side.

1.3.2 Mounting the ONS 15454 in a Rack

Mounting the ONS 15454 in a rack requires a minimum of 18.5 inches of vertical rack space (plus
1 inch for air flow). To ensure the mounting is secure, use two to four #12-24 mounting screws for
each side of the shelf assembly. Figure 1-2 shows the rack mounting position for the ONS 15454.

Figure 1-2 Rack Mount
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Two people should install the ONS 15454 shelf assembly; however, one person can install the shelf
assembly using the temporary set screws. Two hex head set screws are included for use when one
person is installing the shelf assembly. The shelf should be empty for easier lifting. The door can
also be removed to lighten the shelf (see the “Remove the Front Door” section on page 1-11).
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Note If you are installing the fan tray air filter using the brackets provided, mount the brackets on
the bottom of the shelf assembly before installing the ONS 15454 in a rack.

Procedure: Mount the Shelf Assembly in a Rack (One Person)
Step 1 Ensure that the shelf assembly is set for the desired rack size (either 19 or 23 inches).

Step2  Install the set screws using the hex tool that shipped with the assembly.

Step 3  Place the shelf assembly on the set screws using the screw holes that will not be used to
mount the shelf.

Step4  Lift the shelf assembly to the desired rack position.
Step5  Align the screw holes on the mounting ears with the mounting holes in the rack.
Step 6  Install one mounting screw in each side of the assembly.

At least one set of the ONS 15454’s horizontal screw slots should be used to prevent
future slippage.

Step7  When the shelf is secured to the rack, install the remaining mounting screws.

Step 8 Remove the temporary set screws.

Procedure: Mount the Shelf Assembly in a Rack (Two People)
Step 1 Ensure that the shelf assembly is set for the desired rack size (either 19 or 23 inches).

Step2  Lift the shelf assembly to the desired position in the rack.
Step3  Align the screw holes on the mounting ears with the mounting holes in the rack.

Step4  While one person holds the shelf in place, the other person can install one mounting screw
in each side of the assembly.

At least one set of the ONS 15454’s horizontal screw slots should be used to prevent
future slippage.

Step5  When the shelf is secured to the rack, install the remaining mounting screws.

1.3.3 Multiple Installations in a Rack

Most standard seven-foot racks can hold four ONS 15454s and a fuse and alarm panel. However,
unequal flange racks are limited to three ONS 15454s and a fuse and alarm panel or four ONS
15454s when using a fuse and alarm panel from an adjacent rack.

Note If you are using the bottom brackets to install the fan tray air filter, you can install three shelf
assemblies in a standard seven-foot rack. If you are not using the bottom brackets, you can install
four shelf assemblies in a rack.
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Procedure: Mount Multiple ONS 15454s in a Rack
Step 1 Install the fuse and alarm panel in the top space.

Step2  Mount the first ONS 15454 unit directly below the fuse and alarm panel.
Step3  Repeat the procedure with the third and fourth ONS 15454s.

Note The ONS 15454 must have one inch of airspace below the installed unit to allow
air flow to the fan intake. If a second ONS 15454 is installed underneath a unit, the air
ramp on top of the bottom unit provides the desired space. However, if the ONS 15454 is
installed above third party equipment, you must provide a minimum spacing of one inch
between the third party unit and the bottom of the ONS 15454. The third party equipment
must not generate heat upward into the ONS 15454.

1.3.3.1 Four Shelf System Example

A common application is linking multiple shelves with a fiber optic bus to accommodate more
access traffic than a single shelf can support. For example, if you need to drop more than 112 DS-1s
or 96 DS-3s (the maximum that can be aggregated in a single node), you can link the shelves.
However, you cannot merge multiple shelves into a single node. You can link shelves with OC-12
or OC-48 fiber spans as you would link any other two network nodes. They can be co-located in a
facility to aggregate more local traffic.

Figure 1-3 shows a four shelf system. Each shelf is identified as a separate node in the CTC, and
traffic must be mapped using CTC cross-connect options. In the figure, each node uses redundant
fiber optic cards. Node 1 uses redundant OC-N transport and OC-N bus cards for a total of four
cards, with eight free slots remaining. Nodes 2 and 3 each use two redundant OC-N bus cards for a
total of four cards, with eight free slots remaining. Node 4 uses redundant OC-12 bus cards for a total
of two cards, with ten free slots remaining. The four shelf system example presented here is one of
many ways to set up a multiple-shelf system.
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Figure 1-3 Four Shelf System
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1.3.3.2 ONS 15454 Bay Assembly

The Cisco ONS 15454 Bay Assembly simplifies ordering and installing the ONS 15454. The ONS

15454 Bay Assembly allows you to order shelf assemblies pre-installed in a seven-foot rack. The

Bay Assembly is available in a three- or four-shelf configuration. The three-shelf configuration
includes three ONS 15454 shelf assemblies, a pre-wired fuse and alarm panel, and two fiber

management trays. Optional fiber channels can be ordered. The four-shelf configuration includes

four ONS 15454 shelf assemblies and a pre-wired fuse and alarm panel. Optional fiber channels can

be ordered. A four shelf ONS 15454 Bay Assembly is shown in Figure 1-4.
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Figure 1-4 Four Shelf ONS 15454 Bay Assembly

Fuse & Alarm
Panel

Fiber ——>
Channel
(Optional Kit)

Fiber Channel —
Mounting
Brackets

(Optional Kit) — ONS 15454s

1.4 Equipment Access and Features

This section tells you how to access ONS 15454 equipment through the front door and backplane
cover and describes the equipment features.

Note The ONS 15454 has an ESD plug input and is shipped with an ESD wrist strap. The ESD plug
input is located on the outside edge of the shelf on the right hand side. It is labeled “ESD” on the top
and bottom. Always wear an ESD wrist strap and connect the strap to the ESD plug when working
on the ONS 15454.

Note The front door of the ONS 15454 is grounded to prevent the possibility of electrical shock.
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1.4.1 Front Door

The ONS 15454 features a locked door to the front compartment and a screw-in panel over the
backplane. A pinned Allen key that unlocks the front door ships with the ONS 15454. A button on
the right side of the assembly releases the door. The front door (Figure 1-5) provides access to the
ONS 15454 shelf assembly, cable management tray, fan tray assembly, and LCD screen

(Figure 1-12).

Procedure: Open the Front Cabinet Compartment
Step1  Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door.
Turn the key counterclockwise to unlock the door and clockwise to lock it.

Step2  Press the door button to release the latch.

Step3  Swing the door open.

Figure 1-5 Front Door
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The Critical, Major, and Minor alarm LEDs visible through the front door indicate whether a
Critical, Major, or Minor alarm is present anywhere on the ONS 15454. These LEDs must be visible
so technicians can quickly determine if any alarms are present. You can use the LCD to further
isolate alarms. See the “LLCD Alarm Functions” section on page 1-18 for more information.
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You can remove the front door of the ONS 15454 to provide unrestricted access to the front
assembly.

Procedure: Remove the Front Door
Step1  Open the door.

Step2  Lift the door from its hinges from the top left corner of the door (Figure 1-6).

Figure 1-6 Door Hinge
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An erasable label (Figure 1-7) is pasted on the inside of the front door. You can use the label to record

slot assignment, port assignments, card types, node ID, rack ID, and serial number for the ONS
15454.
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Figure 1-7 Erasable Label on the Inside Door
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1.4.2 Card Slots

The ONS 15454 shelf assembly has 17 card slots numbered sequentially from left to right. Slots 1-4
and 14-17 are “multispeed” slots. They can host any ONS 15454 card except the OC-48. Slots 5, 6,
12 and 13 are “high-speed” slots. They can host any ONS 15454 card including OC-48 cards. Slots
7 and 11 are dedicated to timing communications and control (TCC) cards. Slots 8 and 10 are
dedicated to cross-connect (XC and XCVT) cards. Slot 9 is reserved for the optional Alarm Interface
Controller (AIC) card. Slots 3 and 15 can also host DS1N-14 and DS3N-12 cards that are used in
1:N protection. Each shelf assembly slot has a symbol that indicates the type of cards that can be
installed in the slot (see the “Slot Requirements” section on page 1-36 for a list).

Caution Do not operate the ONS 15454 with a single TCC/TCC+ card or a single XC/XCVT card
A installed. Always operate the shelf assembly with one working and one protect of each type of card.

1.4.3 Cable Management Facilities
The ONS 15454 cable management facilities include the following:

® (Cable management clips on optical card faceplates
® A cable routing channel that runs the width of the shelf assembly
® Fiber guides at each side opening of the cable routing channel

The plastic horseshoe-shaped fiber guides ensure that the proper bend radius is maintained in the
fibers. You can remove the fiber guide if necessary to create a larger opening (if you need to route
copper Ethernet cables out the side, for example). It is removed by taking out the three screws
that anchor it to the side of the shelf assembly.
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¢ A fold-down door
® (able tie wrap facilities on EIAs
® Reversible jumper routing fins
You can route cables out either side by positioning the fins as desired.
® Jumper slack storage reels (2) on each side panel

These reels are used to reduce the amount of slack in cables that are connected to other devices.
They are easily removed by taking out the screw in the center of each reel.

Figure 1-8 shows the cable management facilities in the shelf assembly that can be accessed through
the fold-down front door of the shelf, including the cable routing channel and the jumper routing fins.

Figure 1-8 Front Panel Cable Management
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See the “Cable Management” section on page 1-50 for more detailed cable management
information.

1.4.4 Fan Tray Assembly

The fan tray assembly is located at the bottom of the ONS 15454 front compartment. The fan tray is
aremovable drawer that holds fans and fan control circuitry for the ONS 15454. The front door can
be left in place when removing or installing the fan tray but removal is recommended. After you
install the fan tray, you should only need to access it if a fan failure occurs or you need to replace or
clean the fan tray filter.

Note Install the fan tray filter before installing the fan tray assembly if you are not using the bottom
brackets to install the filter on the shelf assembly.

To install or replace the fan tray assembly, it is not necessary to move any of the cable management
facilities. You can remove the fan tray assembly using the retractable handles and replace it by
pushing until it plugs into the receptacle on the back panel.

The fan tray assembly features an air filter at the bottom of the tray that can be installed and removed
by hand. Remove and visually inspect this filter every 30 days. When the filter is dirty, remove the
filter and clean it by either vacuuming the filter or running water through it. Because the filter
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material is delicate, only a very low-power vacuum should be used. If you are cleaning with water,
make sure the filter is completely dry before replacing it in the fan tray. Spare filters should be kept
in stock.

The shelf assembly ships with a bottom bracket that can be used to install the filter. The bottom
bracket consists of two grooved metal pieces that attach to the bottom of the shelf assembly using
three screws each. When the fan tray air filter is installed using the bottom bracket, the filter can be
installed and removed without first removing the fan tray assembly. The following two procedures
describe both methods of filter installation.

Caution Do not force the fan tray assembly into place when installing a fan tray. Forcing the fan
A tray assembly into place can damage the connectors on the fan tray and/or the connectors on the back
panel of the shelf assembly.

Procedure: Install or Replace the Fan Tray Air Filter Without the Bottom Brackets
Step1  Remove the fan tray assembly.

If you are replacing the filter, remove the old filter.

Step2  Slide the filter into the shelf assembly.

Note You must place the edge of the filter flush against the front of the fan tray assembly
compartment when installing the fan tray on top of the filter. Failure to do so could result
in damage to the filter, the fan tray, or both.

Although the filter will work if installed with either side facing up, Cisco recommends that you
install it with the metal bracing facing up to preserve the surface of the filter.

If the bottom bracket is used to install the fan tray air filter, the fan tray does not need to be removed
to access the filter. Attach the brackets to the bottom of the shelf assembly before performing rack
installation.

Procedure: Install or Replace the Fan Tray Air Filter Using the Bottom Brackets
Step1  With the fan tray assembly removed, place the ONS 15454 face down on a flat surface.

Step2  Locate the three screw holes that run along the left and right sides of the bottom of the
shelf assembly.

Step 3  Secure each bracket to the bottom of the shelf assembly using the screws provided.

Each bracket has a filter stopper and a flange on one end. Make sure to attach the brackets
with the stoppers and flanges at the rear of the shelf assembly (the top, if the ONS 15454
is face-down during installation).

Figure 1-9 illustrates bottom bracket installation and Figure 1-10 illustrates fan tray filter
replacement when bottom brackets are used to install the filter.
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Note If you are using the bottom brackets to install the fan tray air filter, you can install three shelf
assemblies in a standard seven-foot rack. If you are not using the bottom brackets, you can install
four shelf assemblies in a rack.

Figure 1-9 Bottom Bracket Installation
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Figure 1-10 Fan Tray Filter Replacement

34237

Fan tray filter
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Procedure: Install the Fan Tray
Step 1 Remove the front door of the shelf assembly.

Step2  Slide the fan tray into the shelf until the electrical plug at the rear of the tray plugs into
the corresponding receptacle on the backplane.

Step 3  To verify that the tray has plugged into the backplane, check that the LCD on the front of
the fan tray is activated.

Procedure: Remove the Fan Tray
Step1  Remove the front door of the shelf assembly.

Step2  Fold out the retractable handles at each outside edge of the fan tray.
Step 3  Slide the fan tray out of the shelf by gently pulling on the handles.

Figure 1-11 shows the location of the fan tray. The filter will function no matter which
side faces up but Cisco recommends that you install the filter with the metal bracing
facing up against the fan tray.

Figure 1-11 Fan Tray Assembly
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Fan speed is controlled by Timing Communications and Control (TCC) card temperature sensors.

The sensors measure the input air temperature at the fan tray assembly. Fan speed options are low,
medium, and high. If the TCC card fails, the fans automatically shift to high speed. The temperature
measured by the TCC sensors is displayed on the LCD screen.
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If one or more fans fail on the fan tray assembly, replace the entire assembly. You cannot replace
individual fans. The red Fan Fail LED on the front of the fan tray illuminates when one or more fans
fail. For fan tray replacement instructions, see the “Install the Fan Tray” section on page 1-16. The
red Fan Fail LED clears after you install a working fan tray.

1.4.5 LCD Screen

The ONS 15454 LCD screen provides port-level information for all ONS 15454 card slots.

You can set the IP address, subnet mask, and default router for the node by using the LCD screen.
This allows you to accomplish these basic operations without a computer. For instructions about
using the LCD screen to set these parameters, see the “Enter IP Address Using Front Panel LCD”
section on page 8-10.

Press the Slot, Port, or Status buttons to display status information for each ONS 15454 slot and port.
The LCD displays the number of Critical, Major, and Minor alarms on a slot or port basis.

Procedure: View Alarms Counts on a Specific Slot and Port
Step1  Use the Slot button to toggle to the desired slot number.

Set the slot number to Slot 0 to see a summary of alarms for the node.
Step2  Use the Port button to toggle to the port.
Step 3  Use the Status button to toggle through all active alarms and conditions.

Figure 1-12 shows the LCD panel.

Figure 1-12 LCD Panel
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By default, the LCD screen displays the ONS 15454 network element IP address. The Cisco
Transport Controller needs this address to access the ONS 15454.

The LCD panel alternately displays the node name and the current date. The IP address alternates
with the current software version on the LCD; the time and temperature also display alternately.

The information displayed on the LCD is determined by the software version you are currently
running.

Caution If the ONS 15454 node connects to a LAN, change the default ONS 15454 IP address to

A an address that is compatible with the network. If you do not change the IP address, the network can
be disrupted. For IP addressing procedures, see the “Setup a PC for Direct Connection” section on
page 3-5.
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1.4.6 LCD Alarm Functions

Note The Critical, Major and Minor alarm LEDs on the fan tray front panel indicate whether a
critical, major, or minor alarm is present anywhere on the ONS 15454 assembly. These LEDs are
viewable through the front door so that you can quickly determine if any alarms are present on the
assembly. These LEDs are independent of the Card, Port, and Status indicators on the LCD. You can
view specific alarm messages in the Alarms menu in the CTC.

When you press the Slot, Port, or Status buttons, the LCD displays the selected slot and port and the
number of Critical, Major, or Minor alarms.

See Chapter 2, “Card Reference,” for descriptions of the port-level states supported by ONS 15454
cards.

1.4.7 Backplane Covers

To access the ONS 15454 backplane, remove the sheet metal on each side of the backplane
(Figure 1-13). Each sheet metal panel is held in place with nine 6-32 x 3/8 inch Phillips screws.

Figure 1-13 Backplane Sheet Metal Covers
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Before installing EIA(s), you need to prepare the backplane by removing the backplane sheet metal
covers to expose the EIA backplane mating connectors.
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Procedure: Remove the Backplane Sheet Metal Covers

Step 1 To remove the lower backplane cover, loosen the five screws that secure it to the ONS
15454 and pull it away from the shelf assembly.

Step2  Loosen the nine perimeter screws that hold the backplane sheet metal cover(s) in place.
Step 3  Lift the panel by the bottom to remove it from the shelf assembly.

Step 4  Store the panel for later use. Attach the backplane sheet metal cover(s) whenever EIA(s)
are not installed.

Figure 1-13 shows the sheet metal covers on the ONS 15454 backplane.

1.4.7.1 EIA Backplane Cover (Optional)

EIAs are typically pre-installed on the ONS 15454 when ordered with the system. EIAs must be
ordered when using DS-1, DS-3, DS3XM-6, or EC-1 cards. Four different EIAs are available for the
ONS 15454: BNC, High-density BNC, SMB, and AMP CHAMP. This section describes each EIA
in detail.

EIAs host a special card that provides coaxial cable connection points (SMB or BNC) for the DS-3
or EC-1 cards. EIAs also host twisted pair wire-wrap adapters for SMB connectors or, for the DS-1
card, AMP CHAMP connectors. EIAs also feature a special backplane cover with cutouts over the
cable connectors. You can install EIAs on one or both sides of the ONS 15454 backplane in any
combination (in other words, AMP Champ on Side A and BNC on Side B or High-density BNC on
side A and SMB on side B, and so forth).

If you are installing EIAs after the ONS 15454 shelf assembly is installed, plug the EIA card into the
backplane. The EIA has six electrical connectors that plug into six corresponding backplane
connectors. The EIA must replace the standard sheet metal cover to provide access via the coaxial
cable connectors. The EIA sheet metal covers use the same screw holes as the solid backplane
panels, but they have 12 additional 6-32 x 1/2 inch Phillips screw holes so you can screw down the
cover and the card using standoffs on the EIA card. For information about installing EIAs, see the
“Install an EIA” section on page 1-24. To view a list of EIAs and their functions, see Table 10-1 on
page 10-13.

1.4.7.2 BNC EIA

The ONS 15454 BNC EIA supports Trompeter UCBJ224 75 Ohm 4 leg connectors. You can use
BNC EIAs for DS-3 (including the DS3XM-6) or EC-1 cards. Figure 1-14 shows the ONS 15454
with pre-installed BNC EIAs.

For instructions on installing coaxial cable with BNC connectors, see the “BNC Installation” section
on page 1-43.
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Figure 1-14 BNC Backplane
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The EIA side marked “A” has 24 pairs of BNC connectors. The first 12 pairs of BNC connectors
correspond to ports 1-12 for a 12-port card and map to Slot 2 on the shelf assembly. The BNC
connector pairs are marked “Tx” and “Rx” to indicate transmit and receive cables for each port. You
can install an additional card in Slot 1 as a protect card for the card in Slot 2. The second 12 BNC
connector pairs correspond to ports 1-12 for a 12-port card and map to Slot 4 on the shelf assembly.
You can install an additional card in Slot 3 as a protect card for the card in Slot 4. Slots 5 and 6 do
not support DS-3 cards when BNC connectors are used.

The EIA side marked “B” provides an additional 24 pairs of BNC connectors. The first 12 BNC
connector pairs correspond to ports 1 to 12 for a 12-port card and map to Slot 14 on the shelf
assembly. The BNC connector pairs are marked “Tx” and “Rx” to indicate transmit and receive
cables for each port. You can install an additional card in Slot 15 as a protect card for the card in Slot
14. The second 12 BNC connector pairs correspond to ports 1 to 12 for a 12 port card and map to
Slot 16 on the shelf assembly. You can install an additional card in Slot 17 as a protect card for the
card in Slot 16. Slots 12 and 13 do not support DS-3 cards when BNC connectors are used.

When BNC connectors are used and a DS3N-12 card is in Slot 3 or 15, the 1:N card protection
extends only to the two slots adjacent to the 1:N card due to BNC wiring constraints.

1.4.7.3 High-Density BNC EIA

1-20

The ONS 15454 High-density BNC EIA supports Trompeter UCBJ224 75 Ohm 4 leg connectors.
You can use High-density BNC EIAs for DS-3 (including the DS3XM-6) or EC-1 cards. Figure 1-15
shows the ONS 15454 with pre-installed High-density BNC EIAs.

For instructions on installing coaxial cable with High-density BNC connectors, see the
“High-Density BNC Installation” section on page 1-45.
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Figure 1-15 High-density BNC Backplane
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The EIA side marked “A” hosts 48 pairs of BNC connectors. Each column of connector pairs is
numbered and corresponds to the slot of the same number. The first column (12 pairs) of BNC
connectors corresponds to Slot 1 on the shelf assembly, the second column to Slot 2, the third column
to Slot 4 and the fourth column to Slot 5. The rows of connectors correspond to ports 1-12 of a
12-port card. The EIA side marked “B” provides an additional 48 pairs of BNC connectors. The first
column (12 pairs) of BNC connectors corresponds to Slot 13 on the shelf assembly, the second
column to Slot 14, the third column to Slot 16 and the fourth column to Slot 17. The rows of
connectors correspond to ports 1-12 of a 12-port card. The BNC connector pairs are marked “Tx”
and “Rx” to indicate transmit and receive cables for each port. The High-density BNC EIA supports
both 1:1 and 1:N protection across all slots.

Install the High-density BNC EIA(s) after removing the backplane sheet metal covers or existing

EIA(S).

1.4.7.4 SMB EIA

The ONS 15454 SMB EIA supports AMP 415484-1 75 Ohm 4 leg connectors. You can use SMB
EIAs with DS-1, DS-3 (including the DS3XM-6), and EC-1 cards. If you use DS-1 cards, use the
DS-1 electrical interface adapter to terminate the twisted pair DS-1 cable from the backplane.
Figure 1-16 shows the ONS 15454 with pre-installed SMB EIAs and the sheet metal cover and screw
locations for the EIA.

For instructions on installing SMB connectors, see the “SMB Installation” section on page 1-45.
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Figure 1-16 SMB Backplane
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The EIA side marked “A” hosts 84 SMB connectors in six columns of 14 connectors. The “A”
side columns are numbered 1-6 and correspond to Slots 1-6 on the shelf assembly. The EIA side
marked “B” hosts an additional 84 SMB connectors in six columns of 14 connectors. The “B”
side columns are numbered 12-17 and correspond to Slots 12-17 on the shelf assembly. The

connector rows are numbered 1-14 and correspond to the 14 ports on a DS-1 card. If you use a
DS-3 or EC-1 card, only ports 1-12 are active. If you use a DS3XM-6 card, only ports 1-6 are
active. The SMB connector pairs are marked “Tx” and “Rx” to identify transmit and receive

cables for each port. If you use SMB connectors, you can install DS-1, DS-3, or EC-1 cards in
any multispeed slot.

1.4.7.5 AMP CHAMP EIA

The ONS 15454 AMP CHAMP EIA supports 64-pin (32 pair) AMP CHAMP connectors for each
slot on both sides of the shelf assembly where the EIA is installed. Cisco AMP CHAMP connectors
are female AMP # 552246-1 with AMP # 552562-2 bail locks. Each AMP CHAMP connector
supports 14 DS-1 ports. You can use AMP CHAMP EIAs with DS-1 cards. Figure 1-17 shows the
ONS 15454 with pre-installed AMP CHAMP EIAs and the corresponding sheet metal cover and
screw locations for the EIA.

For instructions on installing AMP CHAMP connector DS-1 cables, see the “AMP CHAMP
Installation” section on page 1-48.
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Figure 1-17 AMP CHAMP Backplane
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The EIA side marked “A” hosts six AMP CHAMP connectors. The connectors are numbered 1-6 for
the corresponding slots on the shelf assembly. Each AMP CHAMP connector on the backplane
supports 14 DS-1 ports for a DS1-14 card, and each connector features 28 live pairs—one transmit
pair and one receive pair—for each DS-1 port.

The EIA side marked “B” hosts six AMP CHAMP connectors. The connectors are labeled 12—17 for
the corresponding slots on the shelf assembly. Each AMP CHAMP connector on the backplane
supports 14 DS-1 ports for a DS1-14 card, and each connector features 28 live pairs—one transmit
pair and one receive pair—for each DS-1 port.

Procedure: Remove an EIA

Step 1 To remove the lower backplane cover, loosen the five screws that secure it to the ONS
15454 and pull it away from the shelf assembly.

Step2  Loosen the nine perimeter screws that hold the EIA in place.

If you are removing an AMP CHAMP EIA, remove the fastening plate before
proceeding. To remove the fastening plate, loosen the two thumbscrews.

Step 3  Lift the EIA handles and gently pull the EIA panel away from the backplane.
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Procedure: Install an EIA

Step 1 To remove the lower backplane cover, loosen the five screws that secure it to the ONS
15454 and pull it away from the shelf assembly.

Step2  Line up the connectors on the EIA with the mating connectors on the backplane.
Step3  Gently push the EIA until both sets of connectors fit together snugly.

Step4  Replace the nine perimeter screws that were removed with the backplane sheet metal
cover.

Step5 If you are installing an AMP CHAMP EIA, proceed to Step 6; if you are installing any
other EIA, proceed to Step 7.

Step6  Secure the AMP CHAMP EIA by attaching the fastening plate to the shelf assembly.

The fastening plate attaches over the EIA and to the shelf assembly using the integrated
thumbscrews.

Step 7  Reattach the lower backplane cover.

Note EIAs are hot-swappable. You do not need to disconnect power to install or remove
ElAs.

1.4.7.6 Lower Backplane Cover
The lower section of the ONS 15454 backplane is covered by a Plexiglas protector, which is held in
place by five 6-32 x 1/2 inch screws. Remove the lower backplane cover to access the Alarm
Interface Panel (AIP), alarm pin field, and power terminals.

Figure 1-18 Lower Backplane Cover
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Procedure: Access the Alarm Interface Panel, Alarm Pin Field or Power Terminals

Step 1
Step 2
Step 3

Unscrew the five retaining screws that hold the Plexiglas cover in place.
Grasp the Plexiglas cover at each side.

Gently pull the cover away from the backplane (shown in Figure 1-18).

1.4.7.7 Alarm Interface Panel

The Alarm Interface Panel (AIP) is located above the alarm pin field on the lower section of the
backplane (see the “Equipment Access and Features” section on page 1-9 for information about how
to access the AIP). The AIP provides surge protection for the ONS 15454 shelf assembly. It also
provides an interface from the backplane to the fan tray assembly and LCD. The AIP plugs into the
backplane using a 96 pin DIN connector and is held in place with two retaining screws. The panel
has a non-volatile memory chip that stores the unique node (MAC) address.

The MAC address identifies the nodes that support circuits. It allows the CTC to determine circuit
sources, destinations, and spans. The TCC cards in the ONS 15454 also read the MAC address to
store the node database. You can change the default IP address in CTC. See the “Set Up Network
Information” section on page 3-23 for instructions.

If the AIP fails, a MAC Fail alarm displays on the CTC Alarms menu. See the “Viewing ONS 15454
Alarms” section on page 3-18 for more information about alarms.

Procedure: Replace the Alarm Interface Panel

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8
Step 9

Remove the clear cover from the AIP.

Unscrew the two screws that hold the AIP in place.

Grip the panel on each side.

Gently remove the panel from the backplane.

Remove the fan tray assembly power cable.

Attach the fan tray assembly power cable to the new AIP.

Place the new AIP on the backplane by plugging the panel into the backplane using the
DIN connector.

Replace the screws that secure the panel to the backplane.

Reset both TCCs, one at a time.

1.5 Power and Ground Installation

This section explains how to connect the ONS 15454 assembly to the power supply.

a Warning Shut off the power from the power source before beginning work.
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Warning Always use the supplied electrostatic discharge wristband when working with a powered
A ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of
the shelf assembly.

a Warning Do not mix conductors of dissimilar metals in a terminal or splicing connector where
physical contact occurs (such as copper and aluminum, or copper and copper-clad aluminum), unless
the device is suited for the purpose and conditions of use.

a Warning Connect the ONS 15454 only to a DC power source that complies with the safety
extra-low voltage (SELV) requirements in IEC 60950-based safety standards

Use the following wiring conventions:
® Red wire for battery connections (-48V DC)

® Black wire for battery return connections (OV DC)

Note Use an external disconnect (minimum 15A fused) for service purposes. Install according to
local site practice.

The ONS 15454 has redundant -48V DC #8 power terminals on the assembly backplane. The
terminals are labeled BAT1, RET1, BAT2, and RET?2 and are located on the lower section of the
backplane behind a Plexiglas cover. See the “Equipment Access and Features” section on page 1-9
for information about accessing the power terminals.

To install redundant power feeds, use four power cables and one ground cable. For a single power
feed, only two power cables and one ground cable are required. Use #12 or #14 AWG cable. Use a
conductor with low impedance to ensure circuit overcurrent protection. However, the conductor
must have the capability to safely conduct any fault current that might be imposed.

a Warning When installing redundant power feeds, do not use aluminum conductors.

a Warning If you use redundant power leads to power the ONS 15454, disconnecting one lead will
not remove power from the shelf.

Procedure: Install Redundant Power Feeds

Step1  Measure and cut the cables as needed to reach the ONS 15454 from the fuse panel. Use
15A fuses for each power lead. Figure 1-19 shows the ONS 15454 power terminals.

Step2  Dress the power and ground cables according to local site practice.

a Warning When installing the ONS 15454, the ground connection must always be made first and
disconnected last.

Step 3 Remove or loosen the #8 power terminal screws on the ONS 15454. To avoid confusion,
label the cables connected to the BAT1/RET1 power terminals as /, and the cables
connected to the BAT2/RET2 power terminals as 2.
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Note Use only listed compression type connectors when terminating the battery, battery
return, and frame ground conductors.

Caution Before you make any crimp connections, coat all bare conductors (battery, battery return,

A and frame ground) with an appropriate antioxidant compound. Bring all unplated connectors,
braided strap, and bus bars to a bright finish, then coat with an antioxidant before you connect them.
You do not need to prepare tinned, solder plated, or silver-plated connectors and other plated
connection surfaces, but always keep them clean and free of contaminants.

g Caution When terminating power, return, and frame ground, do not use soldering lug, screwless
(push-in) connectors, quick-connect, or other friction-fit connectors.

Step 4

Step 5

a Warning

Step 6

Step 7

Step 8

Strip 1/2 inch of insulation from all power cables that you will use. If you are using lugs,
crimp the lugs onto the ends of all power leads.

Note When terminating battery and battery return connections as shown in Figure 1-19,
follow a torque specification of 10 in-Ibs. When terminating a frame ground, use the
kep-nut provided with the ONS 15454 and tighten it to a torque specification of 31 in-lbs.
The kep-nut provides a frame ground connection that minimizes the possibility of
loosening caused by rotation during installation and maintenance activity. This type of
prevention is inherently provided by the terminal block for battery and battery return
connections.

Terminate the return 1 lead to the RET1 backplane terminal. Use oxidation prevention
grease to keep connections non-corrosive.

Do not secure multiple connectors with the same bolt assembly.

Terminate the negative 1 lead to the negative BAT1 backplane power terminal. Use
oxidation prevention grease to keep connections non-corrosive.

If you use redundant power leads, terminate the return 2 lead to the positive RET terminal
on the ONS 15454. Terminate the negative 2 lead to the negative BAT2 terminal on the
ONS 15454. Use oxidation-preventative grease to keep connections non-corrosive.

Route the cables out using the plastic cable clamp below the power terminals.
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Figure 1-19
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You only ground one cable to ground the assembly. Terminate the other end of the rack ground cable
to ground according to local site practice. The ONS 15454 backplane also has a ground terminal on
the right side of the backplane. Connect a ground terminal for the frame ground (FGND) terminal

according to local site practice.

If the system loses power or both TCC cards are reset, you must reset the ONS 15454 clock. After
powering down, the date defaults to January 1, 1970, 00:04:15.

Warning Do not apply power to the ONS 15454 until you complete all installation steps.

1.6 Alarm Pin Field Connections

1-28

A

Caution Always use the supplied electrostatic discharge wristband when working with a powered
ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of

the shelf assembly.

The ONS 15454 backplane has an alarm pin field located at the bottom of the backplane. The alarm
pin field provides 0.045 square inch wire-wrap pins for installing external alarms, timing input and
output, and craft interface terminals. This section describes the alarm pin field and the pin
assignments for the field. Figure 1-20 shows the wire-wrap pins on the alarm pin field. Beneath each
wire-wrap pin is a frame ground pin. Frame ground pins are labeled FG1, FG2, FG3, etc. Install the
ground shield of the cables connected to the backplane to the ground pin that corresponds to the pin
field used. Figure 1-20 shows pinouts for the ONS 15454.
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See the “Equipment Access and Features” section on page 1-9 for information about how to access
the alarm pin field.

Figure 1-20 Pinouts

A B A B

A B A B A B A B A B A B A B A A B
1 1 1 1 1 1 1 1 1 1 1 1
2 2 2 2 2 2 2 2 2 2 2882
3 3 3 3 3 3 3 3 3 3 3 TBOS
OO0 « OO« OO « OO « OO « OO « O+«

BITS LAN ENVIR _ ALARMS ACO X.25 MODEM _ CRAFT LOCAL _ ALARMS
O O O w O oar O O ©) O O w O awn O ©)
FG1 FG2 FG3 FG4 FGS FG6 FG7 FG8 FG9 FG10 FG11 FG12

Field  Pin ‘ Function | Field | Pin Function ‘

BITS A1 BITS Output 2 negative (-) ENVIR |A1 Normally open output pair number 1
B1 | BITS Output 2 positive (+) ALARMS (g1
A2 BITS Input 2 negative (-) out A2 Normally open output pair number 2
B2 BITS Input 2 positive (+) N/O B2
A3 BITS Output 1 negative (-) A3 Normally open output pair number 3
B3 BITS Output 1 positive (+) B3
A4 BITS Input 1 negative (-) A4 Normally open output pair number 4
B4 BITS Input 1 positive (+) B4
LAN Connecting to a hub, or switch ACO A1l Normally open ACO pair
A1 RJ-45 pin 6 RX- B1
B1 RJ-45 pin 3 RX+ CRAFT | A1 Receive (PC pin #2)
A2 RJ-45 pin 2 TX- A2 Transmit (PC pin #3)
B2 RJ-45 pin 1 TX+ A3 Ground (PC pin #5)
Connecting to a PC/Workstation or router A4 DTR (PC pin #4)
Al RJ-45 pin 2 RX- LOCAL | A1 Alarm output pair number 1: Remote
B1 RJ-45 pin 1 RX+ ALARMS g1 | audible alarm.
A2 RJ-45 pin 6 TX- (AAutiJilzle) A2 AIarAm output pair number 2: Critical
B2 RJ-45 pin 3 TX+ B2 |audible alarm.
ENVIR Al Alarm input pair number 1: Reports N/O A3 Alarm output pair number 3: Major
ALARMS | B1 closure on connected wires. B3 audible alarm.
IN A2 Alarm input pair number 2: Reports A4 Alarm output pair number 4: Minor
B2 closure on connected wires. B4 audible alarm.
A3 Alarm input pair number 3: Reports || LOCAL |A1 Alarm output pair number 1: Remote
B3 closure on connected wires. ALARMS [g1 visual alarm.
A4 Alarm input pair number 4: Reports (V\i/slusal) A2 Alarm output pair number 2: Critical
B4 closure on connected wires. B2 visual alarm.
N/O A3 Alarm output pair number 3: Major
B3 visual alarm.
A4 Alarm output pair number 4: Minor o]
B4 visual alarm. 9
(3]

1.6.1 Alarm Installation

The alarm pin field supports up to 17 alarm contacts: four audible alarms, four visual alarms, one

Alarm Cutoff (ACO), and four user-definable alarm inputs and outputs. Audible alarm contacts are
in the LOCAL ALARM AUD pin field. Visual contacts are in the LOCAL ALARM VIS pin field.
Both of these types of alarms fall into the LOCAL ALARMS category. User-definable contacts are
in the ENVIR ALARM IN and ENVIR ALARM OUT pin fields. These two types of alarms fall into
the ENVIR ALARMS category; you must have the AIC card installed in order to use the ENVIR

ALARMS. The MODEM and X.25 pin fields are not currently used. Alarm contacts are Normally
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Open (N/O), meaning that the system closes the alarm contacts when the corresponding alarm
conditions are present. Each alarm contact consists of two wire-wrap pins on the assembly
backplane. The alarm contacts are wired to the TCC card through the ONS 15454 backplane. Visual
and Audible alarm contacts are classified as Critical, Major, Minor, and Remote. Refer to

Figure 1-20 for alarm pin assignments.

Visual and audible alarms are typically wired to trigger an alarm light at a central alarm collection
point when the corresponding contacts are closed. You can use the Alarm Cutoff pins to activate a
remote ACO for audible alarms. You can also activate the ACO function by pressing the ACO button
on the TCC card faceplate. The ACO function clears all audible alarm indications. After clearing the
audible alarm indication, the alarm is still present and viewable in the Alarms tab in CTC.

To install alarm wires on the backplane, use #22 or #24 AWG alarm wires. Wrap the alarm wires on
the appropriate wire-wrap pins according to local site practice. Each pin field has a frame ground pin
beneath it.

1.6.2 Timing Installation

The ONS 15454 backplane supports two Building Integrated Timing Supply (BITS) clock pin fields.
The first four BITS pins, rows 3 and 4, support output and input from the first external timing device.
The last four BITS pins, rows 1 and 2, perform the identical functions for the second external timing
device. Table 1-1 lists the pin assignments for the BITS timing pin fields.

Table 1-1 External Timing Pin Assignments for BITS
External Device Contact Tip & Ring Function

First external device A3 (BITS 1 Out) Primary ring (-) Output to external device
B3 (BITS 1 Out) Primary tip (+) Output to external device
A4 (BITS 1 In) Secondary ring (-) Input from external device
B4 (BITS 1 In) Secondary tip (+) Input from external device

Second external device A1 (BITS 2 Out) Primary ring (-) Output to external device
B1 (BITS 2 Out) Primary tip (+) Output to external device
A2 (BITS 2 In) Secondary ring (-) Input from external device
B2 (BITS 2 In Secondary tip (+) Input from external device

Note Refer to Telcordia SR-NWT-002224 for rules about provisioning timing references

To install timing wires on the backplane, use #22 or #24 AWG wire; wrap the clock wires on the
appropriate wire-wrap pins according to local site practice. The BITS pin field (FG1) has a frame
ground pin beneath it. Wrap the ground shield of the alarm cable to the frame ground pin. For more
detailed information about timing, see the “Setting Up ONS 15454 Timing” section on page 3-29.

1.6.3 LAN Installation

You can use the Local Area Network (LAN) pins on the ONS 15454 backplane to connect the ONS
15454 to a PC or Ethernet LAN. You can use the LAN pin field to connect a LAN modem to the
ONS 15454 for remote access to the node. You can also use the LAN port on the TCC faceplate to
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connect a computer or to connect the ONS 15454 to the network. For more information about the
ONS 15454 craft interface software and how to connect to a LAN modem, see Chapter 3, “Using the
Cisco Transport Controller.” Use the backplane pins and the LAN port on the TCC card to maintain
two simultaneous craft interface connections. Table 1-2 shows the LAN pin assignments.

Table 1-2 LAN Pin Assignments
Pin Field Backplane Pins RJ-45 Pins
LAN1 B2 1
(Ggmg to a router, hub, or A2 2
switch)
B1 3
Al 6
LAN1 B1 1
(Going to a
PC/workstation) Al 2
B2 3
A2 6

Note LAN 2 pins will be active in a future release.

To install LAN wires on the backplane, use #22 or #24 AWG wire. Wrap the wires on the appropriate
wire-wrap pins according to local site practice. A frame ground pin is located beneath each pin field
(FG2 for the LAN pin field). Wrap the ground shield of the LAN interface cable to the frame ground
pin.

Warning You cannot have simultaneous connections to the front and back LAN ports. Attempting
to connect to both the RJ-45 port in the front (on the TCC/TCC+ card) and the LAN pins in the back
of the shelf assembly can result in loops.

1.6.4 Craft Interface Installation

Note You cannot use the backplane pins and the RS-232 port on the TCC card simultaneously.

You can use the CRAFT pins on the ONS 15454 backplane to connect a computer terminal to serve
as a VT100-type craft interface. You can also use the RS-232 port on the TCC faceplate to connect
a computer terminal to serve as a TL1 craft interface to the ONS 15454. Table 1-3 shows the pin
assignments for the CRAFT pin field.

Table 1-3 Craft Interface Pin Assignments
Pin Field Contact Function
Craft Al Receive
A2 Transmit
A3 Ground
A4 DTR
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To install craft interface wires on the backplane, use #22 or #24 AWG wire. Wrap the craft interface
wires on the appropriate wire-wrap pins according to local site practice. A frame ground pin is
located beneath each pin field (FG9 for the CRAFT pin field). Wrap the ground shield of the craft
interface cable to the frame ground pin. Wrap the ground wire of your computer cable to pin A3 on
the CRAFT pin field.

1.6.5 X.25 Installation

This pin field is not active.

1.6.6 Modem Installation

This pin field is not active.

1.6.7 TBOS Installation

This pin field is not active.

1.7 Ferrite Installation

Ferrite installation is optional. Third-party ferrites can be placed on certain cables to dampen
electromagnetic interference (EMI) from the ONS 15454. Ferrites must be added to meet the
requirements of GR 1089. Refer to the ferrite manufacturer documentation for proper use and
installation of the ferrites. The following illustrations show possible ferrite placements on the ONS
15454 for power cables, AMP CHAMP connectors, EIAs or baluns, BNC/SMB connectors, and the
wire-wrap pin field.

Figure 1-21 shows the suggested method for attaching ferrites to power cabling. Use a single oval
ferrite TDK ZCAT2035-0930 for both pair of cables and a block ferrite Fair Rite 0443164151 for
each pair of cables. Wrap the cables once around and through the block ferrites and pull the cable
straight through the oval ferrites. Place the oval ferrite between the ONS 15454 and the block ferrite
as shown. Place the oval ferrite as close to the power terminals as possible and place the block ferrite
within 5 to 6 inches of the power terminals.

Figure 1-21 Ferrites for Power Cables
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Figure 1-22 shows the suggested method for attaching the ferrites to AMP CHAMP connectors. Use
a block ferrite Fair Rite 0443164151 for each cable.

Figure 1-22 Ferrites for AMP CHAMP Connectors
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Figure 1-23 shows the suggested method for attaching the ferrites to EIAs or baluns. Use an oval
ferrite TDK ZCAT 1730-0730 for each cable.

Figure 1-23 Ferrites for Electrical Interface Assemblies (EIAs) or Baluns
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Figure 1-24 shows the suggested method for attaching the ferrites to SMB/BNC connectors. Use an
oval ferrite TDK ZCAT1730-0730 for each cable and place the ferrite as close to the connector as
possible.

Figure 1-24 Ferrites for SMB/BNC Connectors
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Figure 1-25 shows the suggested method for attaching the ferrites to wire-wrap pin fields. Use an
oval ferrite TDK ZCAT1730-0730 and block ferrite Fair Rite 0443164151 for each pair of cables.
Wrap the cables once around and through the block ferrites and pull the cables straight through the
oval ferrites. Place the oval ferrite as close to the wire wrap pin field as possible and between the
ONS 15454 and the block ferrite as shown. The block ferrite should be within 5 to 6 inches of the
wire-wrap pin field.

Figure 1-25 Ferrites for Pin Field
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1.8 Card Installation and Turn-Up

Caution Always use the supplied electrostatic discharge wristband when working with a powered
A ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of
the shelf assembly.

ONS 15454 cards have electrical plugs at the back that plug into electrical connectors on the
assembly backplane. When the ejectors are fully closed, the card plugs into the assembly backplane.
Figure 1-26 shows card installation.

a Warning The optical cards for the ONS 15454 are Class 1 laser products. These products have been
tested and comply with Class 1 limits.

Figure 1-26 Card Installation

39391
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Procedure: Install ONS 15454 Cards
Step1  Open the card ejectors.

Step2  Slide the cards along the guide rails into the desired card slot.

Step3  Close the ejectors.
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1.8.1 Slot Requirements

Shelf assembly slots have symbols indicating the type of cards that you can install in them. Each
ONS 15454 card has a corresponding symbol. The symbol on the card must match the symbol on
the slot.

® Multispeed slots have circle symbols. In these slots, only install ONS 15454 cards with a circle
symbol on the faceplate.

® High-speed slots have a circle symbol and a triangle symbol. In these slots, only install ONS
15454 cards with a circle symbol or a triangle.

® TCC slots have a square symbol. In these slots, only install ONS 15454 cards with a square
symbol.

® Cross-connect slots have a cross symbol. In these slots, only install ONS 15454 cards with a cross
symbol.

® Protection slots have a P symbol. You can use these slots to supply 1:N protection for electrical
cards.

® The AIC slot has a diamond. In this slot, only install cards with a diamond symbol in this slot.

Table 1-4 shows the slot-card symbol definitions.

Table 1-4 Slot and Card Symbols
Symbol Color/Shape Definition

‘ Orange/Circle Multispeed slot (all line cards except OC-48)
A Blue/Triangle High speed slot (all line cards including OC-48)
. Purple/Square Timing, Communications, and Control (TCC/TCC+) slot
+ Green/Cross Cross-connect (XC/XCVT) slot
P Red/P Protection slot in 1:N protection schemes
‘ Red/Diamond AIC Slot
* Gold/Star Multispeed slot - future

Table 1-5 lists the number of ports, line rates, connector options and connector locations for ONS
15454 optical and electrical cards.
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Table 1-5 Card Ports, Line Rates, and Connectors
Connector
Card Ports Line Rate per Port Connector Types Location
DS1-14 14 1.544 Mbps SMB w/wire wrap Backplane
adapter, AMP CHAMP
Connector*
DSIN-14 14 1.544 Mbps SMB w/wire wrap N/A
adapter, AMP CHAMP
Connector*
DS3-12 12 44.736 Mbps SMB or BNC* Backplane
DS3N-12 12 44.736 Mbps SMB or BNC* N/A
DS3XM-6 6 44.736 Mbps SMB or BNC* Backplane
ECI-12 12 51.84 Mbps SMB or BNC* Backplane
E100T-12 12 100 Mbps RJ-45 Faceplate
E1000-2 2 1000 Mbps SC (GBIC) Faceplate
OC3 1R 4 155.52 Mbps (STS-3) SC Faceplate
OC-12 (IR/LR) 1 622.08 Mbps (STS-12) SC Faceplate
OC-48 (IR/LR/ELR) 1 2488.32 Mbps (STS-48) | SC Faceplate

*  When used as a protect card, the card does not have a physical external connection. The protect card connects to the working card(s) through the backplane and
becomes active when the working card fails. The protect card then uses the physical connection of the failed card.

1.8.2 Card Turn-Up

The procedure for turning up ONS 15454 cards is nearly identical for each card. AIC card turn-up
is slightly different from all other cards and is described in its own procedure, and the XC/XCVT
and TCC/TCC+ turn up procedures are virtually identical and are described in one procedure. Turn
up for all other cards is the same and is covered by one procedure.

Note Because all other cards boot from the active TCC/TCC+ card, at least one TCC/TCC+ card
must be installed in order to boot any other cards.

Procedure: Verify Successful Turn-Up of the AIC Card

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Install the card in the correct slot.

Verify that power is applied to the shelf assembly.

Verify that the red FAIL LED blinks for 30 to 45 seconds.

Verify that after 30 to 45 seconds, all LEDs blink once and turn off.

Verify that the ACT LED is on.

Verify that the card appears in the correct slot on the CTC software screen.

Verify that the card is white on the CTC software screen.
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Procedure: Verify Successful Turn-Up of the TCC/TCC+ and XC/XCVT Cards

Step 1 Install the card in the correct slot (Slot 8 or 10 for the XC/XCVT and slot 7 or 11 for the
TCC/TCC+).

Step2  Verify that power is applied to the shelf assembly.
Step3  Verify that the red FAIL LED blinks for 30 to 45 seconds.

If the FAIL LED is displayed continuously on the TCC/TCC+ card, see the note below
concerning TCC/TCC+ uploading.

Step 4 Verify that after 30 to 45 seconds, all LEDs blink once and turn off.

Step5  Verify that the ACT/STBY LED is the correct color for the card (green for active, yellow
for standby).

On the TCC/TCC+ card, the LED may take several minutes to illuminate while the DCC
processor boots.

Step 6  Verify that the card appears in white in the correct slot on the CTC software screen.

Note This is not the procedure to use when upgrading from XC to XCVT cards. If you
are performing an XC to XCVT upgrade, see the “Upgrade XC Cards to XCVT” section
on page 5-18. If you are performing a TCC to TCC+ upgrade, see the “TCC Card to
TCC+ Card Upgrade” section on page 10-11.

Tip When a TCC/TCC+ card installed in the shelf assembly has a different version of the ONS

p 15454 software installed than the version running on the active TCC/TCC+, it automatically loads
the software version running on the active TCC/TCC+. You do not need to do anything in this
situation. However, the loading TCC/TCC+ card will not boot up in the normal manner. When the
card is first inserted, the red FAIL LED stays on for a short period. The FAIL LED then blinks as
normal after which all LEDs go dark. The FAIL LED and the ACT/STBY LED flash alternately
every 30 to 45 seconds as the new software loads onto the new TCC/TCC+ card. After loading the
new software for approximately 30 minutes, the TCC/TCC+ card becomes the standby card and the
amber LED is illuminated.

ﬂ Warning Follow all directions and warning labels when working with optical fibers. To prevent eye
damage, never look directly into a fiber or connector.

Procedure: Verify Successful Turn-Up of All Other Cards
Step 1 Install the card in the correct slot.

Step2  Verify that power is applied to the shelf assembly.
Step3  Verify that the red FAIL LED blinks for 30 to 45 seconds.
Step 4 Verify that after 30 to 45 seconds, all LEDs blink once and turn off.

Step5  Verify that the ACT LED is on. Note that the signal fail (SF) LED may persist until all
card ports connect to their far end counterparts and signal is present.

Step 6  Verify that the card appears in the correct slot on the CTC software screen.
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Step 7  Verify that the card is white on the CTC software screen.

1.8.3 Card Software Installation

After you install an ONS 15454 card in a valid card slot, the card’s software automatically updates
to the version that operates correctly with the system software installed on the TCC. To verify the
current version of software installed on the XTC, click the Help menu and then click About CTC.
See Chapter 5, “Provisioning Cards” for more information.

1.8.4 Gigabit Interface Converter

GBICs are hot-swappable input/output devices that plug into a Gigabit Ethernet port to link the port
with the fiber optic network. Cisco provides two GBIC models: one for short reach applications (part
number 15454-GBIC-SX) and one for long-reach applications (15454-GBIC-LX). The short reach,
or “SX” model, connects to multimode fiber and the long reach, or “LX”” model, requires single-
mode fiber. Because the GBICs are very similar in appearance, check the label on the GBIC carefully
before installing it. A GBIC is shown in Figure 1-27.

Figure 1-27 Gigabit Interface Converter

Receiver Transmitter

Table 1-6 shows the available GBICs.

Table 1-6 Available GBICs
GBIC Product Number
Short wavelength (1000BaseSX) 15454-GBIC-SX
Long wavelength/long haul (1000BaseL.X) 15454-GBIC-LX

® 15454-GBIC-SX

The 15454-GBIC-SX operates on ordinary multi-mode fiber optic link spans of up to 550 m in
length.

® 15454-GBIC-LX

The 15454-GBIC-LX fully complies with the IEEE 802.3z 1000BaseL.X standard. However,
their higher optical quality allows them to reach 10km over single-mode fiber (SMF) versus the
5 km specified in the standard.
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Procedure: Install Gigabit Interface Converters

1-40

A
A

Step 1 Remove the GBIC from its protective packaging.
Step2  Check the part number to verify that the GBIC is the correct type for your network.

Step 3  Grip the sides of the GBIC with your thumb and forefinger and insert it into the slot on
the front panel of the Gigabit Ethernet card (shown in Figure 1-28).

GBICs are hot-swappable and can therefore be installed/removed while the card/shelf
assembly is powered and running.

Note GBICs are keyed to prevent incorrect installation.

Figure 1-28 GBIC Installation
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Step4  Slide the GBIC through the flap that is covering the opening until you hear a click.
The click indicates the GBIC is locked into the slot.

Warning GBICs are Class 1 laser products. These products have been tested and comply with
Class 1 limits.

Warning Invisible laser radiation may be emitted from the aperture ports of the single-mode fiber
optic modules when no cable is connected. Avoid exposure and do not stare into open apertures.
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Step5  When you are ready to attach the network interface fiber optic cable, remove the plug
from the GBIC and save the plug for future use.

Procedure: Remove a Gigabit Interface Converter
Step 1 Disconnect the network fiber cable from the GBIC SC connector.

Step2  Release the GBIC from the slot by simultaneously squeezing the two plastic tabs (one on
each side of the GBIC).

Step 3  Slide the GBIC out of the Gigabit Ethernet module slot.

A flap closes over the GBIC slot to protect the connector on the Gigabit Ethernet card.

a Warning Ultimate disposal of this product should be handled according to all national laws and
regulations.

1.9 Cable Installation

This section explains how to install fiber, coaxial, and DS-1 cables.

1.9.1 Fiber Cable Installation

Caution Always use the supplied electrostatic discharge wristband when working with a powered
A ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of
the shelf assembly.

ONS 15454 fiber optic cards feature SC connectors. To install fiber optic cables in the ONS 15454,
a fiber cable with the corresponding connector type must be connected to the transmit and receive

ports on the ONS 15454 cards. On ONS 15454 optical card ports, the top connector is Transmit and
the bottom connector is Receive. Cisco recommends that the transmit and receive and the working
and protection fibers be labeled at each end of the fiber span to avoid confusion with cables that are
similar in appearance.

a Warning Follow all directions and warning labels when working with optical fibers. To prevent eye
damage, never look directly into a fiber or connector.

Procedure: Install and Route Fiber Optic Cables in the ONS 15454

Step1  Place the SC connector in front of the connection point on the card faceplate. Each card
supports at least one transmit and one receive connector to create an optical carrier port.
Figure 1-29 shows the cable location.
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Figure 1-29 Fiber Cable Connection

ceplate connector

C cable connector

Front edge of card

Step2  Align the keyed ridge of the cable connector with the receiving slot on the faceplate
connection point.

Step3  Gently push the cable connector into the faceplate connection point until the connector
snaps into place.

Step4  Route fiber cables through the cable retaining clips on the optical card faceplate into the
cable management tray on the bottom of the assembly.

Step5  From the cable management tray, route the fiber cables out the nearest side of the
assembly through cutout holes.

See the “Cable Management Facilities” section on page 1-12 for more information about cable
management.

Note Clean all fiber connectors thoroughly. Dust particles can degrade performance. Put caps on
any fiber connectors that are not used.

Cisco provides clear plastic fiber boots for each optics card. The boots prevent hanging fibers from
bending too sharply, which may degrade performance. The boots also prevent the front door from
interfering with hanging fibers. Figure 1-30 shows the fiber boot attachment.
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Figure 1-30 Fiber Boot Attachment
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You can install the fiber boots on the fiber optic cables before or after the fibers are attached to the
optic card.

Procedure: Install the Fiber Boot

Step 1 Position the open slot of the fiber boot underneath the fiber cable.
Step2  Push the fiber cable down into the fiber boot.
Step 3  Twist the fiber boot to lock the fiber cable into the tail end of the fiber boot.

Step4  Slide the fiber boot forward along the fiber cable until the fiber boot fits snugly onto the
end of the SC cable connector.

1.9.2 Coaxial Cable Installation

A

Caution Always use the supplied electrostatic discharge wristband when working with a powered
ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of
the shelf assembly.

When using ONS 15454 DS-3 electrical cables, the cables must terminate on a pre-installed EIA on
the ONS 15454 backplane. EIAs are available with SMB and BNC type connectors. All DS-3 cables
connected to the ONS 15454 DS-3 card must terminate with coaxial cables using the desired
connector type in order to connect to the specified EIA. For information about physically installing
an EIA in the field, see the “Backplane Covers” section on page 1-18.

1.9.2.1 BNC Installation

When EIAs are pre-installed on the backplane, a special backplane cover panel with cutouts over the
coaxial cable connectors is provided. The BNC EIA supports 24 DS-3 circuits on each side of the
ONS 15454 (24 transmit and 24 receive connectors). If you install BNC EIAs on both sides of the
unit, the ONS 15454 hosts up to 48 circuits. The BNC connectors on the EIA are Trompeter
UCBJ224 (75 Ohm) 4 leg connectors. Right angle mating connectors for the connecting cable are
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AMP 413588-2 (75 Ohm) connectors. A straight connector of the same type can also be used, if
preferred. Use RG-59/U cable to connect to the ONS 15454 BNC EIA. These cables are
recommended to connect to a patch panel and are designed for long runs of up to 450 feet.

Procedure: Install Coaxial Cable With BNC Connectors

Step 1 Place the BNC cable connector over the desired connection point on the backplane.

Figure 1-31 shows how to connect a coaxial cable to the BNC EIA using a right-angle
BNC cable connector.

Step2  Position the cable connector so that the slot in the connector is over the corresponding
notch at the backplane connection point.

Step 3  Gently push the connector down until the notch backplane connector slides into the slot
on the cable connector.

Step4  Turn the cable connector until the notch clicks into place.
Step5  Tie wrap the cables to the EIA according to local site practice.

Step 6  Route the cables to the nearest side of the shelf assembly through the side cutouts
according to local site practice. The rubber coated edges of the side cutouts prevent the
cables from chafing.

Figure 1-31 BNC Backplane Connection Using a Right Angle Connector

32075

Note Slots 1, 3, 15 and 17 are designated protection slots when BNC connectors are used. Slots 5,
6, 11, and 12 do not support DS3-12 cards when BNC connectors are used. A total of four DS3-12
cards may be used to carry traffic when BNC connectors are used.
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Label all cables at each end of the connection to avoid confusion with cables that are similar in
appearance.

1.9.2.2 High-Density BNC Installation

The High-density BNC EIA supports 48 DS-3 circuits on each side of the ONS 15454 (48 transmit
and 48 receive connectors). If you install BNC EIAs on both sides of the unit, the ONS 15454 hosts
up to 96 circuits. You must use straight connectors on RG-59/U cable to connect to the ONS 15454
High-density BNC EIA. Cisco recommends these cables for connection to a patch panel; they are
designed for long runs of up to 450 feet.

Although not required, Cisco strongly recommends using the BNC insertion tool to connect cables
to the EIA. See page 10-15 for more information about the insertion tool.

Procedure: Install Coaxial Cable With High-density BNC Connectors

Step 1 Place the BNC cable connector over the desired connection point on the backplane.

Step2  Using the insertions tool, position the cable connector so that the slot in the connector is
over the corresponding notch at the backplane connection point.

Step3  Gently push the connector down until the notch backplane connector slides into the slot
on the cable connector.

Step4  Turn the cable connector until the notch clicks into place.
Step5  Tie wrap the cables to the EIA according to local site practice.

Step 6  Route the cables to the nearest side of the shelf assembly through the side cutouts
according to local site practice.

The rubber coated edges of the side cutouts prevent the cables from chafing.

1.9.2.3 SMB Installation

The SMB backplane cover is similar to the BNC cover. The SMB EIA has 84 transmit and 84 receive
connectors on each side of the ONS 15454 for a total of 168 SMB connectors (84 circuits). For DS-3
or EC-1, the EIA supports 72 transmit and 72 receive connectors, for a total of 144 SMB connectors
(72 circuits.) The SMB connectors on the EIA are AMP 415504-3 (75 Ohm) 4 leg connectors. Right-
angle mating connectors for the connecting cable are AMP 415484-2 (75 Ohm) connectors. Use
RG-179/U cable to connect to the ONS 15454 EIA. Cisco recommends these cables for connection
to a patch panel; they are not designed for long runs.

Procedure: Install SMB Type Connectors
Refer to Figure 1-32 when performing the following steps.

Step1  Place the SMB cable connector over the desired connection point on the backplane.
Step2  Gently push the connector until it clicks into place.
Step 3  Tie wrap the cables to the EIA according to local site practice.

Step4  Route the cables to the nearest side of the shelf assembly into rack runs according to local
site practice.
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Figure 1-32 SMB Coaxial Cable Connections
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Label the transmit, receive, working and protection cables at each end of the connection to avoid
confusion with cables that are similar in appearance.

1.9.3 DS-1 Cable Installation

DS-1s support both twisted pair wire-wrap cabling and AMP CHAMP connector cabling. Install the
proper backplane EIA on the ONS 15454 for each cabling option. This section provides information
about the DS-1 EIA options.

1.9.3.1 Twisted Pair Wire Wrap Installation

Installing twisted-pair, wire-wrap DS-1 cables requires separate pairs of grounded twisted-pair
cables for receive (in) and transmit (out). Prepare four cables, two for receive and two for transmit,
for each DS-1 facility to be installed.

g Caution Always use the supplied electrostatic discharge wristband when working with a powered
ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of
the shelf assembly.

If you use DS-1 electrical twisted pair cables, equip the ONS 15454 with an SMB-based EIA on each
side of the backplane where DS-1 cables will terminate. You must install special DS-1 electrical
interface adapters on every transmit and receive connector for each DS-1 termination. See the
“Install DS-1 Electrical Interface Adapters” section on page 1-47 for information about installing
SMB backplane covers.
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Note DS-1 electrical interface adapters project an additional 1.72 inches from the ONS 15454
backplane.

EIAs are special cards attached to the assembly backplane that provide cable connectors and a cover
panel that features cutouts over the coaxial cable connectors. EIAs are available with SMB and BNC
type connectors. You must use SMB EIAs for DS-1 twisted-pair cable installation.

If you install DS-1 cards in the ONS 15454, you must fit the corresponding transmit and receive
SMB connectors on the EIA with a DS-1 electrical interface adapter. You can install the adapter on
the SMB connector for the port. The adaptor has wire wrap posts for DS-1 transmit and receive
cables. Figure 1-33 shows the DS-1 electrical interface adapter.

Figure 1-33 Electrical Interface Adapter
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Each DS-1 electrical interface adapter, commonly referred to as a balun, has a female SMB
connector on one end and a pair of .045 inch square wire wrap posts on the other end. The wire wrap
posts are .200 inches apart.

Procedure: Install DS-1 Electrical Interface Adapters

Step1  Attach the SMB connector on the adapter to the SMB connector for the port’s transmit
pair on the backplane.

Step2  Attach the SMB connector on an adapter to the SMB connector for the port’s receive pair
on the backplane.

Step3  Terminate the DS-1 transmit and receive cables for the port to the wire wrap posts on the
adapter.

Make sure to install the electrical interface adapter with the wire wrap posts.

If you place DSIN-14 in Slots 3 and 15 to form 1:N protection groups, do not wire Slots
3 and 15 for DS-1 electrical interface adapters.

Figure 1-34 shows a ONS 15454 backplane with an SMB EIA with DS-1 electrical interface adapters
attached on both sides of the shelf to create DS-1 twisted pair termination points.
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Figure 1-34 Backplane With SMB EIA
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All DS-1 cables connected to the ONS 15454 DS-1 ports must terminate with twisted-pair cables to

connect to the DS-1 electrical interface adapter. The DS-1 electrical interface adapters project 1.72
inches beyond the SMB EIA.

Procedure: Install DS-1 Cables on the DS-1 Electrical Interface Adapters

Step1  Using a wire-wrap tool, connect the receive cables to the receive adapter pins on the
backplane connector for the desired port.

Step2  Connect the transmit cables to the transmit adapter pins on the backplane connector for
the desired port.

Step3  Terminate the shield ground wire on the DS-1 cable to ground according to local site
practice.

Step4  If you place DS1N-14 cards in Slots 3 and 15 to form 1:N protection groups, do not wire
Slots 3 and 15 for DS-1 electrical interface adapters.

1.9.3.2 AMP CHAMP Installation

To instal AMP CHAMP connector DS-1 cables you must use 64-pin bundled cable connectors with
a 64-pin male AMP CHAMP connector. You need an AMP CHAMP connector #552276-1 for the
receptacle side and #1-552496-1 for the right angle shell housing (or their functional equivalent).
The corresponding 64-pin female AMP CHAMP connector on the AMP CHAMP EIA supports one
receive (in) and one transmit (out) for each DS-1 port for the corresponding card slot.

Because each DS1-14 card supports 14 DS-1 ports, only 56 pins (28 pairs) of the 64-pin connector
are used. Prepare one 56-wire cable for each DS-1 facility installed. Table 1-7 shows the pin
assignments for the AMP CHAMP connectors on the ONS 15454 AMP CHAMP EIA. See the“*AMP
CHAMP EIA” section on page 1-22 for more information about the AMP CHAMP EIA.
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Table 1-7 Pin Assignments for AMP Champ Connector

Signal/Wire Pin | Pin |Signal/Wire Signal/Wire Pin |Pin Signal/Wire
Tx Tip 1 1 33 Tx Ring 1 Rx Tip 1 17 49 Rx Ring 1
white/blue blue/white yellow/orange orange/yellow
Tx Tip 2 2 34 Tx Ring 2 Rx Tip 2 18 50 Rx Ring 2
white/orange orange/white yellow/green green/yellow
Tx Tip 3 3 35 Tx Ring 3 Rx Tip 3 19 51 Rx Ring 3
white/green green/white yellow/brown brown/yellow
Tx Tip 4 4 36 Tx Ring 4 Rx Tip 4 20 52 Rx Ring 4
white/brown brown/white yellow/slate slate/yellow
Tx Tip 5 5 37 Tx Ring 5 Rx Tip 5 21 53 Rx Ring 5
white/slate slate/white violet/blue blue/violet
Tx Tip 6 6 38 Tx Ring 6 Rx Tip 6 22 54 Rx Ring 6
red/blue blue/red violet/orange orange/violet
Tx Tip 7 7 39 Tx Ring 7 Rx Tip 7 23 55 Rx Ring 7
red/orange orange/red violet/green green/violet
Tx Tip 8 8 40 Tx Ring 8 Rx Tip 8 24 56 Rx Ring 8
red/green green/red violet/brown brown/violet
Tx Tip 9 9 41 Tx Ring 9 Rx Tip 9 25 57 Rx Ring 9
red/brown brown/red violet/slate slate/violet
Tx Tip 10 10 42 Tx Ring 10 Rx Tip 10 26 58 Rx Ring 10
red/slate slate/red white/blue blue/white
Tx Tip 11 11 43 Tx Ring 11 Rx Tip 11 27 59 Rx Ring 11
black/blue blue/black white/orange orange/white
Tx Tip 12 12 44 Tx Ring 12 Rx Tip 12 28 60 Rx Ring 12
black/orange orange/black white/green green/white
Tx Tip 13 13 45 Tx Ring 13 Rx Tip 13 29 61 Rx Ring 13
black/green green/black white/brown brown/white
Tx Tip 14 14 46 Tx Ring 14 Rx Tip 14 30 62 Rx Ring 14
black/brown brown/black white/slate slate/white
Tx Spare0+ N/A 15 47 Tx Spare0- N/A Rx Spare0+ N/A 31 63 Rx Spare0- N/A
Tx Sparel+ N/A 16 48 Tx Sparel- N/A Rx Sparel+ N/A 32 64 Rx Sparel- N/A

Shaded area corresponds to the white/orange binder group.

A

Caution Always use the supplied electrostatic discharge wristband when working with a powered
ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of
the shelf assembly.

When using DS-1 AMP CHAMP cables, you must equip the ONS 15454 with an AMP CHAMP
connector EIA on each side of the backplane where DS-1 cables will terminate. Each AMP CHAMP
connector on the EIA corresponds to a slot in the shelf assembly and is numbered accordingly. The
AMP CHAMP connectors have screw-down tooling at each end of the connector. See the “AMP
CHAMP EIA” section on page 1-22 for information on AMP CHAMP backplane cover installation.
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Procedure: Install DS-1 AMP CHAMP Cables on the AMP CHAMP EIA

Step 1 Prepare a 56-wire cable for each DS-1 card you will install in the shelf assembly. See
Table 1-7 on page 1-49 for the ONS 15454 AMP CHAMP connector pin assignments.

Step2  Connect the male AMP CHAMP connector on the cable to the female AMP CHAMP
connector on the ONS 15454 backplane.

Step3  Use the clips on the male AMP CHAMP connector to secure the connection.

The female connector has grooves on the outside edge for snapping the clips into place.

1.10 Cable Management

ONS 15454 cable management components include cable management clips on the optical card
faceplates, a cable management tray in the front cabinet compartment, and cable tiewrap facilities
on the EIAs.

1.10.1 Optical Cable Management

Optical cables connect to the SC connectors on the faceplate of the optical cards as described in the
“Fiber Cable Installation” section on page 1-41. Route optical cables down through the fiber
management clips on the optical card faceplate (shown in Figure 1-35).

Route optical cables from the fiber management clips into the cable management area of the shelf
assembly, through a cutout in the nearest side of the assembly, and onto the side of the assembly. A
hinged panel on the front of the shelf assembly folds down to provide access to the cable
management tray. Figure 1-36 shows the fold-down panel and cable management tray.

Figure 1-35 Cable Routing
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Procedure: Route Optical Cables in the Shelf Assembly

Step 1 Open the fold-down front door on the fiber management tray.
Step2  Route the cable on the card faceplate through the fiber clip on the faceplate.
Step3  Route the cables into the cable management tray.

Step4  Route the cables out either side of the cable management tray through the cutouts on each
side of the shelf assembly. Use the reversible fiber guides to route cables out the desired
side.

Step5  Close the fold-down front door when all cables in the front compartment are properly
routed.

Figure 1-36 shows the fold-down front door of the shelf assembly open to display the cable routing
channel.

Figure 1-36 Fold-down Front Door of the Shelf Assembly
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1.10.2 Coaxial Cable Management

Coaxial cables connect to the BNC type or SMB type EIAs on the ONS 15454 backplane using cable
connectors. The BNC type EIAs support up to 48 transmit and receive coaxial connectors on each

side of the ONS 15454 backplane for a total of up to 96 connectors (48 circuits). The SMB type EIAs
support up to 84 transmit and receive coaxial connectors on each side of the ONS 15454 for a total
of up to 168 connectors (84 circuits).

When EIAs are used, the backplane cover uses cutouts over the cable connectors. Incoming cables
terminated with the corresponding connector type (SMB or BNC) can be connected directly onto the
backplane through the cover cutouts.

EIAs feature cable management eyelets for tie wrapping or lacing cables to the cover panel. Tiewrap
or lace the coaxial cables according to local site practice and route the cables through the side cutouts
on either side of the ONS 15454 assembly. The rubber coated edges of the side cutouts prevent the
cables from chafing.
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When using the RG179 cable with SMB connectors, remember that the maximum distance available
with the RG179 cable is less than the maximum distance available with standard RG59 cable. If you
only use the RG179, the maximum available distance is 100 feet versus the 450 feet available with
the larger RG59 cable.

Use short lengths of “pigtail” RG179 to terminate the shelf, and use standard RG59 connected to the
RG179 for the remainder of the cable run. When using a 10-foot section of the RG179, you can
attach a maximum length of 437 feet of RG59. When using a 30-foot section of RG179, you can
attach a maximum length of 311 feet of RG59.

The shorter maximum distance available with the RG179 is due to a higher attenuation rate for the
thinner cable. The attenuation rate for RG59 cable (based on testing with Belden 923, the equivalent
of 328A cable) is ~1.0 dB/100 feet at 22 Mhz (DS-3 data rate). The attenuation rate of RG179 is
6.3 db/100 feet. Use a figure of 5.0 for total cable loss when making calculations. Figure 1-37 shows
one side of the ONS 15454 backplane with SMB EIAs and the coaxial cables properly routed.

June 2001

Figure 1-37 Backplane Cable Routing
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1.10.3 Twisted Pair Cable Management

1-52

Connect twisted pair/DS-1cables to SMB EIAs on the ONS 15454 backplane using cable connectors
and DS-1 electrical interface adapters. The SMB type EIAs support up to 84 transmit and receive
SMB connectors on each side of the ONS 15454 for a total of up to 168 connectors (84 circuits).

When using DS-1 twisted pair cables, the backplane cover features cutouts over the SMB cable
connectors. You must install DS-1 electrical interface adapters on every transmit and receive
connector for DS-1 ports. Incoming cables terminated can be connected directly onto the backplane
using the wire wrap posts on the DS-1 electrical interface adapters.
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SMB EIAs feature cable management eyelets for tie wrapping or lacing cables to the cover panel.
Tie wrap or lace the twisted pair cables according to local site practice and route the cables into the
side cutouts on either side of the ONS 15454 assembly.

1.10.4 AMP CHAMP Cable Management

AMP CHAMP cables connect to the EIAs on the ONS 15454 backplane using AMP CHAMP cable
connectors. The AMP CHAMP EIAs support up to six AMP CHAMP connectors on each side of
the ONS 15454 backplane for a total of up to 12 connectors.

EIAs have cable management eyelets to tiewrap or lace cables to the cover panel. Tiewrap or lace
the AMP CHAMP cables according to local site practice and route the cables. If you configure the
ONS 15454 for a 23-inch rack, two additional inches of cable management area are available on each
side of the assembly. See the“AMP CHAMP EIA” section on page 1-22 and the “AMP CHAMP
Installation” section on page 1-48 and the for more information.

1.10.5 Alarm Cable Management

Route alarm cables out the nearest side of the shelf assembly through the space provided. Tiewrap
eyelets below the alarm pin field can be used to manage alarm cables. Cutouts are protected to
prevent chaffing of the cables.

1.10.6 BIC Rear Cover Installation

The ONS 15454 has an optional backplane interface connector (BIC) rear cover. This clear plastic
cover provides additional protection for the cables and connectors on the backplane (Figure 1-38).

Figure 1-38 Clear BIC Rear Cover
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Procedure: Install the BIC Rear Cover
Step 1 Locate the three screws that run vertically along the edges of the backplane.

Only one pair of screws lines up with the screw slots on the mounting brackets, making
them easy to locate.

Step2  Loosen the top and bottom screws on one edge of the backplane to provide room to slide
the mounting brackets into place using the u-shaped screw slots on each end.

Step 3  Slide one of the mounting brackets into place and tighten the screws.
Step4  Repeat Steps 2 and 3 for the second mounting bracket.

Step5  Attach the cover by hanging it from the mounting screws on the back of the mounting
brackets and pulling it down until it fits snugly into place.

Figure 1-39 Backplane Attachment For BIC Cover
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1.11 ONS 15454 Assembly Specifications

1.11.1 Bandwidth

® Total bandwidth: 240 Gbps
® Data plane bandwidth: 160 Gbps
® SONET plane bandwidth: 80 Gbps
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1.11.2 Slot Assignments

Total card slots: 17
® Universal slots (any traffic card except OC-48): slots 14, 14-17
® High speed slots (any traffic card including OC-48): slots 5, 6, 12, 13
® TCC (Timing, Communication and Control): slots 7, 11
® XC/XCVT (Cross Connect): slots 8, 10
® AIC (Alarm Interface Card): 9

1.11.3 Cards

® TCC

¢ TCC+

* XC

¢ XCVT

¢ AIC

® ECI1-12

¢ E100T-12

¢® DS1-14

¢ DSIN-14

¢ DS3-12

¢ DS3N-12

¢ DS3XM-6

¢® OC31IR 41310
® OCI121R 1310
¢ OCI12LR 1310
¢ OCI2LR 1550
® OC481R 1310
® OC48 LR 1550
® 0OC48 ELR DWDM

1.11.4 Configurations

Terminal mode
® Add-drop multiplexer
® Regenerator mode
® Two fiber BLSR ring
® Two fiber UPSR ring
® Path protected mesh network (PPMN)
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1.11.5 Cisco Transport Controller
® 10 Base-T

® TCC access: RJ-45 connector

® Backplane access: LAN pin field

1.11.6 External LAN Interface

® 10 Base-T Ethernet
® Backplane access: LAN pin field

1.11.7 TL1 Craft Interface
® Speed: 9600 bps
® TCC access: RS-232 DB-9 type connector
® Backplane access: CRAFT pin field

1.11.8 Modem Interface

® Hardware flow control
® TCC: RS-232 DB-9 type connector
® Backplane access: MODEM pin field

1.11.9 Alarm Interface

® Visual: Critical, Major, Minor, Remote
® Audible: Critical, Major, Minor, Remote
® Alarm contacts: 0.045mm, -48V, 50 mA

® Backplane access: Alarm pin fields

1.11.10 EIA Interface

¢ SMB: AMP #415504-3 75 Ohm 4 leg connectors
® BNC: Trompeter #UCBJ224 75 Ohm 4 leg connector
® AMP CHAMP: AMP#552246-1 with #552562-2 bail locks

1.11.11 Database Storage

® Nonvolatile memory: 32MB, 3.0V FLASH memory

1.11.12 BITS Interface

® 2 DS-1 BITS inputs
® 2 derived DS-1 outputs
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® Backplane access: BITS pin field

1.11.13 System Timing

Stratum 3 per Telcordia GR-253-CORE
® Free running accuracy: + 4.6 ppm
® Holdover Stability: 3.7 x10'7/day, including temperature (< 255 slips in first 24 hours)

® Reference: External BITS, line, internal

1.11.14 Power Specifications
® Input power: -48V DC

® Power consumption: 55W (fan tray only); 650W (maximum draw w/cards)
® Power Requirements: -42 to -57 VDC

® Power terminals: #8 Lug

1.11.15 Environmental Specifications

® Operating Temperature: 0 to +55 degrees Celsius

® Operating Humidity: 5 - 95% non-condensing

1.11.16 Dimensions
® Height: 18.5 inches (40.7 cm)

®  Width: 19 or 23 inches (41.8 or 50.6 cm) with mounting ears attached
® Depth: 12 inches (26.4 cm), 5-inch projection from rack
®  Weight: 55 Ibs. (empty)

1.12 Node Turn-Up

This section provides the steps required for the basic turn-up of the ONS 15454 shelf assembly. The
section assumes that individual cards will either be used with their default provisioning values or
will be provisioned by local technicians as required by the site.

1.12.1 Installation
Table 1-8 lists the steps needed to verify a successful installation of the ONS 15454.
Table 1-8 Installation Checklist

Description Check
ONS 15454 mounted securely in rack.
ONS 15454 grounded with rack ground.
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Table 1-8 Installation Checklist (continued)

Description

Power runs to the ONS 15454.

Visual and Audible alarm pins connect to central alarm collection equipment.

If used, BITS, LAN, Alarm, ACO and CRAFT pins connect to corresponding cables.

If used, BITS, LAN, Alarm, ACO and CRAFT cables are tiewrapped and routed under screw holes.
Preferred EIAs are installed.

Coaxial and/or DS-1 cables installed on back of unit.

Laced or tiewrapped coaxial cables run onto the sides of the ONS 15454.

Power connections fused properly (15A recommended).

-48V DC (tolerance -42 to -56V DC) power present at DC A and DC B terminals (if used) when power
applied.

Fan tray filter installed in fan tray with flow direction arrow on filter frame pointing up.
Fan tray assembly installed. When installed, fans will run on high speed with no TCCs installed.
If used, Ethernet patch cords are connected to Ethernet cards.

Fiber optic and/or Ethernet patchcords route through the faceplate clips, into the fiber management tray,
through the side cutout and along the sides of the ONS 15454.

Fiber management tray able to swing up and down without disturbing fiber or Ethernet patchcords.
Fan tray assembly able to be removed without disturbing fiber or Ethernet patchcords.

LCD functions. (Use LCD buttons to toggle through slots, ports and states of cards).

Door mounted with hinges on hinge pins.

Doors open and close without disturbing fiber or Ethernet patchcords.
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1.12.2 Node Turn-Up

Table 1-9 lists the steps necessary to successfully turn-up an ONS 15454 node. Each step references
the page number where the procedure for completing the step can be found. You must complete the
steps listed in Table 1-8 before you begin node turn up.

Table 1-9 Node Turn Up Checklist

Description Check
Configure computer

Verify that the computer has a 486 or higher processor and 128 Megabytes or more of RAM. The
operating system should be Windows 95/98, NT, or UNIX. The browser should either be Netscape
Navigator 4.08 or higher or Microsoft Internet Explorer 4.0 or higher. Netscape Navigator can be installed
from the Cisco ONS 15454 system software CD shipped with the system.

Verify that a straight-through CAT 4 or CAT 5 cable with RJ-45 connectors on each end is used to connect
the computer to the LAN port on the TCC card.

Verify that the computer TCP/IP connection is installed on the computer. If the computer has never been
connected to a network, see the Control Panel>Network>Configuration screen on Windows 95/98 to
verify TCP/IP installation.

Install Cards

Install TCC/TCC+ and XC/XCVT cards. Slots 7 and 11 hold redundant TCC cards. Slots 8 and 10 hold
redundant XC/XCVT cards.

Install one TCC and let it initialize before installing any additional cards. The red Fail LED on the TCC
will flash for approximately 30 seconds and all remaining LEDs will blink once in sequence. The
ACT/STBY LED will be green/amber when the card is initialized. The IP address for the node, the
temperature of the ONS 15454, and the time of day will be displayed on the LCD. Default time of day is
12:00 AM, January 1, 1970

Verify that each card turns up successfully. For more information, see the “Card Turn-Up” section on
page 1-37.

Ensure that transmit and receive fiber patchcords are correctly connected to the optic cards.

Verify that TCC/TCC+ cards and XC/XCVT cards are installed in the ONS 15454 in the correct slots. Do
not operate the ONS 15454 with only one TCC/TCC+ or one XC/XCVT card installed. Always use
redundant cards.

Connect computer

When connecting through a LAN, you must first obtain a valid IP address from your network
administrator. After obtaining a valid IP address, connect directly to the ONS 15454 through either the
LAN port on the TCC or the LAN pins on the rear of the shelf. In the CTC, go to the
Provisioning>Network tabs and set the IP address, subnet mask, and default router address.

You can also use the buttons on LCD panel to set your IP address, subnet mask, and default router address.
Connect the computer LAN cable to the RJ-45 port marked “LAN” on the faceplate of a TCC card.

Get the IP address for the node from the LCD screen on the ONS 15454. Record the IP address for future
reference.

Open the Internet browser to connect with the network element.
Enter the ONS 15454's IP address in the address field of the browser program. Press Return.
Log into the CTC

A log in screen appears. No password is required for the first log in. Network administrators should set up
a new user name and a password for security. User names and passwords are case sensitive.

The CTC main screen appears. The screen graphically depicts the ONS 15454 shelf assembly.
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Table 1-9 Node Turn Up Checklist (continued)

Description

Verify that the TCC and XC/XCVT card(s) are correctly installed. The cards appear in the graphic
depiction of the shelf assembly as white when successfully installed. The card name and slot numbers
where the cards are installed should be identical to the physical installation.

Set up security

To set up user security accounts, go to the Provisioning>Security screen. Superusers can add and modify
other accounts.

Set up accounts for users as required for the local site.
Provision node

Go to the Provisioning>General screen. The Node Name, Contact, and Description are displayed. Set the
node name.

In the Provisioning>General screen, set the time zone, date, and time options as desired.

Go to the Provisioning>Ring screen. Configure the Node ID to Ring Disabled, or to the desired ring
number in a BLSR ring configuration.

Connect to the ONS 15454 over a Local Area Network (LAN)

Change the ONS 15454 IP address to a valid local LAN network IP address in the Provisioning>Network
screen.

Select the subnet mask.
Enter a valid default router, if applicable.
Click Apply to reboot the TCC card and activate the new address.

Change TCP/IP settings on the PC connected to the ONS 15454 so that it is on the same subnet as the
Gateway network element.

Verify that the Netmask field on the PC’s TCP/IP settings match the ONS 15454’s subnet mask.
Restart the PC, if necessary.
After restart, open the browser software and enter the new IP address assigned to the ONS 15454.

Select Provisioning>SonetDCC to view the DCCs over SONET links. DCCs are disabled by default.
Select and enable desired DCCs.

Provision Timing References

Set timing references for the shelf assembly. Select Provisioning>Timing.

For an external BITS clock, set the Timing Mode to External Time.

For Synchronous Status Messaging (SSM), the SSM Message Set field displays clock specifications.
Set Quality of RES to the Quality of the timing reference being received, if applicable.

Set BITS 1 and BITS 2 to In Service. The Coding and Framing fields display clock specifications.
Check the Sync Messaging Enabled box if you are using SSM.

Set the AIS Threshold if AIS should be inserted on the BITS. (Not supported when SSM is enabled.)
Set NE Reference 1 and NE Reference 2 to BITS 1 and BITS 2, respectively.

Set BITS 1 Out and BITS 2 Out as desired to provide timing output using the timing output pins on the
ONS 15454 backplane.

Install any service cards to be used in the ONS 15454. Slot restrictions may apply.

Verify that when a card is installed, the Fail LED blinks for over 30 seconds and then the remaining LEDs
each flash once in sequence.
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Table 1-9 Node Turn Up Checklist (continued)
Description Check

Verify that the green ACT LED turns on for active cards and the yellow STBY LED turns on for standby
cards. The yellow SF LED may persist if far-end ports are not all connected.

Verify that all cards are installed in the correct slots and are white on the main CTC craft interface screen.
This confirms that each card is installed successfully.

Go to the Alarms screen and verify that no equipment alarms are issued against the installed cards.
Connect all cables (near end and far end) for each installed service card port.

Provision Ports

Go to the service card’s Provisioning screen for all connected ports and set the ports to In Service.
For ports that use concatenation, set concatenation as needed within the Circuit provisioning screen.
Check Enabled Sync Messages box to use SSM on each port, if applicable.

Ensure that all links are active to external network elements where cross-connects will be mapped.
Map cross-connects to the Circuits tab and create cross-connects as needed.

Verify Protection and Save the Database

Remove active cards to verify that standby cards become active.

Save the network element database. Record the location of the saved database file for future reference.

1.13 ONS 15454 Software and Hardware Compatibility Matrix

Table 1-10 provides a matrix showing software and hardware compatibility for ONS 15454 Releases
2.0,2.1, and 2.2.0.

Table 1-10 ONS 15454 Software and Hardware Compatibility

Hardware 2.00.0x (2.0) 2.10.0x (2.1) 2.20.0x (2.2.0)

TCC Fully compatible Fully Compatible Fully Compatible
TCC+ Not Supported Not Supported Fully Compatible
XC Fully Compatible Fully Compatible Fully Compatible
XCVT Fully Compatible Fully Compatible Fully Compatible
AIC Fully Compatible Fully Compatible Fully Compatible
ECI1-12 Fully Compatible Fully Compatible Fully Compatible
E100T-12 Fully Compatible Fully Compatible Fully Compatible
E1000-2 Not Supported Not Supported Fully Compatible
DS1-14 Fully Compatible Fully Compatible Fully Compatible
DSIN-14 Fully Compatible Fully Compatible Fully Compatible
DS3-12 Fully Compatible Fully Compatible Fully Compatible
DS3N-12 Fully Compatible Fully Compatible Fully Compatible
DS3XM-6 Fully Compatible Fully Compatible Fully Compatible
OC31R 41310 Fully Compatible Fully Compatible Fully Compatible
OCI12 1R 1310 Fully compatible Fully Compatible Fully Compatible
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Table 1-10

OC12 LR 1310
OC12 LR 1550
OC48 1R 1310
OC48 LR 1550
OC48 ELR 1550

If an upgrade is required for compatibility call the Cisco Technical Assistance Center at

1-877-323-7368.

Fully compatible
Fully compatible
Fully compatible
Fully compatible
Not Supported
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Fully Compatible
Fully Compatible
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Fully Compatible
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CHAPTER 2

Card Reference

This chapter describes the Cisco ONS 15454 cards. It includes descriptions, hardware specifications,
and block diagrams for each card. For installation and turn-up procedures, see Chapter 1,
“Installation.”

2.1 Overview

The cards for the ONS 15454 include common control cards, electrical cards, optical cards, and an
Ethernet/Fast Ethernet card. Each card is marked with a symbol that corresponds to a slot (or slots)
on the ONS 15454 shelf assembly. The cards are then installed into slots displaying the same
symbols (see the “Slot Requirements” section on page 1-36 for a list of slots/symbols). This
overview provides a summary of the cards.

2.1.1 Common Control Cards

The four common control cards are the Timing Communications and Control (TCC/TCC+) card, the
Cross Connect (XC) card, the VT1.5 Capable Cross Connect (XCVT) card, and the Alarm Interface
Controller (AIC) card. The TCC is the main processing center of the ONS 15454 and provides
system initialization, provisioning, alarm reporting, maintenance, and diagnostics. The XC/XCVT
card is the central element for switching; it establishes connections and performs time division
switching (TDS). The AIC card provides customer-definable alarms with its additional input/output
alarm contact closures.

2.1.2 Electrical Cards

The electrical cards are the EC1-12, DS1-14, DS1N-14, DS3-12, DS3N-12, and the DS3XM-6
(Transmux). The EC1-12 card provides twelve STS-1 electrical interfaces. The DS1-14 card
provides 14 DS-1 interfaces. The DS1N-14 card provides 14 DS-1 interfaces but can also provide
1:N protection when necessary. The DS3-12 card has 12 DS-3 interfaces and the DS3N-12 card has
12 DS-3 interfaces and 1:N protection capability. The DS3XM-6 card can convert six framed DS-3
network connections into 168 VT1.5s.

2.1.3 Optical Cards

The optical cards include the OC3IR 4 1310, the OC12IR 1310, the OC12 LR 1310, the OC12 LR
1550, the OC48 IR 1310, and the OC48 LR 1550 cards. The OC3IR 4 1310 card provides four

intermediate or short-range OC-3 interfaces. The OC12IR 1310 card provides one intermediate or
short range OC-12 interface. The OC12 LR 1310 card and the OC12 LR 1550 card each have one
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long-range OC-12 interface but operate at different wavelengths (1310 nm and 1550 nm,
respectively). The OC48 IR 1310 card and the OC48 LR 1550 card each provide one long-range
OC-48 interface and, like the OC12 LR cards, operate at different wavelengths (1310 nm and

1550 nm, respectively). The OC48 Extended Long Reach (ELR) cards provide the dense wavelength
division multiplexing (DWDM) solution for the ONS 15454. There are eighteen OC48 ELR cards;
nine operate in the red band on different wavelengths and nine operate in the blue band on different

wavelengths.

2.1.4 Ethernet Card

The E100T-12 card provides twelve switched, autosensing, 10/100 Base-T Ethernet interfaces. The
Ethernet card reduces the need for certain external Ethernet aggregation equipment such as hubs or

switches.

2.2 Electrical Card Protection

The ONS 15454 provides a variety of electrical card protection methods. This section describes the
protection options. Figure 2-3 shows a 1:1 protection scheme and Figure 2-2 shows a 1:N protection

scheme.

2.2.1 1:1 Protection

In 1:1 protection, a working card is paired with a protect card of the same type. If the working card
fails, the traffic from the working card switches to the protect card. By default, the switched traffic
stays on the protect card. Figure 2-1 shows the ONS 15454 in a 1:1 protection configuration; Slot 1
is protecting Slot 2, Slot 3 is protecting Slot 4, Slot 5 is protecting Slot 6, Slot 17 is protecting Slot
16, Slot 15 is protecting Slot 14, and Slot 13 is protecting Slot 12. Each working card is paired with

a protect card.

Figure 2-1 1:1 Protection Configuration
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2.2.2 1:N Protection

2.2.21

1:N protection allows a single card to protect several working cards. A DSIN-14 card provides
protection for up to five DS1-14 cards, and a DS3N-12 card protects up to five DS3-12 cards. With
the 1:1 protection offered by a standard DS1-14 card or DS3-12 card, protection extends only to the
single working card paired with the standard protection card.

Currently, 1:N protection operates only at the DS-1 and DS-3 levels. 1:N protect cards must match
the levels of their working cards. For example, a DSIN-14 protects only DS1-14 or other DSIN-14
cards, and a DS3N-12 protects only DS3-12 or other DS3N-12 cards. 1:N cards have added circuitry
to act as the protection card in a 1:N protection group. Otherwise, the card is identical to the standard

card and can serve as a normal working card.

The physical DS-1 or DS-3 interfaces on the ONS 15454 backplane use the working card until the
working card fails. When the system detects this failure, the protection card takes over the physical
DS-1 or DS-3 electrical interfaces through the relays and signal bridging on the backplane.

Figure 2-2 shows the ONS 15454 in a 1:N protection configuration. Each side of the shelf has only

one card protecting all of the cards on that side.

Figure 2-2 1:N Protection Configuration
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Revertive Switching

1:N protection supports revertive switching. Revertive switching sends the electrical interfaces back
to the original working card after the card comes back online. Detecting an active working card
triggers the reversion process. There is a variable time period for the lag between detection and
reversion, called the revertive delay, which you can set using the Cisco Transport Controller (CTC).
(For instructions, see the “Configure the BLSR” section on page 4-8 and the “Create a Circuit”
section on page 4-41.) All cards in a protection group share the same reversion settings. 1:N
protection groups default to automatic reversion.
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2.2.2.2 1:N Protection Guidelines
Several rules apply to 1:N protection groups in the ONS 15454:

® Working and protect card groups must reside in the same card bank (A or B).

® The 1:N protect card must reside in Slot 3 for side A and Slot 15 for side B.

® Empty slots or non-protection group cards must not separate the cards in a protection group.

® Working cards may sit on either or both sides of the protect card.

The ONS 15454 supports 1:N equipment protection for all add-drop multiplexer configurations
(ring, linear, and terminal), as specified by GR-253-CORE.

The ONS 15454 automatically detects and identifies a 1:N protection card when the card is installed
in Slot 3 or Slot 15. However, the slot containing the 1:N card in a protection group must be manually
provisioned as a protect slot because by default all cards are working cards.

For detailed procedures on setting up DS-1 and DS-3 protection groups, see the “Converting DS-1
and DS-3 Cards From 1:1 to 1:N Protection” section on page 5-14.

2.2.3 Electrical Card Protection and the Backplane

Protection schemes for electrical cards differ slightly depending on the Electrical Interface
Assembly (EIA) type used on the ONS 15454 backplane. The difference is due to the varying
connector size. For example, because BNC connectors are larger, fewer DS3-12 cards can be
supported when using a BNC connector.

Caution When a protection switch moves traffic from the DS3-12 working/active card to the

A DS3-12 protect/standby card, ports on the new working/standby card cannot be taken out of service.
Lost traffic can result when a port is taken out of service even if the DS3-12 working/standby card
no longer carries traffic.

2.2.3.1 BNC Protection

When you use BNC connectors, the ONS 15454 supports 1:1 protection or 1:N protection for a total
of four working DS-3 electrical cards. If you are using EC-1 electrical cards with the BNC EIA, the
ONS 15454 supports 1:1 protection and a total of four working cards. Slots 2, 4, 14 and 16 are
designated working slots. These slots are mapped to a set of 12 BNC connectors on the EIA. These
slots can be used without protection for unprotected DS-3 access. With 1:N or 1:1 protection, slots
1, 3, 15 and 17 are designated for protection when BNC connectors are used. With 1:N protection,
Slots 3 and 15 are also designated for protection when BNC connectors are used. Slots 5, 6, 12, and
13 do not support DS3-12 cards when you use the regular BNC EIA.

2.2.3.2 High-Density BNC Protection

When you use the High-density BNC EIA, the ONS 15454 supports 1:1 protection or 1:N protection
for eight total working DS-3 electrical cards. If you are using EC-1 electrical cards with the BNC
EIA, the ONS 15454 supports 1:1 protection and a total of eight working cards. Slots 1, 2, 4, 5, 13,
14, 16, and 17 are designated working slots. These slots are mapped to a set of 12 BNC type
connectors on the EIA. These slots can be used without protection for unprotected DS-3 or EC-1
access. Slots 3 and 15 are designated for 1:N protection slots when BNC connectors are used with
the High-density BNC EIA. Slots 6 and 12 do not support DS-3 or EC-1 cards when you use the
High-density BNC EIA.

2-4 Cisco ONS 15454 User Documentation



78-11078-02  June 2001 Card Reference

2

2.2.3.3 SMB Protection

When you use SMB connectors, the ONS 15454 supports 1:1 or 1:N protection. 1:1 and 1:N
protection are available for the DS-1 and the DS-3 electrical cards. If you are using EC-1 cards with
the SMB EIA, the ONS 15454 supports 1:1 protection. Working and protection electrical cards are
defined by card slot pairs (note that the same card is used for working and protect modules; the
protection of the card is defined by the slot in which it is housed). Each slot maps to a set of 12 or
14 SMB connectors on the EIA depending on the number of ports on the corresponding card. Any
slot can be used without protection for unprotected DS-1, DS-3, or EC-1 access.

The DSIN-14 card can be a working or protect card in 1:1 or 1:N protection schemes. When used
with 1:N protection, the DS1N-14 card can protect up to five DS1-14 plug-ins using the SMB
connectors with the DS-1 electrical interface adapters.

2.2.3.4 AMP CHAMP Protection

When you use AMP CHAMP connectors, the ONS 15454 supports 1:1 or 1:N protection. Working
and protection spans are defined by card slot pairs.

The DSIN-14 card can be a working or protect card in 1:1 or 1:N protection schemes. When used
with 1:N protection, the DS1N-14 card can protect up to five DS1-14 plug-ins using the AMP
CHAMP EIA.

2.3 Optical Card Protection

The ONS 15454 currently supports 1+1 span protection to create redundancy for optical cards.
Working and protection spans are defined by card slot pairs. Optical cards in any two slots can be
paired for protection. 1+1 protection pairs a single working card with a single dedicated protect card.
If the working card fails, the protect card takes over.

With non-revertive 1+1 protection, when a failure occurs and the signal switches from the working
card to the protect card, the signal stays switched to the protect card until it is manually switched
back. Revertive 1+1 protection automatically switches the signal back to the working card when the
working card comes back online.

2.4 Multiport Card Protection

For multiport cards such as the DS3-12 and the OC-3, the ports on the card in the protection slot
support the card in the working slot. With 1:1 or 1:N protection (electrical cards), the protect card
must protect an entire slot. In other words, all the ports on the protect card will be used in the
protection scheme. With 1+1 protection (optical cards), protection can be assigned on a per-port
basis. In other words, any number of ports can be assigned as protection ports. On a four-port card,
for example, you could assign one port as a protection port (protecting the corresponding port on the
active card) and leave three ports unprotected. Conversely, you could assign three ports as protection
ports and leave one port unprotected.

Protection schemes can be modified using the CTC software. See the “Creating Protection Groups”
section on page 3-26 for more information.
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2.5 Unprotected Cards

Unprotected cards are not included in a protection scheme; therefore, a card failure or a signal error
results in lost data. Because no bandwidth lies in reserve for protection, unprotected schemes
maximize the available ONS 15454 bandwidth. Figure 2-3 shows the ONS 15454 in an unprotected

configuration. All cards are in a Working state.

Figure 2-3 Unprotected Configuration
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2.6 Timing Communication and Control (TCC/TCC+) Card

The TCC/TCC+ performs system initialization, provisioning, alarm reporting, maintenance,
diagnostics, IP address detection/resolution, SONET Data Communications Channel (DCC)
termination, and system fault detection for the ONS 15454. The TCC/TCC+ also ensures that the
system maintains Telcordia timing requirements. The TCC and the TCC+ perform essentially
identical functions but are not identical cards. The TCC+ is intended as a migration vehicle to future

software releases. Figure 2-4 shows the TCC faceplate and Figure 2-5 shows a block diagram of the
card.

Figure 2-4 TCC Faceplate
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2.6.1 TCC/TCC+ Functionality

The TCC/TCC+ supports multichannel, high-level data link control (HDLC) processing for the
DCC. Up to 48 DCCs can be routed over the Serial Communication Interface (SCI) and terminated
at the TCC/TCC+. The TCC/TCC+ selects and processes ten DCCs to facilitate remote system
management interfaces.
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The TCC/TCC+ also originates and terminates a cell bus carried over the SCI. The cell bus supports
links between any two cards in the system, which is essential for peer-to-peer communication.
Peer-to-peer communication accelerates protection switching for redundant cards.

The node database, IP address, and system software are stored in TCC/TCC+ non-volatile memory,
which allows quick recovery in the event of a power or card failure.

The TCC/TCC+ performs all system-timing functions for each ONS 15454. The TCC/TCC+
monitors the recovered clocks from each traffic card and two DS-1 (BITS) interfaces for frequency
accuracy. The TCC/TCC+ selects a recovered clock, a BITS, or an internal Stratum 3 reference as
the system-timing reference. You can provision any of the clock inputs as primary or secondary
timing sources. A slow-reference tracking loop allows the TCC/TCC+ to synchronize to the
recovered clock, which provides holdover if the reference is lost.

Install TCC/TCC+ cards in Slots 7 and 11 for redundancy. If the active TCC/TCC+ fails, traffic
switches to the protect TCC/TCC+. All TCC/TCC+ protection switches conform to protection
switching standards when the BER counts are not in excess of E10-3 and completion time is less
than 50 ms.

The TCC/TCC+ features an RJ-45 10Base-T LAN port and an RS-232 DB9 type craft interface for
user interfaces. The craft port runs at 9600 bps.

Caution Cisco does not recommend operating the ONS 15454 with only one TCC/TCC+ card. To
A safeguard your system, always operate in a redundant configuration.

2.6.2 Unique TCC+ Functionality

The TCC+ is a memory-enhanced version of the first generation Timing Communication and
Control card. The TCC+ will allow the ONS 15454 to scale from a multiservice OC-48 platform to
a multiservice OC-192 platform in future releases without the need for an additional processor
upgrade.

The enhanced memory of the TCC+ enable it to support the added features that future releases bring.
Software Release 2.1 recognizes both processors; therefore, if a mixture of processors exist on the
same shelf, the mismatch is flagged by the system. The TCC and the TCC+ can coexist on a network
level but not on a shelf level. An upgrade to Release 2.2.0 software is required before you can install
the TCC+.

2.6.3 TCC/TCC+ Card-Level Indicators

The TCC faceplate has eight LEDs. The first two LEDs are card-level indicators. The red FAIL LED
indicates a TCC hardware problem. Replace the unit if the FAIL LED persists. The ACT/STBY
(Active/Standby) LED indicates whether the TCC is active and providing the timing reference and
shelf control (green), or is in standby to the active TCC (yellow).

2.6.4 System Level Indicators

The two red LEDs, CRIT and MAJ, indicate critical and major alarms in the system at the local
terminal. The yellow MIN LED indicates a minor alarm. To provide first-level alarm isolation, the
red REM LED illuminates when an alarm is present in one or several of the remote terminals. The
green SYNC LED indicates that system timing is synchronized to an external reference.
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Press the alarm cutoff (ACO) button to open the audible closure on the backplane. When the ACO
function is activated, the green ACO LED illuminates. ACO state is stopped if a new alarm occurs.
After the originating alarm is extinguished, the ACO LED and audible alarm control are reset.

Figure 2-5 TCC Block Diagram
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2.6.5 TCC/TCC+ Specifications

CTC Software

— Interface: 10 Base-T LAN

— Backplane access: wire wrap
TL1 Craft Interface
— Speed: 9600 baud

— Front panel access: RS-232 DB9 type connector

Synchronization

— Stratum 3 per Telcordia GR-253-CORE

— Free running access: accuracy 4.6 ppm

— Holdover Stability: 3.7 x10'7ppm/day including temperature (<255 slips in first 24 hours)

— Reference: External BITS, line, internal

32506
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¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 20W

¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.7 Cross Connect Card

The Cross Connect (XC) card is the central element for ONS 15454 switching. It establishes
connections and performs time division switching (TDS) at the STS-1 level between ONS 15454

traffic cards. The XC card faceplate, cross-connections, and functions are shown in Figure 2-6,
Figure 2-7, and Figure 2-8.

Figure 2-6 XC Card Faceplate
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The switch matrix on the XC card consists of 288 bidirectionsal ports. When creating bidirectional
STS-1 cross-connects, each cross-connect uses two STS-1 ports. This results in 144 bidirectional
STS-1 cross-connects. The switch matrix is fully crosspoint, non-blocking, and broadcast
supporting. This allows network operators to concentrate or groom low-speed traffic from line cards
onto high-speed transport spans and to drop low-speed traffic from transport spans onto line cards.
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Figure 2-7 Cross-Connect Matrix
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The XC card has 12 input ports and 12 output ports. Four input and output ports operate at either
STS-12 or STS-48 rates. The remaining eight input and output ports operate at the STS-12 rate. An
STS-1 on any of the input ports can be mapped to an STS-1 output port, thus providing full STS-1
time slot assignments (TSA).

The XC card works with the TCC/TCC+ card to maintain connections and set up cross-connects
within the ONS 15454. Either the XC or XCVT is required to operate the ONS 15454. You establish
cross-connect and provisioning information through the user interface on the TCC/TCC+. The
TCC/TCC+ establishes the proper internal cross-connect information and relays the set-up
information to the XC card.

For simplex operation, you can install a single XC card in Slots 8 or 10. A second XC can be added
for redundancy. The card has no external interfaces. All card interfaces are provided through the
ONS 15454 backplane.

a Warning Do not operate the ONS 15454 with a single TCC/TCC+ card or a single XC/XCVT card
installed. Always operate the shelf with one working and one protect card of each type.

2.7.1 XC Card-Level Indicators

The XC faceplate has two card-level LEDs. The red FAIL LED indicates a hardware problem. If the
FAIL LED persists, replace the card. The ACT/STBY LED indicates whether the XC is active and
carrying traffic (green) or in standby mode to the active XC (yellow).
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Figure 2-8
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2.7.2 XC Specifications

® Cross-Connect

— Connection Setup Time: 5 ms

— Latency: 270 ns

¢ Environmental

— Operating Temperature: 0 to +55 degrees Celsius

— Operating Humidity: 5 - 95%, non-condensing

— Power Consumption: 16 Watts

¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.

Cisco ONS 15454 User Documentation

32508

2-13



2 Card Reference 78-11078-02  June 2001

2.8 Cross Connect VT Card

The XCVT card (Figure 2-9) provides the same STS capability as a standard XC card. It provides
non-blocking STS-48 capacity to all of the high-speed slots and non-bidirectional blocking STS-12
capacity to all low-speed slots. This creates a fully non-blocking, 288-port, STS-1 matrix.

The XCVT faceplate, cross-connections, and functions are shown in Figure 2-9, Figure 2-10, and
Figure 2-11.

Figure 2-9 XCVT Faceplate

% XCVT

—
O
O

44055

= &

The XCVT card adds VT1.5 cross-connect capability to the standard STS-level capability. This
allows the XCVT card to manage up to 336 bidirectional VT1.5s or the equivalent of a bidirectional
STS-12. The VT1.5-level signals can be cross connected, dropped, or rearranged. The TCC assigns
bandwidth to each slot on a per STS-1 or per VT1.5 basis.

The XCVT card works with the TCC card to maintain connections and set up cross-connects within
the system. Either the XCVT or XC is required to operate the ONS 15454. You can establish
cross-connect and provisioning information through the user interface on the TCC. The TCC

establishes the proper internal cross-connect information and relays the setup information to the
XCVT card.
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Figure 2-10

2.8.1 VT Mapping

XCVT Cross-Connect Matrix

VT 1.5 Cross-connect ASIC

VTXC

336 bidirectional VT 1.5 cross-connects

L > 8X
—> STS-12

STS-12/48

—>
—»}4x

32125

The Cisco ONS 15454 performs Virtual Tributary (VT) mapping according to Telcordia GR-253
standards. Table 2-1 shows the VT numbering scheme for the ONS 15454 as it relates to the
Telcordia standard.

Table 2-1

ONS 15454 VT Mapping

ONS 15454 VT Number

vT1
VT2
VT3
VT4
VTS
VT6
VT7
VT8

Telcordia Group/VT Number

Groupl/VT1
Group2/VT1
Group3/VT1
Group4/VT1
Group5/VT1
Group6/VT1
Group7/VT1
Group1/VT2
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Table 2-1 ONS 15454 VT Mapping (continued)
ONS 15454 VT Number Telcordia Group/VT Number
VT9 Group2/VT2
VT10 Group3/VT2
VT11 Group4/VT2
VT12 Group5/VT2
VT13 Group6/VT2
VT14 Group7/VT2
VT15 Groupl/VT3
VT16 Group2/VT3
VT17 Group3/VT3
VT18 Group4/VT3
VT19 Group5/VT3
VT20 Group6/VT3
VT21 Group7/VT3
VT22 Groupl/VT4
VT23 Group2/VT4
VT24 Group3/VT4
VT25 Group4/VT4
VT26 Group5/VT4
VT27 Group6/VT4
VT28 Group7/VT4

2.8.2 XCVT Hosting DS3XM-6

The XCVT card works with DS3XM-6 (transmux) cards. A single DS3XM-6 can

demultiplex, or map down to a lower rate, six DS-3 signals into 168 VT1.5s that the XCVT card
manages and cross connects. XCVT cards host a maximum of 336 VT1.5s. In most network
configurations, two DS3XM-6 cards are paired as working and protect cards.

2.8.3 XCVT Card-Level Indicators

The XCVT faceplate has two card-level LEDs. The red FAIL LED indicates a hardware problem.
Replace the unit if the red FAIL LED persists. The ACT/STBY (Active/Standby) LED indicates
whether the XCVT is active and carrying traffic (green) or in standby mode to the active XCVT card
(yellow).

2.8.4 XC/XCVT Compatibility

The XCVT supports run-time compatibility with the XC cross-connect both within a single node and
within a ring of mixed XCVT and XC nodes. However, working and protect cards within a single
ONS 15454 must be either two XC cards or two XCVT cards. If an XC card and an XCVT card are
used together as a working and protect pair, the XCVT acts as an XC card. Both XC and XCVT
systems are supported in unidirectional path switched ring (UPSR) and bi-directional line switched
ring (BLSR) configurations. VT and STS-level cross-connect and protection management are also
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supported in either type of ring. Nodes that rearrange or drop VTs must use an XCVT. Nodes that
only rearrange or drop STSs can use an XC. You do not need to upgrade STS-only nodes to XCVT
in a ring that can handle both VT and STS drop/rearrangement. In this scenario, however, the XC

must run Software Release 2.0 or higher.

When upgrading from XC to XCVT cards, the first XCVT card installed acts as an XC card until the
second XCVT card is installed. For more information, see the “Upgrade XC Cards to XCVT”
section on page 5-18.

If you want to create an STS-capable ring that allows VT drops at some nodes, all of the nodes in
the ring must run Release 2.0 software or higher. The nodes that allow VT drops must use XCVT
cards, and the nodes that do not allow VT drops can use any type of XC card.

When upgrading a system or ring to use the release 2.0 XCVT card, you must first upgrade the

software to Release 2.0.

Figure 2-11

XCVT Block Diagram
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VT cross-connects go to internal port 5 only, which bridges the signal into the VT ASIC.
Port 5 supports 48 STSs, but only the last 24 STSs map VT-level signals.
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2.8.5 XCVT Card Specifications

¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 50 Watts

¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.9 Alarm Interface Controller Card

The Alarm Interface Controller (AIC) card is an optional card that expands system management
capabilities for customer-defined alarm I/O and orderwire. Figure 2-12 shows the AIC faceplate and
Figure 2-13 shows a block diagram of the card.

Figure 2-12 AIC Faceplate
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2.9.1 Customer-Defined Alarms

The AIC card provides additional input/output alarm contact closures. You can define up to four
input and four output contacts. The physical connections are made using the backplane wire-wrap
field. The alarms are defined using the CTC (for instructions see the “Provisioning the Alarm
Interface Controller” section on page 5-9). Each alarm contact has a corresponding LED on the front
panel of the AIC that indicates the status of the alarm. Input alarms are typically used for external
sensors such as open doors, temperature sensors, flood sensors, and other environmental conditions.
Output contacts are typically used to drive visual or audible devices such as bells and lights, but they
can control other devices such as generators, heaters, and fans.
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2.9.1.1 Provisioning I/O Alarm Contacts

You can program each of the four Form A input alarm contacts separately. They can be set to Alarm
on Closure or Alarm on Open. The alarm severity can be set to any of the levels (Critical, Major,
Minor, Not Alarmed, Not Reported). The alarm service level can be programmed to Service
Affecting or Non-Service Affecting. A 63-character alarm description can be assigned for display
by the CTC in the alarm log. The fan tray abbreviation for the alarm is not assignable. It reflects the
generic name of the input contacts. The alarm condition remains until the external input stops driving
the contact and you clear the alarm in CTC.

You can also program the Form A output alarm contacts separately. You can set them to close when
the specified alarm condition is triggered; the default condition for output alarms is the open
position. The alarm triggering conditions can be any ONS 15454 alarm condition including the user-
defined input alarms, or triggering based on severity (i.e. trigger when any Major alarm happens),
or remote alarm. You use pull-down menus in CTC to provision alarm-to-output-contact association;
CTC organizes the alarms by category or by individual alarm. The output contact electrical interface
is 50V, 100mA.

2.9.1.2 Provisionable Items

You can provision several items within the customer-defined alarms. You can provision up to four
OC-N facilities for each local orderwire (LOW) and express orderwire (EOW) as orderwire paths.
External alarm input contacts on the AIC can be provisioned for type, severity, service affecting
status, contact normal, virtual wire, and description. External control output contacts on the AIC can
be provisioned for trigger and local description.

The provisionable triggers cause normally open relay contacts to close. The user-provisionable
triggers consist of the following:

® Local NE alarm severity: A hierarchy of non-reported, non-alarmed, minor, major, or critical
alarm severity that can be set to cause output closure. For example, if the trigger is set to minor,
a minor alarm or above is the trigger.

® Remote NE alarm severity: Same as the Local NE alarm severity but applies to remote alarms
only.

® Virtual wire entities: A raised signal on external outputs 1 through 4 can be provisioned as
triggers to cause output closure.

In addition to provisionable triggers, the CTC allows you to manually force each external output
contact to open or close. Manual operation takes precedence over any provisioned triggers that might
be present.

2.9.2 Orderwire

Orderwire allows a craftsperson to plug a phoneset into an ONS 15454 and communicate with
craftspeople working at other ONS 15454s. The orderwire is a pulse code modulation (PCM)
encoded voice channel that uses E1 or E2 bytes in section/line overhead.

The AIC allows simultaneous use of both local (section overhead signal) and express (line overhead
channel) orderwire channels on a SONET ring or particular optics facility. Local orderwire also
allows communication at regeneration sites when the regenerator is not a Cisco device.

You can provision orderwire functions with the CTC. This is similar to the current provisioning
model for DCC channels. In CTC you provision the orderwire communications network during ring
turn-up so that all NEs on the ring can reach one another. Orderwire terminations (i.e. the optics
facilities that receive and process the orderwire channels) are provisionable. Both express and local
orderwire can be configured as on or off on a particular SONET facility. The system supports up to
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4 orderwire channel terminations per shelf. This allows linear, single ring, dual ring, and small
hub-and-spoke configurations. Keep in mind that orderwire is not protected in ring topologies such
as BLSR and UPSR.

Caution Do not configure orderwire loops. Orderwire loops cause feedback that disables the
orderwire channel.

The ONS 15454 implementation of both local and express orderwire is broadcast in nature. The line
acts as a party line. There is no signalling for private point-to-point connections. Anyone who picks
up the orderwire channel can communicate with all other participants on the connected orderwire
subnetwork. The local orderwire party line is separate from the express orderwire party line. Up to
four OC-N facilities for each local and express orderwire are provisionable as orderwire paths. The
AIC supports a “call” button on the module front panel which, when pressed, causes all ONS 15454
AICs on the orderwire subnetwork to “ring.” The ringer/buzzer resides on the AIC. There is also a
“ring” LED that mimics the AIC ringer. It flashes when any “call” button is pressed on the orderwire
subnetwork. The “call” button and ringer/LED allow a remote craftsperson to get the attention of the
craftspeople across the network.

When provisioning the orderwire subnetwork, make sure that an orderwire loop does not exist.
Loops cause oscillation and an unusable orderwire channel.

Note Only Ports 1 and 3 are valid when using the orderwire function.
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Figure 2-13 AIC Block Diagram
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2.9.3 AIC Specifications

¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 16 Watts

¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.10 EC1-12 Card

The EC1-12 card provides 12 Telcordia-compliant, GR-253 STS-1 electrical interfaces per card.
Each interface operates at 51.840 Mbps over a single 75 ohm 728A or equivalent coaxial span.
Figure 2-14 shows the EC1-12 faceplate and Figure 2-15 shows a diagram of the card.

Figure 2-14 EC1-12 Faceplate
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STS path selection for UNEQ-P, AIS-P, UPSR using BER thresholds, etc. is done on the SONET
ring interfaces in conjunction with the STS cross-connect. The EC1-12 terminates the twelve
selected working STS-1 signals from the backplane. The EC1-12 maps each of the twelve received
ECI signals into 12 STS-1s with visibility into the SONET path overhead.

You can install the EC1-12 card in any ONS 15454 multispeed or high-speed card slot. Each EC1-12

interface features DSX-level outputs supporting distances up to 450 feet depending on facility
conditions.

An EC1-12 card can be 1:1 protected with another EC1-12 card but cannot protect more than one

EC1-12 card. It must be installed in an even-numbered slot to serve as a working card and an odd-
numbered slot to serve as a protect card.
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2.10.1

2.10.2 EC1-12 Port-Level Indicators

EC1-12 Card-Level Indicators

The EC1-12 card faceplate has three card-level LEDs. The red FAIL LED signifies a hardware

problem on the EC1-12 card. Replace the unit if the FAIL LED persists. The green ACT LED means
that the EC1-12 card is operational and ready to carry traffic. The yellow SF LED indicates a signal
failure or condition such as loss of signal (LOS), loss of frame (LOF), or high bit error rate (BER)
on one or more of the card’s EC1-12 ports.

You can obtain the status of the EC1-12 card ports using the LCD screen on the fan tray assembly
of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”
for a complete description of the alarm messages.

Figure 2-15 EC1-12 Block Diagram
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2.10.3 EC1-12 Specifications

2-24

ECI1-12 Input

— Bit Rate: 51.84 Mb/s +/- 20ppm
— Frame Format: SONET

— Line Code: B3ZS

— Termination: Unbalanced coaxial cable

— Input Impedance: 75 ohms +/-5%
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— Cable Loss: Max 450 ft. 734A, RJ59, 728 A/Max 100 ft. RG179
— AIS: TR-TSY-000191-compliant
¢ ECI1-12 Output
— Bit Rate: 51.84 Mb/s +/- 20ppm
— Frame Format: SONET
— Line Code: B3ZS
— Termination: Unbalanced coaxial cable
— Input Impedance: 75 ohms +/-5%
— Cable Loss: Max 450 ft. 734A, RJ59, 728 A/Max 100 ft. RG179
— AIS: TR-TSY-000191-compliant
— Power Level: -1.8 - +5.7 dBm
— Pulse Shape: ANSI T1.102-1988 Figure 8
— Pulse amplitude: 0.36 - 0.85 V peak to peak
— Loopback Modes: Terminal and Facility
— Line Build Out: 0-225 ft.; 226-450 ft.
® ECI1-12 Electrical Interface
— Connectors: BNC or SMB
¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 40 Watts
® Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.11 DS1-14 Card

The ONS 15454 DS1-14 card provides 14 Telcordia-compliant, GR-499 DS-1 interfaces. Each
interface operates at 1.544 Mbps over a 100Q2 twisted pair copper cable. The DS1-14 card can
function as a working or protect card in 1:1 protection schemes and as a working card in 1:N
protection schemes. Figure 2-16 shows the DS1-14 faceplate and Figure 2-17 shows a block diagram
of the card.

Figure 2-16 DS1-14 Faceplate
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You can install the DS1-14 card in any ONS 15454 multispeed or high-speed card slots. Each
DS1-14 interface has DSX-level outputs supporting distances up to 655 feet.

The DS1-14 card supports 1:1 protection. The DS1-14 can be a working card in a 1:N protection
scheme with the proper backplane EIA and wire-wrap or AMP CHAMP connectors. You can also
provision the DS1-14 to monitor for line and frame errors in both directions.

You can group and map DS1-14 card traffic in STS-1 increments to any other card in an ONS 15454.
Each DS-1 is asynchronously mapped into a SONET VT1.5 payload and the card carries a DS-1
payload intact in a VT1.5. For performance monitoring purposes, you can gather bidirectional DS-1
frame-level information (loss of frame, parity errors, CRC errors, etc.). All 14 VT1.5 payloads from
a DS1-14 card are carried in a single STS-1 to the XC or XCVT card where the payload may be
further aggregated for efficient STS-1 transport.
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2.11.1 DS1-14 Card-Level Indicators

The DS1-14 card faceplate has three LEDs. The red FAIL LED indicates a hardware problem.
Replace the card if the red FAIL LED persists. The green/yellow ACT/STBY LED indicates whether
the DS1-14 card is operational and ready to carry traffic (green), or in standby mode (yellow). The
yellow SF LED indicates a signal failure or condition (LOS, LOF, or high BER) on one or more of
the DS1-14 ports.

2.11.2 DS1-14 Port-Level Indicators

You can obtain the status of the DS1-14 card ports using the LCD screen on the fan tray assembly
of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”
for a complete description of the alarm messages.

Figure 2-17 DS1-14 Block Diagram
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2.11.3 DS1-14 Specifications

DS1-14 Input
— Bit Rate: 1.544 Mb/s +/- 32ppm
— Frame Format: Off, SF (D4), ESF
— Line Code: AMI, B8ZS
— Termination: Wire-Wrap, AMP CHAMP
— Input Impedance:100 Ohms
— Cable Loss: Max 655 ft. ABAM #22 AWG
— AIS: TR-TSY-000191-compliant
¢ DSI1-14 Output
— Bit Rate: 1.544 Mb/s +/- 32ppm
— Frame Format: Off, SF (D4), ESF
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— Line Code: AMI, B8ZS

— Termination: Wire-Wrap, AMP CHAMP
— Input Impedance:100 Ohms

— Cable Loss: Max 655 ft. ABAM #22 AWG
— AIS: TR-TSY-000191-compliant

— Power Level: 12.5 to 17.9 dBm centered @ 772 KHz, -16.4 to -11.1 dBm centered at
1544 KHz

— Pulse Shape: GR-499-CORE Figure 9-5
— Pulse Amplitude: 2.4- 3.6 V peak-to-peak
— Loopback Modes: Terminal and Facility
¢ Environmental
— Surge Protection: GR-1089
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 25 Watts
® Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.12 DS1N-14 Card

The DSIN-14 card provides 14 Telcordia-compliant, GR-499 DS-1 interfaces. Each DSIN-14
interface operates at 1.544 Mbps over a 100Q2 twisted-pair copper cable. Figure 2-18 shows the
DSI1N-14 faceplate and Figure 2-19 shows a block diagram of the card.

Figure 2-18 DS1N-14 Faceplate
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Each DS1N-14 interface features DSX-level outputs supporting distances up to 655 feet depending
on facility conditions.

The DSIN-14 card supports 1:N (NS) protection with the proper backplane EIA and wire-wrap or
AMP CHAMP connectors. You can also provision the DSIN-14 to monitor line and frame errors in
both directions.

The DSIN-14 card can function as a working or protect card in 1:1 or 1:N protection schemes. If
you use the DS1N-14 as a standard DS-1 card in a 1:1 protection group, you can install the DSIN-14
card in any ONS 15454 multispeed or high-speed card slot. If you use the card’s 1:N functionality,
you must install a DSIN-14 card in Slots 3 and 15.

You can group and map DS1-14 card traffic in STS-1 increments to any other card in an ONS 15454
system. Each DS-1 is asynchronously mapped into a SONET VT1.5 payload and the card carries a
DS-1 payload intact in a VT1.5. For performance monitoring purposes, you can gather bidirectional
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2.12.1

DS-1 frame-level information (loss of frame, parity errors, or CRC errors, for example). All 14

VT1.5 payloads from a DS1-14 card are carried in a single STS-1 to the XC or XCVT card where
they can be further aggregated for efficient STS-1 transport.

DS1N-14 Card-Level Indicators

The DSIN-14 card faceplate has three LEDs. The red FAIL LED indicates a hardware problem.
Replace the card if the FAIL LED persists. The green/yellow, ACT/STBY LED indicates when

green that the DSIN-14 card is operational and ready to carry traffic, or when yellow that the card
is in standby mode. The yellow SF LED indicates a signal failure or condition (LOS, LOF, or high
BER) on one or more of the DS-1 ports on the card.

2.12.2 DS1N-14 Port-Level Indicators

You can obtain the status of the 14 DS-1 ports using the LCD screen on the fan tray assembly of the

2.12.3 DS1N-

2-30

ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen

displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”

for a complete description of the alarm messages.

Figure 2-19
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14 Specifications
DS1N-14 Input

— Bit Rate: 1.544 Mb/s +/- 32ppm
— Frame Format: Off, SF (D4), ESF
— Line Code: AMI, B8ZS

— Termination: Wire-Wrap, AMP CHAMP

— Input Impedance:100 Ohms

— Cable Loss: Max 655 ft. ABAM #22 AWG

— AIS: TR-TSY-000191-compliant
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¢ DSIN-14 Output
— Bit Rate: 1.544 Mb/s +/- 32ppm
— Frame Format: Off, SF (D4), ESF
— Line Code: AMI, B8ZS
— Termination: Wire-Wrap, AMP CHAMP
— Input Impedance:100 Ohms
— Cable Loss: Max 655 ft. ABAM #22 AWG
— AIS: TR-TSY-000191-compliant

— Power Level: 12.5 to 17.9 dBm centered @ 772 KHz, -16.4 to -11.1 dBm centered at
1544 KHz

— Pulse Shape: GR-499-CORE Figure 9-5
— Pulse Amplitude: 2.4- 3.6 V peak-to-peak
— Loopback Modes: Terminal and Facility
¢ Environmental
— Surge Protection: GR-1089
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 25 Watts
® Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.13 DS3-12 Card

The ONS 15454 DS3-12 card provides twelve Telcordia-compliant, GR-499 DS-3 interfaces per
card for the ONS 15454. Each interface operates at 44.736 Mbps over a single 75Q728A or
equivalent coaxial span. The DS3-12 card operates as a working or protect card in 1:1 protection

schemes and as a working card in 1:N protection schemes. Figure 2-20 shows the DS3-12 faceplate,
and Figure 2-21 shows a block diagram of the card.

Figure 2-20 DS3-12 Faceplate
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You can install the DS3-12 card in any ONS 15454 multispeed or high-speed card slot. Each DS3-12

interface features DSX-level outputs supporting distances up to 450 feet depending on facility
conditions.

The DS3-12 card supports 1:1 protection with the proper backplane EIA. EIAs are available with
BNC or SMB connectors.

a Warning When a protection switch moves traffic from the DS3-12 working/active card to the
DS3-12 protect/standby card, ports on the now working/standby card cannot be taken out of service.

Lost traffic can result if you take a port out of service even if the DS3-12 working/standby card no
longer carries traffic.
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2.13.1 DS3-12 Card-Level Indicators

The DS3-12 card faceplate has three LEDs. The red FAIL LED indicates a hardware problem.
Replace the card if the red FAIL LED persists. The yellow SF LED indicates a signal failure or
condition (LOS, LOF, or high BER) on one or more of the DS-3 ports on the card. The green ACT
LED indicates that the DS3-12 card is operational and ready to carry traffic.

2.13.2 DS3-12 Port-Level Indicators

You can find the status of the 12 DS3-12 card ports using the LCD screen on the fan tray assembly
of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”
for a complete description of the alarm messages.

Figure 2-21 DS3-12 Block Diagram
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2.13.3 DS3-12 Specifications

DS3-12 Input

— Bit Rate: 44.736 Mb/s +/- 20ppm

— Frame Format: DS-3 ANSI T1.107-1988

— Line Code: B3ZS

— Termination: Unbalanced coaxial cable

— Input Impedance: 75 ohms +/-5%

— Cable Loss: Max 450 ft. 734A, RJ59, 728 A/Max 100 ft. RG179
— AIS: TR-TSY-000191-compliant
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¢ DS3-12 Output
— Bit Rate: 44.736 Mb/s +/- 20ppm
— Frame Format: DS-3 ANSI T1.107-1988
— Line Code: B3ZS
— Termination: Unbalanced coaxial cable
— Input Impedance: 75 ohms +/-5%
— Cable Loss: Max 450 ft. 734A, RJ59, 728 A/Max 100 ft. RG179
— AIS: TR-TSY-000191-compliant
— Power Level: -1.8 - +5.7 dBm
— Pulse Shape: ANSI T1.102-1988 Figure 8
— Pulse amplitude: 0.36 - 0.85 V peak-to-peak
— Loopback Modes: Terminal and Facility
® DS3-12 Electrical Interface
— Connectors: BNC or SMB
¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 28 Watts
® Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.14 DS3N-12 Card

The ONS 15454 DS3N-12 card provides twelve Telcordia-compliant, TR499 DS-3 interfaces per
card. Each interface operates at 44.736 Mbps over a single 75 ohm 785A or equivalent coaxial span.
Figure 2-22 shows the DS3N-12 faceplate and Figure 2-23 shows a diagram of the card.

Figure 2-22 DS3N-12 Faceplate
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You can install the DS3N-12 card in any ONS 15454 multispeed or high-speed card slot. Each
DS3N-12 interface features DSX-level outputs supporting distances up to 450 feet depending on
facility conditions. With the proper backplane EIA, the card supports BNC or SMB connectors.

The DS3N-12 can operate as the protect card in a 1:N (1<=N<=5) DS-3 protection group. It has
additional circuitry not present on the basic DS3-12 card that allows it to protect up to 5 working
DS3-12 cards. The basic DS3-12 card can only function as the protect card for one other DS3-12
card. Other than the protection capabilities, the DS3-12 and DS3N-12 cards are identical.
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2.14.1 DS3N-12 Card-Level Indicators

The DS3N-12 card faceplate has three LEDs. The red FAIL LED indicates a hardware problem.

Replace the card if the red FAIL LED persists. The green ACT/STBY LED indicates that the
DS3N-12 card is operational and ready to carry traffic. The yellow SF LED indicates a signal failure
or condition (LOS, LOF, or high BER) on one or more of the DS-3 ports on the card.

2.14.2 DS3N-12 Port-Level Indicators

You can find the status of the 12 DS3N-12 card ports using the LCD screen on the fan tray assembly
of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”

for a complete description of the alarm messages.

Figure 2-23 DS3N-12 Block Diagram
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2.14.3 DS3N-12 Card Specifications

DS3N-12 Input

Bit Rate: 44.736 Mb/s +/- 20ppm

Frame Format: DS-3 ANSI T1.107-1988
Line Code: B3ZS

Termination: Unbalanced coaxial cable

Input Impedance: 75 ohms +/-5%

Cable Loss: Max 450 ft. 734A, RI59, 728 A/Max 79 ft. RG179

AIS: TR-TSY-000191-compliant
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¢ DS3N-12 Output
— Bit Rate: 44.736 Mb/s +/- 20ppm
— Frame Format: DS-3 ANSI T1.107-1988
— Line Code: B3ZS
— Termination: Unbalanced coaxial cable
— Input Impedance: 75 ohms +/-5%
— Cable Loss: Max 450 ft. 734A, RJ59, 728 A/Max 79 ft. RG179
— AIS: TR-TSY-000191-compliant
— Power Level: -1.8 - +5.7 dBm
— Pulse Shape: ANSI T1.102-1988 Figure 8
— Pulse amplitude: 0.36 - 0.85 V peak-to-peak
— Loopback Modes: Terminal and Facility
— Line Build Out: 0-225 ft.; 226-450 ft.
® DS3N-12 Electrical Interface
— Connectors: BNC or SMB
¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 30 Watts
® Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.15 DS3XM-6 Card

The DS3XM-6 card, commonly referred to as a transmux card, provides six Telcordia-compliant,
GR-499-CORE M13 multiplexing functions. The DS3XM-6 converts six framed DS-3 network

connections to 28x6 or 168 VT1.5s. Figure 2-24 shows the DS3XM-6 card faceplate and Figure 2-25
shows a block diagram of the card.

Figure 2-24 DS3XM-6 Faceplate
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You can install the DS3XM-6 in any ONS 15454 multispeed or high-speed card slot. Each

DS3XM-6 interface features DSX-level outputs supporting distances up to 450 feet depending on
facility conditions.

The DS3XM-6 card supports 1:1 protection with the proper backplane EIA. ETAs are available with
BNC or SMB connectors.

2.15.1 DS3XM-6 Hosted By XCVT

The DS3XM-6 card works in conjunction with the XCVT card. A single DS3XM-6 can demultiplex,
or map down to a lower rate, six DS-3 signals into 168 VT1.5s that the XCVT card then manages
and cross connects. XCVT cards host a maximum of 336 VT1.5s or two DS3XM-6 cards. In most
network configurations, two DS3XM-6 cards are paired together as working and protect cards.
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2.15.2 DS3XM-6 Card-Level Indicators

The DS3XM-6 card faceplate has three LEDs. The red FAIL LED indicates a hardware problem.
Replace the card if the red FAIL LED persists. The green ACT LED indicates that the DS3XM-6
card is operational and ready to carry traffic. The yellow SF LED indicates a signal failure or
condition (LOS, LOF, or high BER) on one or more of the DS3XM-6 card ports.

2.15.3 DS3XM-6 Port-Level Indicators

You can find the status of the six DS3XM-6 card ports using the LCD screen on the fan tray assembly
of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”

for a complete description of the alarm messages.

Figure 2-25

DS3XM-6 Block Diagram
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2.15.4 DS3XM-6 Card Specifications

DS3XM-6 Input

Bit Rate: 44.736 Mb/s +/- 20ppm

Frame Format: DS-3 ANSI T1.107-1988
Line Code: B3ZS

Termination: Unbalanced coaxial cable

Input Impedance: 75 ohms +/-5%

AIS: TR-TSY-000191-compliant
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Cable Loss: Max 450 ft. 734A, RJ59, 728 A/Max 100 ft. RG179
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¢ DS3XM-6 Output
— Bit Rate: 44.736 Mb/s +/- 20ppm
— Frame Format: DS-3 ANSI T1.107-1988
— Line Code: B3ZS
— Termination: Unbalanced coaxial cable
— Input Impedance: 75 ohms +/-5%
— Cable Loss: Max 450 ft. 734A, RJ59, 728 A/Max 100 ft. RG179
— AIS: TR-TSY-000191-compliant
— Power Level: -1.8 - +5.7 dBm
— Pulse Shape: ANSI T1.102-1988 Figure 8
— Pulse amplitude: 0.36 - 0.85 V peak-to-peak
— Loopback Modes: Terminal and Facility
— Line Build Out: 0-225 ft.; 226-450 ft.
¢ DS3XM-6 Electrical Interface
— Connectors: BNC or SMB
¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 40 Watts
® Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.16 OC3 IR 4 1310 Card

The OC3 IR 4 1310 card provides four intermediate or short range, Telcordia-compliant, GR-253
SONET OC-3 interfaces. Each interface operates at 155.52 Mbps over a single-mode fiber span and
supports VT payloads and non-concatenated or concatenated payloads on a per STS-1 or STS-3c
basis. Figure 2-26 shows the OC3 IR 4 1310 faceplate and Figure 2-27 shows a diagram of the card.

Figure 2-26 OC3 IR 4 1310 Faceplate
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You can install the OC3 IR 4 1310 card in any ONS 15454 multispeed or high-speed card slot. The
OC3IR 4 1310 card can be provisioned as part of a UPSR or in an ADM/TM configuration. Each
interface features a 1310 nm laser and contains a transmit and receive connector (labeled) on the card
faceplate. The OC3 IR 4 1310 uses SC connectors.

The OC3 IR 4 1310 card supports 1+1 unidirectional protection and bi-directional protection
switching. You can provision protection on a per port basis.

The OC3 IR 4 1310 detects LOS, LOF, Loss of Pointer (LOP), line Alarm Indication Signal (AIS-L),
and line Remote Defect Indication (RDI-L) conditions (see Chapter 9, “CTC Alarms,” for a
description of these conditions). The card also counts section and line BIP errors.
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To enable automatic protection switching, the OC3 IR 4 1310 extracts the K1 and K2 bytes from the
SONET overhead to perform appropriate protection switches. The DCC bytes are forwarded to the
DCC-terminating TCC.

OC3 IR 4 1310 Card-Level Indicators

The OC3 IR 4 1310 card has three card-level LED indicators. The red FAIL LED indicates a
hardware problem. Replace the card if the red FAIL LED persists. The yellow SF LED indicates a
signal failure or condition (LOS, LOF, AISL, or high BER) on one or more of the card’s OC-3 ports.
The green ACT LED indicates the OC3 IR 4 1310 card is carrying traffic or is traffic-ready.

2.16.1

2.16.2 OC3 IR 4 1310 Port-Level Indicators

You can find the status of the 4 card ports using the LCD screen on the fan tray assembly of the ONS
15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen displays
the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,” for a
complete description of the alarm messages.

2-42

y'\

Figure 2-27 OC3 IR 4 1310 Block Diagram
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Warning Follow all directions and warning labels when working with optical fibers. To avoid eye
damage, never look directly into a fiber or connector.
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2.16.3 OC3 |

R 4 1310 Card Specifications

Line

Bit Rate:155.52 Mbps

Code: Scrambled NRZ

Fiber: 1310nm Single Mode

Loopback Modes: Terminal and Facility
Connector: SC

Compliance: Telcordia SONET, GR-GSY-00253

Transmitter

Max. Transmitter Output Power: -8 dBm
Min. Transmitter Output Power: -15 dBm
Center Wavelength: 1274 nm — 1356 nm
Nominal Wavelength: 1310nm

Transmitter: Fabry Perot Laser

Receiver

Max. Receiver Level: -8 dBm

Min. Receiver Level: -28 dBm
Receiver: InGaAs/InP photo detector
Link Loss Budget: 13 dB

Environmental

Eye safety compliance: Class I
Operating Temperature: 0 to +55 degrees Celsius
Operating Humidity: 5 - 95%, non-condensing

Power Consumption: 20 Watts

Dimensions

Height: 12.650 in.
Width: 0.716 in.
Depth: 9.000 in.
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2.17 OC12IR 1310 Card

The OC12 IR 1310 card provides one intermediate or short range, Telcordia-compliant, GR-253
SONET OC-12 interface per card. The interface operates at 622.08 Mbps over a single-mode fiber
span and supports VT payloads and non-concatenated or concatenated payloads on a per STS-1,

STS-3c, STS-6¢, or STS-12c¢ basis. Figure 2-28 shows the OC12 IR 1310 faceplate and Figure 2-29
shows a block diagram of the card.

Figure 2-28 0OC12 IR 1310 Faceplate
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You can install the OC12 IR 1310 card in any ONS 15454 multispeed or high-speed card slot. You
can provision the OC12 IR 1310 as part of a BLSR or UPSR. In ADM/TM configurations, you can
provision the card as either an access tributary or a transport span-side interface.

The OC12 IR 1310 interface features a 1310 nm laser and contains a transmit and receive connector

(labeled) on the card faceplate. The OC12 IR 1310 uses SC optical connections and supports 1+1
unidirectional and bidirectional protection.

The OC12 IR 1310 detects LOS, LOF, LOP, AIS-L, and RDI-L conditions (see Chapter 9, “CTC
Alarms,” for a description of these conditions). The card counts section and line BIT errors.
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To enable automatic protection switching, the OC12 IR 1310 extracts the K1 and K2 bytes from the
SONET overhead and processes them to switch accordingly. The DCC bytes are forwarded to the
DCC-terminating TCC.

2.17.1 OC12 IR 1310 Card-Level Indicators

The OC12 IR 1310 card has three card-level LED indicators. The red FAIL LED indicates a
hardware problem. Replace the card if the red FAIL LED persists. The yellow SF LED indicates a
signal failure or condition (LOS, LOF, AIS-L, or high BER) on the OC-12 interface. The green ACT
LED indicates that the OC12 IR 1310 card is operational and is carrying traffic or is traffic-ready.

2.17.2 OC12 IR 1310 Port-Level Indicators

You can find the status of the OC-12 card port using the LCD screen on the fan tray assembly of the
ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”
for a complete description of the alarm messages.

Figure 2-29 OC12 IR 1310 Block Diagram
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a Warning Follow all directions and warning labels when working with optical fibers. To prevent eye
damage, never look directly into a fiber or connector.

2.17.3 0OC12 IR 1310 Card Specifications
® Line
— Bit Rate: 622.08 Mbps
— Code: Scrambled NRZ
— Fiber: 1310nm Single Mode
— Loopback Modes: Terminal and Facility
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Connectors: SC

Compliance: Telcordia SONET, GR-GSY-00253

® Transmitter

Max. Transmitter Output Power: -8 dBmn
Min. Transmitter Output Power: -15 dBm
Center Wavelength: 1274 nm — 1356 nm
Nominal Wavelength: 1310 nm

Transmitter: Fabry Perot Laser

® Receiver

Max. Receiver Level: -8 dBm

Min. Receiver Level: -28 dBm
Receiver: InGaAs/InP photo detector
Link Loss Budget: 13 dB

® Environmental

Eye safety compliance: Class I
Operating Temperature: 0 to +55 degrees Celsius
Operating Humidity: 5 - 95%, non-condensing

Power Consumption: 14 Watts

® Dimensions

Height: 12.650 in.
Width: 0.716 in.
Depth: 9.000 in.

Cisco ONS 15454 User Documentation



78-11078-02  June 2001 Card Reference

2.18 OC12LR 1310 Card

The OC12 LR 1310 card provides one long-range, Telcordia-compliant, GR-253 SONET OC12
interface per card. The interface operates at 622.08 Mbps over a single-mode fiber span. The OC12
LR 1310 supports non-concatenated or concatenated payloads on a per STS-1, STS-3c, STS-6¢, or
STS-12c¢ basis and reports VT payloads. Figure 2-30 shows the OC12 LR 1310 faceplate and
Figure 2-31 shows a block diagram of the card.

Figure 2-30 OC12 LR 1310 Faceplate
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You can install the OC12 LR 1310 card in any ONS 15454 multispeed or high-speed card slot. You
can provision the OC12 LR 1310 as part of a BLSR or UPSR. In ADM/TM configurations, you can
provision the card as either an access tributary or a transport span-side interface.

The OC12 LR 1310 interface features a 1310 nm laser and contains a transmit and receive connector

(labeled) on the card faceplate. The OC12 LR 1310 uses SC optical connections and it supports 1+1
unidirectional and bidirectional protection.

The OC12 LR 1310 detects LOS, LOF, LOP, AIS-L, and RDI-L conditions (see Chapter 9, “CTC
Alarms,”for a description of these conditions). The card also counts section and line BIT errors.
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2.18.1

To enable automatic protection switching (APS), the OC12 LR 1310 extracts the K1 and K2 bytes
from the SONET overhead and processes them to switch accordingly. The DCC bytes are forwarded

to the TCC, which terminates the DCC.

OC12 LR 1310 Card-Level Indicators

The OC12 LR 1310 card has three card-level LED indicators. The red FAIL LED indicates a

hardware problem. Replace the card if the red FAIL LED persists. The yellow SF LED indicates a
signal failure or condition (LOS, LOF, AIS-L, or high BER) on the OC-12 interface. The green ACT
LED indicates that the OC12 LR 1310 card is operational and is carrying traffic or is traffic-ready.

2.18.2 0OC12 LR 1310 Port-Level Indicators

2.18.3 0C12

2-48

You can find the status of the OC12 LR 1310 card ports using the LCD screen on the fan tray

assembly of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot;
the screen displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC
Alarms,” for a complete description of the alarm messages.

Figure 2-31

OC12 LR 1310 Block Diagram
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a Warning Follow all directions and warning labels when working with optical fibers. To prevent eye
damage, never look directly into a fiber or connector.

Line

— Bit Rate: 622.08 Mbps
— Code: Scrambled NRZ

— Fiber: 1310 nm Single Mode
— Loopback Modes: Terminal and Facility
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— Connectors: SC
— Compliance: Telcordia SONET, GR-253-CORE
¢ Transmitter
— Max. Transmitter Output Power: +2 dBm
— Min. Transmitter Output Power: -3 dBm
— Center Wavelength: 1280 nm — 1335 nm
— Nominal Wavelength: 1310nm
— Transmitter: Distributed Feedback Laser
¢ Receiver
— Max. Receiver Level: -8 dBm
— Min. Receiver Level: -28 dBm
— Receiver: InGaAs/InP photo detector
— Link Loss Budget: 25 dB
¢ Environmental
— Eye safety compliance: Class |
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 14 Watts
¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.19 OC12 LR 1550 Card

The OC12 LR 1550 card provides one long-range, Telcordia-compliant, GR-253 SONET OC-12
interface per card. The interface operates at 622 Mbps over a single-mode fiber span and supports
concatenated STS, non-concatenated STS, and VT payloads. Figure 2-32 shows the OC12 LR 1550
faceplate and Figure 2-33 shows a block diagram of the card.

Figure 2-32 0OC12 LR 1550 Faceplate
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You can install the OC12 LR 1550 card in any ONS 15454 general purpose card slot. The OC12 LR
1550 can be provisioned as part of a BLSR, UPSR, or ADM/TM.

The OC12 LR 1550 uses long reach optics centered at 1550 nm and contains a transmit and receive
connector (labeled) on the card faceplate. The OC12 LR 1550 uses SC optical connections and
supports 1+1 unidirectional protection or provisionable bidirectional or unidirectional switching.

The OC12 LR 1550 detects LOS, LOF, LOP, AIS-L, and RDI-L conditions (see Chapter 9, “CTC
Alarms,” for a description of these conditions). The card also counts section and line BIT errors.

To enable automatic protection switching, the OC12 LR 1550 extracts the K1 and K2 bytes from the

SONET overhead and processes them to switch accordingly. The DCC bytes are forwarded to the
TCC, which terminates the DCC.
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2.19.1 OC12 LR

The OC12 LR 1550 card has three card-level LED indicators. The red FAIL LED indicates a
hardware problem. Replace the card if the red FAIL LED persists. The yellow SF LED indicates a
signal failure or condition (LOS, LOF, AIS-L, or high BER) on the OC-12 interface. The green ACT

1550 Card-Level Indicators

LED indicates that the OC12 LR 1550 card is operational and ready to carry traffic.

219.2 OC12LR

You can find the status of the OC12 LR 1550 card ports using the LCD screen on the fan tray
assembly of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot;
the screen displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC

1550 Port-Level Indicators

Alarms,” for a complete description of the alarm messages.

Figure 2-33 0OC12 LR 1550 Block Diagram

STS-12
0OC-12 Ootical Mux/
O ptical . 3. | Demux <>
™ Mransceiver| ”
CCross
onnect
Flash RAM Matrix
uP bus

a Warning Follow all directions and warning labels when working with optical fibers. To prevent eye

uP

STS-12
—

Main SCI
—

Protect SCI
—>

damage, never look directly into a fiber or connector.

2.19.3 OC12LR

1550 Card Specifications

Line

Bit Rate: 622.08 Mbps

Code: Scrambled NRZ

Fiber: 1550 nm Single Mode

Loopback Modes: Terminal and Facility
Connectors: SC

Compliance: Telcordia SONET, GR-253-CORE
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¢ Transmitter
— Max. Transmitter Output Power: +2 dBm
— Min. Transmitter Output Power: -3 dBm
— Center Wavelength: 1480 nm — 1580 nm
— Nominal Wavelength: 1550 nm
— Transmitter: Distributed Feedback Laser
¢ Receiver
— Max. Receiver Level: -8 dBm
— Min. Receiver Level: -28 dBm
— Receiver: InGaAs/InP photo detector
— Link Loss Budget: 25 dB
¢ Environmental
— Eye safety compliance: Class |
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 14 Watts
¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.20 OC48 IR 1310 Card

The OC48 IR 1310 card provides one intermediate-range, Telcordia-compliant, GR-253 SONET
OC-48 interface per card. Each interface operates at 2488.320 Mbps over a single-mode fiber span
and supports VT payloads and non-concatenated or concatenated payloads on a per STS-1, STS-3c,
STS-6¢ STS-12c, or STS-48c¢ basis. Figure 2-34 shows the OC48 IR 1310 faceplate and Figure 2-35
shows a block diagram of the card.

Figure 2-34 0OC48 IR 1310 Faceplate
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You can install the OC48 IR 1310 card in any ONS 15454 high-speed card slot. You can provision
the OC48 IR 1310 as part of a BLSR or UPSR or, in an ADM/TM configuration, as either an access
tributary or a transport span interface.

The OC-48 interface features a 1310 nm laser and contains a transmit and receive connector
(labeled) on the card faceplate. The OC48 IR 1310 uses SC connectors. The OC48 IR 1310 card
supports 1+1 unidirectional protection and provisionable bidirectional switching.

The OC48 IR 1310 detects LOS, LOF, LOP, AIS-L, and RDI-L conditions (see Chapter 9, “CTC
Alarms,” for a description of these conditions). The card also counts section and line BIT errors.
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To enable automatic protection switching, the OC48 IR 1310 extracts the K1 and K2 bytes from the

SONET overhead and processes them to switch accordingly. The DCC bytes are forwarded to the
TCC. The TCC terminates the DCC.

2.20.1 0OC48 IR 1310 Card-Level Indicators

The OC48 IR 1310 card has three card-level LED indicators. The red FAIL LED indicates a

hardware problem. Replace the card if the red FAIL LED persists. The yellow SF LED indicates a
signal failure or condition (LOS, LOF, AIS-L, or high BER) on the OC-48 interface. The green ACT
LED indicates that the OC48 IR 1310 card is carrying traffic or is traffic-ready.

2.20.2 0OC48 IR 1310 Port-Level Indicators

You can find the status of the OC48 IR 1310 card ports using the LCD screen on the fan tray

assembly of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot;
the screen displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC

Alarms,” for a complete description of the alarm messages.

Figure 2-35

0OC48 IR 1310 Block Diagram
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a Warning Follow all directions and warning labels when working with optical fibers. To prevent eye
damage, never look directly into a fiber or connector.

2.20.3 0OC48 IR 1310 Card Specifications

Line

— Bit Rate: 2488.320 Mbps

— Code: Scrambled NRZ

— Fiber: 1310 nm Single Mode
— Loopback Modes: Terminal and Facility
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— Connectors: SC
— Compliance: Telcordia SONET, GR-GSY-00253
¢ Transmitter
— Max. Transmitter Output Power: 0 dBm
— Min. Transmitter Output Power: -5 dBm
— Center Wavelength: 1280 nm — 1350 nm
— Nominal Wavelength: 1310nm
— Transmitter: Fabry Perot Laser
¢ Receiver
— Max. Receiver Level: 0 dBm
— Min. Receiver Level: -18 dBm
— Receiver: InGaAs InP photo detector
— Link Loss Budget: 13 dB min
¢ Environmental
— Eye Safety Compliance: Class I
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 25 Watts
¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.21 OC48 LR 1550 Card

The OC48 LR 1550 card provides one long-range, Telcordia-compliant, GR-253 SONET OC-48
interface per card. Each interface operates at 2488.320 Mbps over a single-mode fiber span and
supports VT payloads and non-concatenated or concatenated payloads on a per STS-1, STS-3c,
STS-6¢, STS-12c¢, or STS-48c basis. Figure 2-36 shows the OC48 LR 1550 faceplate and

Figure 2-37 shows a block diagram of the card.

Figure 2-36 0OC48 LR 1550 Faceplate
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You can install OC48 LR cards in any ONS 15454 high-speed slot. You can provision the OC48 LR
cards as part of a BLSR or UPSR or, in an ADM/TM configuration, as either an access tributary or
a transport span interface.

The OC48 LR 1550 interface features a 1550 nm laser and contains a transmit and receive connector
(labeled) on the card faceplate. The OC48 LR 1550 card uses SC connectors, and it supports 1+1
unidirectional protection and provisionable bidirectional and unidirectional switching.

The OC48 LR 1550 detects LOS, LOF, LOP, AIS-L, and RDI-L conditions (see Chapter 9, “CTC
Alarms,” for a description of these conditions). The card also counts section and line BIT errors.
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To enable automatic protection switching, the OC48 LR 1550 extracts the K1 and K2 bytes from the
SONET overhead and processes them to switch accordingly. The DCC bytes are forwarded to the
TCC.

2.21.1 0OC48 LR 1550 Card-Level Indicators

The OC48 LR 1550 card has three card-level LED indicators. The red FAIL LED indicates a
hardware problem. Replace the card if the red FAIL LED persists. The yellow SF LED indicates a
signal failure or condition (LOS, LOF, or high BER) on the OC-48 interface. The green ACT LED
indicates that the OC48 LR 1550 card is carrying traffic or is traffic-ready.

2.21.2 0OC48 LR 1550 Port-Level Indicators

You can find the status of the OC48 LR 1550 card ports using the LCD screen on the fan tray
assembly of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot;
the screen displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC
Alarms,” for a complete description of the alarm messages.

Figure 2-37 0OC48 LR Block Diagram
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a Warning Follow all directions and warning labels when working with optical fibers. To prevent eye
damage, never look directly into a fiber or connector.

2.21.3 0OC48 LR 1550 Card Specifications
® Line
— Bit Rate: 2488.320 Mbps
— Code: Scrambled NRZ
— Fiber: 1550 nm Single Mode
— Loopback Modes: Terminal and Facility
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— Connectors: SC

— Compliance: Telcordia SONET, GR-GSY-00253
¢ Transmitter

— Max. Transmitter Output Power: +3 dBm

— Min. Transmitter Output Power: -2 dBm

— Center Wavelength: 1520 nm — 1580 nm

— Nominal Wavelength: 1550 nm

— Transmitter: Distributed Feedback Laser
¢ Receiver

— Max. Receiver Level: -8 dBm

— Min. Receiver Level: -28 dBm

— Receiver: InGaAs APD photo detector

— Link Loss Budget: 26 dB min, with 1 dB dispersion penalty
¢ Environmental

— Eye Safety Compliance: Class I

— Operating Temperature: 0 to +55 degrees Celsius

— Operating Humidity: 5 - 95%, non-condensing

— Power Consumption: 25 Watts
¢ Dimensions

— Height:12.650 in.

— Width: 0.716 in.

— Depth: 9.000 in.
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2.22 0OC48 ELR DWDM Cards

18 distinct OC-48 ITU 200GHz dense wavelength division multiplexing (DWDM) cards provide the
ONS 15454 DWDM channel plan. Each OC48 DWDM card provides one Telcordia-compliant,
GR-253 SONET OC-48 interface. The interface operates at 2.48 Gbps over a single-mode fiber span
and carries both concatenated and non-concatenated payloads on an STS-1 or VT basis. Figure 2-38
shows the OC48 ELR faceplate and Figure 2-39 shows a block diagram of the card.

Figure 2-38 OC48 ELR DWDM Card Faceplate
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Nine of the cards operate in the blue band with spacing of 200 GHz on the ITU grid (1530.33 nm,
1531.90 nm, 1533.47 nm, 1535.04 nm, 1536.61 nm, 1538.19 nm, 1539.77 nm, 1541.35 nm, 1542.94
nm), while the other nine operate in the red band with spacing of 200 GHz on the ITU grid
(1547.72 nm, 1549.32 nm, 1550.92 nm, 1552.52 nm, 1554.13 nm, 1555.75 nm, 1557.36 nm,
1558.98 nm, 1560.61 nm).

You can install the OC48 ELR cards in any ONS 15454 high-speed slot. You can provision the OC48
ELR cards as part of a BLSR or UPSR or, in an ADM/TM configuration, as either an access tributary
or a transport span interface.

32416

Each OC48 DWDM card uses extended long reach optics operating individually within the ITU-T
200 GHz grid. The OC48 DWDM cards are intended to be used in applications with very long

unregenerated spans of up to 200 km (with mid-span amplification). These transmission distances
are achieved through the use of inexpensive optical amplifiers (flat gain amplifiers) such as erbium

Cisco ONS 15454 User Documentation 2-59



2 Card Reference 78-11078-02  June 2001

doped fiber amplifiers (EDFAs). Using co-located amplification, distances up to 200 km can be
achieved for a single channel (160 km for 8 channels). Maximum system reach in filterless
applications without the use of optical amplifiers or regenerators is 24 dB or approximately 80 km,
depending on the condition of the facilities, number of splices and connectors, or other
performance-affecting factors. The OC48 DWDM cards feature wavelength stability of +/- 0.25 nm.
Each interface contains a transmitter and receiver.

The OC48 DWDM cards are the first in a family of cards meant to support extended long reach
applications in conjunction with optical amplification. Using electro-absorption technology, the
0OC48 DWDM cards provide a solution at the lower-extended long reach distances.

The OC48 LR 1550 interface features a 1550 nm laser and contains a transmit and receive connector
(labeled) on the card faceplate. The OC48 LR 1550 card uses SC connectors, and it supports 1+1
unidirectional protection and provisionable bidirectional and unidirectional switching.

The OC48 ELR cards detect LOS, LOF, LOP, AIS-L, and RDI-L conditions (see Chapter 9, “CTC
Alarms,” for a description of these conditions). The cards also count section and line BIT errors.

To enable APS, the OC48 ELR cards extract the K1 and K2 bytes from the SONET overhead and
process them to switch accordingly. The DCC bytes are forwarded to the TCC.

2.22.1 0C48 ELR Card-Level Indicators

The OC48 ELR cards have three card-level LED indicators. The red FAIL LED indicates a hardware
problem. Replace the card if the red FAIL LED persists. The yellow SF LED indicates a signal
failure or condition (LOS, LOF, or high BER) on the OC-48 interface. The green ACT LED indicates
that the card is carrying traffic or is traffic-ready.

2.22.2 0C48 ELR Port-Level Indicators

2-60

You can find the status of the OC48 ELR card ports using the LCD screen on the fan tray assembly
of the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”
for a complete description of the alarm messages.

Figure 2-39 0C48 ELR Block diagram
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Warning Follow all directions and warning labels when working with optical fibers. To prevent eye
A damage, never look directly into a fiber or connector.

2.22.3 0C48 ELR Card Specifications

® Line

— Bit Rate: 2488.320 Mbps

— Code: Scrambled NRZ

— Fiber: 1550 nm Single Mode

— Loopback Modes: Terminal and Facility

— Connectors: SC

— Compliance: Telcordia SONET, GR-GSY-00253, ITU-T G692, ITU-T G958
® Transmitter

— Max. Transmitter Output Power: 0 dBm

— Min. Transmitter Output Power: -2 dBm

— Center Wavelength: £.25 nm

— Transmitter: Electro-absorption laser
® Receiver

— Max. Receiver Level: -8 dBm

— Min. Receiver Level: -28 dBm

— Receiver: InGaAs APD photo detector

— Link Loss Budget: 26 dB min, with 1 dB dispersion penalty
¢ Environmental

— Eye Safety Compliance: Class I

— Operating Temperature: 0 to +55 degrees Celsius

— Operating Humidity: 5 - 95%, non-condensing

— Power Consumption: 25 Watts
¢ Dimensions

— Height:12.650 in.

— Width: 0.716 in.

— Depth: 9.000 in.
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2.23 E100T-12 Card

The E100T-12 card provides twelve ports of IEEE 802.3-compliant, 10/100 interfaces. Each
interface supports full-duplex operation for a maximum bandwidth of 200 Mbps per port and

2.4 Gbps per card. Each port independently detects the speed of an attached device (auto-senses) and
automatically connects at the appropriate speed. The ports auto-configure to operate at either half or
full duplex and can determine whether to enable or disable flow control. The card’s faceplate and
functionality are shown in Figure 2-40 and Figure 2-41.

Figure 2-40 E100T-12 Faceplate
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The E100T-12 Ethernet card provides high-throughput, low-latency packet switching of Ethernet
traffic across a SONET network while providing a greater degree of reliability through SONET
“self-healing” protection services. This Ethernet capability enables network operators to provide
multiple 10/100 Mbps access drops for high-capacity customer LAN interconnects, Internet traffic,
and cable modem traffic aggregation. Efficient transport and co-existence of traditional TDM traffic
with packet-switched data traffic are provided.

The E100T-12 eliminates the need for external aggregation equipment such as routers or Ethernet
switches, remote headends, or distributed point of presences (POPs).
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Each E100T-12 card supports standards-based, wire-speed, layer 2 Ethernet switching between its
Ethernet interfaces. 802.1q tag and port-based VLANS are supported in order to logically isolate
traffic (typically subscribers). 802.1p priority is also supported in order to provide multiple classes
of service.

You can install the E100T-12 card in any general-purpose slot in the shelf assembly. Multiple
Ethernet cards installed in an ONS 15454 act as a single switch supporting a variety of SONET port
configurations. You can create logical SONET ports by provisioning a number of STS channels to
the packet switch entity within the ADM. Logical ports can be created with a bandwidth granularity
of STS-1. The ONS 15454 supports STS-1, STS-3c, STS-6¢, or STS-12¢ configurations.

2.23.1 E100T-12 Card-Level Indicators

The E100T-12 card faceplate has three card-level LED indicators. The red FAIL LED indicates a
hardware problem. Replace the card if the red FAIL LED persists. An ACT LED indicates the status
of the E100T-12. The SF LED is reserved for future options.

2.23.2 E100T-12 Port-Level Indicators

The E100T-12 card also has twelve pairs of LEDs (one pair for each port) to indicate port conditions.
A green LINK LED indicates link has been detected: ON means an active connection and OFF
means no active connection.

You can find the status of the E100T-12 card port using the LCD screen on the fan tray assembly of
the ONS 15454 shelf. Use the LCD to access quickly the status of any port or card slot; the screen
displays the number and severity of alarms for a given port or slot. See Chapter 9, “CTC Alarms,”
for a complete description of the alarm messages.

Figure 2-41 E100T-12 Block Diagram
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2.23.3 E100T-12 Card Specifications

¢ Environmental
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95%, non-condensing
— Power Consumption: 40 Watts

¢ Dimensions
— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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2.24 E1000-2 Card

The E1000-2 card provides two ports of IEEE-compliant, 1000 Mbps interfaces. Each interface
supports full-duplex operation for a maximum bandwidth of 2 Gbps per port and 4 Gbps per card.
Each port auto-configures for full duplex and 802.3x flow control. The E1000-2 card uses GBIC
modular receptacles for the optical interfaces. For Release 2.2.0, two GBIC modules are offered as
separate orderable products for maximum customer flexibility: An IEEE 1000Base-SX compliant,
850 nm optical module and an IEEE 1000Base-LX-compliant, 1300 nm optical module. The 850 nm
SX optics are designed for multimode fiber and distances of up to 220 meters on 62.5 micron fiber
and up to 550 meters on 50 micron fiber. The 1300 nm LX optics are designed for single-mode fiber
and distances of up to five kilometers. Other GBIC modules for long reach 1550 nm and twisted-pair
copper will be offered for use with the E1000 card when those components become available. The
card’s faceplate and functionality are shown in Figure 2-42 and Figure 2-43.

Figure 2-42 E1000-2 Card Faceplate

E1000
2

The E1000-2 Gigabit Ethernet card provides high-throughput, low-latency packet switching of
Ethernet encapsulated traffic (IP and other layer 3 protocols) across a SDH/SONET network while
providing a greater degree of reliability through SONET “self-healing” protection services. This
enables network operators to provide multiple 1000 Mbps access drops for high-capacity customer
LAN interconnects, Internet traffic, and cable modem traffic aggregation. Efficient transport and
co-existence of traditional TDM traffic with packet-switched data traffic is provided.

0

44551
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The E1000-2 card eliminates the need for external aggregation equipment such as routers, Ethernet
or ATM switches at the customer site, remote headends, or distributed POPs.

Each E1000-2 card supports standards-based, layer 2+ Ethernet switching between its Ethernet
interfaces and any other Ethernet or SONET trunk interfaces on the ONS 15454. 802.1q tag and
port-based VLANS are supported in order to logically isolate traffic (typically subscribers). 802.1p
priority is also supported in order to provide multiple classes of service.

You can install the E1000-2 card into any general-purpose slot in the shelf assembly for a total shelf
capacity of 20 Gigabit Ethernet ports. Multiple Ethernet cards installed in an ONS 15454 can act as
either a single switching entity or as a single switch supporting a variety of SONET port
configurations. You can create logical SONET ports by provisioning a number of STS channels to
the packet switch entity within the Cisco ADM. Logical ports can be created with a bandwidth
granularity of STS 1. In a single or multicard configuration, the ONS 15454 can support the
following unstitched STS configurations: 1 STS-12c, 2 STS-6¢, 4 STS-3c, or 12 STS-1 and the
following stitched configurations: 2 STS-6¢c, 4 STS-3c, or 12 STS-1s.

2.24.1 E1000-2 Card-Level Indicators

The E1000-2 card faceplate has two card-level LED indicators. The red FAIL LED indicates a
hardware problem or catastrophic software failure on the E1000-2 card. As part of the boot
sequence, the FAIL LED is turned on until the software deems the card operational. A green ACT
LED provides the operational status of the E1000-2. When the ACT LED is green it indicates that
the E1000-2 card is active and the software is operational.

2.24.2 E1000-2 Port-Level Indicators

The E1000-2 card also has one bi-color LED per port. The green LINK LED indicates whether
linkbeat has been detected (ON), meaning that an active network cable is installed, or if an active
network cable is not plugged into the port (OFF). The amber port ACT LED flashes at a rate
proportional to the level of traffic being received and transmitted over the port.
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Figure 2-43 E1000-2 Block Diagram
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2.24.3 E1000-2 Card Specifications

® Environmental

— Operating Temperature: 0 to +55 degrees Celsius

— Operating Humidity: 5- 95%, non-condensing

— Power Consumption: 40 Watts

® Dimensions

— Height: 12.650 in.
— Width: 0.716 in.
— Depth: 9.000 in.
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CHAPTER 3

Using the Cisco Transport Controller

This chapter explains how to connect computers to the Cisco ONS 15454 and set up the ONS 15454
using the Cisco Transport Controller (CTC) software.

3.1 Overview

CTC is a Java application that is downloaded from the Timing Communications and Control (TCC)
card to your computer when you connect to the ONS 15454. CTC allows you to provision and
manage the ONS 15454 using Netscape Navigator or Microsoft® Internet Explorer. You can also
use TL1 commands to communicate with the ONS 15454 through VT100 terminals, VT100
emulation software, or you can Telnet to the node using TL1 port 2361.

To use CTC, your computer needs a web browser and appropriate versions of the Java Runtime
Environment (JRE) and Java plug-ins. Netscape Communicator and required Java files are provided
on the Cisco ONS 15454 software CD. You can install Netscape and the Java files using procedures
in the following sections.

Each time you connect to an ONS 15454, a CTC launcher is downloaded from the ONS 15454 TCC
card to your computer. The launcher verifies that the computer has a CTC version that matches the
version on the TCC. If the computer does not have CTC, or if the version on the TCC is a later
release, the launcher downloads the CTC application to the temporary directory designated by your
computer’s operating system. (For a detailed description of the TCC card, see the “Timing
Communication and Control (TCC/TCC+) Card” section on page 2-7.)

3.2 Preparing PCs to Run CTC

The following minimum requirements are needed to run CTC from personal computers:
® 486 processor
® 128 megabytes of RAM
® LAN connection (to access the ONS 15454 through a LAN)
®  Windows 95, Windows 98, or Windows NT (Windows NT is recommended)
® Any one of the following:
— Netscape Navigator 4.08 or higher
— Netscape Communicator 4.61 or higher, or

— Internet Explorer 4.0 (service pack 2) or higher
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Netscape Communicator is included on the Cisco ONS 15454 software CD. Internet Explorer 5.0
is included with Windows 98 second edition.

® Java Runtime Environment 1.2.2 with Java 1.2 plug-in (included on CTC software CD)

® User-supplied category 5 cable with RJ-45 connectors on each end

Note Your mouse pointer scheme should be set to Windows Standard (Windows 95/98) or None
(Windows NT). To check the settings, choose Settings>Control Panel from the Windows Start
menu. Double-click the Mouse option. From the Pointers tab of the Mouse Properties dialog, select
the Windows Standard (or “none” for NT) mouse scheme. Click OK.

Procedure: Install Netscape Communicator (Windows)

If a web browser is not installed, install Netscape Communicator or Microsoft Internet Explorer
using procedures provided by those vendors. Netscape Communicator is provided on the Cisco ONS
15454 software CD. To install it:

Step 1 Insert the Cisco ONS 15454 software CD into your PC’s CD drive.

Step2 In the Windows/Netscape directory, double click n32e461.exe and follow the on-screen
instructions.

Procedure: Install the Java Files (Windows)

3.3

3-2

Step1  Insert the ONS 15454 software CD into your PC’s CD drive.

Step 2 In the Windows/Jre1.2.2 folder, double click jrel_2_2-win.exe and follow the on-screen
instructions.

Step 3 In the Windows folder, double click JavaPolicyInstall.bat.

A message displays on the DOS screen stating the installation was successful.
Step4  Enable the JRE 1.2 plug-in:
a) From the Windows Start menu, select Programs>Java Plug-in Control Panel.
b) On the Java Plug-in Properties dialog, click the Advanced tab.

(
(
(
(d

)
c) Under Java Run Time Environment, choose JRE 1.2.
)

Click Apply. Close the Java Plug-in Properties dialog.

Preparing Solaris Workstations to Run CTC

To install CTC Release 2.2.0 software on Solaris workstations, the workstation must have Solaris
2.6 or 2.7 installed, with a minimum 128 megabytes of RAM. Use the following procedures to install
Netscape and the appropriate Java files on the Solaris workstation.
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Note Solaris installation instructions use "CD/" instead of an actual CD-ROM path. Remember to
substitute the path to your CD-ROM drive.

Procedure: Install qzip
To install Netscape, you need qzip. If qzip is not installed:

Step1  Insert the Cisco Transport Controller Release 2.2.0 CD into your CD-ROM drive. If the
directory of the CD does not open automatically, open it.

Step2  Extract the files from the CD/Solaris/files.tar archive to a temporary directory on your
hard drive by typing:

cd /var/tmp
tar xvf /CD/solaris/files.tar

Step3  Copy qzip from the /var/tmp/Solaris/Netscape to /ust/local/bin (you may need to create
/usr/local/bin and add it to your path). Type:

mkdir -p /usr/local/bin
cp /var/tmp/Solaris/Netscape/gzip /usr/local/bin

Step4  Add /usr/local/bin and /opt/NSCPcom to your search path by typing:

csh: % set path = ( /usr/local/bin /opt/NSCPcom S$path )
sh or ksh: # PATH=/usr/local/bin:/opt/NSCPcom:$SPATH
# export PATH

Step5  Set the environment variable in the startup files in each user’s home directory: .cshrc for
csh and .profile for sh or ksh.

Procedure: Install Netscape Navigator (Solaris)

If Netscape Navigator 4.08 or Netscape Communicator 4.61 or later is not installed on the
workstation, install it from the CTC Release 2.2.0 CD:

Step 1 Insert the Cisco Transport Controller Release 2.2.0 CD into your CD-ROM drive. If the
directory of the CD does not open automatically, open it.

Step2  Extract the files from the CD/Solaris/files.tar archive (if not extracted in a previous
procedure) to a temporary directory on your hard drive by typing:

cd /var/tmp
tar xvf /CD/solaris/files.tar

Step3  Go to /var/tmp/Solaris/Netscape and type:

tar xvf navigator-v408-export.sparc-sun-solaris2.5.1.tar

Step4  Follow the instructions in:
/var/tmp/Solaris/Netscape/navigator-v408.sparc-sun-solaris2.5.1/README.install.

When prompted for the Netscape Communicator software location, type:

/opt /NSCPcom

Netscape Communicator is installed in [/opt/netscape]: /opt/NSCPcom.
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Procedure: Install the Java Files (Solaris)

If JRE 1.2.2.2_05 with Java 1.2 plug-in is not installed on the workstation, complete Steps 1-8 to
install it from the CTC Release 2.2.0 CD. If JRE 1.2.2.2_05 with 1.2 plug-in is installed, skip to
Step 9.

Step 1 Insert the Cisco Transport Controller Release 2.2.0 CD into your CD-ROM drive. If the
directory of the CD does not open automatically, open it.

Step2  Extract the files from the CD/Solaris/files.tar archive (if not extracted in a previous
procedure) to a temporary directory on your hard drive by typing:

cd /var/tmp
tar xvf /CD/solaris/files.tar

Step3  Go to the /var/tmp/Solaris/Jrel.2.1_05/ directory and unpack the appropriate tar archive:
® For Solaris 2.6, unpack the *.6.tar archive
® For Solaris 2.7, unpack the *.7.tar archive

Step4  Un-compress each patch file by typing:

cd /var/tmp/Solaris/Jrel.2.1_05

tar -xvf 1.2.1_03_patches_sparc_5.6.tar# or ...5.7.tar
cd 5.6 or 5.7

uncompress *

Step 5 For each un-compressed tar file, unpack the archive, enter the directory, and follow the
instructions, for example:

tar xvf 105181-11.tar

Step 6 Remove the intermediate tar files, for example:

rm *.tar

Step7  Add each patch using /usr/sbin/patchadd, for example:

/usr/sbin/patchadd 105181-11

Note Refer to http://java.sun.com/products/jdk/1.2.1/install-solaris-patches.html for
more information on installing Solaris patches.

Step 8  Install the Java 1.2 plug-in using /usr/sbin/pkgadd, for example,

cd /var/tmp/Solaris/Jrel.2.1 03
tar xvf plugin-12-sparc.tar
pkgadd -d . SUNWj2pi

This installs javaplugin.so into /opt/NSCPcom/plugins. If Netscape was installed under
/opt/NSCPcom, the plug-in is installed in the Netscape directory. If so, copy javaplugin.so
to <Netscape-directory>/plugins. For more information about installing the JRE, see:

http://java.sun.com/products/jdk/1.2/runtime solaris.html

Step9  Modify java.policy to allow the CTC launcher to write to the workstation’s hard drive:
(a) Exit Netscape if a Netscape session is running.

(b) Modity java.policy:
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® To enable the applet for all users, copy the lines from: /CD/Cerent/LAUNCHER.policy
to /opt/NSCPcom/j2pi/lib/security/java.policy.

Otherwise:

® If your home directory has a .java.policy file, copy the lines from
/CD/Cerent/LAUNCHER.policy to that file.

® If your home directory does not have a .java.policy file, copy the
/CD/Cerent/LAUNCHER.policy file to your home directory and rename it .java.policy.

Note The per-user .java.policy has a leading period (.) while the system-wide file does
not.

Step 10  Use Netscape to launch and run CTC. (Before launching Netscape, make sure to put
/opt/NSCPcom/j2pi/bin in your path.)

Step 11 Clean up the temporary files by typing:

cd /var/tmp
rm -fr Solaris

Step 12 Type eject cdrom to remove the CTC CD from your CD-ROM drive.

3.4 Connecting PCs to the ONS 15454

You can connect a PC to the ONS 15454 using the RJ-45 LAN port on the TCC or the LAN 1 pins
on the ONS 15454 backplane. For initial setup, use the front panel RJ-45 port. For long-term
connections, Cisco recommends using the LAN pins to keep the front panel area uncluttered. For a
list of LAN pin assignments, see Table 1-2 on page 1-31.

Each ONS 15454 must have a unique Internet Protocol (IP) address that you use to access the ONS
15454. The address is displayed on the front panel’s liquid crystal display (LCD) at turn-up. The
initial IP address, 192.1.0.2, is a generic default address for ONS 15454 access and configuration.

Each computer used to communicate with the ONS 15454 should have only one IP address.

Note Do not use dual Network Interface Cards or an enabled NIC card and dial-up adapter at the
same time; this hampers communication between the CTC and ONS 15454s.

3.4.1 Direct Connections

Use the following procedures to connect a PC running Windows 95, Windows 98, or Windows NT
directly to an ONS 15454.

Procedure: Setup a PC for Direct Connection
Step1  From the Windows Start menu, choose Settings>Control Panel.

Step2  On the Control Panel dialog, click the Network icon.
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Step3  On the Network dialog, shown in Figure 3-1, select the following:
® Windows 95/98: select TCP/IP for your PC Ethernet card, then click Properties.
® Windows NT: choose the Protocols tab, select TCP/IP Protocol, and click

Properties.
Figure 3-1 Network Dialog
Windows 95/98 Windows NT
2 x| Metwork K E
Configuration l Identification] Access Control Identification] Services  Protocols lAdapters] Bindings]

Metwork Protocols:

The following network, components are installed:

3 DialUp Adapter ﬂ
HEM ThirkPad Fast Infrared Port

3 ircom CardBus Ethernet 104100 Adapter

4 Fast Infrared Protocol -» 1BM ThinkPad Fast Infrared Part

5 TCPAP <> DiallJp Adapter

Add... | Femaove
Add... Bemove | Froperties. .. |
Frimary Metwork Logon: .
|EI' o ™ m ﬂ Drescription:
ent for Micrasaft Netwarks Tranzport Control Protocol/Internet Protocol. The default wide

area network protocol that provides communication across

File and Frint Sharing... diverse interconnected netwaorks.

Description
TCPAP is the protocol you use to connect ta the Internet and
wide-area nebworks.

()8 Cancel

34330

()8 | Cancel |

Step4  (Windows 95/98 only) On the TCP/IP Properties dialog:

(a) Click the DNS Configuration tab and select Disable DNS.

(b) Click the WINS Configuration tab and select Disable WINS Resolution.
Step 5 Click the IP Address tab to open the IP Address window (Figure 3-2).
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Figure 3-2 IP Address Window

Windows 95/98 Windows NT
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azk pour network. administrator for an address, and then bype it in
the space below.

An IP address can be automatically assigned to this computer.
If your network. does not automatically azsign IP addresses, ask
your network. administrator for an address, and then type it in
the space below.

Adapter:
" Obtsin an [P address sutomaticall
R L R [[1] HP EN1207D-TX PCI 107100 Fast Ethemet Adapter 7|
" Obtain an IP address from a DHCP server
|F Address: 192. 1 .31 .100

' Specify an P address
Subnet Mask: |P Address: T8z 1 . @ . 1m

Subnet Magk:

Default Gateway: . . .

Advanced...
QK | Cancel | Apply |

oK | Cancel |

34332

Step 6  Click Specify an IP address.

Step 7  In the IP Address field, enter an IP address identical to the ONS 15454 (the ONS 15454
IP address is shown on the front LCD panel) except for the last three digits. The last three
digits must be between 1 and 254. This places the PC on the same subnet as the ONS
15454.

Step8  Type 255.255.255.0 in Subnet Mask.
Step9  Click OK.
Step 10 (Windows 95/98) Click the Gateway tab (Figure 3-3).

Figure 3-3 TCP/IP Properties - Gateway Tab (Windows 95/98)

TCF/IP Properties S

Bindings | Advanced | MetBI0S |
DNS Configuration  Gateway l WMS Configuration ] IP Address ]

The first gateway in the Installed Gateway list will be the default.
The address order in the list will be the order in which these
machines are used.

Mew gateway:

192. 1 .31 .100 Add

Installed gateways:

e

Ok | Cancel

3433
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Step 11

Step 12

Step 13

Step 14

This step defines the ONS 15454 as the default gateway for the PC. In New Gateway
(Windows 95/98) or Default Gateway (Windows NT), type the ONS 15454 IP address.
For initial setup, this is the default address that ships with the ONS 15454 (192.1.0.2).

Click Apply (Windows NT) or Add (Windows 95/98). For Windows 95/98, verify that
the IP address displays in the Installed Gateways field.

If your PC runs on Windows 95/98, you will be prompted to restart your PC. Click Yes.
If your PC runs on Windows NT, you do not need to restart your computer.

Test the connection:
(a) Start Netscape Navigator or Windows Explorer.

(b) Enter the ONS 15454 IP address in the Web address (URL) field. Within 30 seconds,
the CTC login screen displays. If it does not appear, continue with Steps ¢ and d.

(¢) From the Windows Start menu, choose MS-DOS prompt.

(d) Atthe DOS prompt, type ping [ONS 15454 IP address], for example,
ping 192.1.0.2.If your computer is connected to the ONS 15454, a reply
from [IP address] message displays.

If your PC is not connected, a Request timed out message displays. If this occurs,
check that the cables connecting the PC to the ONS 15454 are securely attached. Check the
Link Status LED on the PC NIC card. Repeat Steps 1-14, verifying IP and submask
information.

3.4.2 Local Area Network Connections
To access the ONS 15454 from a local area network (LAN):

® The ONS 15454 TP address must be changed to a LAN-compatible IP address.

® The ONS 15454 must be physically connected to the LAN (typically using cross-over cable to a
router, hub, or switch).

® If the PC Network settings were changed for direct access to the ONS 15454, change the settings
back to LAN access. Usually this means setting the IP Address on the TCP/IP dialog back to
“Obtain an IP address automatically.” If your LAN requires that DNS or WINS is enabled,
change the setting on the DNS Configuration or WINS Configuration tab of the TCP/IP dialog.

® If your computer is connected to a proxy server, disable proxy service or add the ONS 15454
nodes as exceptions.

If these conditions have been met, to access the ONS 15454, start your web browser and type the
ONS 15454 IP address in the URL field.

Procedure: Disable Proxy Service: Windows with Internet Explorer

3-8

Step 1
Step 2
Step 3
Step 4

From the Start menu, select Settings>Control Panel.

In the Control Panel window, select Internet Options.

From the Internet Properties dialog, select the Connections tab and click LAN Settings.
On the Local Area Network (LAN) Settings dialog do one of the following:

® Deselect “Use a proxy server” to disable the service, or
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® Leave “User a proxy server” selected and click Advanced. On the Proxy Setting
dialog under Exceptions, enter the IP addresses of ONS 15454 nodes that you will
access. Separate each address with a semi colon. You can insert an asterisk for the host
number to include all the ONS 15454s on your network. Click OK to close each open
dialog.

Procedure: Disable Proxy Service: Windows with Netscape
Step1  Open Netscape.

Step 2 From the Edit menu, select Preferences.

Step 3  In the Preferences dialog under Category, select Advanced>Proxies.

Step4  On the right side of the Preferences dialog under Proxies, do one of the following:
® Select “Direct connection to the Internet,” to bypass the proxy server, or

® Select “Manual proxy configuration” to add exceptions to the proxy server, then click
View. On the Manual Proxy Configuration dialog under Exceptions, enter the IP
addresses of ONS 15454 nodes that you will access. Separate each address with a
comma. Click OK to close each open dialog.

3.4.3 Remote Access to the ONS 15454

You can remotely access an ONS 15454 node using a LAN modem. The LAN modem must be
connected to the RJ-45 port on a TCC card or to the LAN pins on the ONS 15454 backplane. The
LAN modem must be properly configured for use with the ONS 15454. When the modem is
installed, dial-up access to the ONS 15454 is available using a personal computer modem.

3.4.4 Connecting to the ONS 15454 with TL1 Terminals

Although the ONS 15454 is designed to be used with CTC, you can communicate with the ONS
15454 using TL1 commands or Telnet to port 2361. To connect a TL1 terminal (or a PC running
terminal emulation software) to the ONS 15454, use the DB-9 plug on the front panel of the TCC or
the CRAFT pins on the backplane. For a list of CRAFT pin assignments, see Table 1-3 on page 1-31.
For information about TL1 commands that can be used with the ONS 15454, see Chapter 11, “TL1
Reference.”

3.5 Logging into the ONS 15454

After you set up the physical connections between the PC and ONS 15454 and change your PC
network settings, you can log into the CTC and begin setting up the ONS 15454 node.

Procedure: Log into the ONS 15454
Step 1 From the PC connected to the ONS 15454, start Netscape or Windows Explorer.

Step2  In the Netscape or Internet Explorer Web address (URL) field, type the ONS 15454 1P
address. For initial setup, this is the default address, 192.1.0.2.
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When the PC connects to the ONS 15454, the login window displays (Figure 3-4).
Figure 3-4 Login Screen

@cic (=1 E3
Cisco TRANSPORT CONTROLLER

Mode Name 17220212172
User Name [cizco1s
Password |

Login Clear

34328

Step3  Type a valid user name and password. For initial setup, type the user name “CISCO15”
and click Login (no password is required).

Note CISCOL1S5 is the default user name provided with every ONS 15454. This user
name has Superuser rights and privileges so you can set up other ONS 15454 users. The
CISCOLS5 user is delivered without a password. To assign a password, click the
Provisioning>Security tabs and change the Superuser password. In addition to
CISCOLS5 user, a “cerent454” user is provided for compatibility with previous CTC
releases. For more information about ONS 15454 security, see the “Setting Up ONS
15454 Security” section on page 3-24.

After logging in, the CTC node view (Figure 3-5) appears. From here, you can navigate
to other CTC views to perform the ONS 15454 operations, administration, maintenance,
and provisioning tasks described in the following sections.

Note The term “node” refers to a single ONS 15454. See the glossary for a detailed
definition.
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3.6 CTC Views

The CTC window includes a menu bar and a top and bottom pane. CTC provides three ONS 15454
views:

® Network view—displays information about the ONS 15454 network. You perform ONS 15454
network management tasks in this view.

® Node view—displays information about one ONS 15454 node. You perform node management
tasks in this view.

® Card view—displays information about individual ONS 15454 cards. You perform card
management tasks in this view.

A graphic of the current view appears in the upper right portion of the CTC window. The node view
displays the ONS 15454 shelf. The network view displays a background map with ONS 15454 nodes
represented by colored squares. The card view displays a graphic of the selected card.

A thumbnail of the parent view is displayed in the upper left corner of the CTC window. Parent view
is the level above the current view. For example, network view is the parent of node view, and node
view is the parent of card view. Below the thumbnail, status information for the current view is
shown. In node view, the Node name; IP address; session boot date and time; a summary of critical
(CR), major (MJ), and minor (MN) alarms; the name of the user who is logged in; and the user’s
security level are shown. In network view, the status of the selected node or span is shown.

The middle of the CTC window provides tabs to access CTC functions. Some CTC tabs have
subtabs, which are used to access subfunctions. The tabs that are displayed depend on the view. In
node view, six tabs are displayed: Alarms, History, Circuits, Provisioning, Inventory, and
Maintenance. In network view, only the Alarms, History, and Circuits tabs are displayed. CTC
window elements are shown in Figure 3-5.

Figure 3-5 CTC Window Elements
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3.6.1 Node View

The CTC node view (Figure 3-5) is displayed each time you log into CTC. Node view shows a
real-time depiction of the ONS 15454 shelf. The colors of the cards, shown in Table 3-1, indicate the
status of the physical card and slot.

Table 3-1 Node View Card Colors

Card Color Status

Grey slot is not provisioned; no card is installed

Blue slot is provisioned; no card is installed

White slot is provisioned; a functioning card is installed
Yellow slot is provisioned; a minor alarm condition exists
Orange slot is provisioned; a major alarm condition exists
Red slot is provisioned; a critical alarm exists

Node view provides six tabs to access node information and perform node maintenance and
provisioning tasks. Some tabs have subtabs. Figure 3-5 shows the CTC Node view with the
Provisioning subtabs displayed. Node view tabs and subtabs are shown in Table 3-2.

Table 3-2 Node View Tabs and Subtabs

Tab Description Subtabs
Alarms Lists current alarms for the node none

History Provides a history of node alarms including date, Session, Node

type, and severity of each alarm. The Session subtab
displays alarms and events for the current session.
The Node subtab displays alarms and events since
the software installation.

Circuits Allows you to create, delete, edit, and map circuits none

Provisioning Provision the ONS 15454 node General, Ether Bridge, Network,
Protection, Ring, Security, SNMP, Sonet
DCC, Timing

Inventory Provides inventory information (part number, serial none

number, CLEI codes) for cards installed in the node

Maintenance Allows you to perform maintenance tasks for the Database, Ether Bridge, Protection, Ring,
node Software, XC cards, Timing, Diagnostic

3.6.2 Network View

Network view (Figure 3-6) displays information about the ONS 15454 network. You perform
network provisioning and management tasks in this view. A United States map is displayed and the
ONS 15454 nodes are represented by colored squares. The color of the square indicates the status of
the node. Table 3-3 shows the colors and their corresponding status.

3-12 Cisco ONS 15454 User Documentation



78-11078-02  June 2001 Using the Cisco Transport Controller 3

Figure 3-6 Network View

@cic [_[O]x]

File GoTo Help

PROPERTIES:

B¥171+

Critical :0

Major : 2

Mi 11

inor O < Node color
172 s f
IR indicates its status

ST+
faiarms] History| cireutts |
Date | wode | Type | siot| Port| sev|sT|sal  cond Dascription
05/04/0017:49:24| SV171+ [FAC-12-1) 12 | 1 MJ | R EOC SDCC tarmination failure. B
05/04/0015:45:04| SV171+ |FAC-14-3) 14 | 3 MJ | R EOC SDCC tarmination failure.

FAC-15-3]| 16 MM | R LOS Loss of Signal

Al
Synchronize Alarms | Delete Cleared Alarms | [ AutoDelete Cleared Alarms §
@
Table 3-3 Node Status
Color Alarm Status
Green No alarms
Yellow Minor alarms
Orange Major alarms
Red Critical alarms

Grey with node name | Node is initializing

Grey with IP address | Node is initializing, or a problem exists with IP routing from node to PC

The network view tabs display network alarms and alarm history and allow you to set up and edit
network circuits. In addition, you can click spans (the lines connecting the nodes) and node icons on
the network map to quickly view circuit properties, provision circuits, and perform protection
switches. Table 3-4 shows the actions that you can perform in network view.

Table 3-4 Network View Actions
Action Procedure
Open a node Any of the following:

¢ Double click the node icon
* Right-click the icon, choose Open from the shortcut menu

¢ From the CTC Go To menu, choose Other Node, then choose the node from the Select

Node dialog
Move a node icon Pressing the Control <Ctrl> and left mouse buttons, drag the node icon to a new location.
Reset node icon Right click a node and choose Reset Position from the shortcut menu. The node icon
position moves to the position defined by the longitude and latitude fields on the General subtab.

Display span properties | Click a network span. Properties display in the upper left corner of the window.
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Table 3-4 Network View Actions (continued)
Action Procedure
Perform a UPSR Right click a network span and click Circuits. See the “Switch UPSR Traffic” section on
protection switch for an | page 4-24 for UPSR protection switch procedures.
entire span
Provision a circuit Right click a node and choose Provision Circuit from the shortcut menu. For circuit
procedures, see the “Create a Circuit” section on page 4-41.
Update circuits with Right click a node and choose Update Circuits With New Node from the shortcut menu.
new node Use this command when you add a new node and want to pass circuits through the new

node.

3.6.3 Card View

Card view displays information about individual ONS 15454 cards. (Figure 3-7 shows an OC3 IR 4
1310 in card view.) You perform card-specific maintenance and provisioning tasks in card view. The
information that is displayed and the tasks you can perform depend on the card. CTC displays a card
view for all ONS 15454 cards except the TCC, XC, and XCVT cards.

Card view provides access to six tabs: Alarms, History, Circuits, Provisioning, Maintenance, and
Performance. (The Performance tab is not displayed for the AIC card.) However, the subtabs, fields,
and information displayed under each tab depend on the card type selected.

Figure 3-7 Card View
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3.7 CTC Navigation

You can use different methods to navigate to views within the CTC window. You can select views
from the Go To menu. You can also double click or right click objects in the window. Moving the

mouse over nodes, cards, and card ports displays popup information about the node, card, or port.
Figure 3-8 shows an example.
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Figure 3-8 CTC Popup Information
@cic [ [O]x]
File GoTo Help
e e e e T e ey e v e e
il I
Part:1 In ServiceiAct] i
— 0 o | Lont nSemicepotie Moving the mouse over
IP Addr @ 172.20.212.172 O O J J CTC window elements
Booted : 2/4/00 11:50 AN oy B bl displays ONS 15454
CR= 0 MJ= 0 MN= O . .
Usger : cerentdsd status information
Authority: Superuser i 2 % 4 5 § 7 8 9 10 11 1z 13 14 15 46 17
A History | circuits | Provisioning | Inventory | Maintenance |
Date Type Slot | Part| Sev |ST SA Cond Description

Synechronize Alatms | Delete Cleared Alarms | AutoDelete Cleared Alarms

34333

Different methods for navigating within the CTC window are shown in Table 3-5.

Table 3-5 CTC Window Navigation
Technique Description
Go To menu
¢ Network View Displays the network view
¢ Parent View Displays the parent of the currently selected view; in card view, node view will be

displayed. In node view, the network view will display.

* Selected object Displays the currently selected object; if you select a card on the node view shelf, the card
view for the selected card will display. If you select a node on the network view map, the
node view for the node will display.

e Other Node Displays a dialog where you can select any node within the current network.
Double Click

¢ Network Thumbnail | Displays the network view

¢ Node Thumbnail Displays the node view

¢ Node on the Displays the node in node view
network view map

¢ Card in node view Displays the card in card view

Right Click

* Node in network Displays a menu from which you can: 1) open the node, 2) provision the circuits, 3) update
view circuits with a new node, and 4) reset the node icon position to the longitude and latitude

provisioned for the node on the Provisioning>General tabs.

¢ Span in network Displays a menu from which you can 1) view information about the source and destination
view slots, ports, the span’s protection scheme and optical or electrical level, and 2) display a
Circuits on Span dialog. This dialog displays additional span information and allows you to
perform UPSR protection switching.
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Table 3-5 CTC Window Navigation (continued)
Technique Description
e Card in card view Displays a menu from which you can: 1) open the card, 2) delete the card, and 3) reset the
card.

Move Mouse Cursor

¢ Over node in Displays a summary of node alarms and provides a warning if the node icon has been
network view moved out of the map range
¢ Over span in Displays circuit (node, slot, port) and protection information

network view

¢ Over card in node Displays card type and card status
view

¢ Over card port in Displays port number and port status
node view

3.8 Viewing CTC Table Data

Much of the ONS 15454 data that CTC displays, such as alarms, alarm history, circuits, and node
inventory, is displayed in tables. You can change the way the CTC tables are displayed. For example,
you can:

® Rearrange or hide table columns.

® Sort tables by primary and secondary keys in descending or ascending order. (Sorting and hiding
is available for all read-only tables except Inventory.)

® Export CTC table data to spreadsheets and database management programs to perform additional
data manipulation. For exporting procedures, see the “Printing and Exporting CTC Data” section
on page 3-34.

To change CTC table display, left-click or right-click a table column header. Right clicking a column
header displays a shortcut menu, shown in Figure 3-9, with table column display options.
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Figure 3-9 Table Column Shortcut Menu
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Table 3-6 lists the options that you can use to customize information display in CTC tables.

Table 3-6

Table Display Options

Task

Rearrange column order
Reset column order
Hide column

Resize column

Display a hidden column

Display all hidden
columns

Sort table (primary)

Sort table (secondary
sorting keys)

Reset sorting

View table row count

Click

Drag column header right or left
N/A

N/A

Position cursor over the column border
and drag right or left

N/A
N/A

Click a column header; each click changes
sort order (ascending or descending)

Pressing Shift, click column header

N/A
N/A

Cisco ONS 15454 User Documentation

Right Click Shortcut Menu

N/A

Select Reset Columns Order/Visibility
Select Hide Column

N/A

Select Show Column>[column name]

Select Reset Columns Order/Visibility
Select Sort Column

Select Sort Column (incremental)
Select Reset Sorting

Table row count is the last item on the
shortcut menu
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3.9 Viewing ONS 15454 Alarms

3-18

Select the Alarms tab (Figure 3-10) to display current and cleared alarms generated on the node.
Table 3-7 shows the information that is displayed for each ONS 15454 alarm.

Table 3-7 Alarm Data
Column Description
Num Unique, per-node alarm identifier (this column is hidden by default)
Ref If an alarm references another alarm, the number of the referenced alarm (this column is hidden by
default)
Date Date and time of the alarm
Node Node where the alarm occurred, based on the active TCC (displays in network view only)
Type Type of alarm, based on circuit type
Slot Slot where the alarm occurred
Port Port where the alarm occurred
Sev Severity level: CR (critical), MJ (major), MN (minor), NA (not alarmed), NR (not reported)
ST Status: R (raised), C (clear)
SA When checked, indicates the alarm is service affecting
Cond The error message code. See Chapter 9, “CTC Alarms” for troubleshooting procedures
Description | Description of the alarm
Figure 3-10 Alarms Tab
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Alarms are displayed in one of five background colors, listed in Table 3-8, to quickly communicate
the alarm severity. For information about troubleshooting alarms, see Chapter 9, “CTC Alarms.”
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Table 3-8 Alarm Colors
Color Description
Red Critical Alarm

Orange Major Alarm

Yellow Minor Alarm
Blue Event Notification (not an alarm)
White Cleared alarm or event

3.9.1 Controlling Alarm Display

You can control the display of alarms on the Alarms tab. Table 3-9 shows the actions you can
perform from the Alarms tab.

Table 3-9 Alarm Display

Button

Synchronize Alarms

Delete Cleared Alarms
Checkbox

AutoDelete Cleared Alarms

3.9.2 Viewing Alarm History

Action

Updates the alarm display; although CTC displays alarms in real time, the
Synchronize Alarms button allows you to verify the alarm display. This is particularly
useful during provisioning or troubleshooting.

Deletes alarms that have been cleared

If checked, automatically deletes cleared alarms

The History tab displays historical alarm data. The History tab also shows the events (that is,
non-reported activities) that occur in addition to the alarms. For example, protection switching
events or performance monitoring threshold crossings appear here. The History tab presents two

alarm history views:

® The Session subtab (Figure 3-11) presents alarms and events for the current CTC session. (Events
are non-reported activities, such as timing changes and threshold crossings.) When you log off,

the alarms disappear.

® The Node subtab (Figure 3-12) shows the alarms and events that occurred at the node since the
CTC software installation. The ONS 15454 can store up to 256 critical alarms, 256 major alarms,
256 minor alarms, and 256 events. When the limit is reached, the ONS 15454 discards the oldest

alarms and events.

Tip Double click an alarm in the alarm table to display the corresponding view. For example,
double-clicking a card alarm takes you to card view. In network view, double-clicking a node alarm

takes you to node view.
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Figure 3-11 History>Session Subtab
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3.9.3 Setting Up General Node Information

The first ONS 15454 provisioning task you will perform is setting up basic node information. If the
node is to be connected to a LAN or other ONS 15454s, the information that you enter for the node,
such as node name and IP address, must be coordinated with your network administrator.

Procedure: Set Up General Node Information
Step1  Log into the ONS 15454 node.

Step 2 From node view, click the Provisioning tab.
Step 3  In the General subtab, type the following:
® Node Name—type a name for the node.

® Contact—type the contact person’s name for the node contact and the phone number
(optional).

® Location—type the node’s location (optional).

® Latitude—type the node’s latitude in the format Nddmmssfff, where d=degrees,
m=minutes, s=seconds, and f=fractional seconds.

® Longitude—type the node’s longitude in the format Wdddmmssfff, where d=degrees,
m=minutes, s=seconds, and f=fractional seconds.

CTC uses the latitude and longitude to place node icons on the network view map. To
convert longitudes and latitudes given in degrees to degrees, minutes, and seconds, see
the “Convert Coordinates to Degrees, Minutes, and Seconds” section on page 3-21.

® Use SNTP Server—when checked, CTC uses a Simple Network Time Protocol
(SNTP) server to set the date and time of the node. Using an SN'TP server ensures that
all ONS 15454 network nodes use the same date and time reference. The server
synchronizes the node’s time during power outages or software upgrades. If you check
Use SNTP Server, type the server’s IP address in the next field. If you do not use an
SNTP server, complete the Date, Time and Time Zone fields. The ONS 15454 will use
these fields for alarm dates and times.

® Date—type the current date.
® Time—type the current time.
® Time Zone—type the time zone.

Step4  Click Apply.

CTC uses the longitude and latitude you enter on the General subtab to place node icons on the
network view map. You can obtain the longitude and latitude for cities and Zip Codes from the US
Census Bureau U.S. Gazetteer website (www.census.gov/cgi-bin/gazetteer). Coordinates are
generally provided in degrees. CTC requires that you enter coordinates in degrees, minutes, and
seconds. Use the following procedure to convert coordinates.

Procedure: Convert Coordinates to Degrees, Minutes, and Seconds

Step 1 Find the location’s longitude and latitude. For example, Petaluma, California is
38.250739 N, 122.615536 W.
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Step2  Use the appropriate directional letter plus the first two digits of latitude and first three
digits of longitude with no conversion. For Petaluma, this is N38 (latitude) and W122
(longitude).

Step3  Using the unconverted longitude and latitude, multiply the number after the decimal by
60 to convert it to minutes. For example, .250739 x 60 is 15.0443, and .615536 x 60 is
36.93216. Use the whole numbers for the minutes (in the example, 15 and 36).

Step4  Multiply the number after the decimal from Step 3 by 60 to convert it to seconds. In the
example, .0443 x 60 is 2.6580, and .93216 x 60 is 55.9296. Use the whole numbers of the
total (in the example, 02 and 55) for the seconds. If the whole number for either minutes
or seconds is less than ten, add a zero to the left of the number, for example 2 is entered
as 02.

Step5  Use zeros for fractional seconds, because the values are not significant for node
positioning on the CTC network view map.

Step 6  Convert the latitude, originally given in degrees, to the format Nddmmssfff, where
d=degrees, m=minutes, s=seconds, and f=fractional seconds. In this example,
38.257039 N = N381502000.

Step7  Convert the longitude, originally given in degrees, to the format Wdddmmssftf. In the
example, 122.615536 = W1223655000. Enter zeros if degrees are less than 100, for
example, 98 degrees is entered 098.

3.9.4 Setting Up ONS 15454 Network Information

Before you connect an ONS 15454 to other ONS 15454s or to a LAN, you must change the default
IP address that is shipped with the ONS 15454 (192.1.0.2). IP addresses are unique identifiers for
nodes or hosts connected to a network using TCP/IP. Each address consists of a network number and
a host number. The network numbers are used for routing, while the host number is used to address
an individual host within the network or subnetwork. A subnet mask is used to extract network and
host information from the IP address.

IP addresses are 32-bit binary numbers. However, to make IP addresses easier to work with, they are
represented as four decimal values, each representing eight bits in the range O to 255 (known as
octets) separated by decimal points. For example, the following IP address is in binary format:

10001100.10110011.11011100.11001000
The same address, represented as four decimal values, is:

140.179.220.200
Because the IP addresses that you work with represent binary addresses, changing an address is not
always straightforward. Therefore, before you change the ONS 15454 IP addresses, consult your
LAN administrator or someone knowledgeable in TCP/IP to ensure addresses are suitable to your
network. Additional information about ONS 15454 network management and Ethernet applications
is provided in Chapters 7 and 8.

Use the following procedure to set up networking information for the ONS 15454. If the ONS 15454
or the computer used to access the ONS 15454 is linked to a network router, you should create a
static route, which can be provisioned using the Static Route fields.
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Procedure: Set Up Network Information
Step1  From the CTC node view, click the Provisioning tab.

Step2  Click the Network subtab (Figure 3-13) and complete the following:
® [P Address—type the node IP address.

® Prevent LCD IP Config—if checked, prevents the ONS 15454 IP address from being
changed using the LCD. See the “IP Address Entry Using Front Panel LCD” section
on page 8-10.

®  Default Router—if the ONS 15454 must communicate with a device that has an IP
address that the ONS 15454 is not routed to, it forwards the packets to the default
router. Type the address of the router in this field. If the ONS 15454 is not connected
to a LAN, leave this field blank.

®  Subnet Mask Length—type the subnet mask length (decimal number representing the
subnet mask length in bits), or click the arrows, to adjust the subnet mask length.

® MAC Address (read only)—displays the ONS 15454 address as it is identified on the
Media Access Control layer.

® Static Routes—static routes permit multiple CTC sessions with different destination
IP addresses on the same subnet. For static route provisioning procedures, see the
“Static Route Provisioning” section on page 8-30.

Figure 3-13 Provisioning>Network Subtab
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Step3  Click Apply.
Step4  Click Yes on the confirmation dialog.

The TCCs will reboot, one at a time.
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3.9.5 Setting Up ONS 15454 Security

The ONS 15454 has four security levels that limit the functions users can perform: Retrieve,
Maintenance, Provisioning, and Superuser. A Retrieve user can retrieve and view CTC information
but cannot set or modify parameters. A Maintenance user can access only Maintenance options. A
Provisioning user can access only Provisioning and Maintenance options. A Superuser, usually the
network element administrator, can perform all of the functions of the other security levels as well
as set names, passwords, and security levels for other users. A list of CTC actions that can be
performed at each security level is shown in Table 3-10.

Table 3-10 ONS 15454 Security Levels

CTC Tab Subtab Actions Retrieve Maintenance Provisioning Superuser
Alarms n/a Delete cleared alarms X X X X
History Session Read only
Node Retrieve X X X X
Circuits n/a Create/Delete/Edit/ X X
VLAN
Map X X X X
Provisioning ~ General All X
EtherBridge All X X
Sonet DCC  All X
Timing All X X
SNMP Create/Delete/Edit X
Browse traps X X X X
Security Create/Delete X
Change password same user same user same user X
Ring All (BLSR) X X
Protection Create/Delete/Edit X X
Browse groups X X X X
Network Modify mask/IP/Route X
Inventory n/a Delete X X
Reset X X X
Maintenance  Database Backup/Restore X
EtherBridge Read only
Protection Operation on X X X
protection groups
Ring BLSR maintenance X X X
Software Upgrade/Activate/ X
Revert
XC Cards Protection switches X X X
Diagnostic ~ Retrieve X
Timing Read-only
Audit Retrieve X X X X
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Note In order for users to access multiple nodes, the same user name and password must exist on
each node.

Security levels also limit the amount of time a user can leave the system idle before the CTC window
is locked to prevent unauthorized users from making changes. Higher security levels have shorter
idle times. Table 3-11 shows CTC security levels and their idle times.

Table 3-11 ONS 15454 Security Idle Times
Security Level Idle Time

Retrieve Unlimited

Maintenance 60 minutes

Provisioning 30 minutes

Superuser 15 minutes

Procedure: Create New Users
Step 1 From the CTC window, click the Provisioning tab.

Step2  Click the Security subtab.

Step 3  On the Security pane, click Create.

Step4  In the Create User dialog (Figure 3-14), enter the following:
® Name— type the user name.

® Password—type the user password. The password must contain at least six characters

and can be any letter or number (a-z, A-Z, 0-9).
Confirm Password—type the password again to confirm it.

Security Level—select the user’s security level.

Figure 3-14 Create User Dialog

@ Create User

Marne: |msmith

Password: |******

Confirm Password: |**ﬂn

Security Level: [FEe

Ok Cancel

34324

Step5  Click OK.

Note CTC users must be added to each node where they need access. Users are not automatically
added to other network nodes.
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Procedure: Edit User Security
Step 1 From the CTC window, click the Provisioning tab.

Step2  Click the Security subtab.
Step3  On the Security pane, click the user you want to edit.

Step4  On the right portion of the Security pane, enter new security information for the user:
name, password, password confirmation, and/or security level. (A Superuser does not
need to enter an old password. Other users must enter their old password when changing
their own password.)

Step5  Click Apply.

Note Changing user permissions and access levels does not take effect while the user is logged into
CTC. The changes take effect the next time the user logs into CTC. If the user has access to more
than one node, you must change the user settings at each node.

3.9.6 Creating Protection Groups

The ONS 15454 provides several card protection methods. When you set up protection for ONS
15454 cards, you must choose between maximum protection and maximum card slot availability.
The highest protection reduces the number of available card slots; the highest card slot availability
reduces the protection. Table 3-12 shows the protection types that can be set up for ONS 15454

cards.
Table 3-12 Protection Types
Type Cards Description
1:1 Any Pairs one working card with one protect card. Protect cards must be placed in an
electrical odd-numbered slot and the working card must be placed in an even-numbered
slot that follows the protect slot, for example, protect in Slot 1, working in Slot 2
and protect in Slot 3, working in Slot 4.
1:N DS-1 and Assigns one protect card for several working cards. The maximum is 1:5. Protect
DS-3 cards cards (DSIN-14, DS3N-12) must be installed in Slots 3 or 15 and the cards they
protect must be on the same side of the shelf. Protect cards must match the cards
they protect. For example, a DSIN-14 can only protect DS1-14 or DSIN-14
cards. If a failure occurs, traffic reverts back when the working card comes back
online after the time indicated in the reversion has elapsed.
1+1 Any optical | Pairs an optical port with a protect optical port. Protect ports must match the
working ports. For example, Port 1 of an OC-3 card can only be protected by Port
1 of another OC-3 card.
Unprotected Any Unprotected cards may cause signal loss if a card fails or incurs a signal error.
0:1 However, because no card slots are reserved for protection, unprotected schemes

maximize the service xxx available for use on the ONS 15454. Unprotected is the
default protection type.
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Procedure: Create Protection Groups

Step 1
Step 2
Step 3
Step 4

From the CTC window, click the Provisioning tab.
Click the Protection subtab.
Under Protection Groups, click Create.

In the Create Protection Group dialog (Figure 3-15), enter the following:

® Name—type a name for the protection group, up to 32 alpha-numeric characters.

® Type—choose the protection type: 1:1, 1:N, or 1+1. The protection selected

determines the cards that are available to serve as protect and working cards. For
example, if you choose 1:N protection, only DS-1N and DS-3N cards are displayed.

Protect Card or Port—choose the protect card (if using 1:1 or 1:N) or protect port (if
using 1+1) from the list.

Based on these selections, a list of available working cards or ports is displayed under
Available Cards or Available Ports.

Figure 3-15 Create Protection Group Dialog (1+1)

@Cleale Protection Group
Marne: [0C12-1 Type: [1+1 porty =]
Protect Part: [slot 14 (0C12), port 1 |

Available Paorts Working Ports

v Revertive Reversion time: |5.D jmin.

Ok Cancel

34323

Step 5

Step 6

Step 7

From the Available Cards or Available Ports list, choose the card or port that you want to
be the working card or port (the card(s) or port(s) that will be protected by the card or port
selected in Protect Cards or Protect Ports). Select the top arrow button to move them to
the Working Cards or Working Ports list.

Complete the remaining fields:
® Bidirectional switching—(optical cards only) click if you want both transmit and

receive channels to switch if a failure occurs to one.

® Revertive—if checked, the ONS 15454 reverts back to the working card or port after
failure conditions are corrected.

Reversion time—if Revertive is checked, enter the amount of time following failure
condition correction that the ONS 15454 should switch back to the working card or
port.

Click OK.
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Procedure: Edit Protection Groups
Step 1 From the CTC window, click the Provisioning tab.

Step 2 Click the Protection subtab (Figure 3-16).

Figure 3-16 Provisioning>Protection Subtab
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Step3  Under Protection Groups, choose a protection group.

Step4  Under Selected Group, edit the fields as appropriate. (For field descriptions, see the
“Create Protection Groups” section on page 3-27.)

Step5  Click Apply.

Procedure: Delete Protection Groups
Step 1 Log in to CTC.

Step2  Verify that working traffic is not running on the protect card:
(a) Click the Maintenance>Protection tabs.

(b) Under Protection Groups, choose the group you want to delete.
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(¢) Under Selected Group, verify that the protect card is in standby mode. If it is in
standby mode, continue with Step 3. If it is active, manually switch traffic back to
the working card. Verify that the protect card is in standby mode, then continue with
Step 3. If the protect card is still active, do not continue. Begin troubleshooting
procedures or call technical support.

Step 3 From the CTC window, click the Provisioning>Protection tabs.
Step4  Under Protection Groups, click a protection group.

Step5  Click Delete.

3.9.7 Setting Up ONS 15454 Timing

You must set the SONET timing parameters for each ONS 15454. ONS 15454 timing is set to one
of two modes: external or line. In typical ONS 15454 networks, at least one node is set to external
and the other nodes are set to line. The external node derives its timing from a Building Integrated
Timing Supply (BITS) source wired to the BITS backplane pins. (Figure 1-20 shows a diagram of
the BITS pin location.) The BITS source, in turn, derives its timing from a Primary Reference Source
(PRS) such as a Stratum 1 clock or GPS signal. The line nodes derive timing from Optical Carrier
cards.

For protection, up to three timing references can be identified. These are typically two BITS-level
or line-level sources and an internal reference. The internal reference is the Stratum 3 (ST3) clock
provided on every ONS 15454 TCC card.

Figure 3-17 shows an ONS 15454 network timing setup example. Node 1 is set to external timing.
Two references are set to BITS. These are Stratum 1 timing sources wired to the node’s BITS input
pins on the ONS 15454 backplane. Its third reference is set to internal. The BITS output pins on the
backplane of Node 3 are used to provide timing to outside equipment, such as a Digital Access Line
Access Multiplexer.
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Figure 3-17 ONS 15454 Timing Example
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Synchronization Status Messaging (SSM) is a SONET protocol that communicates information
about the quality of the timing source. SSM messages are carried on the S1 byte of the SONET Line
layer. They enable SONET devices to automatically select the highest quality timing reference and
to avoid timing loops.

SSM messages are either Generation 1 or Generation 2. Generation 1 is the first and most widely
deployed SSM message set. Generation 2 is a newer version. If you enable SSM for the ONS 15454,
consult your timing reference documentation to determine which message set to use. Table 3-13 and
Table 3-14 show the Generation 1 and Generation 2 message sets.

Table 3-13 SSM Generation 1 Message Set

Message | Quality | Description

PRS 1 Primary reference source - Stratum 1
STU 2 Sync traceability unknown

ST2 3 Stratum 2

ST3 4 Stratum 3

SMC 5 SONET minimum clock

ST4 6 Stratum 4

DUS 7 Do not use for timing synchronization
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Table 3-13

Message
RES

Table 3-14

Message
PRS
STU
ST2
TNC
ST3E
ST3
SMC
ST4
DUS
RES

SSM Generation 1 Message Set (continued)

Quality | Description

Reserved; quality level set by user

SSM Generation 2 Message Set

Quality | Description

1 Primary reference source - Stratum 1
2 Sync traceability unknown

3 Stratum 2

4 Transit node clock

5 Stratum 3E

6 Stratum 3

7 SONET minimum clock

8 Stratum 4

9 Do not use for timing synchronization

Reserved; quality level set by user

Procedure: Setup ONS 15454 Timing

Step 1
Step 2

Log into the node and click the Provisioning tab.
Click the Timing subtab (Figure 3-18) and complete the following:

® Timing Mode—set to External if timing is derived from an external BITS source wired
to the backplane pins; set to Line if timing is derived from an Optical Carrier card.

® SSM Message Set—choose the message set level supported by your network. If a
Generation 1 node receives a Generation 2 message, the message will be mapped
down to the next available Generation 1. For example, a ST3E message becomes a
ST3.

®  Quality of RES—if your timing source supports the reserve S1 byte, you set the timing
quality here. (Most timing sources do not use RES.) Qualities are displayed in
descending quality order as ranges. For example, ST3<RES<ST2 means the timing
reference is higher than a Stratum 3 and lower than a Stratum 2. See Table 3-13 and
Table 3-14 for more information.

® Revertive—if checked, the ONS 15454 reverts back to a primary reference source after
the conditions that caused it to switch to a secondary timing reference are corrected.

® Revertive Time—If Revertive is checked, indicate the amount of time the ONS 15454
will wait before reverting back to its primary timing source.

The BITS Facilities section sets the parameters used by your BITS1 and BITS2 timing
references. Many of these settings are determined by the timing source manufacturer.

® State—set the BITS reference to IS (In Service) or OOS (Out of Service). For nodes
set to Line timing, set State to OOS; for nodes using external timing, or nodes using
the external BITS out, set State to IS.

® Coding—set to the coding used by your BITS reference, either B8ZS or AMI.
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®  Framing—set to the framing used by your BITS reference, either ESF (Extended
Super Frame, or SF (D4)(Super Frame). Synchronization Status Messaging is not
available with Super Frame.

® Sync Messaging—check to enable Synchronization Status Messaging.

® AIS Threshold—sets the quality level where a node sends an AIS from the BITS 1 Out
and BITS 2 Out backplane pins. When a node times at or below the AIS Threshold
quality, AIS is sent (used when SSM is disabled or frame is SF).

Reference fields define up to three timing references for the node and up to six BITS Out
references. BITS Out references define the timing references used by equipment that can
be attached to the node’s BITS Out pins on the backplane. If you attach equipment to
BITS Out, you normally attach it to a Line mode node because equipment near the
External timing reference can be directly wired to the reference.

® NE Reference—defines up to three network element (the current node) references (Ref
1,Ref 2, Ref3). The options displayed depend on the node’s timing mode. If the timing
mode is External, the options are BITS1, BITS2, and Internal. If the timing mode is
Line, the node’s working optical cards are displayed. In this case, select optical ports
on cards that are directly or indirectly connected to a BITS timed source, that is, the
node’s trunk cards.

® BITS I Out/BITS 2 Out—define the timing references for equipment wired to the BITS
Out backplane pins. Normally, BITS Out is used with Line nodes, so the options
displayed are the working optical cards.

Figure 3-18 Provisioning>Timing Subtab
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Step3  Click Apply.
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3.10 Viewing ONS 15454 Inventory

The Inventory tab (Figure 3-19) displays information about cards installed in the ONS 15454 node
including part numbers, serial numbers, hardware revisions, and equipment types. The tab provides
a central location to obtain information and to determine applicability of ONS 15454 Product
Change Notices (PCNs) and Field Service Bulletins (FSBs). Using the ONS 15454 export feature,
you can export inventory data from ONS 15454 nodes into spreadsheet and database programs,
where information can be consolidated for network inventory management and reporting.

Figure 3-19 Inventory Tab
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1 DS3XM | DS3HM-6 87-31-00019 |POIC 031191 NOCLEl | 76-99-D0066-0023 | «|

2 DSTM | DSTM-G 87-31-00019 |POIC 028287 NOCLEl | 76-09-D0066-002a

3 D53IN DE3N-12 87-31-00014 [003& | 033663 NOCLEI | 76-99-00080-001a

1 ocT2 OC1 2-IR-1 87-31-00003 [005H | 003020 NOCLEl | 76-09-00011-x02a

5

6

7 TCC oo+ 800-07048-01 |05 FAAD4U18M... NOCLEl  |57-4327-02-A0

8 XOVT HOWT 87-23-00002 |0D3E | 045267 NOGCLEl | 76-89-D0068-004b

g AlC AlC 87-21-00002 |003F 044455 NOCLEl  |NOT APPLICABLE

10 XCVT HOVT 87-23-00002 |0D3E | 045388 NOCLEI | 76-09-00068-004b

11 TCC TCC 800-07048-01 |05 FAADS11GM... |NOCLEl  |67-4327-02-A0

12 oc3 OGR4 87-31-00002 |POSD | 046430 NOCLEI | 76-09-00003-004a

13 0c3 OCHIR-4 57-31-00002 |POSD | 046532 NOCLEl | 76-99-00003-004a

14 oc12 01 2-IR-1 87-31-00003 |005H 013353 NOCLEl | 76-88-00011-x02a

15 DSIN DS1N-14 87-31-00013 |002ZE 009214 NOCLEl | 76-89-00051-0058 — .

16 D51 DS1-14 87-31-00005 |0020 003134 NOCLE|  |76-89-00051-004a | - | 2
T

The Inventory tab displays the following information about the cards installed in the ONS 15454:
® Slot #—the slot where the card is installed.
® Egpt Type—equipment type the slot is provisioned for, for example, OC-12 or DS-1.

® Actual Eqpt Type—the actual card that is installed in the slot, for example, OC12 IR 4 1310 or
DSIN-14.

Note While an ONS 15454 slot is provisioned by the card that is installed in the slot, you can
pre-provision a slot before the card is installed by right-clicking the slot in node view and selecting
a card type.

® HW Part #—card part number; this number is printed on the top of the card
® HW Rev—card revision number

® Serial #—card serial number; this number is unique to each card
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® (CLEI Code—Common Language Equipment Identifier code

® Firmware Rev—revision number of the software used by the ASIC chip installed on the card

3.11 Printing and Exporting CTC Data

You can print CTC windows and you can print CTC data that is displayed in columns, such as alarms
and inventory. You can also export CTC table data in formats that can be used use by other

applications such as spreadsheets, word processors, and database management applications.
Table 3-15 shows CTC data that can be exported.

Table 3-15

View
Node

Network

OC Cards

DS Cards

AIC Card

EC1-12

DS3XM-6

CTC Table Data

Tab
Alarms
History

Provisioning

Maintenance
Inventory
Alarms
History
Circuits
Alarms
Circuits
Provisioning
Maintenance
Performance
Alarms
Circuits
Provisioning
Alarms
Circuits
Maintenance
Alarms
Circuits
Provisioning
Maintenance
Performance
Alarms
Circuits
Provisioning

Maintenance
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Procedure: Print CTC Data

Use the following procedure to print CTC screens and data. Before you start, make sure your PC is
connected to a printer.

Step 1 From the CTC File menu, click Print.

Step2  In the Print dialog (Figure 3-20) choose an option:
® Entire Frame—prints the entire CTC window

® Tabbed View—rprints the lower half of the CTC window

® Table Contents—prints CTC data in table format; this option is only available for CTC

table data (see Table 3-15)

Figure 3-20 CTC Print Dialog
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Step3  Click OK.

Step4  In the Windows Print dialog, choose a printer and click Print.

Procedure: Export CTC Data
Step 1 From the CTC File menu, click Export.

Step2  In the Export dialog (Figure 3-21) choose an option:

® As HTMIL—saves the data as an HTML file. The file can be viewed with a web
browser without running CTC.

® As CSV—saves the CTC table values as text, separated by commas. You can import
CSV data into spreadsheets and database management programs.

® As TSV—saves the CTC table values as text, separated by tabs. You can import TSV
data into spreadsheets and database management programs.
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Figure 3-21 CTC Export Dialog
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Step3  Click OK.

Step4  In the Save dialog, enter a file name in one of the following formats:
® [filename].htm for HTML files.
® [filename].csv for CSV files.
® [filename].tsv for TSV files.

Step5  Navigate to a directory where you want to store the file.

Step6  Click OK.

3.12 Displaying CTC Data in Other Applications

3-36

You can display CTC data exported in HTML with any web browser application, such as Netscape

Navigator or Microsoft Internet Explorer. To display the data, use the web browser’s File/Open

command to open the CTC data file.

You can display CTC data exported as comma separated values (CSV) or tab separated values (TSV)

in text editors, word processors, spreadsheets, and database management applications. Although

procedures depend on the application, you typically can use File/Open to display the CTC data. Text

editors and word processors display the data exactly as it is exported. Spreadsheet and database

management applications display the data in cells. You can then format and manage the data using
the spreadsheet or database management application tools.
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Configuring Networks

This chapter provides procedures for configuring ONS 15454 rings and circuits including
Bidirectional Line Switched Rings (BLSRs), Unidirectional Path Switched Rings (UPSRs), linear
add-drop multiplexers (ADMs), circuits, Data Communication Channel (DCC) tunnels, and
loopbacks.

4.1 Bidirectional Line Switched Rings

The ONS 15454 supports two-fiber BLSRs with up to 16 ONS 15454 nodes. BLSRs allocate half
the available fiber bandwidth for protection. In an OC-48 BLSR, for example, STSs 1-24 are
allocated to working traffic, and STSs 25-48 are allocated for protection. If a break occurs on one
fiber, working traffic switches to the protection bandwidth (STSs 25-48) on the other fiber. Working
traffic travels in one direction on STSs 1-24 on one fiber, and on STSs 1-24 in the opposite direction
on the second fiber. Because the working and protection bandwidths must be equal, you can create
only OC-12 and OC-48 BLSRs. Figure 4-1 shows a two-fiber OC-48 BLSR.
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Figure 4-1 Four-Node, Two-Fiber OC-48 BLSR
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SONET sends BLSR protection information over the K1 and K2 overhead bytes. The K bytes
communicate failure conditions and actions taken between different nodes in the ring. Receiving
nodes monitor the K bytes to determine when to switch the SONET signal to an alternate physical
path. BLSRs are limited to a maximum of 16 nodes due to K byte node addressing requirements.

BLSR rings work well for distributed “mesh” and node-to-node traffic applications, such as
interoffice networks and access networks. A BLSR node can terminate traffic fed from either side
of the ring. Protection is provided by BLSR “standby bandwidth.” Table 4-1 shows the bidirectional
bandwidth capacities of two-fiber BLSRs.

Table 4-1 Two-Fiber BLSR Capacity

OC Rate  Working Bandwidth Protection Bandwidth  Ring Capacity
0C-12 STS1-6 STS 7-12 6 x N" - PT"
0C-48 STS 1-24 STS 25-48 24 xN-PT

* N equals the number of ONS 15454 nodes configured as BLSR nodes.
T PT equals the number of STS-1 circuits passed through an ONS 15454 node (capacity can vary depending on the
traffic pattern).

In BLSRs, bandwidth can be reused around the ring. The ONS 15454 can carry more traffic in
networks with a distributed traffic pattern than a network with traffic flowing through one central
hub. With a distributed traffic pattern, a BLSR can carry more traffic than a UPSR operating at the
same optical rate.

Figure 4-2 shows an example of BLSR bandwidth reuse. The same STS carries three different traffic
sets simultaneously on different spans on the ring: one set from Node 3 to Node 1, one from Node 1
to Node 2, and another from Node 2 to Node 3.
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Figure 4-2
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Figure 4-3 shows a sample BLSR implementation. A regional long-distance network connects to
other carriers at Node 0. Traffic is delivered to the service provider’s major hubs.

® Carrier 1 delivers six DS-3s over two OC-3 spans to Node 0. Carrier 2 provides twelve DS-3s
directly. Node O receives the signals and delivers them around the ring to the appropriate node.

® The ring also brings 14 DS-1s back from each remote site to Node 0. Intermediate nodes serve

these shorter regional connections.

® The ONS 15454 OC-3 module supports a total of four OC-3 ports, so that two additional OC-3

spans can be added at little cost.
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Figure 4-3 Sample BLSR Application
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Figure 4-4 shows the shelf layout for Node 0, which has one free slot. Figure 4-5 shows the shelf
layout for the remaining sites in the ring. In this BLSR configuration, an additional eight DS-3s at
Node IDs 1 and 3 can be activated. An additional four DS-3s can be added at Node ID 4, and ten
DS-3s can be added at Node ID 2. Each site has free slots for future traffic needs.
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Figure 4-4 Sample Shelf Layout for Node 0 in Figure 4-3
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Figure 4-5 Sample Shelf Layout for Nodes 1-4 in Figure 4-3
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4.1.2 Setting Up BLSRs

To set up a BLSR, you perform five basic procedures:

® Install the Optical Carrier cards and attach the fibers
® Create the BLSR DCC terminations

® Enable the BLSR ports

® Set up BLSR timing

® Configure the BLSR ring

The BLSR setup procedures in this section are for a two-fiber, two-node BLSR. However, you can
apply the same setup principles to larger rings.

Procedure: Install the Optical Carrier Cards
Step1  Use the procedures in the “Card Installation and Turn-Up” section on page 1-35 to install
the OC-12 or OC-48 cards.

You can install the OC-12 cards in any slot, but the OC-48 cards can only be installed in
Slots 5, 6, 12, or 13. Figure 4-6 shows a sample OC-48 BLSR. Figure 4-7 shows a sample
card installation for a two-node, OC-48 BLSR.

Figure 4-6 Two Node OC-48 BLSR
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Figure 4-7 Sample Shelf Setup for Two Node BLSR
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Step 2
Step 3

Allow the cards to boot.

Attach the fiber to the cards. When the ACT LED on the card you installed turns green,
use the steps in the following procedure to configure the BLSR.

Procedure: Create the BLSR DCC Terminations

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Log into the first node that will be in the BLSR.
Click the Provisioning>Sonet DCC tabs.
Under SDCC Terminations, click Create.

On the Create SDCC Terminations dialog, press Control and click the two slots/ports that
will serve as the BLSR ring ports at the node. For example, Slot 6 (OC-48)/Port 1 and
Slot 12 (OC-48)/ Port 1.

Note The ONS 15454 uses the SONET Section layer DCC (SDCC) for data
communications. It does not use the Line DCCs; therefore, the Line DCCs are available
to tunnel DCCs from third-party equipment across ONS 15454 networks. For more detail,
see the “Provision a DCC Tunnel” section on page 4-48.

Click OK.
The slots/ports display under SDCC Terminations.
Complete Steps 2 — 5 at each node that will be in the BLSR.

Cisco ONS 15454 User Documentation



4 Configuring Networks

78-11078-02

June 2001

Procedure: Enable the Optical Card Ports
Step 1 Open one of the nodes that will be in the BLSR.

Step2  Double click one of the optical cards that you configured as an SDCC termination.

Step 3  Click the Provisioning>Line tabs.

Step4  Click Status (Figure 4-8) and choose In Service.

Figure 4-8 Line Subtab
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Step5  Repeat Steps 2 — 4 for the other optical card configured as a SDCC termination.

Step 6  Repeat Steps 2 — 5 for each node that will be in the BLSR.

After configuring the SONET DCC, you set the timing for the node. For procedures, see the “Setup

ONS 15454 Timing” section on page 3-31. For general information about ONS 15454 timing,
including Synchronization Status Messaging, see the “Setting Up ONS 15454 Timing” section on

page 3-29. After you configure the BLSR timing you can enable the BLSR ports, which is described
in the following procedure.

Procedure: Configure the BLSR
Step1  Log into one BLSR node.

4-8

Step2  Click the Provisioning>Ring tabs.

Step 3 On the Ring subtab under BLSR, assign a Node ID in the NODE ID field.

The Node ID identifies the node to the BLSR. Nodes in your BLSR must have different

Node IDs. After you select a Node ID, the other BLSR fields are displayed.
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Step4  Set the BLSR properties:
® Ring ID—assign aring ID (a number between 0 and 255). You must use the same Ring
ID for all nodes in the same BLSR.
® Reversion time—set the amount of time after which the working traffic will revert
back to the original working path. The default is 5 minutes.
® FEast Port—assign the east port from the pull-down menu.
®  West Port—assign the west port from the pull-down menu.
The east and west ports must be ports where you created SDCC terminations in the
“Create the BLSR DCC Terminations” section on page 4-7. The fiber of the east port
must plug into the fiber of the west port on an adjacent node, and the fiber of the east port
must plug into the port of a west port. To avoid errors, use a system to assign BLSR ports.
A common practice is to make the east port the furthest slot to the right and the west port
the farthest left. For example, if you use Slots 4 and 14, Slot 14 is the east port and Slot
4 is the west port. Figure 4-9 shows the Ring subtab with the east and west ports selected.
Figure 4-9 Ring Subtab
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Step5  Click Apply.
Step 6  When the BLSR Map Ring Change dialog displays, click Yes.
Step7  On the BLSR Ring Map dialog, click Accept.
The node is added to the BLSR ring map. However, Default K alarms will display until
all nodes in the ring are configured.
Step8  Complete Steps 2 — 7 at each node that you are adding to the BLSR.
Step9  When all nodes are added to the BLSR, switch to network view to verify that span lines

appear between all BLSR nodes and that the Default K alarms are cleared.
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Step 10 Test the BLSR using testing procedures normal for your site. Here are a few steps you can
use:

(a) Log into a node, click the Maintenance>Ring tabs, and choose MANUAL RING
from East Operation. Click Apply. Verify that traffic switches normally.

—
O
-

Choose Clear from East Operation and click Apply.

—~
O
-

Repeat Steps a and b for West Operation.

(d) Pull fibers at one node and verify that traffic switches normally.

4.1.3 Adding and Dropping BLSR Nodes

This section provides procedures for adding and dropping BLSR nodes. To add or drop a node, you
force a protection switch to route traffic away from the span where service will be performed.
Figure 4-10 shows a three-node BLSR before the new node is added.

Note You can only add one node at a time to an ONS 15454 BLSR.

Figure 4-10 Three Node BLSR Example
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Procedure: Add a BLSR Node

Perform these steps on-site and not from a remote location.

Step 1 Install the optical cards in the ONS 15454 that you will add to the BLSR. Make sure fiber
cables are available to connect to the cards. Run test traffic through the node to ensure the
cards are functioning properly.

Step2  Log into the node that will connect to the new node through its east port (Node 1 in the
example shown in Figure 4-10).
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Step 3

g Caution

Step 4

Step 5

Step 6

Step 7

Step 8

Manually switch protection on the east port:

(a) Click the Maintenance>Ring tabs.

(b) From East Operation, choose FORCE RING.
(c) Click Apply.

Performing a manual switch generates a manual equipment request alarm. This is normal.

Traffic is unprotected during a protection switch.

Log into the node that will connect to the new node through its west port (Node 3 in the
example).

Manually switch protection on the west port:

(a) Click the Maintenance>Ring tabs.

(b) From West Operation, choose FORCE RING.
(c) Click Apply.

Log into the new node and complete the BLSR setup procedures in the “Setting Up
BLSRs” section on page 4-6:

® Provision the SONET DCC
® Configure the BLSR timing
® Enable the BLSR ports

® Configure the BLSR

Remove the fiber connections from the two nodes that will connect directly to the new
node.

(a) Remove the east fiber from the node that will connect to the west port of the new
node.

(b) Remove the west fiber from the node that will connect to the east port of the new
node.

Replace the removed fibers with fibers that are connected to the new node. Connect the
west port to the east port and the east port to the west port, as shown in Figure 4-11.
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Figure 4-11 BLSR Example with Added Fourth Node
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Step9  Log out of CTC and then log back in. Wait for the BLSR Ring Map Change dialog to
display. (If the ring map does not display, select the Provisioning>Ring tabs and click
Ring Map.)

Step 10 When the BLSR Map Ring Change dialog displays, click Yes.
Step 11 On the BLSR Ring Map dialog, click Accept.

Step 12 From the Go To menu, select Network View. Click the Circuits tab. Wait until all the
circuits are discovered. The circuits that pass through the new node will be shown as
incomplete.

Step 13 In network view, right click the new node and select Update Circuits with the new node
from the shortcut menu. Verify that the number of updated circuits displayed in the dialog
is correct.

Step 14  Select the Circuits tab and verify that no incomplete circuits are present.

Step 15 Clear the protection switch. Do this for the node that is using its east port to connect to
the new node, and for the node that is using its west port to connect to the new node.

(a) To clear the protection switch from the east port, display the Maintenance>Ring
tabs. From East Operation choose CLEAR. Click Apply.

(b) To clear the protection switch from the west port, click West Operation and choose
CLEAR. Click Apply.
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Procedure: Drop a BLSR Node

g Caution The following procedure minimizes traffic outages during node deletions, but traffic will
be lost when you delete and recreate circuits that passed through the deleted node.

Step 1

Step 2

g Caution

Step 3

Step 4
Step 5

Step 6
Step 7
Step 8

Step 9

In the node that will be removed, delete all the circuits that originate or terminate in that
node. (If a circuit has multiple drops, delete only the drops that terminate on the node you
want to delete.)

a) Click the Circuits tab.

(
(b) Select the circuits that you need to delete, then click Delete.
(c) Click Yes when prompted.
(d)

d) If a multidrop circuit has drops at the node that will be removed, select the circuit,

click Edit, and remove the drops.

Note Do not log into the node that is being removed.

Manually switch traffic away from the ports of neighboring nodes that will be
disconnected when the node is removed:

(a) Open the node that is connected through its east port to the removed node.

(b) Click the Maintenance>Ring tabs and choose FORCE from East Operation. Click
Apply.

(c) Open the node that is connected through its west port to the removed node.

(d) From West Operation choose FORCE. Click Apply.

Traffic is unprotected during the protection switch.

Remove all fiber connections between the node being removed and the two nodes where
it is still connected.

Reconnect the two neighboring nodes.

Wait for the BLSR Map Ring Change dialog to display. If the dialog does not display,
select the Provisioning>Ring tabs and click Ring Map.

When the BLSR Map Ring Change dialog displays, click Yes.
On the BLSR Ring Map dialog, click Accept.

Delete, then recreate each circuit that passed through the deleted node. Do this one circuit
at a time.

Clear the protection switches on the neighboring nodes:
(a) Open the node with the protection switch on its east port.

(b) Click the Maintenance>Ring tabs and choose CLEAR from East Operation. Click
Apply.

(a) Open the node with the protection switch on its west port.
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(b) Click the Maintenance>Ring tabs and choose CLEAR from West Operation. Click
Apply.
Step 10 If a BITS clock is not used at each node, check that the synchronization is set to one of
the eastbound or westbound BL.SR spans on the adjacent nodes. If the removed node was

the BITS timing source, use a new node as the BITS source or select internal
synchronization at one node from which all other nodes will derive their timing.

Step 11 Select the Circuits tab and verify that incomplete circuits are not present.

Step 12 Recreate all circuits deleted in Step 1 that passed through the dropped node.

4.1.4 Moving BLSR Trunk Cards

Caution Call the Technical Assistance Center (1-877-323-7368) before performing this procedure
A to ensure that provisioning and circuit data is preserved.

Caution To arrange the trunk cards, you will drop one node at a time from the current BLSR ring.
A This procedure is service affecting during the time needed to complete the steps below. This applies
to all BLSR nodes where cards will change slots. Review all the steps before you proceed.

Figure 4-12 shows a four node OC-48 BLSR made up of Node 1, Node 2, Node 3, and Node 4. Node
4 is temporarily removed from the active BLSR, while the OC-48 card in Slot 6 moves to Slot 5 and
the OC-48 card in Slot 12 moves to Slot 6.

Figure 4-12 BLSR Trunk Card Switchover Example
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Procedure: Move a BLSR Trunk Card
Use the following steps to move one BLSR trunk card to a different slot. Use this procedure for each
card you want to move. Although the procedure is for OC-48 BLSR trunk cards, you can use the
same procedure for OC-12 cards.

Note The ONS 15454 nodes must have CTC Release 2.0 or later and cannot have active alarms for
the OC-48 or OC-12 cards or the BLSR configuration.

Step1  Switch traffic away from the node where the trunk card will be switched:

(a) Log into the node connected through its east port to the node where the trunk card
will be moved. Click the Maintenance>Ring tabs.

(b) From East Operation, choose FORCE RING.
(c) Click Apply.

When you perform a manual switch, a manual equipment request alarm is generated. This
is normal.

g Caution Traffic is unprotected during a protection switch.

(d) Log into the node that is connected through its west port to the node where the trunk
card will be moved. Click the Maintenance>Ring tabs.

(e) From West Operation, choose FORCE RING.

(f)  Click Apply.
Step2  Log into the node where the trunk card you will move is installed.
Step 3  Click the Circuits tab (Figure 4-13).

Step4  Record the provisioning information of the affected circuits. You will need this
information later to restore the circuits.
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Figure 4-13 Circuits Tab
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Step5  Delete the circuits on the card you are removing:
(a) Highlight the circuit(s). To select multiple circuits, press the Shift or Ctrl key.
(b) Click Delete.
(¢) On the Delete Circuit dialog, click Yes.
Step6  Delete the SONET DCC termination on the card you are removing:
(@) Click the Provisioning>Sonet DCC tabs.

(b) Under SDCC Terminations, click the Sonet DCC you need to delete and click
Delete.

Step 7  Disable the ring on the current node:
(@) Click the Provisioning>Ring tabs.
(b) From Node ID and choose Ring Disabled.
(c) Click Apply.

Step 8  If the OC card is a timing source, select the Provisioning>Timing tabs and set timing to
Internal.

Step9  Place the ports on the card out of service:

(a) Double click the card.

(b) On the Provisioning>Line tabs under Status, choose Out of Service for each port.
Step 10 Physically remove the card.
Step 11  Insert the card into its new slot and wait for the card to boot.

Step 12 To delete the card from its former slot, right click the card in node view and select Delete
from the list of options.
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Step 13  Place the port(s) back in service:

(a)
(b)
(©)
(d)

To open the card, double click or right click the card and select Open.
Click the Provisioning tab.
From Status choose In Service.

Click Apply.

Step 14 Follow the steps described in the “Setting Up BLSRs” section on page 4-6 to reenable the
ring using the same cards (in their new slots) and ports for east and west.

Step 15 Manually reenter the circuits that were deleted.

For more information about circuit provisioning, see the “Creating and Provisioning
Circuits” section on page 4-40.

Step 16 If you use line timing and the card you are moving is a timing reference, reenable the
timing parameters on the card.

4.2 Unidirectional Path Switched Rings

UPSRs provide duplicate fiber paths around the ring. Working traffic flows in one direction and
protection traffic flows in the opposite direction. If a problem occurs in the working traffic path, the
receiving node switches to the path coming from the opposite direction.

Figure 4-14 shows a basic UPSR configuration. If Node ID 0 sends a signal to Node ID 2, the
working signal travels on the working traffic path through Node ID 1. The same signal is also sent
on the protect traffic path through Node ID 3. If a fiber break occurs (Figure 4-15), Node ID 2
switches its active receiver to the protect signal coming through Node ID 3.
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Figure 4-14 Basic UPSR Configuration
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Because each traffic path is transported around the entire ring, UPSRs are best suited for networks
where traffic concentrates at one or two locations and is not widely distributed. UPSR ring capacity
is equal to its bit rate. Services can originate and terminate on the same UPSR, or they can be passed
to an adjacent access or interoffice ring for transport to the service-terminating location.

CTC automates ring configuration. UPSR traffic is defined within the ONS 15454 on a
circuit-by-circuit basis. If a path-protected circuit is not defined within a 1+1 or BLSR line
protection scheme and path protection is available and specified, CTC uses UPSR as the default.

4.2.1 Sample UPSR Application

Figure 4-16 shows a common UPSR application. OC-3 optics provide remote switch connectivity to
a host TR-303 switch. In the example, each remote switch requires eight DS-1s to return to the host
switch. Figure 4-17 and Figure 4-18 show the shelf layout for each site.

Figure 4-16 Sample OC-3 UPSR Application
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8 DS-1s <------ = Fiber 2

Node ID 0 has four DS1-14 cards to provide 56 active DS-1 ports. The other sites only require two
DS1-14 cards to handle the eight DS-1s to and from the remote switch. You can use the other half
of each ONS 15454 shelf to provide support for a second or third ring to other existing or planned
remote sites.

In this sample OC-3 UPSR, Node 0 contains four DS1-14 cards and two OC3 IR 4 1310 cards. Six
free slots also exist in this setup and can be provisioned with cards or left empty. Figure 4-17 shows
the shelf setup for these cards.
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Figure 4-17

Node ID 0 Layout for Sample OC-3 UPSR
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In this sample OC-3 UPSR, Nodes 1 to 3 each contain two DS1-14 cards and two OC3 4 IR 1310
cards. Eight free slots exist. They can be provisioned with other cards or left empty. Figure 4-18
shows the shelf setup for this configuration sample.

Figure 4-18

Node ID 1-3 Layout for Sample OC-3 UPSR
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4.2.2 Setting Up a UPSR

To set up a UPSR, you perform four basic procedures:
® Install the Optical Carrier cards and attach the fiber
® Create the UPSR DCC terminations

® Configure the timing

® Enable the ports

After you enable the ports, you set up the UPSR circuits. UPSR signal thresholds are set at the circuit
level. For procedures on creating UPSR circuits, see the “Creating and Provisioning Circuits”
section on page 4-40.

Procedure: Install the Optical Carrier Cards

Step1  Use the procedures in Chapter 1 to install the Optical Carrier cards. If you use OC-48
cards, make sure they are installed in Slots 5, 6, 12, or 13.

Step2  When the ACT LED turns green, log into the node. Figure 4-19 shows a sample two-node
OC-48 UPSR, and Figure 4-20 shows a sample shelf setup for the two-node, OC-48
UPSR.

Figure 4-19 Sample Two Node OC-48 UPSR
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Figure 4-20 Sample Two Node OC-48 UPSR Shelf Setup
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Procedure: Configure the UPSR DCC Terminations
Step 1 Log into the first node that will be in the UPSR.

Step2  Click the Provisioning>Sonet DCC tabs.
Step3  Under SDCC Terminations, click Create.

Step4  Onthe Create SDCC Terminations dialog, press Control and click the two slots/ports that
will serve as the UPSR ring ports at the node. For example, Slot 6 (OC-48)/Port 1 and
Slot 12 (OC-48)/Port 1.

Note The ONS 15454 uses the SONET Section layer DCC (SDCC) for data
communications. It does not use the Line DCCs. These can be used to tunnel DCCs from
third party equipment across ONS 15454 networks. For procedures, see the “Provision a
DCC Tunnel” section on page 4-48.

Step5  Click OK.
The slots/ports display under SDCC Terminations.
Step6 Complete Steps 2 — 5 at each node that will be in the UPSR.

After configuring the SONET DCC, set the timing for the node. For procedures, see the “Setup ONS
15454 Timing” section on page 3-31. For general information about ONS 15454 timing, see the
“Setting Up ONS 15454 Timing” section on page 3-29. After configuring the timing, enable the
UPSR ports as described in the following procedure.
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Procedure: Enable the UPSR Ports
Step 1 Open one of the UPSR nodes.

Step2  Double click one of the cards that you configured as an SDCC termination.
Step 3  Click the Provisioning>Line tabs.
Step4  Under Status, select In Service for each port that you want enabled.

Step5  Click Apply.

You configured a UPSR for one node. Use the same procedure to configure the additional nodes. To
create path protected mesh networks, see the “Path Protected Mesh Networks™ section on page 4-38.
To create circuits, see the “Creating and Provisioning Circuits” section on page 4-40.

4.2.3 Adding and Dropping UPSR Nodes

This section provides procedures for adding and dropping nodes in an ONS 15454 UPSR
configuration. To add or drop a node, you manually switch traffic on the affected spans to route
traffic away from the area of the ring where service will be performed. Use the selector maintenance
option to switch traffic from a UPSR span at different protection levels. The selector maintenance
option is useful when you need to temporarily reroute traffic from a UPSR span to add or drop nodes,
perform maintenance, or perform other operations. Figure 4-21 shows a three-node UPSR before a
fourth node is added.

Figure 4-21 Three Node UPSR
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Procedure: Switch UPSR Traffic
Step 1 Go to the CTC network view.

4-24

Step2  Right click the span that will be cut to add the new node and select Circuits from the

shortcut menu (Figure 4-22).

[H[=] E3

Span: 8V171/s14/p1 - 5W172is1 2ip3

Figure 4-22 Span Shortcut Menu
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Synchronize Alarms ‘ Delete Cleared Alarms | AutoDelete Cleared Alarms

Step 3  On the Circuits on Span dialog (Figure 4-23), select the protection from the Switch all

UPSR circuits away menu:

Caution FORCE and LOCKOUT commands override normal protective switching mechanisms.
Applying these commands incorrectly might cause line outages.

CLEAR removes a previously-set switch command.

33572

MANUAL (recommended) switches the span if the new span is error free.

FORCE forces the span to switch, regardless of whether the new span is error free.

LOCKOUT locks out or prevents switching to a highlighted span. (LOCKOUT is only
available when Revertive traffic is enabled.)
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Figure 4-23 Circuits on Span Dialog
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Step 4
Step 5

Step 6

Click Apply.

When the confirmation dialog appears, click OK to confirm the protection switching. The
column under Switch State changes to your chosen level of protection.

Click Close after Switch State changes.

Procedure: Add a UPSR Node

Note You can add only one node at a time. Perform these steps onsite and not from a remote

location.

Step 1

Step 2
Step 3

g Caution

Step 4

Step 5

At the node that will be added to the UPSR:

® Verify that the Optical Carrier cards are installed and fiber is available to connect to
the other nodes.

® Run test traffic through the cards that will connect to the UPSR.

® Provision the new node following the procedures listed in the “Setting Up a UPSR”
section on page 4-21.

Log into one of the nodes that will directly connect to the new node.

Use the procedures in the “Switch UPSR Traffic” section on page 4-24 to switch traffic
away from the span that will connect to the new node.

Traffic is not protected during a protection switch.

Two nodes will connect directly to the new node; remove their fiber connections:

(a) Remove the east fiber connection from the node that will connect to the west port
of the new node (Node 1 in the example shown in Figure 4-21).

(b) Remove the west fiber connection from the node that will connect to the east port
of the new node (Node 3 in the Figure 4-21 example).

Replace the removed fiber connections with connections from the new node. Connect the
west port to the east port and the east port to the west port as shown in Figure 4-24.
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Figure 4-24 UPSR Example With Fourth Node
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Note Perform this step on site at the new node.

Step6  Log out of CTC and then log back in.

Step7  Go to the network view. The new node should appear in the network map. Wait for a few
minutes to allow all the nodes to appear.

Step 8  Click the Circuits tab and wait for all the circuits to appear, including spans. The affected
circuit will display as “incomplete.” One span will be missing until you update the circuit
with the new node (Step 9). All other spans should be present.

Step 9  In the network view, right-click the new node and select Update Circuits with new node

from the list of options. Wait for the confirmation dialog to appear. Verify that the number

of updated circuits displayed in the dialog is correct.

Step 10  Select the Circuits tab and verify that no incomplete circuits are displayed. If incomplete

circuits are displayed, run the Update command again.

Step 11
protection switch.

Procedure: Drop a Node

A

Step 1

Use the procedures in the “Switch UPSR Traffic” section on page 4-24 to clear the

Caution The following procedure is designed to minimize traffic outages during node deletions,
but traffic will be lost when you delete and recreate circuits that passed through the deleted node.

Use the procedures in the “Switch UPSR Traffic” section on page 4-24 to switch traffic

away from the node you are dropping. Do this on all spans connected to the node you are

deleted.
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g Caution

Step 2

Step 3

Step 4
Step 5

Step 6

Traffic is not protected during a force protection switch.

In the node that will be removed, delete circuits that originate or terminate in that node.
(If a circuit has multiple drops, delete only the drops that terminate on the node you are
deleting.)

(a) Click the Circuits tab.
(b) Select the circuit(s) to delete. To select multiple circuits, press the Shift or Ctrl key.
(c) Click Delete.

(d) Click Yes when prompted.

From the node that will be deleted, remove the east and west span fibers. At this point,
the node should no longer be a part of the ring.

Reconnect the span fibers of the nodes remaining in the ring.

Open the Alarms window of each newly-connected node and verify that the span cards
are free of alarms. Resolve any alarms before proceeding.

One circuit at a time, delete and recreate each circuit that passed through the deleted node.

Note If the removed node was the BITS timing source, select a new node as the BITS source, or
select another node as the master timing node.

Step 7

Verify the network map and circuits:
(a) Switch to network view.
(b) Select the Circuits tab, then select each circuit and click Map.

(c) Verify that all circuits are correct and no incomplete circuits are displayed.

4.3 Subtending Rings

Because the ONS 15454 supports up to ten SONET DCCs, one ONS 15454 can terminate and groom
five UPSR rings or four UPSR rings and one BLSR ring. (If you tunnel DCCs, this number drops by
one ring for each DCC tunnel. See the “DCC Tunneling” section on page 4-47.) Subtending rings
from a single ONS 15454 reduces the number of shelves and cards required, and reduces external
shelf-to- shelf cabling. Figure 4-25 shows an ONS 15454 with multiple subtending rings.

Note You cannot nest rings on the same ONS 15454 nodes. For example, if a UPSR is set up on
Nodes 1 — 4, you cannot run a BLSR on the same nodes.
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Figure 4-25 ONS 15454 With Multiple Subtending Rings
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This section shows how to subtend a UPSR from a BLSR. To subtend multiple rings, repeat the
following procedure for each ring. Figure 4-26 shows a UPSR subtending from a BLSR. In this

example, Node 2 is the only node serving both the BLSR and UPSR. Some Node 2 slots are
dedicated to BLSR and others to UPSR.
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Figure 4-26 Multiple Subtending Rings
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Procedure: Subtend a UPSR from a BLSR

Step 1
Step 2
Step 3

Fill the optical slots with the number of optical cards needed for your application.
From the Node view, click the Provisioning>Sonet DCC tabs.

Click Create.

The Create SDCC Termination dialog is displayed (Figure 4-27).

Figure 4-27 Create SDCC Termination dialog
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Step 4
Step 5
Step 6

Step 7

Step 8
Step 9
Step 10

In the Create SDCC Terminations dialog, click the slot and port that will carry the UPSR.
Click OK.

Repeat Steps 3 — 5 for all optical slots/ports that will carry the UPSR.

The selected slots/ports are displayed under SDCC Terminations.

Put the ports that you will use in service:

(a) Inthe node view, double click the desired optical card.

(b) Select the Provisioning>Line tabs. Under Status, choose In Service.

(c) Click Apply.

Repeat Step 7 for all ports/slots that will carry the UPSR.

Follow Steps 1 — 8 for the other nodes you will use for the UPSR.

Go to the network view to view the subtending ring.

Procedure: Subtend a BLSR from a UPSR

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Fill the optical slots with the number of optical cards needed for your application.

From the Node view, click the Provisioning>Sonet DCC tabs.

Click Create.

The Create SDCC Termination dialog is displayed.

In the Create SDCC Terminations dialog, click the slot and port that will carry the BLSR.
Click OK.

Repeat Steps 3 — 5 for all optical slots/ports that will carry the BLSR.
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The selected slots/ports are displayed under SDCC Terminations.
Step7  Configure the BLSR:
(a) Click the Provisioning>Ring tabs.
(b)  On the Ring subtab under BLSR, assign a Node ID in the NODE ID field.

The Node ID identifies the node to the BLSR. Nodes in your BLSR must have different Node
IDs. After you select a Node ID, the other BLSR fields are displayed.

(c) Setthe BLSR properties:

® Ring ID—assign a ring ID (a number between 0 and 255). You must use the same Ring
ID for all nodes in the same BLSR.

® Reversion time—set the amount of time after which the working traffic reverts back to the
original working path. The default is 5 minutes.

® East Port—assign the east port from the pull-down menu.
®  West Port—assign the west port from the pull-down menu.
(d) Click Apply.
Step 8  Put the ports that you will use in service:

a) In the node view, double click the desired optical card.

(

(b) Select the Provisioning>Line tabs. Under Status, choose In Service.
(c) Click Apply.

(d) When the BLSR Map Ring Change dialog displays, click Yes.

(e) On the BLSR Ring Map dialog, click Accept.

Step9  Repeat Step 8 for all ports/slots that will carry the BLSR.
Step 10 Follow Steps 1 — 9 for the other nodes you will use for the BLSR.

Step 11 Go to the network view to see the subtending ring.

4.4 Creating a Linear ADM Configuration

You can configure ONS 15454s as a line of add-drop multiplexers (ADMs) by configuring one set
of optical cards as the working path and a second set as the protect path. Unlike rings, linear ADMs
require that the optical cards at each node be in 1+1 protection to ensure that a break to the working
line is automatically routed to the protect line.

Figure 4-28 shows three ONS 15454s in a linear ADM configuration. Working traffic flows from
Slot 6 of Node 1 to Slot 6 of Node 2, and from Slot 12 of Node 2 to Slot 12 of Node 3. You create
the protect path by placing Slot 6 in a 1+1 protection with Slot 5 at Nodes 1 and 2, and Slot 12 in
1+1 protection with Slot 13 at Nodes 2 and 3.
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Figure 4-28 Linear ADM
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Procedure: Create a Linear ADM

Complete
Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

the following steps for each node that will be included in the linear ADM.

Complete the general setup information for the node. For procedures, see the “Setting Up
General Node Information” section on page 3-21.

Set up the network information for the node. For procedures, see the “Setting Up ONS
15454 Network Information” section on page 3-22.

Setup 1+1 protection for the optical cards in the ADM. In Figure 4-28, Slots 6 and 12 are
the working ports and Slots 5 and 13 are the protect ports. In this example, you would set
up one protection group for Node 1 (Slots 5 and 6), two for Node 2 (Slots 5 and 6, and 12
and 13) and one for Node 3 (Slots 12 and 13). For procedures on creating protection
groups, see the “Creating Protection Groups” section on page 3-26.

For optical ports connecting ONS 15454s, set the SONET Data Communications
Channel terminations:

(a) Log into a linear ADM node and select the Provisioning>Sonet DCC tabs.
(b) Under SDCC Terminations, click Create.
(c) On the Create SDCC Terminations dialog, select the working port. Click OK.

Note Terminating nodes (Nodes 1 and 3 in Figure 4-28) will have one SDCC, and
intermediate nodes (Node 2 in Figure 4-28) will have two SDCCs.

Use the procedures provided in the “Setting Up ONS 15454 Timing” section on
page 3-29 to set up the node timing. If a node is using line timing, set the working optical
card as the timing source.

Place the optical ports in service:

(a) Open an optical card that is connected to the linear ADM.

(b)  On the Provisioning>Line tabs under Status, select In Service.
(c) Click Apply.

Repeat Step 6 for each optical card connected to the linear ADM.
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Procedure: Convert a Linear ADM to UPSR
The following procedures describe how to convert a three-node linear ONS 15454 ADM to a UPSR.

g Caution This procedure affects service.

Step 1 Start CTC and log into one of the nodes that you want to convert from linear to ring.

Step2  Click the Maintenance>Protection tabs (Figure 4-29).

Figure 4-29 Maintenance>Protection Subtab
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Step3  Select the 1+1 protection group (that is, the group supporting the 1+1 span cards). Verify
that the working slot is active. For example, under Selected Group, the working port
should be shown as “Working/Active.” If the slot says “Working/Standby,” manually
switch traffic to the working slot:

34755

(@) In Operations, select Manual_Switch_to_Working. Click Apply.
(b) Click Yes on the confirmation dialog.

(c) Verify that the working slot is carrying traffic. If it is, continue to Step (d). If not,
clear the conditions that prevent the card from carrying working traffic before
proceeding.

(d) In Operations, select Clear. Click Apply.
(e) Click Yes on the confirmation dialog.
Repeat Step 3 for each group listed in Protection Groups.
Step4  Foreach node, delete the 1+1 OC-N protection group that supports the linear ADM span:

(a) Click the Provisioning>Protection tabs.
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(b) In Protection Groups, select the group you want to delete (shown in Figure 4-30).
Click Delete.

(c) Click Yes on the confirmation dialog.

Figure 4-30 Provisioning>Protection Subtab
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Step5  Physically remove one of the protect fibers running between the middle and end nodes.
In the Figure 4-31 example, the fiber running from Slot 13/Node 2 to Slot 13/Node 3 is
removed.

Figure 4-31 Linear to UPSR Conversion
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Step 6  Physically reroute the other protect fiber to connect the two end nodes. In the Figure 4-31
example, the fiber between Node 1/Slot 5 and Node 2/ Slot 5 is rerouted to connect Node
1/Slot 5 to Node 3/Slot 13.

Step 7  Inthe middle node, remove the optic cards that are no longer connected to end nodes and
delete their equipment records. (If you are leaving the optic cards in place, skip this step
and go to Step 9.) In this example, cards in Node 2/Slots 5 and 13 are removed:

a) Double click the first card (Slot 5, in the example).

b) In the Provisioning>Line tabs under Status, select Out of Service.

(
(b)
(¢) From the Go To menu, select Parent View.
(d)

d) Right click the card you just placed out of service (e.g. Slot 5) and select Delete

Card. (You can also go to the Inventory tab, select the card, and click Delete.)
(e) Click Yes on the confirmation dialog.
() Repeat (a) through (e) for the second card (e.g. Slot 13).
(9) Record all information for each cross-connect in the linear configuration.
Step 8  Go to one of the end nodes.
Step 9  Select the Provisioning>Sonet DCC tabs.
Step 10 Under SDCC Terminations, click Create.

Step 11 Highlight the slot that is not already in the SDCC Terminations list (in this example, port
1 of Slot 5 (OC-48).

Step 12 Click OK.
Step 13  Go to the node on the opposite end (Node 3 in Figure 4-31) and repeat Steps 9 — 12.

Step 14 Delete and reenter the circuits one at a time. (See the “Creating and Provisioning Circuits”
section on page 4-40.)

Note Deleting circuits affects traffic.

Step 15  Go to the network map to view the newly-created ring (Figure 4-32).

4-34 Cisco ONS 15454 User Documentation



78-11078-02  June 2001 Configuring Networks

Figure 4-32 Network View with Ring
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Procedure: Convert a Linear ADM to a BLSR
The following procedures describe how to convert a three-node linear ONS 15454 ADM to a BLSR.

g Caution This procedure affects service.

Step1  Start CTC and log into one of the nodes that you want to convert from linear to ring.

Step2  Click the Maintenance>Protection tabs.

Step3  Select the 1+1 protection group (that is, the group supporting the 1+1 span cards). Verify
that the working slot is active. For example, under Selected Group, the working port

should be “Working/Active.” If the slot says “Working/Standby,” manually switch traffic
to the working slot:

(@) In Operations, select Manual_Switch_to_Working. Click Apply.
(b) Click Yes on the confirmation dialog.

(c) Verify that the working slot is carrying traffic. If it is, continue to Step d. If not,

before proceeding clear the conditions that prevent the card from carrying working
traffic.

(d) In Operations, select Clear. Click Apply.
(e) Click Yes on the confirmation dialog.

Repeat Step 3 for each group listed in Protection Groups.
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Step4  For each node, delete the 1+1 OC-N protection group that supports the linear ADM span:
(a) Click the Provisioning>Protection tabs.
(b) In Protection Groups, select the group you want to delete. Click Delete.
(c) Click Yes on the confirmation dialog.

Step5  Physically remove one of the protect fibers running between the middle and end nodes.
In the Figure 4-33 example, the fiber running from Slot 13/Node 2 to Slot 13/Node 3 is
removed.

Figure 4-33 Linear to BLSR Conversion
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Step 6  Physically reroute the other protect fiber so it connects the two end nodes. In the
Figure 4-33 example, the fiber between Node 1/Slot 5 and Node 2/Slot 5 is rerouted to
connect Node 1/Slot 5 to Node 3/Slot 13.

Step 7  Inthe middle node, remove the optic cards that are no longer connected to end nodes and
delete their equipment records. (If you are leaving the optic cards in place, skip this step
and go to Step 9.) In this example, cards in Node 2/Slots 5 and 13 are removed:

a) Double click the first card (Slot 5, in the example).

b) In the Provisioning>Line tabs under Status, select Out of Service.

(
(b)
(¢) From the Go To menu, select Parent View.
(d)

d) Right click the card you just placed out of service (Slot 5 in the example) and select
Delete Card. (Or, you can go to the Inventory tab, select the card, and click

Delete.)
(e) Click Yes on the confirmation dialog.
() Repeat (a) through (e) for the second card (Slot 13 in the example).

(g) Select the Provisioning>Line tabs and record the circuit information for the linear
configuration. To export the circuit information, select Export from the File menu.
(For more information about exporting CTC data, see the “Printing and Exporting
CTC Data” section on page 3-34.)
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Step8  Go to one of the end nodes.
Step 9  Select the Provisioning>Sonet DCC tabs.
Step 10 Under SDCC Terminations, click Create.
Step 11 Highlight the slot that is not already in the SDCC Terminations list (in this example, port
1 of Slot 5 (OC-48) on Node 1.
Step 12 Click OK.
Step 13  Go to the node on the opposite end (Node 3 in Figure 4-33) and repeat Steps 9 — 12.
Step 14  For circuits running on a BLSR protect STS (STSs 7-12 for an OC-12 BLSR, STSs 25-48
for an OC-48 BLSR), delete and recreate the circuit:
(a) Delete the first circuit.
(b) Recreate the circuit on STSs 1- 6 (for an OC-12 BLSR) or 1 — 24 (for an OC-48
BLSR) on the fiber that served as the protect fiber in the linear ADM. Before
creating the circuit, deselect “Route Automatically” and “Fully Protected Path” on
the Circuit Creation dialog box. Follow procedures in the “Creating and
Provisioning Circuits” section on page 4-40 to provision the circuit.
(c) Repeat Steps (a) and (b) for each circuit residing on a BLSR protect STS.
Note Deleting circuits affects traffic.
Step 15 Configure the BLSR:
(@) Click the Provisioning>Ring tabs.
(b)  On the Ring subtab under BLSR, assign a Node ID in the NODE ID field.
The Node ID identifies the node to the BLSR. Nodes in your BLSR must have different Node
IDs. After you select a Node ID, the other BLSR fields are displayed.
(c) Set the BLSR properties:
® Ring ID—assign a ring ID (a number between 0 and 255). You must use the same Ring
ID for all nodes in the same BLSR.
® Reversion time—set the amount of time after which the working traffic reverts back to the
original working path. The default is 5 minutes.
® East Port—assign the east port from the pull-down menu.
®  West Port—assign the west port from the pull-down menu.
(d) Click Apply.
() When the BLSR Map Ring Change dialog displays, click Yes.
(f)  On the BLSR Ring Map dialog, click Accept.
Step 16  Go to the network map to view the newly-created ring.
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4.5 Path Protected Mesh Networks

ONS 15454 networks give you the option to set up path protected mesh networks (PPMN). PPMN
extends the protection scheme of UPSR from the basic ring configuration to the meshed architecture
of several interconnecting rings. Typical UPSR protection creates two separate routes between
source and destination nodes on a single UPSR. PPMN does this for source and destination nodes
that do not lie on the same ring but link together through a network of meshed connections. When
applied to a single ring, PPMN uses the same paths as the Telcordia-specified UPSR.

PPMN connects the source and destination of a circuit over two diverse paths through a network of
single or multiple meshed rings. These two routes form a circuit-level UPSR. The source sends
traffic on each of the diverse routes to the destination node, where the destination node uses the
active route or switches to the standby route.

Note The primary and secondary routes are guaranteed to be link and span diverse, but not node
diverse.

When you check the “Fully protect path” box during the normal A to Z provisioning process, PPMN
provisions automatically in CTC. Choosing this option establishes an alternate route for the circuit
in addition to the normally provisioned route. The second route or the protected path follows a
unique second path through the network between the source and destination and sets up a second set
of cross-connections. You can do this routing manually as well.

Figure 4-34 shows an example of PPMN. In the example, A to Z provisioned Node 3 as the source
node and Node 9 as the destination node. The ONS 15454 CTC determined that the shortest route
between the two end nodes passes through Node 8 and Node 7, shown by the dotted line. A to Z
provisioning then automatically created cross-connections at each of the four nodes, 3, 8, 7, and 9,
to provide the route for working traffic.

When the protected circuit box is checked, PPMN establishes a second unique route between Nodes
3 and 9 and automatically creates cross-connections at each of the five nodes, 3, 2, 1, 11, and 9 as
illustrated by the dashed line. If a signal failure occurs on the primary path, traffic switches to the
second, or protected circuit path. In this example, Node 9 switches from the traffic coming in from
Node 7, to the traffic coming in from Node 11 and service resumes. The switch occurs within

50 milliseconds.
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Figure 4-34 Path Protected Mesh Network Example
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PPMN also allows spans of different SONET line rates to be mixed together in “virtual rings.”
Figure 4-35 shows Nodes 1, 2, 3, and 4 forming a standard OC-48 ring. Nodes 5, 6, 7, and 8 link to
the backbone ring through OC-12 fiber. The “virtual ring” formed by Nodes 5 — 6 — 7 — 8 uses both
OC-48 and OC-12.

Figure 4-35 PPMN Virtual Ring

ONS 15454 ONS 15454 ONS 15454 ONS 15454
Node 5 Node 1 Node 4 Node 8

X
0OC-48 UPSR > 009
X

ONS 15454 ONS 15454 ONS 15454 ONS 15454
Node 6 Node 2 Node 3 Node 7

0C-12

Q@ T

Cisco ONS 15454 User Documentation

4-39



4 Configuring Networks 78-11078-02  June 2001

4.6 Creating and Provisioning Circuits

You can create STS, VT1.5, and Ethernet circuits across and within ONS 15454 nodes and assign.
circuits different attributes. For example, you can:

® Create one-way, two-way, or multicast circuits.
® Assign user-defined names to circuits.

® Assign different circuit sizes. STS circuits can be STS-1, STS-3c, STS-12c or STS-48c. Ethernet
circuits can be STS-1, STS-3¢c, STS-6¢, or STS-12c.

Note Procedures for creating Ethernet circuits are provided in the “ONS 15454 Ethernet Circuit
Configurations” section on page 7-16.

® Route circuits automatically or manually.
® Set an attribute so that CTC routes circuits only on protected paths.
® Set a filter to prevent you from attaching circuits to unprotected cards.

® Define a secondary circuit source or destination that allows you to interoperate an ONS 15454
UPSR with third-party equipment UPSRs.

4.6.1 Cross Connect Card Capacities

The ONS 15454 XC and XCVT cards perform the port-to-port time division multiplexing. XC cards
perform STS switching; XCVT cards perform STS and VT1.5 switching. All TDM traffic consumes
XC and XCVT bandwidth, even traffic that originates and terminates on the same ONS 15454. For
example, each OC-12 card and the 12-port DS3-12 card consume 12 STS ports.

Table 4-2 shows the terminating STS and STS port-connection capacities of the XC and XCVT
cards. Table 4-3 shows the terminating STS and VT1.5 connection capacities.

Table 4-2 XC and XCVT Card Capacity: STSs (Bidirectional)

Card Terminating STSs | Connections between STS ports (1 to 1)
XC 288 144

XCVT 288 144

Table 4-3 XC and XCVT Card Capacity: VT1.5s (Bidirectional)

Card Terminating STSs | Connections between VT1.5 ports

XC 0 0

XCVT 24 (672 VT1.5s) 336

When VT1.5 circuits are routed through ONS 15454 nodes, the number of VTs used within the
XCVT cross-connect matrix depends on the protection scheme of the node. VT use is slightly higher
at the source and drop nodes in 1+1 protection and in UPSRs than in BLSRs. Table 4-4 shows an
example of VT use within an XCVT at the source and drop nodes.
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Table 4-4 VT Use Example

VT ports Used Within
Protection XCVT Matrix per circuit Description

1+1 3 1) I/O card
2) Trunk card (working)

3) Trunk card (protect)
UPSR 3* 1) I/O card
2) Trunk card (working)

3) Trunk card (protect)

BLSR 2 1) I/O card
2) Trunk card (working)

*  Source and drop nodes; two VT ports are used at pass-through nodes

4.6.2 VT Tunnels

You can tunnel VT1.5 circuits through ONS 15454 nodes. VT1.5 tunnels provide two benefits:

® VTL.5 tunnels allow you to route VT1.5 circuits through ONS 15454s with XC cards. (VT1.5
circuits require XCVT cards at the source and drop nodes.)

® When tunneled through nodes with XCVT cards, VT1.5 tunnels do not use VT connection
capacity, thereby freeing the XCVT card’s capacity for other VT1.5 circuits.

When planning VT1.5 circuits, weigh the benefits of using tunnels with the need to maximize STS
capacity. For example, a VT1.5 tunnel between Node 1 and Node 4 passing (transparently) through
Node 2 and Node 3 is advantageous if:

® A full STS is used for Node 1 — Node 4 VT1.5 traffic (that is, the number of VT1.5s between
these nodes is close to 28),

® Node 2 or Node 3 have XC cards, or
® XCVT cards at Node 2 and Node 3 have reached full VT cross-connection capacity.

However, if the Node 1 - Node 4 tunnel carries only a few VT1.5 circuits, creating a regular VT1.5
circuit between Nodes 1, 2, 3, and 4 might maximize STS capacity.

When you create a VT1.5 circuit, CTC checks to see whether a tunnel already exists between source
and drop nodes. If a tunnel exists, CTC checks the tunnel capacity. If capacity is sufficient, CTC
routes the circuit on the existing tunnel. If a tunnel does not exist, or if an existing tunnel does not
have sufficient capacity, CTC displays a dialog asking whether you want to create a tunnel. Before
you create the tunnel, review the existing tunnel availability, keeping in mind future bandwidth
needs. In some cases, manually routing a circuit might make more sense than creating a new tunnel.

Procedure: Create a Circuit

Step1  Loginto CTC and click the Circuits tab.
Step2  Click Create. The Circuit Creation dialog (Figure 4-36) displays.
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Figure 4-36
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In the Circuit Creation dialog, complete the following fields:

Name—assign a name to the circuit. The name can be alphanumeric and up to 32
characters (including spaces).

Type—select the type of circuit you want to create: STS, VT (VTL.5), or VT tunnel.
The circuit type you select determines the circuit-provisioning options that are
displayed.

Size—select the circuit size.

Bidirectional—check this box if you want to create a two-way circuit; uncheck it to
create a one-way circuit.

Number of circuits—type the number of circuits you want to create. If you enter more
than 1, CTC returns to the Circuit Source dialog after you create each circuit until you
finish creating the number of circuits you specified here.

Route Automatically—check this box if you want the CTC to choose the circuit path
automatically. If it is not checked, you must provision the circuit spans and set the
circuit paths manually.

Fully Protected Path—check this box if you want CTC to route circuits only on
protected paths. In other words, if a path cannot be a BLSR, UPSR, linear ADM, or
PPM protected, CTC will not allow it to be used in the circuit if this box is checked.

Protected Drops—If this box is checked, CTC only displays cards residing in 1:1, 1:N,
or 1+1 protection for circuit source and destination selections.

If the circuit is on a UPSR, set the UPSR Selector Defaults:

Revertive—check this box if you want working traffic to revert back to its original
path when the conditions that diverted it to the protect path are repaired. If it is not
checked, working traffic remains on the protect path.

Reversion time—if Revertive is checked, set the reversion time. This is the amount of
time after which the traffic reverts back to the original working path when conditions
causing the switch are cleared (the default is 5 minutes).

SF threshold—set the UPSR Path-level signal failure BER thresholds.
SD threshold—set the UPSR Path-level signal degrade BER thresholds.

Switch on PDI-P—check this box if you want traffic to switch when an STS payload
defect indicator is received.

Click Next.
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Step 6

Step 7
Step 8

Step 9

Figure 4-37

Circuit Path Selection

In the Circuit Source dialog, set the circuit source.

Options include node, slot, port, STS, and VI/DS-1. The options displayed depend on the
circuit type and circuit properties you selected and the cards installed in the node. For
example, if the node does not have an XCVT card, VT circuits are not available for
selection. For Ethergroups, see the “ONS 15454 Ethernet Circuit Configurations” section
on page 7-16.

Click Use Secondary Source if you need to create a UPSR bridge/selector circuit entry
point in a multivendor UPSR ring.

Click Next.

In the Circuit Destination dialog, enter the appropriate information for the circuit
destination. Click Use Secondary Destination if you need to create a UPSR
bridge/selector circuit destination point in a multivendor UPSR ring.

Click Next. If you checked Route Automatically in Step 3, go to Step 10. If you did not
check Route Automatically in Step 3, the Circuit Creation dialog is displayed (Figure
4-37). Follow Steps a — e to manually route your circuit path.

Circuit Path Selection Dialog
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)
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(a) Click the line of the span that will carry the circuit (the span turns white) and move
the arrow so that it points from the source to the destination. To change the direction
of the arrow, click the selected line again.

(b) Click Source STS or VT and select the source STS or VT.
(c) Click Add Span.
The span turns blue.

(d) Verify that the spans are correctly provisioned. The spans in the Selected Spans were
added.

When provisioning a BLSR circuit, you only need to select one BLSR path from the source
to the drop. If you are provisioning a UPSR, you can only select unprotected spans as paths.
BLSR and 1+1 protected spans are not allowed. When selecting UPSR spans, select two
different paths from source to drop. In Figure 4-37, the arrows would point from Node_1 to
Node_2, Node_2 to Node_3, and from Node_1 to Node_3 (protect span).
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Caution The ONS 15454 allows BLSR traffic to pass through an intermediate node on different

A STSs (for example, incoming traffic on STS-1, outgoing traffic on STS-2). However, if a
pass-through node with incoming and outgoing traffic on different STSs becomes isolated (that is,
multiple failures occur), the traffic supported by these STSs is not protected by the protection switch.
Therefore, use the same STS/VT when passing traffic through a BLSR node.

(e) Click Next.
Step 10 In the Confirm Circuit Creation dialog, verify the circuit information.
Step 11 If the information is correct, click Finish.

If you entered more than 1 in Number of Circuits in the Circuit Attributes dialog, the
Circuit Source dialog is displayed so you can create the remaining circuits. Otherwise,
you are finished provisioning a circuit.

Note Ports must be placed in service before the circuits can carry traffic.

4.6.3 Creating Circuits With Multiple Drops

Unidirectional circuits can have multiple drops for use in broadcast circuit schemes. In broadcast
scenarios, one source transmits traffic to multiple destinations, but traffic is not returned back to the
source.

Note When you create a unidirectional circuit, the card that does not have its backplane Rx input
terminated with a valid input signal generates an LOS alarm. You cannot mask the alarm through
CTC or through an internal hairpin connection. This will be addressed in a future release.

Procedure: Create a Circuit with Multiple Drops

Step 1 Create a unidirectional circuit by using the procedures in the “Create a Circuit” section
on page 4-41. (To create a unidirectional circuit, deselect Bidirectional on the Circuit
Creation dialog.)

Step2  On the Circuits window, select the circuit and click Edit.
Step3  On the Drops tab of the Edit Circuits dialog, select the circuit and click Create.

Step4  On the Define New Drop dialog, complete the appropriate fields to define the new circuit
drop: Node, Slot, Port, STS, VT (if applicable).

Step5  Click OK.
Step 6  If you need to create additional drops, repeat Steps 3 — 5. If not, click Close.

Step 7  Verify the new drops appear under the circuit’s Destination column on the Circuits
window.
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4.6.4 Creating Monitor Circuits

You can set up secondary circuits to monitor traffic on primary circuits. You can create monitor
circuits for bidirectional circuits only. For unidirectional circuits, simply create a drop to the port
where the test equipment is attached. Figure 4-38 shows an example. At Node 1, a VT1.5 is dropped
from Port 1 of an EC1-12 card. To monitor the VT1.5 traffic, test equipment is plugged into Port 2
of the EC1-12 and CTC is used to provision a circuit monitor to Port 2. Circuit monitors are one-way.
The monitor in Figure 4-38 shows VT 1.5 traffic received by the EC1-12. To monitor traffic sent from
Node 1, a circuit monitor needs to be set up at Node 2.

Note Monitor circuits cannot be used with stitched Ethernet circuits.

Figure 4-38 Monitor Circuit Example
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Procedure: Set Up a Monitor Circuit
Step1  Loginto CTC.

Step 2 In node view, select the Circuits tab.
Step 3  Select the circuit that you want to monitor. Click Edit.
Step4  On the Edit Circuit dialog, select the Monitors tab (Figure 4-39).

The Monitors tab displays ports that you can use to monitor the circuit selected in Step 3.

Figure 4-39 Monitors Tab
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Step 5 On the Monitors tab, select a port, then click Create Monitor Circuit.

Step 6 On the Circuit Creation dialog, select the destination node, slot, port, and STS for the
monitored circuit. Click Next.
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Step 7 On the Circuit Creation dialog confirmation, review the monitor circuit information.
Click Finish.

Step 8  On the Edit Circuit dialog, click Close. The new monitor circuit displays on the Circuits
tab.

4.6.5 Editing UPSR Circuits

To change UPSR selectors and switch protection paths, use the Edit Circuits dialog (Figure 4-40).
You can view the UPSR circuit’s working and protection paths, edit the reversion time, edit the
Signal Fail/Signal Degrade thresholds, turn PDI-P on or off, and perform maintenance switches on
the circuit selector. You can also display a map of the UPSR circuits to better see circuit flow
between nodes.

Figure 4-40 Edit Circuit Dialog - UPSR Tab
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Procedure: Edit UPSR Circuits
Step 1 Log into the source or drop node of the UPSR circuit.

Step2  Click the Circuits tab.

Step 3  Click the circuit you want to edit, then click Edit.
Step 4 On the Edit Circuit dialog, click the UPSR tab.
Step 5  Edit the UPSR selectors:

® Reversion Time—controls whether or not working traffic reverts back to the working
path when conditions that diverted it to the protect path are repaired. If you select
Never, traffic does not revert. Selecting a time sets the amount of time after which
traffic reverts back to the working path following repair of the working path.

® SF BER Level—sets the UPSR signal failure bit error rate threshold.
® SD BER Level—sets the UPSR signal degrade bit error rate threshold.
® PDI-P—when checked, traffic switches on STS payload defect indication path.

®  Switch State—switches circuit traffic between the working and protect paths. The
color of the Working Path and Protect Path fields indicate the active path. Normally,
the Working Path is green and the Protect Path is purple. If the Protect Path is green,
working traffic has switched to the Protect Path.
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CLEAR—removes a previously-set switch command.

LOCKOUT OF PROTECT—yprevents traffic from switching to the protect circuit
path.

FORCE TO WORKING—forces traffic to switch to the working circuit path,
regardless of whether the path is error free.

FORCE TO PROTECT—forces traffic to switch to the protect circuit path, regardless
of whether the path is error free.

MANUAL TO WORKING—switches traffic to the working circuit path when the
working path is error free.

MANUAL TO PROTECT—switches traffic to the protect circuit path when the protect
path is error free.

Caution FORCE and LOCKOUT commands override normal protective switching mechanisms.
Applying these commands incorrectly might cause circuit outages.

Step 6  Click Apply.
Step7  Click Close.

4.7 DCC Tunneling

SONET provides four data communications channels (DCCs) for network element operations,
administration, maintenance, and provisioning: one on the SONET Section layer and three on the
SONET Line layer. The ONS 15454 uses the Section DCC (SDCC) for ONS 15454 management
and provisioning.

You can use the Line DCCs (LDCCs) and the SDCC (when the SDCC is not used for ONS 15454
DCC terminations) to tunnel third-party SONET equipment SDCCs across ONS 15454 networks.
To create a DCC tunnel, you connect the tunnel end points from one ONS 15454 optical port to
another. DCC traffic is forwarded transparently, byte-for-byte, across the ONS 15454 network. Each
ONS 15454 can support up to 32 DCC tunnel connections. Table 4-5 shows the DCC tunnels that
you can create.

Table 4-5 DCC Tunnels

SONET SONET OC-3 . 0C-12 0OC-48
DCC Layer Bytes (Ports 1 & 3) (all ports) (all ports)
SDCC Section D1-D3 Yes Yes Yes
Tunnel 1 Line D4 - D6 No Yes Yes
Tunnel 2 Line D7-D10 No Yes Yes
Tunnel 3 Line D11-D12  No Yes Yes

*  You cannot use Ports 2 and 4 on OC-3 cards for DCC tunnels.
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4.7.1 Creating DCC Tunnels

A DCC tunnel is a series of connection points that map a third-party equipment SDCC to ONS 15454
LDCCs. DCC tunnel end points are defined by slot, port, and DCC type (SDCC, Tunnel 1, Tunnel
2, or Tunnel 3). You can link an SDCC to an LDCC (Tunnel 1, Tunnel 2, or Tunnel 3), and an LDCC
to an SDCC. You can also link LDCCs to LDCCs and link SDCCs to SDCCs.

Figure 4-41 shows a DCC tunnel example. Third-party equipment is connected to OC-3 cards at
Node 1, Slot 3, Port 1, and Node 3, Slot 3, Port 1. Each ONS 15454 node is connected by OC-48
trunk cards. In the example, three tunnel connections are created, one at Node 1 (OC-3 to OC-48),
one at Node 2 (OC-48 to OC-48), and one at Node 3 (OC-48 to OC-3).

Figure 4-41 DCC Tunnel Example
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Procedure: Provision a DCC Tunnel
Step1  Log into an ONS 15454 that is connected to the non-ONS 15454 network.

Step2  Click the Provisioning>Sonet DCC tabs.
Step3  Beneath the DCC Tunnel Connections area (bottom right of the screen), click Create.

Step4  In the Create DCC Tunnel Connection dialog (Figure 4-42), select the tunnel end points
from the From (A) and To B) lists.

Note You cannot use the SDCC listed under SDCC Terminations (left side of the screen)
for tunnel connections. These are used for ONS 15454 SDCCs.
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Figure 4-42 Create DCC Tunnel Connection Dialog
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Step 6  The ports hosting the a DCC tunnel are not in service:

(a) Double click the card hosting the DCC in the shelf graphic or right click the card
and select Open.

—
O
-

Click the Provisioning>Line tabs.
Under Status, select In Service.

(d) Click Apply.

—~
O
-

DCC Provisioning is now complete for one slot/port. Repeat these steps for all slots/ports that are
part of the DCC tunnel, including any intermediate nodes that will pass traffic through third party
equipment. The procedure is confirmed when the third party network elements successfully
communicate over the newly established DCC tunnel.
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4.8 Loopbacks and Network Tests

4.8.1

4-50

Use loopbacks and hairpins to test newly-created circuits before adding live traffic or to logically
isolate the source of a network failure. All ONS 15454 1/O cards, except Ethernet cards, allow
loopbacks and hairpins.

Network Test Types

Facility loopbacks test the line interface unit (LIU) of a card, the backplane, and cabling. You put a
facility loopback on a card and use a test set to run traffic over the loopback. A successful facility
loopback eliminates the LIU of the card, backplane, and cabling plant as the cause or potential cause
of a network problem. Figure 4-43 shows a facility loopback on a DS-N card.

Figure 4-43 The facility loopback process

DS-N OC-N

XC

Test Set[< N

55261

Terminal loopbacks test a circuit path through the XC card and loop back from the card that the
terminal loopback is testing. Figure 4-44 shows a terminal loopback set on an OC-N card. The test
set traffic comes in on the DS-N card and goes through the XC card to the OC-N card. The terminal
loopback on the OC-N card turns the signal around before it reaches the LIU and sends it through
the XC card to the DS-N card. This test verifies that the XC card and circuit paths are valid, but does
not test the LIU on the OC-N card. To test the LIU on an OC-N card, connect an optical test set to
the OC-N card ports and perform a facility loopback or use a loopback or hairpin on a card that is
farther along the circuit path.

Figure 4-44 The terminal loopback process

DS-N k
st Set[ < T mz

Hairpin circuits bring traffic in and out on a DS-N port instead of sending the traffic onto the OC-N.
A hairpin loops back only the specific STS or VT circuit and does not cause an entire OC-N port to
loopback, which would drop all traffic on the OC-N port. The hairpin allows you to test a circuit on
nodes running live traffic.

{ XC OC-N

55266
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Figure 4-45 The hairpin circuit process

st Set
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4.8.2 Network Test Procedures

Facility loopbacks, terminal loopbacks, and hairpin circuits are often used together to test the circuit
path through the network or to logically isolate a fault. Performing a network test at each point along
the circuit path systematically eliminates possible points of failure. In our example, we test a DS-N
circuit on a two node BLSR. Using a series of facility loopbacks, terminal loopbacks, and hairpins,
we trace the path of the circuit and eliminate possible points of failure.

A logical progression of five network test procedures apply to this scenario: a facility loopback on
the source node DS-N card, a hairpin on the source node DS-N card, a hairpin on the destination
node OC-N card, a terminal loopback to the destination node DS-N card, and a facility loopback to
the destination DS-N card.

Procedure: Perform a Facility Loopback on a Source DS-N Card

The first loopback test is a facility test performed on the first card in the circuit; in this example, the
DS1-14 card in source node. Completing a successful facility loopback on this card eliminates the
cabling, DS-N card, and the backplane as possible failure points.

Figure 4-46 Facility loopback on a source DS-N card
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g Caution Performing a loopback on an in-service circuit is service affecting.
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Note Loopbacks operate only on in-service ports.

Step1  Test the test set with a hard loop.

To perform a hard loop, bridge the test set transmit (Tx) and receive (Rx) terminals with
a cable and send traffic across this loop to ensure that the test set works.
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Use appropriate cabling to attach the electrical test set transmit (Tx) and receive (Rx)

terminals of the test set to the backplane connectors or DSx panel for the port you are
testing. Both transmit (Tx) and receive (Rx) connect to the same port. Setup the test set

In node view, double-click the loopback card where you will perform the loopback.

On the Loopback subtab, select Facility (Line) from the Loopback Type column for the

Step 2
accordingly.
Step 3
Step4  Click the Maintenance > Loopback tabs.
Step 5
port being tested.
Figure 4-47 Performing a facility loopback
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Step6  Click Apply.

Step 7

On the confirmation dialog box, click Yes.

Note Itis normal for an alarm to appear during loopback setup. The alarm clears when you remove

the loopback.

Step 8  If the test set is not already sending traffic, send test set traffic on the loopback circuit.

Step9  Examine the traffic received by the test set. Look for errors or any other signal
information that the test set is capable of indicating.

Step 10 If the test set indicates a good circuit:

(a) Clear the Facility Loopback:

® On the Loopback subtab, select None from the Loopback Type column.

® Click Apply.

(b)  Skip to the second procedure (the ‘“Perform a Hairpin on a Source Node” section on

page 4-54).
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Step 11 A faulty circuit signifies a problem with the DS-N card, the cabling from the DS-N card

to the DSx panel, or the backplane. Test the DS-N cabling, the DS-N card, and then the

backplane.
Step 12 To test the cabling:

(@) Replace the suspect cabling (the cables from the test set to the backplane ports) with
a known good cable.

(b) If aknown good cable is not available, test the suspect cable with a test set. Remove
the suspect cable from the backplane and connect the cable to the transmit (Tx) and
receive (Rx) of the test set. Run traffic to determine whether the cable is good or
suspect.

(c) Resend test set traffic on the loopback circuit with a known good cable installed.

(d) If the circuit is now good, the problem was probably the defective cable. Replace
this cable and skip to the “Perform a Terminal Loopback on a Destination DS-N
Card” section on page 4-59.

Step 13  To test the card:

(a) Replace the suspect card with a known good card.

(b) Resend test set traffic on the loopback circuit with a known good card.

(c) If the circuit is now good, the problem was probably the defective card. Replace the
suspect card and skip to the“Perform a Terminal Loopback on a Destination DS-N
Card” section on page 4-59.

(d) Return the defective card to Cisco through the returned materials authorization
(RMA) process. Call the Cisco Technical Assistance Center (TAC) at
1-877-323-7368 to open an RMA case.

Step 14  If the loopback test fails with a known good cable and a known good card, then the
backplane is suspect.

(a) Repeat the facility loopback test for the DS-N card, but use a different port. This
requires setting up a new facility loopback on CTC for the new port and running
cables from the test set to the new port.

(b) If the loopback test on the new port fails, the entire backplane is suspect.

(c) Iftheloopback test succeeds on the new port, the backplane problem may be limited
to the original port.

(d) No user-serviceable operations exist for the backplane. Call the Cisco Technical
Assistance Center (TAC) at 1-877-323-7368 to open an RMA case for the
backplane. Tell them whether the entire backplane is suspect or only specific ports.

(e) Replace the backplane.

() Resend test set traffic on the loopback circuit with known good cabling, a known
good card, and the replacement backplane.

(9) If the circuit is now good, the problem was probably the defective backplane. Skip
to the “Perform a Hairpin on a Source Node” section on page 4-54.

Step 15 Clear any loopback before testing the next segment of the circuit path.
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Procedure: Perform a Hairpin on a Source Node
The second loopback test is a hairpin circuit performed on the first XC card in the circuit.
Completing a successful loopback through this card eliminates the possibility that the source XC
card is the reason for the faulty circuit.

Figure 4-48 Hairpin on a source node
Source Destination
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Note The ONS 15454 does not support simplex operation on the XC/XCVT card. Two XC/XCVT
cards must be installed for each node.

Test Set

|
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Step 1 Test the test set with a hard loop if you have not already done so.

To perform a hard loop, bridge the test set transmit (Tx) and receive (Rx) terminals with
a cable and send traffic across this loop to make the test set work.

Step2  If youjust completed the prior procedure, Perform a Facility Loopback on a Source DS-N
Card, page 4-51, leave the electrical test set hooked up to the DS-N card.

Step3  If you are starting the current procedure without the electrical test set hooked up to the
DS-N card, use appropriate cabling to attach the electrical test set transmit (Tx) and
receive (Rx) terminals to the backplane connectors or DSx panel for the port you are
testing. Both transmit (Tx) and receive (Rx) connect to the same port. Set up the test set
accordingly.

Step 4  Click the Circuits tab and click the Create button.

Step5  Give the circuit an easily-identifiable name, such as hairpinl.
Step 6  Set the Circuit Type and Size to your normal preferences.
Step 7  Uncheck the Bidirectional check box and click Next.

Step 8  In the Circuit Source dialog box, fill in the same card and port where you performed the
first loopback test. The DS-N card in the source node.

Step9  Click Next.

Step 10 In the Circuit Destination dialog box, use the same card and port used for the source
information.

Step 11 Click Finish.

Step 12 Confirm that the newly-created circuit appears with a direction column noting that this
circuit is 1-way.

Step 13  If the test set is not already sending traffic, send test set traffic on the loopback circuit.
Step 14 Examine the test traffic received by the test set. Look for errors or any other signal

information that the test set is capable of indicating.
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Step 15

Step 16

Step 17

Step 18

If the test set indicates a good circuit, skip to the “Perform a Hairpin on a Destination
Node” section on page 4-56.

If the test traffic is not received or is poor quality, there may be a problem with the XC
card.

Caution XC manual switches (side switches) are service-affecting. Any live traffic on any card in
the node endures a hit of up to 50 ms.

Perform a software reset on the standby XC/XCVT card:

(a) Determine the standby XC card. On both the physical node and the CTC screen, the
ACT/STBY LED of the standby XC card is yellow, and the ACT/STBY LED of the
active XC card is green.

(b) Position the cursor over the standby XC/XCVT card.
(¢) Right-click to choose RESET CARD.
Do a manual switch (sideswitch) of the XC cards and retest the circuit:

(a) Determine the standby XC card. The ACT/STBY LED of the standby XC card is
yellow, and the ACT/STBY LED of the active XC card is green.

Note Place the cursor on top of the card graphic to display a dialog. This display
identifies the card as XC: Active or XC: Standby.

(b) In the node view, select the Maintenance > XC/XCVT Cards tabs.
(¢) From the Cross Connect Cards menu, choose Switch.

(d) Click Yes on the Confirm Switch dialog box.

Note After the active XC/XCVT goes into standby, the original standby slot becomes
active. This causes the ACT/STBY LED to become green on the former standby card.

(e) Resend test set traffic on the loopback circuit.
Now the test set traffic goes through the alternate XC card.

() Examine the test traffic received by the test set. Look for errors or any other signal
information that the test set is capable of indicating.

(9) If the signal received by the test set is still faulty or non-existent, assume the XC
card is not causing the problem. Skip to Step j of this procedure.

(h) If the circuit is now good, the problem could be a defective card. To confirm a
defective original XC card:

® Redo the manual switch (sideswitch) procedure to make the original active XC card again

the active card.

® Resend test set traffic on the loopback circuit.

® If the signal received by the test set is still faulty or non-existent, return the defective card
to Cisco. Call the Technical Assistance Center (TAC) at 1-877-323-7368 to open an RMA

case.
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® If the circuit is now good, the XC card may have had a temporary problem that was
cleared by the sideswitch.

i)  Replace the defective XC card.
j)  Click the Circuits tab.
k) Highlight the newly-created hairpin circuit and click Delete.

I)  Go to the “Perform a Hairpin on a Destination Node” section on page 4-56.

Procedure: Perform a Hairpin on a Destination Node

The third test is a hairpin circuit on the XC card in the destination node. To perform this test, first
create a bidirectional circuit from the source DS-N card to the source OC-N node in the transmit
direction. Creating the bidirectional circuit and completing a successful hairpin eliminates the
possibility that the source and destination OC-N cards, the destination XC card, or the fiber span is
responsible for the faulty circuit.

Figure 4-49 Hairpin on a destination node
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Step 1 Test the test set with a hard loop if you have not done so.

55264

Note To perform a hard loop, bridge the test set transmit (Tx) and receive (Rx) terminals
with an appropriate cable and send traffic across this loop to ensure the test set works.

Step2  If you are starting the current procedure with the electrical test set hooked up to the DS-N
card, leave the test set hooked up.

Step3  If you are starting the current procedure without the electrical test set hooked up to the
DS-N card, use appropriate cabling to attach the electrical test set transmit (Tx) and
receive (Rx) terminals to the backplane connectors or DSx panel for the port you are
testing. Both transmit (Tx) and receive (Rx) connect to the same port. Set up the test set
accordingly.

Step4  To create the first circuit, click the Circuits tab and click the Create button.
Step5  Give the circuit an easily-identifiable name, such as bidirectionall.

Step 6  Select the appropriate circuit type, VT or STS-1.

Step 7  Leave the Bidirectional check box checked and click Next.

Step 8  In the Circuit Source dialog box, fill in the same card and port where you performed the
first loopback test (the DS-N card in the source node).
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Step9  Click Next.

Step 10 In the Circuit Destination dialog box, use the source node OC-N card and port.

Step 11 Click Next and Finish.

Step 12  Confirm that the newly-created circuit appears with a direction column showing a 2-way
circuit.

Step 13 Log into the destination node.

Step 14 For the second circuit, click the Circuits tab and click the Create button.

Step 15  Give the circuit an easily-identifiable name, such as hairpin2.

Step 16  Set Circuit Type and Size to your normal preferences.

Step 17 Uncheck the Bidirectional check box and click Next.

Step 18 In the Circuit Source dialog box, fill in the destination OC-N card and port.

Step 19  Click Next.

Step 20 In the Circuit Destination dialog box, use the same card and port from the Circuit Source
dialog box.

Step 21  Click Finish.

Step 22 Confirm that the second newly-created circuit appears with a direction column noting a
1-way circuit.

Step 23 Double-click the circuit to display the network view.

Step 24  Verify that the circuits connect to the correct slots. For example, source node/Slot 6 (east
slot) to destination node/Slot 12(west slot). If two east or two west slots are connected,
the circuit will not work. Except for the distinct slots, all other circuit information, such
as ports, should be identical.

Step 25 If the test set is not already sending traffic, send test set traffic on the loopback circuit.

Step 26 Examine the test traffic received by the test set. Look for errors or any other signal
information indicated by the test set.

Step 27 If the test set indicates a good circuit, skip to the “Perform a Terminal Loopback on a
Destination DS-N Card” section on page 4-59.

Step 28 If the test traffic is not received or is poor quality, a problem may exist with the destination

Step 29

Step 30

XC card, the source or destination OC-N card, or the fiber span. Test the destination XC
card, then the OC-N cards, and then test the fiber span.

Caution XC manual switches (side switches) are service-affecting. Any live traffic on any card in
the node will endure a hit of up to 50 ms.

Perform a software reset on the standby XC/XCVT card:

(a) Determine the standby XC card. On both the physical node and the CTC screen, the
ACT/STBY LED of the standby XC card is yellow, and the ACT/STBY LED of the
active XC card is green.

(b) Position the cursor over the standby XC/XCVT card.
(¢) Right-click to choose RESET CARD.

Do a manual switch (sideswitch) of the XC cards and retest the circuit:
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(a)
(b)
(©)

In the node view, select the Maintenance > XC/XCVT Cards tabs.
From the Cross Connect Cards menu, choose Switch.

Click Yes on the Confirm Switch dialog box.

Note After the active XC/XCVT goes into standby, the original standby slot becomes
active. This causes the ACT/STBY LED to become green on the former standby card.

(d)

Resend test set traffic on the loopback circuit.
Now the test set traffic routes through the alternate XC card.

Examine the test traffic received by the test set. Look for errors or any other signal
information that the test set is capable of indicating.

If the signal received by the test set is still faulty or non-existent, assume the XC
card is not causing the problem. Skip to Step k of this procedure.

If the circuit is now good, the problem could be a defective card. To confirm a
defective original XC card:

® Redo the manual switch (sideswitch) procedure to make the original active XC card again
the active card.

® Resend test set traffic on the loopback circuit.

® If the signal received by the test set is still faulty or non-existent, return the defective card
to Cisco. Call the Technical Assistance Center (TAC) at 1-877-323-7368 to open an RMA
case.

® If the circuit is now good, the XC card may have had a temporary problem that was
cleared by the sideswitch.

Replace the defective XC card.

Click the Circuits tab.

Resend test set traffic on the loopback circuit.

The test set traffic routes through the alternate XC card rather than the original XC card.

Examine the received test set traffic. Look for errors or any other signal information
that the test set is capable of indicating.

If the signal received by the test set is still faulty or non-existent, assume the
problem does not lie in a faulty XC card and skip to Step 31 of this procedure.

If the circuit is now good, the problem could be a defective card. To confirm a
defective original XC card:

® Repeat the manual switch (side switch) procedure to make the original active XC card
again the active card.

® Resend test set traffic on the loopback circuit.

® If the signal received by the test set is still faulty or non-existent, return the defective card
to Cisco. Call the Technical Assistance Center (TAC) at 1-877-323-7368 to open an RMA
case.

® If the circuit is now good, the XC card may have had a temporary problem that is now
cleared by the sideswitch.
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Step 31

Step 32
Step 33

Step 34

Step 35

Step 36

Step 37
Step 38
Step 39

(n) Replace the defective XC card.

(0) Click Apply and click the Circuits tab.

To eliminate the possibility of faulty OC-N cards:

(a) Replace the suspect source OC-N card with a known good card.

(b) Resend test set traffic on the loopback circuit with a known good card.

(c) If the circuit is now good, the problem was probably the defective card. Return the
defective card to Cisco. Call the Technical Assistance Center (TAC) at
1-877-323-7368 to open an RMA case.

(d) Repeat steps a — b for the suspect destination OC-N card.

(e) Skip to the “Perform a Terminal Loopback on a Destination DS-N Card” section on
page 4-59.

If the test traffic is not received or is poor quality and the OC-N card is a known good
card, then the fiber span is suspect.

If you now have a valid fiber span, resend test set traffic on the loopback circuit.

Examine the test traffic being received by the test set. Look for errors or any other signal
information that the test set is capable of indicating.

If you do not have a valid test signal or a valid fiber span, try to obtain access to another
known good span, hook the source and destination OC-N cards to the known good span,
and resend the test signal.

If you do not have a valid signal with a known good span, valid OC-N cards, and a valid
XC card, repeat the “Perform a Hairpin on a Destination Node” section on page 4-56 to
try and determine the problem or call the Cisco Technical Assistance Center (TAC) at
1-877-323-7368 and explain the situation.

If you have a valid test signal with the known good span, replace or fix the original fiber
span to obtain a valid circuit. Then, go to “Perform a Hairpin on a Destination Node”
section on page 4-56

Highlight the newly-created hairpin circuit.
Click Delete.

Go to the “Perform a Terminal Loopback on a Destination DS-N Card” section on
page 4-59.

Procedure: Perform a Terminal Loopback on a Destination DS-N Card

The fourth test is a terminal loopback performed on the fourth I/O card in the circuit; in this example
the DS-N card in the destination node. First create a bidirectional circuit that starts on the source
node DS-N port and terminates on the destination node DS-N port, then proceed with the terminal
loopback test. Completing a successful terminal loopback to a destination node DS-N card
eliminates the possibility that this card is responsible for the faulty circuit.
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Figure 4-50 Terminal loopback on a destination DS-N card
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Step1  Test the test set with a hard loop if you have not already done so.

To perform a hard loop, bridge the test set transmit (Tx) and receive (Rx) terminals with
an appropriate cable and send traffic across the loop to ensure the test set works.

Step2  If you are starting the current procedure with the electrical test set hooked up to the DS-N
card in the source node, leave the test set hooked up.

Step 3  If you are starting the current procedure without the electrical test set hooked up to the
DS-N card in the source node, use appropriate cabling to attach the electrical test set
transmit (Tx) and receive (Rx) terminals to the backplane connectors or DSx panel for the
port you are testing. Both transmit (Tx) and receive (Rx) connect to the same port. Setup
the test set accordingly.

Step4  Click the Circuits tab and click the Create button.

Step 5 Give the circuit an easily-identifiable name, such as DSNtoDSN.
Step 6  Set Circuit Type and Size to your normal preferences.

Step7  Leave the Bidirectional check box checked and click Next.

Step 8  In the Circuit Source dialog box, fill in the same card and port where you performed the
first loopback test (the DS-N card in the source node).

Step9  Click Next.
Step 10 In the Circuit Destination dialog box, use the DS-N card and port in the destination node.
Step 11 Click Finish.

Step 12  Confirm that the newly created circuit appears on a Circuits screen row with a direction
column that shows a 2-way circuit.

Step 13 In node view, double-click the card that requires the loopback. In this example, the DS-N
card in the destination node.

Step 14 Click the Maintenance > Loopback tabs.
Step 15 On the Loopback subtab, select Terminal (Inward) from the Loopback Type column.
Step 16  Click Apply.

Step 17  On the confirmation dialog box, click Yes.

Note Loopbacks operate only on in-service ports.
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Note It is normal for an alarm to appear during a loopback setup. The alarm clears when you
remove the loopback.

Step 18 If the test set is not already sending traffic, send test set traffic on the loopback circuit.

Step 19 Examine the test traffic being received by the test set. Look for errors or any other signal
information that the test set is capable of indicating.

Step 20 If the test set indicates a good circuit, skip to the “Perform a Facility Loopback on a
Destination DS-N Card” section on page 4-61.

Step 21 If the test traffic is not received or is poor quality, then test the DS-N card.
(a) Replace the suspect card with a known good card.
(b) Resend test set traffic on the loopback circuit with a known good card.

(c) Ifthe circuit is now good, the problem was probably the defective card. Replace the
suspect card and return the defective card to Cisco. Call the Technical Assistance
Center (TAC) at 1-877-323-7368 to open an RMA case.

Procedure: Perform a Facility Loopback on a Destination DS-N Card

The final test is a facility loopback performed on the last card in the circuit; in this case the DS-N
card in the destination node. Completing a successful facility loopback on this card eliminates the
possibility that the destination node cabling, DS-N card, LIU, or backplane is responsible for a faulty
circuit.

Figure 4-51 Facility loopback on a destination DS-N card
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g Caution Performing a loopback on an in-service circuit is allowed but is service affecting.

Note Loopbacks operate only on in-service ports.

Step 1 Test the test set with a hard loop if you have not already done so.

To perform a hard loop on the test set, bridge the test set transmit (Tx) and receive (Rx)
terminals with an appropriate cable and send traffic across this loop to make the test set
works.
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Step2  Use appropriate cabling to attach the electrical test set transmit (Tx) and receive (Rx)
terminals to the backplane connectors or DSx panel for the port you are testing. Both
transmit (Tx) and receive (Rx) connect to the same port. Set up your test set accordingly.

Step3  In node view, double-click the card where you will perform the loopback.

Step4  Click the Maintenance > Loopback tabs.

Note Loopbacks operate only on in-service ports.

Step5  On the Loopback subtab, select Facility (Line) from the Loopback Type column for the
port being tested.

Step6  Click Apply.

Step7  On the confirmation dialog box, click Yes.

Note It is normal for an alarm to appear during loopback. The alarm clears when you remove the
loopback.

Step 8  If the test set is not already sending traffic, send test set traffic on the loopback circuit.

Step9  Examine the test traffic received by the test set. Look for errors or any other signal
information that the test set is capable of indicating.

Step 10 If the test set indicates a clean circuit:
(a) Clear the Facility Loopback:
® On the Loopback subtab, select None from the Loopback Type column.
® Click Apply.

(b) The entire DS-N circuit path has now passed its comprehensive series of loopback
tests. This circuit qualifies to carry live traffic.

Step 11  If the test traffic is not received or is poor quality, there is a problem with the DS-N card,
the cabling from the DS-N card, or the backplane. Test the DS-N cabling first, the DS-N
card next, and the backplane last.

Step 12 To test the cabling:

(a) Replace the suspect cabling (the cables from the test set to the backplane ports) with
a known good cable.

(b) If aknown good cable is not available, you can test the suspect cable with a test set.
Remove the suspect cable from the backplane and connect the cable to the transmit
(Tx) and receive (Rx) of the test set. Run traffic to determine whether this is a good
cable.

(c) Resend test set traffic on the loopback circuit with a known good cable installed.

(d) If the circuit is now good, the problem was probably the defective cable. Replace
this cable.

(e) Skip to Step 14.
Step 13  To test the card:

(a) Replace the suspect card with a known good card.
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Resend test set traffic on the loopback circuit with a known good card.

If the circuit is now good, the problem was probably the defective card. Replace the
defective card.

Return your defective card to Cisco. Call the Technical Assistance Center (TAC) at
1-877-323-7368 to open an RMA case.

Step 14 If the loopback test fails with a known good cable and known good card, then the
backplane is suspect.

(a)

(9)

Repeat the facility loopback test for the DS-N card, but use a different port. This will
require setting up a new facility loopback on CTC for the new port and running
cables from the test set to the new port.

If the loopback test on the new port fails, the entire backplane is suspect.

If the loopback test succeeds on the new port, the backplane problem may be limited
to the original port.

No user-serviceable operations exist for the backplane. Call the Cisco technical
assistance center (TAC) at 1-877-323-7368 to open an RMA case on the backplane.
Make sure to include whether the entire backplane is suspect or only specific ports.

Replace the backplane.

Resend test set traffic on the loopback circuit with known good cabling, a known
good card, and the replacement backplane.

If the circuit is now good, the problem was probably the defective backplane.

Step 15 The entire DS-N circuit path has now passed its comprehensive series of loopback tests.
This circuit qualifies to carry live traffic.

4.9 Managing Multiple ONS 15454 Rings

A small modification to the CMS.INI file enables CTC to manage multiple rings or nodes that are
connected only by Ethernet and not interconnected by fiber or the DCC. Figure 4-52 shows a
multiple ONS 15454 ring. An ONS 15454 with an unmodified CMS.INI file can only manage the
ONS 15454 that the PC dialed directly into and the three node ring attached to that ONS 15454. The
file cannot manage the single node and two-node ring that are not optically connected to the dialed
into ONS 15454. However, you can modify the CMS.INI file to manage the additional single node
and two node ring.
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Figure 4-52 CTC Multiple Ring Management
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Procedure: Enable Multiple Ring Management

4-64

The following procedure shows how to enable CTC for multiple ring management. To enable
multiple ring management, the CTC software must be installed and launched.

A Caution Close all CTC sessions before modifying the CMS.INI file.

Step 1 from the Windows Start menu, select Find>Files or Folder.
Step2 In the Find dialog, type CMS.INI in the Named field. Click Find Now.

Step3  Double-click the located file to bring up Microsoft Notepad or a similar text-editing
program. Example text from an unmodified CMS.INI file is shown below:

#CTC Preferences File

#Tue Aug 8 15:00:27 PDT 2000
CMS_LAUNCHER.CmsJarPath=C\"\\TEMP\CMS51877 jar
CMS.LastHost=192.168.106.143

Step4  Record on paper the IP addresses for the rings and nodes that connect directly to the
Ethernet. Do not record IP addresses that connect to the Ethernet through another node
on the ring.

Note All nodes in a ring can connect directly to the Ethernet; in this case any node IP address in
the ring can be used.
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Step 5

In this example, record IP addresses 192.168.105.119 and 192.168.104.109 because they
connect directly to the Ethernet. Do not record the IP address 192.168.103.199 because it
does not connect directly to the Ethernet. The IP address 192.168.103.199 connects via
the ring to 192.168.104.109, which connects to the Ethernet.

After recording the IP addresses, close any open CTC sessions and edit the CMS.INI file
text by adding an additional line below the next line that contains the date.

The added line reads Topology.Hosts=(first [P address to manage through
Ethernet)\n(second IP address to manage through Ethernet)\n(third IP address to manage
through Ethernet), etc. In the example, the additional line reads:
Topology.Hosts=192.168.106.143\n192.168.105.119\n192.168.104.109. The modified
CMS.INI text is:

#CTC Preferences File

#Tue Aug 8 15:00:27 PDT 2000
Topology.Hosts=192.168.106.143\n192.168.105.119\n192.168.104.109
CMS_LAUNCHER.CmsJarPath=C\\\TEMP\CMS51877.jar
CMS.LastHost=192.168.106.143

Note The IP address used for the node ring directly connected to the PC does not need to be entered
in the added line. This IP address is already present in the bottom line of the CMS.INI file.

Step 6
Step 7

Save and close the modified CMS.INI. file.

Launch CTC and view the separate configurations in one CTC network view.

4.10 Creating Diagnostic Files

When working with ONS 15454 customer support, you might need to record system information to
a file for diagnosis by technical personnel.

Procedure: Create a Diagnostic File

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Select the Maintenance>Diagnostic tabs.
Click Diagnostic.

In the Save dialog, type a file name. Do not add an extension to the file name; the CTC
extension is added automatically.

Choose a directory where you want to save the file.

Click Save. A dialog confirms a successful file transfer. (The dialog can take 20-30
seconds to display.)

E-mail the diagnostic file to the address given to you by customer support.
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CHAPTER 5

Provisioning Cards

This chapter provides procedures to configure ONS 15454 electrical cards, optical cards, and the
Alarm Interface Controller card. The chapter also tells you how to upgrade the XC card to an XCVT
card and convert the DS1-14 and DS3-12 cards from 1:1 to 1:N protection.

5.1 Provisioning Electrical Cards

The DS1-14, DS1N-14, DS3-12, DS3N-12, DS3XM-6, and EC1-12 cards are pre-provisioned with
settings that you can modify to manage transmission quality. To provision electrical card settings,
open the card in CTC and select the Provisioning tab. Use the subtabs to provision the line, line
threshold, line electrical path, and SONET thresholds.

5.1.1 Card Settings

The Line subtab is where you set transmission line settings, including line type, coding, length, and
status. Figure 5-1 shows the Line subtab for the DS1-14 card. Table 5-1 shows the available
electrical card line settings.

Figure 5-1 Line Subtab
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Table 5-1

Heading
#

Line Type

Line Coding

Line Length

Status

PJ Sts Mon #

(EC1-12 only)
Line Buildout
(EC1-12 only)

Rx Equalization
(EC1-12 only)

Line Settings - Electrical

Description

Port number

Defines the line framing type

Defines the DS-1 transmission coding type that is
used

Defines the distance (in feet) from backplane
connection to the next termination point

Places port in or out of service

Sets the STS that will be used for pointer
justification. If set to zero, no STS is used

Defines the distance (in feet) from backplane to
next termination point

For early EC1-12 card versions, equalization can
be turned off if the line length is short or the
environment is extremely cold; Rx Equalization
should normally be set to On

Options

¢ 1-6(DS3XM-6)

e 1-12(DS3-12, DS3N-12, EC1-12)
e 1-14 (DS1-14, DSIN-14)

¢ D4 (default)

» ESF - Extended Super Frame

¢ Unframed

e M13 - DS3XM-6 only

e C BIT - DS3XM-6 only; default

¢ AMI - Alternate Mark Inversion (default)
* B8ZS - Bipolar 8 Zero Substitution
* B3ZS - DS3XM-6 only, default
DS-1:

e 0-131 (default)

e 132-262

e 263-393

e 394 -524

e 525-655

DS-3. DS3XM-6

e (-225 (default)

e 226 -450

Out of Service (default)

In Service

0 (default)

1

¢ 0 - 225 (default)

e 226 -450

On (checked, default)

Off (unchecked)

Table 5-2 shows electrical card threshold settings for all ONS 15454 electrical cards except the
DS3XM-6. Table 5-3 shows the DS3XM-6 card thresholds. The default values are based on
threshold recommendations in GR-820-CORE, Sections 4.0 (DS-1) and 5.0 (DS-3).

June 2001

Table 5-2 Threshold Settings - Electrical
Heading Description Options
# Port number e 1-12(DS3-12, DS3N-12, EC1-12)

e 1-14(DS1-14, DSIN-14)
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Table 5-2

Heading
CvV

ES

SES

SAS

UAS

AIS

Loss

PJ

SEFS

SF BER
Level

SD BER
Level

Threshold Settings - Electrical (continued)

Description

Coding violations

Errored Seconds

Severely Errored Seconds

Severely Errored Frame/Alarm Indication
Signal

Unavailable Seconds

Alarm Indication Signal

Loss of signal

Pointer Justification

Severely errored frame seconds

Sets the signal fail bit error rate

Sets the signal degrade bit error rate

Options

Numeric. Defaults (15 min/1 day):
e 13,340/133,400 (DS-1)

* 387/3,865 (DS-3)

e 1,312/13,120 (EC-1)

Numeric. Defaults (15 min/1 day):
e 65/648 (DS-1)

e 25/250 (DS-3)

e 87/864 (EC-1)

Numeric. Defaults (15 min/1 day):
* 10/100 (DS-1)

e 4/40 (DS-3)

e 1/4 (EC-1)

Numeric. Default (15 min/1 day):

e 2/17 (DS-1)

Numeric. Default (15 min/1 day):

¢ 3/10 (all cards)

Numeric. Default (15 min/1 day):

e 10/10 (DS-1)

Numeric. Default (15 min/1 day):

e 10/10 (DS-3)

Numeric. Defaults (15 min/1 day):
¢ 60/5,760 (EC-1 Near End)

¢ 0/0 (EC-1 Far End)

Numeric. Defaults (15min/1 day):
¢ 500/5,000 (EC-1 Near End)

¢ 0/0 (EC-1 Far End)

EC-1 card only:

¢ 1E-3

¢ 1E-4 (default)

¢ 1E-5

EC-1 card only:

¢ 1E-5

¢ 1E-6

¢ 1E-7 (default)

e 1E-8

* 1E-9
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Table 5-3 Threshold Settings - DS3XM-6 Card

Heading Description Options

# Port number e 1-6

CvV Coding violations Numeric. Defaults (15 min/1 day):

e 387/3,865 (Line)
e 382/3,820 (Electrical Path - DS-3, Near and Far End))
ES Errored Seconds Numeric. Defaults (15 min/1 day):
e 25/250 (Line)
e 25/250 (Electrical Path - DS-3, Near & Far End)
¢ 65/648 (Electrical Path - DS-1 Near End)
¢ 0/0 (Electrical Path - DS-1, Far end)
SES Severely Errored Seconds Numeric. Defaults (15 min/1 day):
e 4/40 (Line)
¢ 4/40 (Electrical Path - DS-3, Near and Far End)
¢ 10/100 (Electrical Path - DS-1 Near End)
¢ 0/0 (Electrical Path - DS-1, Far end)
SAS Severely Errored Frame/Alarm indication | Numeric. Defaults (15 min/1 day):
Signal « 2/8 (Electrical Path - DS-3, Near & Far End)
e 2/17 (Electrical Path - DS-1 Near End)
¢ 0/0 (Electrical Path - DS-1, Far end)
UAS Unavailable Seconds Numeric. Defaults (15 min/1 day):

¢ 10/10 Electrical Path, DS-1, Near End; DS-3; Near &
Far End

¢ (/0 Electrical Path, DS-1 Far End
AIS Alarm Indication Signal Numeric. Defaults (15 min/1 day):

¢ 10/10 Electrical Path, DS-1, Near End; DS-3; Near &
Far End

¢ 0/0 Electrical Path, DS-1 Far End

Loss Loss of signal Numeric. Default (15 min/1 day):
* 10/10 (Line)

5.1.2 Provisioning DS3XM-6 Cards

The DS3XM-6 transmux card can accept up to six DS-3 signals and convert each to 28 VT1.5s.
Conversely, it can take 28 T-1s and multiplex them into a channeled CBIT or M23 framed DS-3.
Unlike the DS3-12 and DS3N-12 cards, the DS3XM-6 allows circuit mapping at the VT level. To
provision a DS3XM-6 card, perform three basic steps:

® Set up the protection groups
® Set up the circuits

® Provision the ports
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Procedure: Set Up DS3XM-6 Protection Groups
Step1  Click the Provisioning>Protection tabs.

Step2  Click Create.

Step 3  Inthe Create Protection Group dialog, type the name for the protection group in the Name
field (optional).

Step4  Click Type and choose 1:1 from the pull-down menu. (1:1 is the only type of protection
available for the DS3XM-6 card.)

Note For 1:1 protection groups, install the protect card in an odd-numbered slot and the
working card in an even-numbered slot that follows the protect slot.

Step5  Click Protect Card and select the protect card from the pull-down menu.
The selected card will appear in the Protect Card field.

Step 6  To select the working card, click the card and click the arrow tab (>>) to move the card
from the Available side to the Working side.

Step7  Click OK.

After you set up the protection groups for the DS3XM-6 card, set up the circuits. For circuit
provisioning procedures, see the “Creating and Provisioning Circuits” section on page 4-40. Setting
up circuits for the DS3XM-6 is identical to other cards.

Procedure: Provision the DS3XM-6 Ports

Step 1 To open the DS3XM-6 card, either double click or right click the card and choose Open
from the list of options.

Step2  Click the Provisioning tab.

Step 3  In the Line subtab, (Figure 5-2) complete the following fields:
® Line Type—set framing (either M23 or C BIT)
® Line coding—always set to B3ZS

® Line Length—set the line length from your equipment to a patch panel. Line length is
the same as line build out (LBO).

® Status—choose In Service from the pull-down menu.
Step4  Click Apply.

Step 5 Select the Line Thrshld, Sonet Thrshld, and Elect Path Thrshld subtabs to set the
card’s performance monitoring thresholds.
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Figure 5-2
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The DS3XM-6 card is now provisioned. Refer to this section whenever you need to install a new

DS3XM-6 card.

5.2 Provisioning Optical Cards

33567

The OC-3, OC-12, and OC-48 cards are pre-provisioned with settings that you can modify to

manage transmission quality. To provision the optical cards, open the card in CTC and select the
Provisioning tab. Each optical card provides three subtabs: Line, Thresholds, and STS. Figure 5-3

shows the Thresholds subtab for an OC12 IR 1310 card.
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Figure 5-3
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The Line subtab provisions line transmission quality settings. Line settings are shown in Table 5-4.

Table 5-4

Heading
#

SF Ber Level

SD Ber Level

Provides Synch

Enable Synch
Messages

Send Do Not
Use

PJ Sts Mon #

Line Settings - Optical

Description

Port number

Sets the signal fail bit error rate

Sets the signal degrade bit error rate

If checked, the card is provisioned as a network element
timing reference on CTC Provisioning>Timing tabs

Enables synchronization status messages (S1 byte), which
allows the node to choose the best clocking source

When checked, sends a DUS (do not use) message on the
S1 byte

Sets the STS that will be used for pointer justification. If set
to 0, no STS is monitored. (Only one STS per card can be
monitored, even on a multiport card such as the OC-3)

Cisco ONS 15454 User Documentation

Options

e 1(0C-12,0C-48)
1-4 (OC-3)
1E-3

1E-4 (default)
1E-5

1E-5

1E-6

1E-7 (default)
1E-8

1E-9

.
.

.

.

Read-only

* Yes (checked)

No (unchecked)

Yes (checked, default)

No (unchecked)

Yes (checked)

No (unchecked; default)

0 (default) - 3 (OC-3, per port)
0 (default) - 12 (OC-12)

0 (default) - 48 (OC-48)
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Table 5-5 shows the ONS 15454 optical threshold settings.

Table 5-5 Threshold Settings - Optical
Heading Description

# Port number

CvV Coding violations (Line)

ES Errored Seconds (Line)

SES Severely Errored Seconds (Line)
PSC Protection Switching Count (Line)
PSD Protection Switch Duration (Line)
UAS Unavailable Seconds (Line)

PJ Pointer Justification (Path)

SEFS Severely errored frame seconds

Options

e 1(0C-12,0C-48)

e 1-4 (0C-3)

Numeric. Defaults (15 min/1 day):

e 1312/13,120 (OC-3 Near and Far End))
¢ 5,315/53,150 (OC-12 Near and Far End)
e 21,260/212,600 (OC-48 Near & Far End)
Numeric. Default (15 min/1 day):

e 87/864 (Near and Far End)

Numeric. Defaults (15 min/1 day)

¢ 1/4 (Near and Far End)

Numeric. Default (15 min/1 day):

¢ 1/5 (Near End)

¢ 0/0 (Far End)

Numeric. Default (15 min/1 day):

¢ 300/600 (Near End)

¢ 0/0 (all optical cards, Far End
Numeric. Default (15 min/1 day):

¢ 3/10 (Near and Far End)

Numeric. Default:

e 60/5,760 (Near End)

¢ 0/0 (Far End)

Numeric. Default:

¢ 500/5,000 (Near End)

¢ 0/0 (Far End)

5.3 Provisioning the OC-3 Card for STM-1

You can provision the OC3 IR 4 1310 card to support either OC-3 or STM-1 signals. When
provisioned for STM-1, all four ports drop and insert STM-1 traffic in unprotected or 1+1 protected
Automatic Protection Switching (APS) mode. Each STM-1 signal is mapped as a 155 Mbps
concatenated signal (STS-3c) for transparent transport over a SONET network. The original STM-1

5-8

traffic may be handed off as an STM-1 or OC-3.

Because SDH and SONET frame format and size are nearly identical, their line speed meets, starting
at 155 Mbps. At the STM-1/0C-3 level, the ONS 15454 performs section and line overhead
conversions and maps the 261x9 byte VC-4 into an STS-3c for transparent transport across the

SONET domain. At the far end, the STS-3c carrying the original VC-4 is then remapped into an

STM-1 for handoff to an SDH network element.
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The ONS 15454 performs section, line overheads and pointer conversions between SDH and
SONET for an STM-1 to OC-3c circuit. However, to ensure operability, the following requirements
must be met:

The embedded payload must be compatible on both sides and require no conversion of any kind.
Examples of such payloads include concatenated ATM or Packet over SONET/SDH signals.

The path overhead (POH) must be compatible on both sides and require no conversion of any
kind. Each overhead byte must be processed identically or simultaneously ignored. Key POH
bytes to consider are the J1 (path indicator) and C2 (payload format).

Most SONET and SDH routers and ATM switches can be configured to meet these requirements.

Procedure: Provision the OC3 IR 4 1310 for STM-1
Step1  Log into the node and double click the OC3 IR 4 1310 card.

Step2  Click the Provisioning>Line tabs.

Step3  Under Line Mode (bottom of window), choose SDH.
Step4  Click Apply.

5.4 Provisioning the Alarm Interface Controller

The Alarm Interface Controller (AIC) card can be provisioned to receive input from, or send output
to, external devices wired to the ONS 15454 backplane. (For a description of the AIC, see the “Alarm
Interface Controller Card” section on page 2-19.) You can provision the AIC to:

Generate CTC alarms based on events detected by external devices such as heating or cooling
equipment failure, fire alarms, smoke detection, and other environmental changes that can
damage ONS 15454 equipment.

Turn external devices on or off based on a CTC alarm. For example, you can provision the AIC
to turn on an audio or visual device, such as a bell or light, when a critical ONS 15454 alarm
occurs.

Figure 5-4 shows the flow to and from external devices provisioned through the AIC.
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Figure 5-4 AIC Alarm Input and Output
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To provision the AIC, open the card in CTC and select the Provisioning tab (Figure 5-5). You
provision external alarms using the External Alarms subtab and provision external controls using the
External Controls subtab.

Figure 5-5 AIC Provisioning Tab - External Alarms Subtab
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External devices provisioned on the AIC are wired to the Environmental Alarms (ENVIR ALARMS
IN and ENVIR ALARMS OUT) backplane pins. See the “Alarm Pin Field Connections” section on
page 1-28 for more information.
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5.4.1 Using Virtual Wires

Provisioning the AIC card provides a “virtual wires” option that you can use to route external alarms
and controls from different nodes to one or more alarm collection centers. In Figure 5-6, smoke
detectors at Nodes 1, 2, 3, and 4 are assigned to Virtual Wire #1, and Virtual Wire #1 is provisioned
as the trigger for an external bell at Node 1.

Figure 5-6 AIC Virtual Wire Example
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<------- = External control

When using AIC virtual wires, you can:
® Assign different external devices to the same virtual wire.

® Assign virtual wires as the trigger type for different external controls.

Procedure: Provision External Alarms
Step 1 Wire the external-device relays to the ENVIR ALARMS IN backplane pins.

Step2  Log into the node in CTC and display the AIC in card view.
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Step 3

Step 4
Step 5

On the External Alarms subtab (Figure 5-5), complete the following fields for each
external device wired to the ONS 15454 backplane:

® FEnabled—click to activate the fields for the alarm input number.
® Alarm Type—select an alarm type from the provided list.

® Severity—select a severity. The severity determines how the alarm is displayed in the
CTC Alarms and History tabs and whether the LEDs are activated. Critical, Major,
and Minor activate the appropriate LEDs. Not Alarmed and Not Reported do not
activate LEDs, but do report the information in CTC.

®  Virtual Wire—To assign the external device to a virtual wire, select the virtual wire.
Otherwise, do not change the None default.

®  Raised When—select the contact condition (open or closed) that will trigger the alarm
in CTC.

® Description—default descriptions are provided for each alarm type; change the
description as necessary.

If you want to provision additional devices, complete Step 3 for each additional device.

Click Apply.

Procedure: Provision External Controls

Step 1
Step 2
Step 3

Step 4
Step 5

Wire the external control relays to the ENVIR ALARMS OUT backplane pins.
In CTC, log into the node and display the AIC in card view.

On the External Controls subtab, complete the following fields for each external control
wired to the ONS 15454 backplane:

® Enabled—click to activate the fields for the alarm input number.

® Trigger Type—select a trigger type: a local minor, major, or critical alarm, a remote
minor, major, or critical alarm, or a virtual wire activation.

® Description—enter a description.
If you want to provision additional controls, complete Step 3 for each additional device.

Click Apply.

5.4.2 Provisioning AIC Orderwire

The AIC provides RJ-11 jacks to allow onsite personnel to communicate with one another using
standard phone sets. The AIC Local and Express orderwire channels are carried on the SONET
Orderwire overhead:

® Local orderwire is carried on the SONET Section layer E1 byte. Regenerators between ONS
15454 nodes terminate the channel.

® Express orderwire is carried on the E2 byte of the SONET Line layer.
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If regenerators are not used between ONS 15454 nodes, local or express AIC orderwire channels can
be used. If regenerators exist, use the Express orderwire channel. You can provision up to four ONS

15454 optical carrier ports for each orderwire path.

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a
complete orderwire loop. For example, a four-node ring typically has east and west ports provisioned

at all four nodes. However, to prevent orderwire loops from occurring, provision two orderwire ports
(east and west) at all but one of the ring nodes.

Procedure: Provision AIC Orderwire

Ve

communication.
Step 1 In CTC, open the AIC card.
Step 2

Express Orderwire) that you want to create.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire

Select the orderwire subtab appropriate to the orderwire path (Local Orderwire or

The Local Orderwire subtab is shown in Figure 5-7. Provisioning procedures are the same

for both types.
Figure 5-7 AIC - Local Orderwire Subtab
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Step 3

Under Available Ports, select each port that you want to use for the orderwire channel and

click Add to move them to the Selected Ports column.

Step 4

If needed, adjust the Tx and Rx dBm by moving the slider to the right or left for the

headset type (four-wire or two-wire) that you will use. (In general, you should not need
to adjust the dBm.)
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Step5  Click Apply.

5.4.3 Using the AIC Orderwire

The AIC orderwire channels function as a party line. Anyone plugging a phone set into an AIC
orderwire channel can communicate with all participants on the connected orderwire. The AIC does
not provide private, point-to-point connections. To get the attention of participants, press the AIC
Call button to activate a buzzer and illuminate the RING LED on AICs at all connected nodes.

5.5 Converting DS-1 and DS-3 Cards From 1:1 to 1:N Protection

The ONS 15454 provides several protection options for DS1-14 and DS3-12 cards: unprotected, 1:1,
and 1:N. Changing protection from 1:1 to 1:N increases the available bandwidth because two of the
three cards used for protection in the 1:1 protection group become working cards in the 1:N group.

When setting up 1:N protection, install the DSIN-14 or DS3N-12 card in Slot 3 or 15 on the same
side of the ONS 15454 as the cards it protects. Slot 3 protects cards in Slots 1 -2 and 4 - 6. Slot 15
protects Slots 12 - 14 and 16 - 17. A DS1N-14 or DS3N-12 card installed in Slot 3 or 15 can protect
up to five DS1-14 or DS3-12 cards. If you install a DS3N-12 or DSIN-14 card in another slot, it
behaves like a normal DS-1 or DS-3 card.

Procedure: Convert DS1-14 Cards From 1:1 to 1:N Protection

Note This procedure assumes DS1-14 cards are installed in Slots 1 through 6 and/or Slots 12
through 17. The DS1-14 cards in Slots 3 and 15, which are the protection slots, will be replaced with
DSIN-14 cards. The ONS 15454 must run CTC Release 2.0 or later. The procedure also requires at
least one DSIN-14 card and a protection group with DS1-14 cards.

Step 1 Click the Maintenance>Protection tabs.

Step2  Click the protection group that contains Slot 3 or Slot 15 (where the DSIN-14 will be
installed).

Step3  Make sure the slot you are upgrading is not carrying working traffic. Under Selected
Group, the protect slot must say Protect/Standby (shown in Figure 5-8) and not
Protect/Active. If the protect slot status is Protect/Active, use the following steps to switch
traffic to the working card:

(a) Under Selected Group, click the protect card.
(b) From Operation at the bottom of the screen, select MANUAL.
(c) Click Apply.

Note The working slot should change to Working/Active and the protect slot should
change to Protect/Standby. If they do not change, do not continue. Troubleshoot the
working card and slot to determine why the card cannot carry working traffic.
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(d) From Operation, select CLEAR.
(e) Click Apply.

Figure 5-8 Protection Group Slot Status
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Step4  Repeat Steps 1-3 for each protection group that you need to convert. If you are only
converting one protection group, proceed to Step 5.
Step5  Verify that no standing alarms exist for any of the DS1-14 cards that you are converting.
Step 6  Clear any alarms that may exist on the DS1-14 cards before proceeding. If you have
difficulty clearing alarms, contact your next level of support.
Step 7  Click the Provisioning>Protection tabs.
Step 8  Click the 1:1 protection group containing cards that will be moved into the new protection
group.
Step9  Click Delete.
Step 10 When the confirmation dialog displays, click Yes.
Note Deleting the 1:1 protection groups does not disrupt service. However, no
protection bandwidth exists for the working circuits until you complete the 1:N protection
procedure. Therefore, complete this procedure as quickly as possible.
Step 11 If needed, repeat Steps 8 - 10 for other protection groups.
Step 12  On the node view shelf graphic, right-click the DS1-14 card in Slot 3 or Slot 15 and select
Delete from the shortcut menu. Wait for the card to disappear from the node view.
Step 13  Physically remove the DS1-14 card from Slot 3 or Slot 15.
Step 14 Physically insert a DSIN-14 card in the same slot.
Step 15  Verify that the card boots up properly.
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Step 16  Click the Inventory tab and verify that the new card appears as a DS1N-14.
Step 17 Click the Provisioning>Protection tabs.

Step 18 Click Create. The Create Protection Group dialog opens with the protect card in the
Protect Card field and the available cards in the Available Cards field.

Step 19 Type a name for the protection group in the Name field (optional).
Step 20 Click Type and choose 1:N (card) from the pull-down menu.
Step 21  Verify that the DSIN-14 card appears in the Protect Card field.

Step 22 Under Available Cards, highlight the cards that you want in the protection group. Click
the arrow (>>) tab to move the cards to the Working Cards list.

Step 23 Click OK. The protection group appears under Protection Groups on the Protection
subtab.

Procedure: Convert DS3-12 Cards From 1:1 to 1:N Protection

Note This procedure assumes that DS3-12 cards are installed in Slots 1 - 6 and/or Slots 12 - 17. The
DS3-12 cards in Slots 3 and 15, which are the protection slots, will be replaced with DS3N-12 cards.
The ONS 15454 must run CTC Release 2.0 or later. The procedure also requires at least one
DS3N-12 card and a protection group with DS3-12 cards.

Step 1 Click the Maintenance>Protection tabs.

Step2  Click the protection group containing Slot 13 or Slot 15 (where you will install the
DS3N-12 card).

Step3  Make sure the slot you are upgrading is not carrying working traffic. Under Selected
Group, the protect slot must say Protect/Standby as shown in Figure 5-8, and not
Protect/Active. If the protect slot status is Protect/Active, use the following steps to switch
traffic to the working card:

(@) Under Selected Group, click the protect card.
(b) From Operation at the bottom of the screen, select MANUAL.
(c) Click Apply.

Note The working slot should change to Working/Active and the protect slot should
change to Protect/Standby. If they fail to change, do not continue. Troubleshoot the
working card and slot to determine why the card cannot carry working traffic.

(d) From Operation, select CLEAR.
(e) Click Apply.

Step4  If you are converting more than one protection group, repeat Step 2 for each group that
needs conversion. Otherwise, proceed to Step 5.

Step5  Verify that no standing alarms exist for any of the DS3-12 cards you are converting.
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Note Clear any alarms that may exist on the DS3-12 cards before proceeding. If you
have difficulty clearing alarms, contact your next level of support.

Step 6  Click the Provisioning>Protection tabs.

Step7  Click a 1:1 protection group containing cards that will be moved into the new protection
group.
Step 8  Click Delete.

Step9  When the confirmation dialog displays, click Yes.

Note Deleting the 1:1 protection groups will not disrupt service. However, no protection
bandwidth exists for the working circuits until the 1:N protection procedure is completed.
Do not delay when completing this procedure.

Step 10 If you are deleting more than one protection group, repeat Steps 6 - 8 for each group.
Otherwise, proceed to Step 11.

Step 11 On the node view shelf graphic, right-click the DS3-12 card in Slot 3 or Slot 15 and select
Delete from the shortcut menu.

Step 12 Physically remove the DS3-12 card from Slot 3 or Slot 15. This raises an improper
removal alarm.

Step 13 In node view, right-click the slot that held the removed card and select delete from the
pull-down menu. Wait for the card to disappear from the node view.

Step 14 Physically insert a DS3N-12 in the same slot.

Step 15  Verify that the card boots up properly.

Step 16  Click the Inventory tab and verify that the new card appears as a DS3N-12.
Step 17  Click the Provisioning>Protection tabs.

Step 18 Click Create.

The Create Protection Group dialog shows the protect card in the Protect Card field and
the available cards in the Available Cards field.

Step 19 Type a name for the protection group in the Name field (optional).
Step 20 Click Type and select 1:N (card) from the pull-down menu.
Step 21  Verify that the DS3N-12 card appears in the Protect Card field.

Step 22 Under Available Cards, highlight the cards that you want in the protection group. Click
the arrow (>>) tab to move the cards to the Working Cards list.

Step23 Click OK.

The protection group should appear under Protection Groups on the Protection subtab.

This completes the procedure for converting a DS3N-12 from 1:1 to 1:N protection. Repeat this
process for all protection groups or nodes that need upgrading.
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5.6 Upgrading XC Cards to XCVT

This section explains how to replace dual XC cards with dual XCVT cards in an ONS 15454 with

live traffic. The substitution will not disrupt traffic. Figure 5-9 shows a ONS 15454 with XC cards
installed.

Figure 5-9 ONS 15454 with XC Cards
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Procedure: Upgrade XC Cards to XCVT

Upgrading XC cards to XCVT requires that the ONS 15454 run CTC Release 2.0 or later. Two XC
cards must be installed in the ONS 15454, and two XCVT cards must be available for installation.

Step1  Determine the standby XC card. The ACT/STBY LED of the standby XC card is yellow,
while the ACT/STBY LED of the active XC card is green.

Note You can also place the cursor on top of the card graphic to display a dialog. This

display identifies the card as XC: Active or XC: Standby. Figure 5-10 shows an Active XC
dialog.
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Figure 5-10 Active XC Card
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Step2  Remove the standby XC card from the ONS 15454. This raises an improper removal
alarm.

Step 3  Insert the first XCVT card into the empty XC slot and latch the levers.
The fail LED above the ACT/STBY LED becomes red, blinks for several seconds, then
turns off.

The ACT/STBY LED turns yellow and stays lit.
Step4  In node view, select the Maintenance>XC Cards tabs (Figure 5-11).
Figure 5-11 XC Cards Subtab
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Step5  Use the Slot Operation menu for the slot of the active card. In this example, Slot 10
Operation.

Step6  Choose MANUAL from the pull-down menu.
Step7  Click Apply.

Note A minor alarm will appear on the manually switched slot. After the active XC
disengages, the standby slot or first XCVT card becomes active. This causes the
ACT/STBY LED on the first XCVT card to change from yellow to green.

Step8  Choose CLEAR from the same Slot Operation menu.
Step9  Click Apply.
Step 10 Physically remove the now standby XC card from the ONS 15454.

Step 11 Insert the second XCVT card into the empty XC slot. The second XCVT card boots up
and becomes a standby XCVT.
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CHAPTER 6

DWDM

This chapter provides a general overview of Dense Wavelength Division Multiplexing (DWDM)
technology, components, and applications and describes how the Cisco ONS 15454 implements
DWDM solutions.

6.1 DWDM Overview

DWDM increases the information-carrying capacity of existing fiber optic infrastructure to
eliminate the high cost of installing new fiber optic cable. The majority of the current high-speed
backbones used by service providers are comprised of fiber optic links operating at 2.5 Gigabits per
second (Gbps) or 10 Gbps. DWDM offers a scalable solution for using existing installed fiber optics
to gain increased bandwidth.

DWDM transmits multiple signals simultaneously at different wavelengths. This allows a single
fiber to operate as if it were multiple fibers, referred to as “virtual fiber.” Each signal carried can be
at a different rate (OC-48 or OC-192 for example) yet use the same physical fiber optic cable.

6.2 DWDM Components

All DWDM systems consist of the following components: precise wavelength optical transmitters
(lasers), optical multiplexers (mux) and demultiplexers (demux), and broadband optical receivers.
Optional components of a DWDM system are optical add/drop multiplexers (OADM) and optical
amplifiers. Figure 6-1 shows the basic concept of a DWDM system with an amplifier.
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Figure 6-1 DWDM System
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6.2.1 Optical Transmitters and Transponders

The optical transmitters for DWDM systems are high resolution, precision narrow-band lasers.
These lasers allow close channel spacing, which increases the number of wavelengths that can be
used in the 1500 nm band while minimizing the effects of signal impairments such as dispersion.
The optical transmitter minimizes power loss which to allow long transmission distances and a high
level of signal integrity. These lasers can use optical amplifiers that boost signal strength for
extended distances and eliminate the electronic-amplifier need to regenerate individual optical
signals. Most laser systems are designed to wavelength frequencies that follow the ITU-T, which
enables simplified interoperability and easier component selection.

A component of some DWDM systems is the transponder, which converts broadband optical signals
to specific wavelengths using optical-to-electrical-to-optical (OEO) conversion. Transponders or
wavelength converters are optional devices that provide the conversion of one optical wavelength
(in other words, 1310 nm or 1550 nm) to a precision narrow-band wavelength. This conversion
enables devices that are not equipped with precision narrowband lasers to be multiplexed onto a
single fiber, such as routers, ATM switches, or other multiplexers.

6.2.2 Optical Amplifiers

Optical amplifiers boost optical signals to minimize the effects of power loss and attenuation that
result from sending light pulses over optical fiber. Optical amplifier technology is the key to enabling
the high speed, high-volume transmission of DWDM to take place. Optical amplifier technology
was the key to the commercial success of long-haul DWDM systems. However, because of the
shorter distances found in metropolitan and regional networks, optical amplifiers are not always
deployed in these networks.

Before the advent of optical amplifiers, each signal had to be regenerated electronically. When
regenerating an optical signal electronically, the signal must first be converted to an electrical signal,
amplified, and then converted back to an optical signal before being retransmitted. Electronic
regeneration requires a separate regenerator for each wavelength on each fiber. A single optical
amplifier can amplify all of the wavelengths on one fiber.

The most common type of optical amplifier is the erbium doped fiber amplifier (EDFA).
Conventional EDFAs operate in the 1530 to 1560 nm range.
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6.2.3 Optical Multiplexers and Demultiplexers

Optical multiplexers combine the transmit signals from different wavelengths onto a single optical
fiber. Optical demultiplexers separate the combined signals into their component wavelengths at the
receiving end. Thin film dielectric filters and optical gratings types of multiplexers and
demultiplexers. DWDM multiplexers are typically passive devices, which means they do not require
electrical input. These passive multiplexers behave like high-precision prisms to separate the
individual colors of the DWDM signal.

6.2.4 Optical Receivers

Optical receivers detect incoming lightwave signals and convert them to an appropriate signal for
processing by the receiving device. Optical receivers are usually wideband devices that can detect
light over a relatively wide range of wavelengths. The ability to detect this wide range of
wavelengths allows a single receiver to accept any wavelength in the 1300 to 1550 nm range.

6.2.5 OADMs

Optical Add/Drop Multiplexers (OADMs) can be deployed into a DWDM system or network for
added signal grooming flexibility. OADMs allow you to add or drop channels from a fiber that is
dense wave division multiplexed. OADMs are installed in a multi-wavelength fiber span, and allow
a specific wavelength on the fiber to be demultiplexed (dropped) and remultiplexed (added) while
enabling all other wavelengths to pass. As the result of an OADM filter, the wavelengths that pass
through experience only a small amount of signal attenuation.

6.3 DWDM Applications

DWDM offers many benefits over traditional fiber-optic systems. It minimizes fiber usage by
creating “virtual fiber” to convert each fiber into multiple fibers. DWDM provides greater scalability
and extends the non-regenerated distance limits. It is also bit-rate and protocol independent. These
benefits enable many new applications. A few of the possible applications are described in this
section.

6.3.1 Long Distance

DWDM technology works well for long distance carriers that use point-to-point or ring topologies.
Having 16 new transmission channels instead of one greatly improves a carrier’s ability to expand
capacity while setting aside backup bandwidth without deploying new fiber.

DWDM technology has been used extensively by long distance carriers and has allowed the existing
fiber plant to keep pace with the growing demand for bandwidth. DWDM systems designed for
long-haul networks have the ability to provide more than 32 wavelengths over a single fiber.

6.3.2 Self-Healing Rings

The development of self-healing rings depends on the large amount of capacity provided by
DWDM. Self-healing rings are typical in most sophisticated telecommunications networks. Using
DWDM, a telecommunications network operator can construct a 40 Gb/s ring with 16 separate fully-
protected signals. All of this can be accomplished using just two fibers.
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DWDM technology does not hinder the deployment of self-healing ring technology as found in
SONET systems, and is transparent to the protocol operating on top of the OC-N signal. DWDM
systems provide multiple wavelengths that can be used for the working or protection channels of a
SONET system. These wavelengths can also be used for unprotected optical signals, such as those
found on many routers or ATM equipment.

6.3.3 Network Expansion

For network operators that are building or expanding their networks, DWDM is an economical way
to future-proof existing infrastructure. DWDM allows for incremental capacity increases and ease
in implementing new equipment. In some geographic areas where the industrial base is rapidly
expanding, DWDM is one way to meet the growing demand without laying new fiber.

6.4 DWDM and the ONS 15454

The Cisco ONS 15454 DWDM solution employs 18 distinct OC48 ITU DWDM cards. Nine of these
cards operate in the blue band with spacing of 200 GHz, and the other nine operate in the red band
with 200 GHz spacing. The optics have a link budget of 25 dB. The cards are intended to be used for
long unregenerated spans of up to 200 km with mid-span amplification, or 80 km without
amplification.

6.4.1 ONS 15454 OC48 ELR ITU Optics

The ONS 15454 OC48 ELR ITU optics complement the standard OC-48 optics cards currently
offered on the platform. As with all ONS 15454 optics cards, they can be configured for operation
in ring networks (UPSR or BLSR), linear networks, point-to-point or ADM configurations, mesh
networks, or as a terminal node. The ONS 15454 system can be configured with a combination of
ITU and non-ITU cards, depending on the user's application.

Pairing the ONS 15454 ELR ITU optics with bidirectional DWDM multiplexers and demultiplexers
can provide up to 45 Gb/s of bandwidth over a single fiber. Where available fiber is limited, the
resulting fiber bandwidth improvement reduces the need to install new fiber. Because the Cisco
DWDM solution is standards-based and ITU-compliant, users can deploy products from third-party
manufacturers to build multivendor networks that best suit their applications.

Engineering a metropolitan fiber link with DWDM and ITU lasers is similar to using single channel
operation. Because the ONS 15454 OC48 ELR ITU optics are designed for single span,
non-amplified links, this solution should operate over most types of fiber plant. Fiber non-linear
effects including four-wave mixing, stimulated brillouin scattering, self-phase modulation,
cross-phase modulation, and stimulated raman scattering are irrelevant because of the low optical
transmit power levels and wide frequency spacing of the DWDM system.

6.4.2 Using the ONS 15454 in a DWDM Network

The deployment of DWDM does not limit the type of network topology supported, whether it is a
ring, linear, or mesh network. The ability of the ONS 15454 platform to deliver multiple services
(DS-1, DS-3, and Ethernet, for example) is unaffected. The DWDM passive
multiplexers/demultiplexers are transparent to the data traversing the wavelengths and are used to
expand the capacity of the existing fiber. The ONS 15454 can support applications that use both the
ITU and standard 1310nm or 1550nm wavelengths depending on the requirements of the particular
network. Figure 6-2 shows the Cisco ONS 15454 used in a DWDM ring application.
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Figure 6-2 DWDM Ring Application
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6.4.2.1 ONS 15454 DWDM Network Design

The ONS 15454 DWDM solution expands the available options for designing a high-bandwidth
network that uses existing infrastructure. It is important to follow a set of engineering
guidelines/practices to be sure that you are maximizing the benefits and efficiency of your DWDM

network. This section presents high-level examples of some common network design improvements
using DWDM.

6.4.2.2 Survivable Network

Building a survivable network is one of the primary concerns when making network design
decisions. At the very least, you should make sure that there is no interruption of traffic because of
a fiber cut. Eliminating a single point of failure is one way to create a more survivable network.
Figure 6-3 shows two examples of the same network. Example A has working and protection circuits
set up on the same fiber to create a single point of failure. Example B is a survivable network with
working and protection circuits set up on different fibers taking separate routes.
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Figure 6-3 Survivable Network
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6.4.2.3 Sparing Practices
Sparing keeps a network up and running after a card failure. The two methods of sparing are 1:1 card
sparing and wavelength sparing. Wavelength sparing is the preferred method because it requires only
one spare card at each site. With 1:1 card sparing, each card must have an identical card in inventory
at the site.

6-6 Cisco ONS 15454 User Documentation



CHAPTER 7

Ethernet Applications

This chapter explains how to use the Ethernet features of the Cisco ONS 15454.

7.1 Ethernet over SONET Application

To maximize Ethernet cost effectiveness, the ONS 15454 integrates Ethernet access into the same
SONET platform that transports data and voice traffic. The ONS 15454 supports layer 2 switching
and the ability to classify Ethernet traffic as defined in IEEE 802.1 Q. You can switch tagged traffic
onto separate SONET STS channels to engineer bandwidth by traffic class. Ethernet over SONET
lets service providers augment Time Division Multiplexing (TDM) services with Ethernet, and
allows users to deliver data traffic over existing facilities. The ONS 15454 can also concentrate
Ethernet ports into one or more STS-n circuits to use bandwidth more efficiently.

7.2 Router Aggregation Application

The ONS 15454 Ethernet solution uses existing SONET infrastructure to transport aggregate traffic
from multiple, remote sources. Figure 7-1 illustrates the aggregation and transport.
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Figure 7-1 Router Aggregation Application
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7.3 Transparent LAN Application

7-2

The ONS 15454 supports Transparent LAN Service (TLS) that provides private network service
across a SONET backbone. Because network subscribers sometimes share the same equipment or
even the same STS channels, it is necessary to logically isolate subscriber traffic. Service providers
can use the IEEE 802.1Q feature in the ONS 15454 to define multiple, virtual local area networks
(VLANS) across the backbone. Specific Ethernet ports and SONET STS channels can be defined as
a VLAN group. VLAN groups isolate the subscriber’s traffic from users outside the VLAN group
and keep “outside” traffic from “leaking” into the VPN. Figure 7-2 illustrates a transparent LAN
application.
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Figure 7-2 Transparent LAN Application
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7.4 ONS 15454 Ethernet Cards

The ONS 15454 supports two separate Ethernet cards, the E100T and the E1000-2. This section
describes the characteristics of each card.

741 E100T

The ONS 15454 uses E100T cards for Ethernet (10 Mbps) and Fast Ethernet (100 Mbps). The E100T
enables network operators to provide multiple 10/100 Mbps access drops for high-capacity customer
LAN interconnections. The card provides efficient transport and co-existence of traditional TDM
traffic with packet switched data traffic. The E100T eliminates the need for external Ethernet
aggregation equipment.

Specifications:
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95% non-condensing

— Power Consumption: 40 Watts
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Figure 7-3 E100T Card, Front view
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Table 7-1 E100T Ethernet Port LED States
LED State Description
Amber Transmitting and Receiving
Solid Green Idle and Link Integrity
Flashing Green Transmitting only or Receiving only
Green Off Inactive connection or uni-directional traffic.

7.4.2 E1000-2

The ONS 15454 uses the E1000-2 cards for Gigabit Ethernet (1000 Mbps). The E1000-2 enables
network operators to provide multiple 1000 Mbps access drops for high-capacity customer LAN
interconnections. The E1000-2 provides efficient transport and co-existence of traditional TDM
traffic with packet-switched data traffic.
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For Cisco Release 2.2.0, two GBIC modules are offered as separate products for flexibility: an IEEE
1000Base-SX compliant 850 nm optical module and an IEEE 1000Base-LX compliant 1300 nm
optical module. The 850 nm SX optics are designed for multimode fiber and distances of up to
220 meters on 62.5 micron fiber and up to 550 meters on 50 micron fiber. The 1300 nm LX optics
are designed for single-mode fiber and distances of up to 5 kilometers.

Caution IE1000-2 cards lose traffic for approximately 30 seconds when an ONS 15454 database
A is restored. Traffic is lost during the period of spanning tree reconvergence. The CARLOSS alarm
will appear and clear during this period.

Specifications:
— Operating Temperature: 0 to +55 degrees Celsius
— Operating Humidity: 5 - 95% non-condensing

— Power Consumption: 40 Watts

Figure 7-4 E1000-2 Card, Front view
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Table 7-2 E1000-2 Ethernet Port LED States
LED State Description
Amber Transmitting and Receiving
Solid Green Idle and Link Integrity
Flashing Green Transmitting only or Receiving only
Green Off Inactive connection or uni-directional traffic.

7.5 Virtual Local Area Networks (VLANS)

As Ethernet networks grow, too many hosts transmitting data within a single broadcast domain cause
an increase in “broadcast storms.” You can create VLANs with the CTC to partition the broadcast
domain into several domains and decrease the likelihood of broadcast storms. A VLAN carves out
its own single broadcast domain from the larger Ethernet network.

The ONS 15454 supports port-based VLANSs that group ports into virtual workgroups. These
VLANS ensure that Ethernet ports see only traffic from ports within the same VLAN. These different
VLANSs communicate with each other through a router that spans multiple VLANSs by using router
ports in each VLAN, or through a router that understands IEEE 802.1Q.

7.5.1 IEEE 802.1Q

IEEE 802.1Q, the VLAN standard, places a Q-tag in the frame header. The 802.1Q-aware devices
look at Q-tags to differentiate LANs. Therefore, multiple 802.1Q VLANSs representing different
logical networks can be transported over the same physical port. If a frame is received without a
Q-tag, the frame is given a Q-tag based on the default VLAN assigned to the ingress port. If a frame
is received with a Q-tag attached, the port classifies the frame based on the VLAN identifier present
in the Q-tag.

Many older Ethernet devices do not understand 802.1Q tagging. Because 802.1Q lengthens the
Ethernet header, older (non-802.1Q) devices may incorrectly identify the 802.1Q tagged packets as
giants (an Ethernet frame larger than 1518 bytes) and drop them. The ONS 15454 takes non-tagged
packets from the ingress port and assigns the frame to the VLAN associated with the ingress port. If
packets come into the ONS 15454 network already tagged, the ONS 15454 uses the already-attached
tag to forward the packet accordingly. Figure 7-5 illustrates different ways the ONS 15454 performs
802.1Q tagging.

The CTC allows the user to assign specific ports to specific VLANSs and prohibit ports from being
part of specific VLANs. ONS 15454 ports can also be set to Untag or Tagged. See the “Provision
Ethernet Ports for VLAN Membership” section on page 7-59 for more information on these
operations.
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Figure 7-5 Q-tag
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7.5.2 |EEE 802.1Q Priority Queuing (formerly IEEE 802.1P)

Priority Queuing eases network congestion by mapping Ethernet traffic to different priority levels.
Networks without Priority Queing handle all packets on a first-in-first-out basis. Priority Queuing
assigns priorities to data packets. The ONS 15454 uses a “leaky bucket” algorithm to establish a
weighted priority (not a strict priority). A weighted priority gives high-priority packets greater
access to bandwidth, but does not totally preempt low priority packets. 70% of bandwidth goes to
the high priority que and the remaining 30% goes to the low priority que. Low priority packets can
also be dropped when the network is congested. The ONS 15454 takes the eight priorities specified
in IEEE 802.1Q and maps them to two queues (shown in Table 7-3). Priority Queuing information
is carried through the network via IEEE 802.1Q tags

Table 7-3 Priority Queuing
User Priority Queue Allocated Bandwidth
0,1,2,3 Low 30%
4,5,6,7 High 70%
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Figure 7-6 Priority Queuing
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7.6 Spanning Tree

STP detects and eliminates network loops. By default, the ONS 15454 uses IEEE 802.1D STP on
the optical line interfaces. When STP detects multiple paths between any two network hosts, STP
blocks ports until only one path exists between any two network hosts (Figure 7-7). The single path
eliminates possible bridge loops.

Figure 7-7 Spanning Tree Blocked Path

Redundant path (blocked)

When loops occur, some Ethernet switches see the same stations transmitting data on more than one
interface. This condition disables the forwarding algorithm and allows duplicate frames to be
forwarded. To remove loops, STP defines a tree that spans all the switches in an extended network.
STP forces certain redundant data paths into a standby (blocked) state. If one network segment in
the STP becomes unreachable, the spanning-tree algorithm reconfigures the spanning-tree topology
and reactivates the blocked path to re-establish the link. STP operation is transparent to end stations,
which do not discriminate between connections to a single LAN segment or a switched LAN with
multiple segments. The ONS 15454 supports one STP instance per circuit up to a maximum of eight
instances per shelf.

Starting with Release 2.2.0, users have the ability to enable STP on the Ethernet ports of the E100
and E1000 cards. This allows redundant circuit paths to be available for additional fault tolerance,
but not cause a loop, as they are blocked by STP.
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Figure 7-8 Enabling Spanning Tree
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Procedure: Enable Spanning Tree on Ethernet Ports
Step1 At the card-level view, click the Provisioning tab and the Port subtab.

Step2 In the left-hand column, find the applicable port number and check the Stp Enabled box
to enable STP for that port (see Figure 7-8).

Step3  Click Apply.

7.6.1 Spanning Tree Parameters

Default spanning tree parameters are appropriate for most situations. Contact the Technical
Assistance Center (TAC) at 1-877-323-7368 before you change the default STP parameters.

At the node view click the Maintenance>Spanning Trees> Etherbridge tabs to view spanning tree
parameters.
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Figure 7-9 Spanning Tree Parameters
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Table 7-4 Spanning Tree Parameters
BridgeID The unique identifier of the ONS 15454 that is transmitting the configuration bridge protocol
data unit (BPDU). The bridge ID combines ONS 15454’s MAC address and Priority.
TopoAge The amount of time in seconds since the last topology change.
TopoChanges Number of times the spanning tree topology has been changed since the shelf was booted.

DesignatedRoot Identifies the spanning tree’s designated root for a particular spanning tree instance.

RootCost Identifies the total path cost to the designated root.

RootPort The port used to reach the root.

MaxAge The maximum time that received-protocol information is retained before it is discarded.
HelloTime The time interval, in seconds, of the transmission of configuration BPDUs by a bridge

attempting to become the spanning tree root or a bridge that is the spanning tree root.

HoldTime The minimum time period, in seconds, that elapses during the transmission of configuration
information on a given port.

ForwardDelay The time spent by a port in the listening state and the learning state.
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7.6.2 Spanning Tree Configuration

To view the spanning tree configuration, at the node view click the Provisioning tab and

Etherbridge subtab.

Figure 7-10
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Table 7-5 Spanning Tree Configuration
Column Default Value | Value Range
Priority 32768 0-65535
Bridge max age 20 seconds 6-40 seconds
Bridge Hello Time 2 seconds 1-10 seconds
Bridge Forward Delay 15 seconds 4-30 seconds
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7.6.3 Viewing Spanning Tree
Figure 7-11 Circuit Screen
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Procedure: View Spanning Tree
Step 1 On the circuit screen (Figure 7-11), highlight an Ethernet circuit.

Step2  Click the Map button.

Note On the spanning tree map, green represents forwarding spans and purple represents blocked
(protect) spans. If you have a packet ring configuration, at least one span should be purple.
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Multicard and Single-card EtherSwitch

Release 2.0 of the ONS 15454 used multicard EtherSwitch exclusively. As Ethernet cards were
added within a shelf, they would combine to form a single layer 2 switch. The bandwidth of the
single switch formed by the Ethernet cards matches the bandwidth of the provisioned Ethernet
circuit up to STS-6C worth of bandwidth. Figure 7-12 illustrates a multicard EtherSwitch
configuration.

Figure 7-12 Multicard EtherSwitch

VLAN A-:X:

-._Ethernet card #1

Ethernet card #2@

ONS Node Shared packet ring $ONS Node

" Ethernet card #3 Ethernet card #4 ™

6
6

Router % Router

In Release 2.2.0 and later, single-card EtherSwitch Ethernet is an additional option that allows each
Ethernet card to remain a single switching entity within the ONS 15454 shelf. Both E100 and E1000
cards allow either multicard EtherSwitch or single-card EtherSwitch operation. Single-card
EtherSwitch allows a full STS-12C worth of bandwidth between two Ethernet circuit points.
Figure 7-13 illustrates a single-card EtherSwitch configuration.

Figure 7-13 Single-card EtherSwitch
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Seven scenarios for provisioning single-card EtherSwitch bandwidth are possible:
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7 12 STS-1s

Note When configuring scenario 3, the STS 6¢ must be provisioned before either of the STS 3c
circuits. A future software release will resolve this issue.

Note When deleting and recreating Ethernet circuits that have different sizes, all STS circuits
provisioned to the EtherSwitch must be deleted before the new circuit scenario is created. A future
software release will resolve this issue.

Figure 7-14 illustrates the Card Mode screen where the EtherSwitch option is provisioned.

Figure 7-14 Card Mode
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7.8 ONS 15454 Ethernet Circuit Configurations

There are three common methods for configuring Ethernet circuits between ONS 15454 nodes: a
straight circuit configuration, a shared packet ring configuration, and a hub and spoke configuration.
Two nodes usually connect with a straight circuit configuration. More than two nodes usually
connect with a shared packet ring configuration or a hub and spoke configuration.
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Figure 7-15 shows a straight circuit configuration, Figure 7-16 shows a shared packet ring
configuration, and Figure 7-17 shows a hub and spoke configuration.

Figure 7-15 Straight Circuit Configuration
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Figure 7-16 Shared Packet Ring Ethernet Circuit Configuration
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Figure 7-17 Hub and Spoke Ethernet Circuit Configuration
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Note Before making Ethernet connections, choose a circuit size from STS-1, STS-3C, STS-6C, or

STS-12C.

Note When making an STS-12C Ethernet circuit, the E100 and the E1000 cards must be configured

as single-card EtherSwitch.

7.8.1 Multicard EtherSwitch Ethernet Circuit Provisioning

Procedure: Provision a Multicard Straight Ethernet Circuit

Note Single-card EtherSwitch allows a full STS-12C worth of bandwidth between two Ethernet
circuit points. Multicard EtherSwitch limits bandwidth to STS-6C worth of bandwidth between two

Ethernet circuit points.
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Figure 7-18 Multicard Straight Circuit
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Step1  Log into one of the ONS 15454 Ethernet circuit endpoints.
Step2  Double click one of the Ethernet cards included in the circuit.
Step 3  Click the Provisioning tab and the Card subtab.
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Figure 7-19 Card Mode Window
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Step 4 Under Card Mode, verify that Multi-card EtherSwitch Group is checked.
Step5  Display the node view.

Step 6  Repeat Steps 2-4 for all other Ethernet cards in the ONS 15454 that will make up the
circuit.

Step7  Log into the other ONS 15454 endpoint.
Step 8  Repeat Steps 2-6.
Step9  Click the Circuits tab.
Step 10  Click Create.
The Circuit Attributes dialog opens (see Figure 7-20).
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Figure 7-20 Circuit Attributes Dialog
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Step 11 In the Name field, type a name for the circuit.

Step 12 From the Type menu, choose STS.
Note VT and VT Tunnel Type: do not apply to Ethernet circuits.

Step 13  Choose the size of the circuit from the Size menu.
Note The valid circuit sizes for an Ethernet Multicard circuit are STS-1, STS-3C, and
STS-6C.

Step 14  Verify that the Route Automatically box is checked.

Step 15  Verify that the Bidirectional box is checked.

Step 16  Click Next.
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7-22

Figure 7-21 Circuit Source
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Step 17 Choose the circuit source from the Node menu (see Figure 7-21) in the circuit creation
dialog box.

Note Either end node can be the circuit source.

Step 18 Choose Ethergroup from the Slot menu.
Step 19  Click Next.
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Figure 7-22 Circuit Destination
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Step 20 Choose a circuit destination from the Node menu (see Figure 7-22). Choose the node that

is not the source.
Step 21  Choose Ethergroup from the Slot menu.
Step 22 Click Next.

The Circuit VLAN Selection window displays (see Figure 7-23).

Note Do not use the default VLAN to pass traffic between nodes.
Step 23 Create the VLAN:

(a) Click the New VLAN tab.

The Define New VLAN dialog opens (see Figure 7-23).
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Figure 7-23 Define New VLAN Dialog
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(b) Assign a name to your VLAN that will allow you to easily identify a particular
network.
(c) Assigna VLAN ID.

This should be the next available number between 2 and 4093 that is not already assigned to
an existing VLAN. Each ONS 15454 network supports a maximum of 509 user provisionable

VLANS.
(d) Click OK.
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Figure 7-24 Circuit VLAN Selection
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(e) Highlight the VLAN name and click the arrow >> tab to move the available
VLAN(s) to the Circuit VLANS column.

Step 24 Click Next.
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Figure 7-25 Circuit Confirmation
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Step 25 The Confirm Circuit Creation dialog opens and displays the following information about
the point-to-point circuit:

® Circuit is bidirectional Ethernet

® Circuit size

® Circuit name

VLAN:Ss that will be transported across this circuit
® ONS 15454 nodes included in the circuit

Note If the circuit information is not correct, use the <Back button to correct the
information.

Step 26  Click Finish.

You now need to provision the Ethernet ports and assign these ports to VLANSs. For port
provisioning instructions, see the “VLAN Membership and Ethernet Port Provisioning”
section on page 7-59. For information about manually provisioning circuits, see the
“Ethernet Manual Cross-Connects” section on page 7-54.
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Procedure: Provision a Single Card Ethernet Straight Circuit

Figure 7-26 Single-card Straight Circuit
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Step1  Log into one of the ONS 15454 Ethernet circuit endpoints.
Step2  Double click the Ethernet card that will make the circuit.

Step 3  Click the Provisioning tab and the Card subtab.
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Figure 7-27 Single-card EtherSwitch Screen
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Step 4 Under Card Mode, check the Single-card EtherSwitch.
Step5  Click Apply.

Step 6  Log into the other ONS 15454 endpoint and repeat Steps 2-5.
Step 7  Display the node view.

Step8  Click the Circuits tab.

Step9  Click Create.

The Circuit Attributes window opens.
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Figure 7-28

Ed
File GoTo Help

Circuit AttributesDialog

=151 x|

Alarms] History Circuits \ Provie | Name: |

— | gize: [5T51
Circuit Mame |Type‘ Swze|

|+ Bidirectional

Murnber of circuits: 1

|v Route Automatically

El
=]

S S SR by SIS S SE S B S ==
o 12frec |xo] [zovifree fociz]erod EPD: o
Hode iNode 3 g B
IP &ddr : 152z.1.1.100 |:| D
Booted : 6/5/00 3:45 P [ [
cR=O0M=0Mm=0 b eI g
Tser 1 cerentdSd @Eircuil Creation
Authorivy: Superuser Circuit Attributes
Circuit Protection

[ Fully Protected Path
[ Protected Drops

Path Selectors (UPSR protection anly)

| Revertive Reversiontime min.

SF threshold: [1E-4 =]
5D threshold: [1E-7 |
[” Switch on FDI-P
Mext= Cancel |

AllVLANS...

42897

Step 10
Step 11

From the Type menu, choose STS.

In the Name field, type a name for the circuit.

Note VT and VT Tunnel Type: do not apply to Ethernet circuits.

Step 12
Step 13
Step 14

Step 15 Click Next.

Choose the size of the circuit from the Size menu.
Verify that the Route Automatically box is checked.

Verify that the Bidirectional box is checked.
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Figure 7-29 Circuit Source
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Step 16  Choose the circuit source from the Node menu.

Note Either end node can be the circuit source.

Step 17 From the Slot menu, choose the Ethernet card for which you enabled the single-card
EtherSwitch.

Step 18 Click Next.
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Figure 7-30 Circuit Destination
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Step 19 Choose the circuit destination from the Node menu.

Note Choose the node that is not the source.

Step 20 From the slot menu, choose the Ethernet card for which you enabled the single-card
EtherSwitch.

Step 21  Click Next.
The Circuit VLAN Selection window displays. See Figure 7-31.

Note Do not use the default VLAN to pass traffic between nodes.

Step 22 Create the VLAN:
(a) Click the New VLAN tab.
The Define New VLAN dialog opens.
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Figure 7-31
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Assign a name to your VLAN to help you easily identify a particular network.

Assign a VLAN ID.

This should be the next available number (between 2 and 4093) not already assigned to an
existing VLAN. Each ONS 15454 network supports a maximum of 509 user provisionable
VLANS.

Click OK.

Highlight the VLAN name and click the arrow >> tab to move the VLAN(s) from
the Available VLANs column to the Circuit VLANS column (see Figure 7-32).
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Figure 7-32 Circuit VLAN Selection
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Step 23 Click Next.
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Figure 7-33
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The Confirm Circuit Creation dialog opens and displays the following information about
the point-to-point circuit (see Figure 7-33):

Circuit is bidirectional Ethernet

Circuit size

Circuit name

VLAN:Ss that will be transported across this circuit

ONS 15454 nodes included in the circuit

Note If the circuit information is not correct, use the <Back button to correct the
information.

Step 24  Click Finish.

You now need to provision the Ethernet ports and assign these ports to VLANSs. For port
provisioning instructions, see the “VLAN Membership and Ethernet Port Provisioning”
section on page 7-59. For information about manually provisioning circuits, see the
“Ethernet Manual Cross-Connects” section on page 7-54.

Cisco ONS 15454 User Documentation

42728



78-11078-02  June 2001 Ethernet Applications 7

7.8.2 Shared Packet Ring Ethernet Circuit Provisioning
This section provides steps for creating a shared packet ring. Figure 7-34 illustrates a sample shared

packet ring. (Your network architecture may differ from the example.)

Figure 7-34 Shared Packet Ring
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Procedure: Provision a Shared Packet Ring
Step1  Log into one of the ONS 15454 Ethernet circuit endpoints.

Step2  Double click one of the Ethernet cards that will make up the circuit.

Step 3  Click the Provisioning tab and the Card subtab.
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Figure 7-35 Multicard EtherSwitch Group
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Step 4 Under Card Mode, verify that Multi-card EtherSwitch Group is checked.
Step5  Display the node view.

Step 6  Repeat Steps 2-4 for all other Ethernet cards in the ONS 15454 that will make up the
shared packet ring.

Step7  Log into the other ONS 15454 endpoint.
Step 8  Repeat Steps 2-6.

Step9  Click the Circuits tab.

Step 10  Click Create.

The Circuit Creation dialog opens (see Figure 7-36).
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Figure 7-36 Circuit Attributes Dialog
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Step 11 In the Name field, type a name for the circuit.
Step 12 From the Type menu, choose STS.

Step 13  From the Size menu, choose the size of the circuit.

Note For shared packet ring Ethernet, valid circuit sizes are STS-1, STS-3C, and

STS-6C.

Step 14  Verify that Route Automatically is not selected.

Step 15  Verify that Bidirectional is selected.

Note You must manually provision the circuits if you are building a shared packet ring

configuration.

Step 16  Click Next.
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Figure 7-37 Circuit Source Dialog
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Step 17 Choose the circuit source from the Node menu.

Note Any shared packet ring node can serve as the circuit source.

Step 18 Choose Ethergroup from the Slot menu.
Step 19  Click Next.

Step 20 Choose the circuit destination in the Node menu.

Note Except for the source node, any shared packet ring node can serve as the circuit
destination.

Step 21  Choose Ethergroup from the Slot menu.
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Figure 7-38
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Step 22 Click Next.
The Circuit VLAN Selection window opens (see Figure 7-38).

Note Do not use the default VLAN to pass traffic between nodes.

Step 23 Create the VLAN:

(@)

(b)

Click the New VLAN tab.
The Define New VLAN dialog opens.

Assign a name to your VLAN. The name should be one that allows you to easily
identify a particular network.

Assign a VLAN ID.

This VLAN ID number must be unique. It is usually the next available number not already
assigned to an existing VLAN (between 2 and 4093). Each ONS 15454 network supports a
maximum of 509 user-provisionable VLANS.

Click OK.

Highlight the VLAN name and click the arrow >> tab to move the VLAN(s) from
the Available VLANs column to the Circuit VLANs column.

By moving the VLAN from the Available VLANs column to the Circuit VLANS column, all

the VLAN traffic is forced to use the shared packet ring circuit you created.
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Step 24 Click Next.
Figure 7-39 Circuit Path Selection
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Step 25 Click the line representing the span between Node 1 (Source) and Node 2 (Drop 1). Click
the line again until the arrow points from the source (in this case, Node 1) to the
destination (Node 2).
Step 26  Click the Source STS menu and choose a source STS.
The menu shows the STSs available to carry the shared packet ring circuit.
Step 27 Click Add Span.
Step 28 Repeat Steps 25, 26, and 27 for the next span (between nodes 2 and 3 in this example).
Step 29 Repeat Steps 25, 26, and 27 for the span between nodes 3 and 1. Figure 7-40 shows the

Circuit Path Selection dialog with all the spans selected.

Note As each new span is selected, make sure the direction arrow on each span

continues along a continuous path of travel. The arrows should connect head-to-tail in a

circle (see Figure 7-40).
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Figure 7-40 Circuit Path Selection (all spans)
:;Zj @Eilcuil Creation 1] ]
File GoTn Help Cireuit Path Selection, Name=circuit 1
PROPERTIES:
Node 1
Critical :0
Major : O
Minor : 0O Maode 1
(Source)
Mode 3 Mode 2
(Drap 1)
Alarmsl History C\rcuitsl
i| Delete.. £ All YLANS...
— Selected Spans: Select Circuit Span

CircuitMarne | Tyre| S8 | € [\ade 1611 —» Mode 21211

Unknown STS | 1 1 2% Iode 2:5:1:1 = Node 31 2:1:1
Mode 3:6:1:1 --= Node 1:12:1:1
Source 5TS)
v [
«Back ‘ et | Cancel ‘

42735

Step 30 Click Next.
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Figure 7-41 Circuit Creation
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Step 31  Verify that the new circuit is correctly configured.

Note If the circuit information is not correct, use the <Back button to correct the information.

Step 32 Click Finish.
Step 33 Add the remaining packet ring drops:

(a) Highlight the shared packet ring circuit (see Figure 7-42).
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Figure 7-42 Highlighted Circuit Path
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(b) Click Edit.

Figure 7-43 Edit Circuit Dialog Box
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c) Click the Nodes tab.
Click the Add button to add additional drops.

2

Choose Ethergroup from the Slot menu.

—
fa)

(
(
(e) Choose Node 3 from the Node menu.
(
(g) Click OK.

(h) Click Close.

You now need to provision the Ethernet ports and assign ports to VLANSs. For instructions on
port provisioning, see the “VLAN Membership and Ethernet Port Provisioning” section on
page 7-59. For information about manually provisioning Ethernet circuits, see the “Ethernet
Manual Cross-Connects” section on page 7-54.

Figure 7-44 shows a completed shared packet ring circuit.
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Figure 7-44 Completed Shared Packet Ring Circuit
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7.8.3 Hub and Spoke Ethernet Circuit Provisioning

This section provides steps for creating a hub and spoke Ethernet circuit configuration. The hub and
spoke configuration connects point-to-point circuits (the spokes) to an aggregation point (the hub).
In many cases, the hub is an E1000-2 card that links to a high-speed connection and the spokes are
E100T cards. Figure 7-45 illustrates a sample hub spoke ring. (Your network architecture may differ
from the example.)
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Figure 7-45
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Procedure: Provision a Hub and Spoke Ethernet Circuit

Step 1
Step 2
Step 3

7-46

Log into one of the ONS 15454 Ethernet circuit endpoints.
Double-click the Ethernet card that will create the circuit.

Click the Provisioning tab and the Card subtab.
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Figure 7-46 Single-card EtherSwitch Screen
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Step 4 Under Card Mode, check the Single-card EtherSwitch.
Step5  Click Apply.

Step 6  Log into the other ONS 15454 endpoint and repeat Steps 2-5.
Step 7  Display the network view.

Step8  Click the Circuits tab.

Step9  Click Create.

The Circuit Attributes dialog opens (shown in Figure 7-47).
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Figure 7-47 Circuit Attributes Dialog
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In the Name field, type a name for the circuit.

From the Type menu, choose STS.

AllVLANS..

Note VT and VT Tunnel Type: do not apply to Ethernet circuits.

Choose the size of the circuit from the Size menu.
Verify that the Route Automatically box is checked.
Verify that the Bidirectional box is checked.

Click Next.
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Figure 7-48 Circuit Source
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Step 16  Choose the circuit source from the Node menu.

Note Either end node can be the circuit source.

Step 17 From the Slot menu, choose the Ethernet card for which you enabled the single-card
EtherSwitch.

Step 18 Click Next.

Step 19  Choose the circuit destination from the Node menu.

Note Choose the node that is not the source.

Step 20 From the Slot menu, choose the Ethernet card for which you enabled the single-card
EtherSwitch.

Step 21  Click Next.
The Circuit VLAN Selection dialog displays.
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Figure 7-49 Circuit VLAN Selection
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Note Do not use the default VLAN to pass traffic between nodes.

Step 22 Create the VLAN:
(@) Click the New VLAN tab.
The Define New VLAN dialog opens (see Figure 7-49).

(b) Assign a name to your VLAN that will allow you to easily identify a particular
network.

(c) Assigna VLAN ID.

This should be the next available number (between 2 and 4093) not already assigned to an
existing VLAN. Each ONS 15454 network supports a maximum of 509 user-provisionable
VLANS.

(d) Click OK.
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Figure 7-50
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(e) Highlight the VLAN name and click the arrow >> tab to move the VLAN(s) from
the Available VLANS column to the Circuit VLANS column.
Step 23 Click Next.
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Figure 7-51 Circuit Confirmation
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The Confirm Circuit Creation dialog opens and displays the following information about
the point-to-point circuit (see Figure 7-51):

® (Circuit is bidirectional Ethernet

® Circuit size

® Circuit name
VLAN:Ss that will be transported across this circuit

® ONS 15454 nodes that are part of this circuit

Note If the circuit information is not correct, use the <Back button to correct the
information.

Step 24 Click Finish.

You must now provision the second circuit and attach it to the already-created VLAN.
Step 25 Log into the ONS 15454 Ethernet circuit endpoint for the second circuit.
Step 26 Double-click the Ethernet card that will create the circuit and go to the card view.
Step 27 Click the Provisioning tab and the Card subtab.
Step 28 Under Card Mode, check Single-card EtherSwitch.
Step 29 Click Apply.
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Step 30 Log into the other ONS 15454 endpoint and repeat Steps 26-30.
Step 31 Go to the node view.
Step 32 Click the Circuits tab.
Step 33 Click Create.
Step 34 Choose STS from the Type menu.
Note VT and VT Tunnel Type: do not apply to Ethernet circuits.
Step 35 Choose the size of the circuit from the Size menu.
Step 36  Verify that the Route Automatically box is checked.
Step 37  Verify that the Bidirectional box is checked.
Step 38 Click Next.
Step 39 Choose the circuit source from the Node menu.
Note Either end node can be the circuit source.
Step 40 Click Next.
Step 41  Choose the circuit destination from the Node menu.
Note Choose the node that is not the source.
Step 42 From the Slot menu, choose the Ethernet card for which you enabled the single-card
EtherSwitch.
Step 43 Click Next.
The Circuit VLAN Selection dialog is displayed.
Note Do not use the default VLAN to pass traffic between nodes.
Step 44 Highlight the VLAN that you created for the first circuit and click the arrow >> tab to
move the VLAN(s) from the Available VLANSs column to the Selected VLANs column.
Step 45 Click Next.
Step 46  Click Finish.

You now need to provision the Ethernet ports and assign the ports to VLANSs. For
instructions about port provisioning, see the “VLAN Membership and Ethernet Port
Provisioning” section on page 7-59. For information about assigning Ethernet ports to
VLANS, see the “Provision Ethernet Ports for VLAN Membership” section on page 7-59.
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7.8.4 Ethernet Manual Cross-Connects

ONS 15454s require end-to-end CTC visibility between nodes for normal provisioning of Ethernet
circuits. When other vendors’ equipment sits between ONS 15454s, OSI/TARP- based equipment
does not allow tunneling of the ONS 15454 TCP/IP-based DCC. To circumvent this lack of
continuous DCC, the Ethernet circuit must be manually cross-connected to an STS channel riding
through the non-ONS network. This allows an Ethernet circuit to run from ONS node to ONS node
utilizing the non-ONS network.

Note Provisioning manual cross-connects for multi-card Etherswitch circuits is a separate
procedure from provisioning manual cross-connects for single-card Etherswitch circuits. Both
procedures are listed below.

Caution If a CARLOSS alarm repeatedly appears and clears on an Ethernet manual cross connect,
the two Ethernet circuits may have a circuit-size mismatch. For example, a circuit size of STS-3c
was configured on the first ONS 15454 and circuit size of STS-12¢ was configured on the second
ONS 15454. To troubleshoot this occurrence of the CARLOSS alarm, refer to the CARLOSS alarm
troubleshooting procedure in the Alarm Troubleshooting chapter of the Cisco ONS 15454
Troubleshooting and Maintenance Guide.

Figure 7-52 Ethernet manual cross-connects
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Procedure: Provision a Single-card Etherswitch Manual Cross-Connect
Step1  Log into one of the ONS 15454 Ethernet circuit endpoints.

Step2  Double-click one of the Ethernet cards that will comprise the circuit.
Step 3  Click the Provisioning > Card tabs.
Step 4 Under Card Mode, verify that Single-card EtherSwitch is checked.

If the Single-card EtherSwitch is not checked, check it and click Apply.
Step5  Display the node view.
Step 6  Click the Circuits tab and click Create.

The Circuit Creation (Circuit Attributes) dialog box opens (Figure 7-53).
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Figure 7-53 Creating an Ethernet circuit
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In the Name field, type a name for the circuit.

From the Type menu, choose STS.

The types VT and VT Tunnel do not apply to Ethernet circuits.

Choose the size of the circuit from the Size menu.

The valid circuit sizes for an Ethernet Multicard circuit are STS-1, STS-3c and STS-6c.
Verify that the Bidirectional checkbox is checked and click Next.

The Circuit Creation (Circuit Source) dialog box opens.

From the Node menu, choose the current node as the circuit source.

Choose the Ethernet card that will comprise the circuit from the Slot menu and click Next.
The Circuit Creation (Circuit Destination) dialog box opens.

From the Node menu, choose the current node as the circuit destination.

Choose the optical card that will comprise the circuit from the Slot menu.

Choose the STS that will comprise the circuit from the STS menu and click Next.

Note For the Ethernet manual cross-connect, the destination and source should be the
same node.

The Circuit Creation (Circuit VLAN Selection) dialog box opens (Figure 7-49).

Note As a general rule, do not use the default VLAN to pass traffic between nodes.

Create the VLAN:
(a) Click the New VLAN tab.
The Circuit Creation (Define New VLAN) dialog box opens (Figure 7-54).
(b) Assign an easily-identifiable name to your VLAN.
(c) Assigna VLAN ID.

The VLAN ID should be the next available number (between 2 and 4093) that is not already

assigned to an existing VLAN. Each ONS 15454 network supports a maximum of 509
user-provisionable VLANS.
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Figure 7-54
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Step 17

Step 18

Step 19

Step 20

(e) Highlight the VLAN name and click the arrow >> tab to move the VLAN(s) from
the Available VLANSs column to the Circuit VLANSs column (Figure 7-56).

Click Next.

The Circuit Creation (Circuit Routing Preferences) dialog box opens.
Confirm that the following information is correct:

® Circuit name

® Circuit type

® Circuit size

® VLAN:S that will be transported across this circuit

® ONS 15454 nodes included in this circuit

June 2001

Note If the circuit information is not correct use the Back button, then redo the
procedure with the correct information. Alternately, you can click Finish, then delete the
completed circuit and start the procedure from the beginning.

Click Finish.

You now need to provision the Ethernet ports and assign these ports to VLANS. For port
provisioning instructions, see the “VLAN Membership and Ethernet Port Provisioning”
section on page 7-59. Return to the following step after assigning the ports to VLANS.

Repeat Steps 1 — 19 at the second ONS 15454 Ethernet manual cross-connect endpoint.

Note The appropriate STS circuit must exist in the non-ONS 15454 equipment to
connect the two STSs from the ONS 15454 Ethernet manual cross-connect endpoints.

Procedure: Provision a Multi-card Etherswitch Manual Cross-Connect

Step 1

7-56

Log into one of the ONS 15454 Ethernet circuit endpoints.
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Step2  Double-click one of the Ethernet cards that will comprise the circuit.
Step 3  Click the Provisioning > Card tabs.
Step 4 Under Card Mode, verify that Multi-card EtherSwitch is checked.
If the Multicard-card EtherSwitch is not checked, check it and click Apply.
Step5  Display the node view.
Step 6  Repeat Steps 2 — 5 for any other Ethernet cards in the ONS 15454 that will comprise the
circuit.
Step7  Click the Circuits tab and click Create.

The Circuit Creation (Circuit Attributes) dialog box opens (Figure 7-55).

Figure 7-55 Creating an Ethernet circuit
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In the Name field, type a name for the circuit.

From the Type menu, choose STS.

The types VT and VT Tunnel do not apply to Ethernet circuits.

Choose the size of the circuit from the Size menu.

The valid circuit sizes for an Ethernet Multicard circuit are STS-1, STS-3c and STS-6c.
Verify that the Bidirectional checkbox is checked and click Next.

The Circuit Creation (Circuit Source) dialog box opens.

From the Node menu, choose the current node as the circuit source.
Choose Ethergroup from the Slot menu and click Next.

The Circuit Creation (Circuit Destination) dialog box opens.

From the Node menu, choose the current node as the circuit destination.

Choose Ethergroup from the Slot menu and click Next.

Note For the Ethernet manual cross-connect, the destination and source should be the
same node.

The Circuit Creation (Circuit VLAN Selection) dialog box opens (Figure 7-56).

Note Do not use the default VLAN to pass traffic between nodes.
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Step 16 Create the VLAN:
(@) Click the New VLAN tab.
(b) Assign an easily-identifiable name to your VLAN.
(c) Assigna VLANID.
The VLAN ID should be the next available number (between 2 and 4093) that is not already
assigned to an existing VLAN. Each ONS 15454 network supports a maximum of 509
user-provisionable VLANS.
(d) Click OK.
Figure 7-56 Selecting VLANs
2 Circuit Creation
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(e) Highlight the VLAN name and click the arrow >> tab to move the VLAN(s) from
the Available VLANSs column to the Circuit VLANSs column (Figure 7-56).
Step 17  Click Next.
The Circuit Creation (Circuit Routing Preferences) dialog box opens.
Step 18 Confirm that the following information is correct:
® Circuit name
¢ Circuit type
® Circuit size
® VLAN:S that will be transported across this circuit
® ONS 15454 nodes included in this circuit
Note If the circuit information is not correct use the Back button, then redo the
procedure with the correct information. Alternately, you can click Finish, then delete the
completed circuit and start the procedure from the beginning.
Step 19  Click Finish.
You now need to provision the Ethernet ports and assign these ports to VLANS. For port
provisioning instructions, see the “VLAN Membership and Ethernet Port Provisioning”
section on page 7-59. Return to the following step after assigning the ports to VLANS.
Step 20 Highlight the circuit and click Edit.
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The Edit Circuit dialog box opens.
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Step 21

Step 22

Step 23
Step 24

Step 25

Step 26

Step 27

Click Drops and click Create.
The Define New Drop dialog box opens.

From the Slot menu, choose the optical card that links the ONS 15454 to the non-ONS
15454 equipment.

From the Port menu, choose the appropriate port.

From the STS menu, choose the STS that matches the STS of the connecting non-ONS
15454 equipment.

Click OK.
The Edit Circuit dialog box opens.

Confirm the circuit information that displays in the Circuit Information dialog box and
click Close.

Repeat Steps 1 — 26 at the second ONS 15454 Ethernet manual cross-connect endpoint.

Note The appropriate STS circuit must exist in the non-ONS 15454 equipment to
connect the two ONS 15454 Ethernet manual cross-connect endpoints.

7.9 VLAN Membership and Ethernet Port Provisioning

This section explains how to provision Ethernet ports, including provisioning Ethernet ports for
VLAN membership.

Procedure: Provision Ethernet Ports for VLAN Membership

Note The same basic procedure configures E100T-12 and E1000-2 Ethernet ports for VLAN
membership. The VLAN port provisioning screen shown in this example is for an E100T-12 card.

The ONS 15454 allows you to configure the VLAN membership and the Q-tag handling of
individual Ethernet ports.

Step 1

With the Provisioning menu tab selected, click the VLAN subtab (see Figure 7-57).
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Figure 7-57 VLAN Port Provisioning Screen
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Step2  To place aportin a VLAN, click the port and choose either Tagged or Untag. Figure 7-57
shows Port 1 placed in the test | VLAN and Port 2-Port 12 in the default VLAN. Table 7-6
shows valid port settings.

If a port belongs to only one VLAN, go to that VLAN’s row and choose Untag from that port’s
column. Choose -- for all the other VLAN rows under that port. This allows the VLAN with Untag
selected to access that port and prohibits the other VLANS with -- selected to access the port.

If a port is a trunk port, it connects multiple VLANSs to an external device, such as a router. This port
must have tagging (8021.Q) enabled for all the VLANSs that connect to the external device. Choose
Tagged at each VLAN row in the trunk port column. Choose Untag in the default VLAN row in the
column under the trunk port’s heading.

Table 7-6 Port Settings
Setting Description
-- A port marked with this symbol does not belong to the VLAN.
Untag The ONS 15454 will tag ingress frames and strip tags from egress frames.
Tagged The ONS 15454 will handle ingress frames according to VLAN ID, egress frames will

not have their tags removed.

Note If Tagged is chosen, the attached devices must be IEEE 802.1Q VLAN aware.
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Step 3  After each port is placed in the appropriate VLAN, click Apply.

Note Both ports on an individual E1000-2 card cannot be members of the same VLAN.

Procedure: Provision E1000-2 Ethernet Ports
Step 1 Double-click the card graphic to open the Ethernet card.

Step 2 From the Ethernet card view, choose the Provisioning menu tab.

Step3  Choose the Port subtab.

Note Most provisioning requires only two fields: Enabled and Mode.

Figure 7-59 shows the Provisioning menu screen with the Port subtab selected.

Figure 7-58 Port Provisioning Screen
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Step4  From the Port Provisioning screen, choose the appropriate mode for each Ethernet port.
The valid choices for the E1000-2 card are 1000 Full or Auto.

Step5  Click the Enabled box to activate the desired Ethernet ports.
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Note The Status column displays information about the port’s current operating mode.

Step6  Click Apply.

Your Ethernet ports are now provisioned and ready to be configured for VLAN
membership (see the “Provision Ethernet Ports for VLAN Membership” section on
page 7-59).

Procedure: Provision E100T-12 Ethernet Ports
Step 1 Double click the card graphic to open the E100T-12 card.

Step 2 From the Ethernet card view, choose the Provisioning menu tab.
Step3  Choose the Port subtab.

Figure 7-59 shows the Provisioning menu screen with the Port function subtab selected.

Figure 7-59 Port Provisioning Screen
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Step4  From the Port Provisioning screen, choose the appropriate mode for each Ethernet port.
Valid choices for the E100T-12 card are Auto, 10 Half, 10 Full, 100 Half or 100 Full.

Step 5 In the Enabled column, click the box to activate the desired Ethernet ports.
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Most provisioning requires filling in two fields: Enabled and Mode. However, the user
may also map incoming traffic to a low priority or a high priority using the Priority
column or enable spanning tree with the Stp Enabled column. The Status column displays
information about the port’s current operating mode, and the Stp State column gives the
current Spanning tree status.

Step 6  Click Apply.

Your Ethernet ports are now provisioned and ready to be configured for VLAN
membership (see the “Provision Ethernet Ports for VLAN Membership” section on
page 7-59).

7.10 Ethernet Maintenance and Performance Screens

The CTC provides several screens of information to help manage and maintain Ethernet
performance.

7.10.1 Statistics Screen

The Ethernet statistics screen lists Ethernet parameters at the port level. Table 7-7 defines the
parameters. Click the Performance and Statistics tabs at the card level view to display the screen (see
Figure 7-60).
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Figure 7-60 Ethernet Statistics
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Table 7-7 Ethernet Parameters
Parameter Meaning
Link Status Indicates if link integrity is present; up indicates present, and down
indicates not present
RX Packets Number of packets received since the last counter reset
RX Bytes Number of bytes received since the last counter reset
TX Packets Number of packets transmitted since the last counter reset
TX Bytes Number of bytes transmitted since the last counter reset
RX Total Errors | Total number of receive errors
RX FCS Number of packets with a Frame Check Sequence (FCS) error. FCS
errors indicate Frame corruption during transmission
RX Alignment Number of packets with alignment error; alignment errors are Frames
not received whole
RX Runts Number of packets received that are less than 64 bytes in length
RX Giants Number of packets received that are greater than 1518 bytes in length
TX Collisions Number of transmit packets that are collisions; collisions are caused

by the port and attached device transmitting at the same time
TX Excessive Number of consecutive collisions

TX Deferred Number of packets deferred
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7.10.2 Line Utilization Screen

The Line Utilization screen shows the percentage of line or port bandwidth currently used and the
percentage used in the past. Click the Performance and Utilization tabs at the Ethernet card view
to display the screen (see Figure 7-61). At the Interval drop-down menu, choose a time segment

variable for the intervals. Valid intervals are 1 minute, 15 minutes, 1 hour, and 1 day.

Note Line utilization numbers express the average of ingress and egress traffic as a percentage of

capacity.

Figure 7-61
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7.10.3 History Screen

The Ethernet History screen lists past Ethernet statistics. Choose the appropriate port from the Line
menu. Table 7-7 defines the listed parameters. At the Ethernet card view, click the Performance tab

and History subtab to view the screen (shown in Figure 7-62).
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Figure 7-62 Ethernet History
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7.10.4 Spanning Trees Screen

The Spanning Trees screen lists information about spanning trees on the ONS 15454. Click the
Maintenance>EtherBridge>Spanning Trees tabs to view the screen (shown in Figure 7-63). For
more information about spanning trees and the ONS 15454, see the “Spanning Tree” section on
page 7-10.
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Figure 7-63 Spanning Tree Topology

@cic [ [=]x]
File GoTo Help
Sl S S iy S S S
frod eroddoc iz o povijec paovifoc foc
Hode :Node 2 B &
IP Addr : 192.1.1.1 D |:|
Booted : 6/6/00 11:09 AM e L
CR= 0 Md= 1 MN= O
User @ cerent4dsd
Authority: Superuser hl 2 3 4 5 6 7 g g 10 11 12 13 14 15 16 17

A\arms} H\storﬂ mvisiommg] Imventany MaimEﬂEﬂCE}

Databaze  [gp MAC Addresses} Trunk Utll\zatlon}

Ether Bridge #* | BridgelD | Topohge |TUpUChang.| DesignatedRoot RootCost RootPort Maxtge | HelloTime | HoldTime ForwDelay
P | g 8000 00107008503 36600 84 000D 00107026703 4 T 0 2 1 15
Ring
Software
HC Cards
Diagnostic
Tiring
Audit

42740

7.10.5 MAC Addresses Screen

A MAC address is a hardware address that physically identifies the equipment attached to the ONS
15454 port or the network attached to the port. The MAC addresses table (also called the MAC
forwarding table) lists the MAC Addresses stored by the ONS 15454 and the VLAN, Slot/Port/STS,
and circuit that links the ONS 15454 to each MAC address (see Figure 7-64).

Figure 7-64 MAC Addresses Discovered
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Click the Maintenance>EtherBridge>MAC Addresses tabs to view the screen (see Figure 7-65).
® Click Retrieve for the ONS 15454 to retrieve and display the current MAC IDs.
® (Click Clear to clear the highlighted rows.
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® (Click Clear All to clear all displayed rows.

Figure 7-65 MAC Forwarding Table
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7.10.6 Trunk Utilization Screen

The Trunk Utilization screen is similar to the Line Utilization screen, but the Trunk Utilization
screen shows the percentage of circuit bandwidth being used rather than the percentage of line
bandwidth being used. Choose a time segment variable for the intervals at the Interval menu. Click
the Maintenance>EtherBridge>Trunk Utilization tabs to view the screen (shown in Figure 7-66).

Note The percentage shown is the average of ingress and egress traffic.
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Figure 7-66 Trunk Utilization
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7.11 Remote Monitoring Specification Alarm Thresholds

The ONS 15454 features SNMP Remote Network Monitoring (RMON) that allows network
operators to monitor the health of the network with a Network Management System (NMS). For a
complete list of the implemented RMON Management Information Bases (MIBs), see the “SNMP
Remote Network Monitoring” section on page 8-8.

One of the ONS 15454’s RMON MIBs is the Alarm group. The alarm group contains the
alarmTable. An NMS uses the alarmTable to find the alarm-causing thresholds for network
performance. The thresholds apply to the current 15-minute interval and the current 24-hour interval.
The RMON monitors several variables, such as Ethernet collisions, and triggers an event when the
variable crosses a threshold during that time interval. For example, if a threshold is set at 1000
collisions and 1001 collisions occur during the 15-minute interval, an event triggers.

CTC allows you to provision these thresholds for Ethernet statistics. The following tables define the
variables provisioned in the CTC. For example, to set the collision threshold, click
etherStatsCollisions in the Variable menu.
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Table 7-8 Ethernet Threshold Variables (MIBs)
Variable Definition
iflnOctets Total number of octets received on the interface, including framing octets.
iflnUcastPkts Total number of unicast packets delivered to an appropriate protocol.
iflnErrors Number of inbound packets discarded because they contain errors.
ifOutOctets Total number of transmitted octets, including framing packets.
ifOutUcastPkts Total number of unicast packets requested to transmit to a single address.

dot3statsAlignmentErrors

dot3StatsFCSErrors

dot3StatsSingleCollisionFrames

dot3StatsMutlipleCollisionFrame

dot3StatsDeferredTransmissions

dot3StatsLateCollision

dot3StatsExcessiveCollision

dot3StatsFrameTooLong

etherStatsUndersizePkts

etherStatsFragments

etherStatsPkts64Octets

etherStatsPkts65to127Octets

etherStatsPkts128t02550ctets

etherStatsPkts256t05110ctets

etherStatsPkts512to1023Octets

etherStatsPkts1024to15180ctets

etherStatsBroadcastPkts
etherStatsMulticastPkts

etherStatsJabbers

etherStatsCollisions

etherStatsCollisionFrames
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Number of frames with an alignment error, i.e., the length is not an integral
number of octets and the frame cannot pass the FCS test.

Number of frames with framecheck errors, i.e. there is an integral number of
octets, but an incorrect FCS.

Number of successfully transmitted frames for which there was exactly one
collision.

Number of successfully transmitted frames for which there were multiple
collisions.

Number of times the first transmission was delayed because the medium was
busy.

Number of times that a collision was detected later than 64 octets into the
transmission (also added into collision count).

Number of frames for which transmissions failed because of excessive
collisions.

Number of received frames that were bigger than the maximum size
permitted.

Number of packets received with a length less than 64 octets.

Total number of packets without an integral number of octets or with a bad
FCS and less than 64 octets long.

Total number of packets received (including error packets) that were
64 octets in length.

Total number of packets received (including error packets) that were 65 —
172 octets in length.

Total number of packets received (including error packets) that were 128 —
255 octets in length.

Total number of packets received (including error packets) that were 256 —
511 octets in length.

Total number of packets received (including error packets) that were 512 —
1023 octets in length.

Total number of packets received (including error packets) that were 1024 —
1518 octets in length.

Total number of good broadcast packets received.
Total number of good multicast (non broadcast) packets received.

Total number of packets longer than 1518 octets without an integral number
of octets or a bad FCS.

Best estimate of the total number of collisions on this segment.

Best estimate of the total number of frame collisions on this segment.
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Table 7-8 Ethernet Threshold Variables (MIBs)
Variable Definition
etherStatsCRCAlignErrors Total number of packets with a length between 64 and 1518 octets
(inclusive) that had a bad FCS or were not an integral number of octets in
length.

Procedure: Creating Ethernet Thresholds

Figure 7-67 Ethernet Alarm Screen
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Step 1 From the node view, click the Provisioning tab and the Etherbridge subtab.
Step2  Click the Thresholds tab.
Step3  Click Create.

The Create Ether Threshold menu appears.
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Figure 7-68 Ethernet Alarm Thresholds
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Step4  Click the Slot menu to choose the appropriate Ethernet card.

Step5  Click the Port menu to choose the Port on the Ethernet card.

Step 6  Click the Variable menu to choose the variable. Table 7-8 lists and defines the Ethernet
Threshold Variables available in this field.

Step7  Click the Alarm Type to choose whether the event will be triggered by the rising
threshold, falling threshold, or both the rising and falling thresholds.

Step 8  Click the Sample Type, either Relative or Absolute. Relative restricts the threshold to
use the number of occurrences in the user-set sample period. Absolute sets the threshold
to use the total number of occurrences, regardless of any time period.

Step9  Type in an appropriate number of seconds for the Sample Period.

Step 10 Type in the appropriate number of occurrences for the Rising Threshold.

Note The rising threshold is the number of occurrences that must be exceeded to trigger
an event. For example, if a network problem causes 1001 collisions in 15 seconds, these
occurrences cross a rising threshold set at 1000 collisions in 15 seconds.

Step 11 Type in the appropriate number of occurrences for the Falling Threshold. In most cases

a falling threshold is set lower than the rising threshold.
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Note A falling threshold is the counterpart to a rising threshold. When the number of
occurrences drops below a falling threshold, it resets the rising threshold. For example,
when the network problem that caused 1001 collisions in 15 minutes subsides and creates
only 799 collisions in 15 minutes, occurrences fall below a falling threshold of 800
collisions. This resets the rising threshold so that if network collisions again spike over a
1000 per 15- minute period, an event again triggers when the rising threshold is crossed.
An event is triggered only the first time a rising threshold is exceeded (otherwise a single
network problem might cause a rising threshold to be exceeded multiple times and cause
a flood of events).

Step 12  Click the OK button to complete the procedure.

7.12 Basic Ethernet Connectivity Testing

Most connectivity problems experienced in an Ethernet network can be fixed by following a few
guidelines. Refer to this section if you have problems connecting Ethernet networks. See Figure 7-69
when consulting these guidelines.

Figure 7-69 Ethernet Connectivity Reference
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Procedure: Test Ethernet Connectivity

Step1  Verify that no SONET alarms exist for the STS-N that carries the VLAN #1 Ethernet
circuit.

Step2  Verify that no Ethernet specific alarms exist.

Step3  Verify that the ACT LED on the Ethernet card is green.
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Step4  Verify that Ports 1 and 3 on ONS 15454 #1 and Port 1 and Port 2 on ONS 15454 #2 have
green link-integrity LEDs. If there is no green link-integrity LED for any of these ports:

(a) Verify physical connectivity between the ONS 15454s and the attached device.
(b) Verify that the ports are enabled on the Ethernet cards.
(c) Verify that you are using the proper Ethernet cable and that it is wired correctly.

Step5  Verify connectivity between device A and device C by performing an ICMP ping between
these locally attached devices. If the ping is unsuccessful:

(a) Verify that device A and device C can ping each other.
(b) Verify that device A and device C are on the same IP subnet.

(c) Verify that both Port 1 and Port 3 on the Ethernet card are assigned to the same
VLAN.

Step 6  Repeat Steps 4 and 5 for devices B and D.

Verify that the Ethernet circuit that carries VLAN #1 is provisioned and that both ONS
15454 #1 and ONS 15454 #2 are included in the VLAN #1 circuit.
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CHAPTER 8

Network Management

This chapter explains concepts related to network management with the ONS 15454. It includes
Simple Network Management Protocol (SNMP), front panel LCD IP entry, Proxy ARP, IP
addressing and subnets, IP troubleshooting, and Static Route Provisioning.

8.1 Simple Network Management Protocol

Simple Network Management Protocol (SNMP) is an application-layer Internet Protocol (IP) that
allows network devices to exchange management information. SNMP enables network
administrators to manage network performance, find and solve network problems, and plan for
network growth.

The Cisco ONS 15454 supports SNMP Version 1 (SNMPv1) and SNMP Version 2c (SNMPv2c).
Both versions share many features, but SNMPv2c offers additional protocol operations. This section
describes both versions and explains how to configure SNMP on the ONS 15454. Figure 8-1
illustrates a basic network managed by SNMP.

Figure 8-1 Basic Network Managed by SNMP

24186
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8.1.1 SNMP Basic Components

An SNMP-managed network consists of three primary components: managed devices, agents, and
management systems. A managed device is a network node that contains an SNMP agent and resides
on a managed network. Managed devices collect and store management information and use SNMP
to make this information available to management systems that use SNMP. Managed devices include
routers, access servers, switches, bridges, hubs, computer hosts, and printers.

An agent is a software module that resides in a managed device. An agent has local knowledge of
management information and translates that information into a form compatible with SNMP. The
SNMP agent gathers data from the management information base (MIB), which is the repository for
information about device parameters and network data. The agent can also send traps, or notification
of certain events, to the manager. Figure 8-2 illustrates these SNMP operations.

Figure 8-2 SNMP Operations

NMS Network device

et, get-next, get-bulk
_‘ get, g g > e
<

’ get-response, traps
SNMP Manager MIB

SNMP Agent

A management system executes applications that monitor and control managed devices.
Management systems provide the bulk of the processing and memory resources required for network
management. One or more management systems must exist on any managed network. Figure 8-3
illustrates the relationship between the three key SNMP components.
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Figure 8-3
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8.1.2 SNMP Support

The ONS 15454 supports SNMP v1 and v2c traps and gets. The SNMP MIBs in the ONS 15454 define
alarms, traps, and status. Through SNMP, network management system (NMS) applications can query a
management agent using a supported MIB. The functional entities include an Ethernet switch, SONET
multiplexer, and many others. SNMP can access the ONS 15454 through the Timing Communication and
Control (TCC) card Ethernet port, the backplane LAN wire-wrap, or SONET Data Communication Channel

(SDCCO).

Procedure: Set up SNMP Support

Step 1 On the Cisco Transport Controller (CTC) window, click the Provisioning tab.
Step 2 From the Provisioning menu, click the SNMP function tab.
Step3  Click Create.

The Create SNMP Trap Destination dialog opens (Figure 8-4).
For a description of SNMP traps, see the “SNMP Traps” section on page 8-7.
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Figure 8-4 Create SNMP Trap Destination Dialog
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Step4  Type the IP address of your NMS in the IP Address field.
Step5  Type the SNMP community name in the Community Name field.

For a description of SNMP community names, see the “SNMP Community Names”
section on page 8-8.

Note The community name is a form of authentication and access control. The
community name assigned to the ONS 15454 is case-sensitive and must match the
community name of the NMS.

Note The default UDP port for SNMP is 162.

Step 6  Set the Trap Version field for either SNMPv1 or SNMPv2.
Refer to your NMS documentation to determine whether to use SNMP v1 or v2.

Step7  Set your maximum traps per second in the Max Traps per Second field.

Note The max traps per second is the maximum number of traps per second that you
want sent to the SNMP manager. If set to 0, there is no maximum and all traps are sent.

Step8  Click OK.

SNMP settings are now configured. To view SNMP information for each node, click the
IP address of a node on the Trap Destinations screen (Figure 8-5).
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Figure 8-5 Trap Destinations Screen
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8.1.3 SNMP MIBs

A Management Information Base (MIB) is a hierarchically-organized collection of information.
MIBs are accessed using a network-management protocol such as SNMP. They are comprised of
managed objects and are identified by object identifiers.

The ONS 15454 SNMP manager uses information in the MIB to perform the operations described
in Table 8-1
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Table 8-1 SNMP Manager Operations
Operation Description
get-request Retrieve a value from a specific
variable
get-next-request Retrieve the value following the

named variable; Often used to
retrieve variables from within a table

)

get-response The reply to a get-request,
get-next-request, get-bulk-request,
or set-request sent by an NMS

get-bulk-request Similar to get-next-request, but fill
the get-response with up to
max-repetition number of get-next
interactions

trap An unsolicited message sent by an
SNMP agent to an SNMP manager
indicating that some event has
occurred

1.With this operation, an SNMP manager does not need to know the exact variable name. A sequential search is performed to find the needed variable from within

8-6

the MIB.

A managed object (sometimes called a MIB object) is one of any number of specific characteristics
of a managed device. Managed objects are comprised of one or more object instances that are
essentially variables.

The ONS 15454 MIBs ship on the accompanying software CD. These MIBs need to be compiled in
the following order. If the order is not followed, one or more MIB files may not compile.

1 cerentregistry.mib
2 cerentTC.mib
3 cerent454.mib

If you are unable to compile the ONS 15454 MIBs, call the Technical Assistance Center (TAC) at
1-877-323-7368.

Table 8-2 IETF Standard MIBs Implemented in the ONS 15454 SNMP Agent
RFC# | Module Name Title/Comments
1213 RFC1213-MIB, MIB-II from RFC1213 with enhancement from RFC1907 for v2
+1907 | SNMPV2-MIB
1493 BRIDGE-MIB Bridge/Spanning Tree (SNMPv1 MIB)
2037 ENTITY-MIB Entity MIB using SMI v2
2233 IF-MIB Interface evolution (enhances MIB-II)
2358 Etherlike-MIB Ethernet-like interface (SNMPv2 MIB)
2495 DS-1/E1
2496 DS-3/E3
2558 SONET-MIB SONET
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Table 8-2 IETF Standard MIBs Implemented in the ONS 15454 SNMP Agent
RFC# | Module Name Title/Comments
2674 P-Bridge and Q-Bridge MIB

8.1.4 SNMP Traps

The ONS 15454 can receive SNMP requests from a number of SNMP managers and send traps to
ten trap receivers. The ONS 15454 generates all alarms and events as SNMP traps.

Traps generated by the ONS 15454 contain an object ID that uniquely identifies the alarm. An entity
identifier uniquely identifies which entity generated the alarm (slot, port, STS, VT, BLSR, STP, etc.).
The traps give the severity of the alarm (critical, major, minor, event, etc.) and indicate whether the
alarm is service affecting or non-service affecting. The traps also contain a date/time stamp that
shows the date and time the alarm occurred. The ONS 15454 also generates a trap for each alarm
when the alarm condition clears.

Each SNMP trap contains seven variable bindings (Table 8-3).

Table 8-3 SNMP Trap Variable Bindings
Number | Name Description
1 cerentNodeTime Indicates current local time as reflected by the ONS 15454
2 cerent454AlarmState Specifies alarm severity and service affecting status

(SA/NSA); only {minorlmajorlcritical } +{NAINSA} are
represented here

3 cerent454AlarmObjectType Indicates what type of entity raised this alarm (for
example, DS-3, etherBridge, VI-TERM, etc); the NMS
often uses this value to decide which table to poll for
further information about the alarm

4 cerent454AlarmObjectIndex Every alarm is raised by an object that is an entry in a
specific table. This is the index of the object in that table;
in other words, if the alarm is interface related, this is the
index of the interface in the interface table.

5 cerent454AlarmSlotNumber This indicates the object slot that raised this alarm; if no
slot is relevant to the alarm, the object slot will be zero

6 cerent454AlarmPortNumber This indicates the object port that raised this alarm; if no
object port is relevant to the alarm, the object port will be
zero.

7 cerent454AlarmLineNumber This indicates the object LINE that raised this alarm; If no

LINE is relevant to the alarm, the LINE will be zero.

The ONS 15454 supports generic and Internet Engineering Task Force (IETF) traps. The generic
traps are listed in Table 8-4. IETF-supported traps are listed in Table 8-5.

Table 8-4 Generic Traps Supported in the ONS 15454

IETF Standard Objects in
Trap From RFC# Varbind List Description
ColdStart RFC1213-MIB None Agent up - cold start
WarmStart RFC1213-MIB None Agent up - warm start
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Table 8-4 Generic Traps Supported in the ONS 15454

IETF Standard Objects in
Trap From RFC# Varbind List Description
AuthenticationFailure RFC1213-MIB None Community string

did not match

Table 8-5 IETF Traps Supported by the ONS 15454
IETF standard objects
Trap From RFC # in varbind list
Description
NewRoot RFC1493/ None Sending agent is the new root of the
BRIDGE-MIB spanning tree
TopologyChange RFC1493/ None A port in a bridge has changed from
BRIDGE-MIB Learning to Forwarding or Forwarding
to Blocking
EntConfigChange RFC2037/ None entLastChangeTime value has changed
ENTITY-MIB

8.1.5 SNMP Community Names

You can provision community names for all SNMP requests from the SNMP Trap Destination
window in CTC (see the “Set up SNMP Support” section on page 8-3). In effect, any SNMP request
using a community name that matches a community name on the list of provisioned SNMP trap
destinations is considered valid. Otherwise, the request is considered invalid and is dropped.

If an SNMP request contains an invalid community name, the request is silently dropped and the
MIB variable, snmpInBadCommunityNames, is incremented. All SNMP requests containing a
validated community name are granted access to all MIB variables managed by the agent.

8.1.6 SNMP Remote Network Monitoring

The ONS 15454 incorporates Remote Monitoring (RMON) to allow network operators to monitor
the ONS 15454’s E100 and E1000 cards. This feature is not apparent to the typical CTC user,
because RMON interoperates with a network management application. However, with CTC the user
can provision the RMON alarm thresholds (see the “Remote Monitoring Specification Alarm
Thresholds” section on page 7-69). The CTC also monitors the five RMON groups implemented by
the ONS 15454.

The ONS 15454 RMON implementation is based on the IETF standard MIB Request for Comment
(RFC)1757. The ONS 15454 implements five groups from the standard MIB: Ethernet Statistics,
History Control, Ethernet History, Alarm, and Event.

8.1.6.1 Ethernet Statistics Group

The Statistics group contains the basic statistics for each monitored subnetwork in a single table
named etherstats.
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8.1.6.2 History Control Group

The History Control group defines sampling functions for one or more monitor interfaces. RFC 1757
defines the historyControlTable.

8.1.6.3 Ethernet History Group

RFC 1757 defines the etherHistoryTable. The etherHistoryTable will be implemented as defined in
RFC 1757, within the bounds of the historyControlTable.

8.1.6.4 Alarm Group

The alarm group consists of a single alarm table. This table provides the network performance alarm
thresholds for the network management application.You can provision the thresholds in the table
with CTC.

8.1.6.5 Event Group

The event group consists of two tables, evenTable and logTable. The evenTable is read-only. The
logTable is implemented as specified in RFC 1757.
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8.2 IP Address Entry Using Front Panel LCD

Users can se